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Overview of this guide 
The InForm Design Guide describes how to design a study for deployment to the InForm application. 
 

Audience 
This guide is for users of the Central Designer application, including the following. 

 

User Description 

Clinical data manager A user who is involved in the study design process. 

Library administrator A user with library administration privileges for one or more 
clinical areas. 

Central Designer administrator An IT representative who supports and maintains the application 
from a technology and infrastructure perspective. 

Study design team Users who implement a study. This team includes several roles 
such as form designer, rule designer, and study workflow 
designer. 

Medical project manager A user who works with the CRF designer to create an annotated 
study protocol, usually based on existing CRFs for the therapeutic 
area. This user is concerned with the overall set of study 
questions and logic, not the individual details of form design. 

Statistician A user who interacts with study designers with respect to data 
collection needs for analysis. 

Translator A user who is responsible for translating text in clinical studies, 
forms, items, and rule queries to a specified language. 
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Prerequisites 
You should have experience in one or more of the following clinical areas: 

• Data management 

• Data analysis 

• Study design 

• Library management 

• Project management 

Additionally, rule developers must have the following levels of programming expertise, depending on 
the types of rules they will be creating. 

 

Type of rule Required programming expertise 
Simple edit checks using rule 
templates. 

None. 

Comparisons, calculations. • Understanding of C# or similar (for example, Java, C, or 
C++) expression syntax. 

• Ability to incorporate functions in expressions. 

User-defined functions. • Ability to program in a .NET language (for example, C#) 
and create .NET assemblies. 
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Documentation 
The product documentation is available from the following locations: 

• My Oracle Support (https://support.oracle.com)—Release Notes and Known Issues. 

• Oracle Technology Network (http://www.oracle.com/technetwork/documentation/hsgbu-
154445.html)—The most current documentation set, excluding the Release Notes and Known Issues. 

If the software is available for download, the complete documentation set is available from the 
Oracle Software Delivery Cloud (https://edelivery.oracle.com). 

All documents may not be updated for every Central Designer release. Therefore, the version 
numbers for the documents in a release may differ. 

 

Item Description 
Release Notes The Release Notes document provides detailed information about the requirements, 

enhancements, and fixed issues in the current release. 

Known Issues The Known Issues document provides detailed information about the known issues 
in this release, along with workarounds, if available. 

Installation Guide The Installation Guide provides system requirements and instructions for installing 
and upgrading the Oracle® Health Sciences Central Designer software and the 
Oracle® Health Sciences Central Designer Administrator software. 

Administrator 
Guide 

The Administrator Guide describes how to use the Oracle® Health Sciences Central 
Designer Administrator software to set up users, permissions, system 
configuration parameters, and catalog defaults. 

User Guide The User Guide introduces the study design environment in the Oracle® Health 
Sciences Central Designer application and describes how to work as a study 
design team in that environment, including how to: 

• Work collaboratively. 

• Maximize study design efficiency by reusing study objects. 

• Manage collections of study objects.  

InForm Design 
Guide 

The InForm Design Guide describes how to design a study for deployment to the 
InForm application. 

Rules Reference 
Guide 

The Rules Reference Guide is a reference to the tools that are available for creating 
rule expressions, including: 

• Study object properties. 

• Functions. 

• Constants. 

• Data mappings. 

• Methods, operators, and literals. 
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Item Description 

Secure 
Configuration 
Guide 

The Secure Configuration Guide provides an overview of the security features 
provided with the Oracle® Health Sciences Central Designer application, including 
details about the general principles of application security, and how to install, 
configure, and use the Central Designer application securely. 

Third Party 
Licenses and 
Notices 

The Third Party Licenses and Notices document includes licenses and notices for 
third party technology that may be included with the Central Designer software. 

Secure 
Development 
Guide 

The Secure Development Guide provides an overview of common security risks for 
developers using Application Programming Interfaces (APIs) with the Oracle® 
Health Sciences Central Designer application, and information on how to address 
those risks. 

  
 

Documentation accessibility 
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program 
website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc. 
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If you need assistance 
Access to Oracle Support 
Oracle customers that have purchased support have access to electronic support through My Oracle 
Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired. 
 

Finding Central Designer information and patches on My Oracle Support 
The latest information about the Central Designer application is on the Oracle Support self-service 
website, My Oracle Support. Before you install and use the Central Designer application, check My 
Oracle Support for the latest information, including Release Notes and Known Issues, alerts, white 
papers, bulletins, and patches. 
 

Creating a My Oracle Support account 
You must register at My Oracle Support to obtain a user name and password before you can enter 
the site. 

1 Open a browser to https://support.oracle.com. 

2 Click the Register link. 

3 Follow the instructions on the registration page. 
 

Finding information and articles 
1 Sign in to My Oracle Support at https://support.oracle.com. 

2 If you know the ID number of the article you need, enter the number in the text box at the top 
right of any page, and then click the magnifying glass icon or press Enter. 

3 To search the knowledge base, click the Knowledge tab, and then use the options on the page to 
search by: 

• Product name or family. 

• Keywords or exact terms. 
 

Finding patches 
You can search for patches by patch ID or number, product, or family. 

1 Sign in to My Oracle Support at https://support.oracle.com. 

2 Click the Patches & Updates tab.  

3 Enter your search criteria and click Search. 

4 Click the patch ID number. 

The system displays details about the patch. You can view the Read Me file before downloading 
the patch. 

5 Click Download, and then follow the instructions on the screen to download, save, and install the 
patch files. 
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Finding Oracle documentation 
The Oracle website contains links to Oracle user and reference documentation. You can view or 
download a single document or an entire product library. 
 

Finding Oracle Health Sciences documentation 
For Oracle Health Sciences applications, go to the Oracle Health Sciences Documentation page at 
http://www.oracle.com/technetwork/documentation/hsgbu-clinical-407519.html.  

Note: Always check the Oracle Health Sciences Documentation page to ensure you have the most 
up-to-date documentation. 

 

Finding other Oracle documentation 
1 Do one of the following: 

• Go to http://www.oracle.com/technology/documentation/index.html. 

• Go to http://www.oracle.com, point to the Support tab, and then click Product 
Documentation. 

2 Scroll to the product you need, and click the link. 
 

Finding prerequisite software for Oracle Health Sciences applications 
Prerequisite software for Oracle Health Sciences applications is available from the following 
locations: 

• Download the latest major or minor release from the Oracle Software Delivery Cloud 
(https://edelivery.oracle.com/). 

For information on the credentials that are required for authorized downloads, click FAQ on the 
main page of the Oracle Software Delivery Cloud portal. 

• Download subsequent patch sets and patches from My Oracle Support 
(https://support.oracle.com).  

To find patch sets or patches, select the Patches & Updates tab. 

If a previous version of prerequisite software is no longer available on the Oracle Software Delivery 
Cloud, log a software media request Service Request (SR). Previous versions of prerequisite software 
are archived and can usually be downloaded. After you open an SR, you can check its status: 

• US customers: Call 1-800-223-1711. 

• Outside the US: Check www.oracle.com/us/support/contact/index.html for your local Oracle 
Support phone number. 

For more information on logging a media request SR, go to My Oracle Support for Document 
1071023.1: Requesting Physical Shipment or Download URL for Software Media 
(https://support.oracle.com/epmos/faces/DocumentDisplay?id=1071023.1). 
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Creating a study 
You can create a study from scratch or from a template. When you create a study, the Central 
Designer application creates a study project with the same name by default. You can change the 
study and project name when creating the study. 

1 Select File > New Study Project. 

The New Study dialog box appears. 

2 Type a name and description of the project. 

3 Type a name and description of the study. 

4 In the Templates section, select one of the following: 

• No template—Do not base the study on a template. 

• Use project template—Base the study on a project template. 

• Use study template—Base the stud on a study template. 

5 In the templates list, select a template. The list contains all templates that are saved in the 
repository. Because templates do not have versions, the template that you choose is the latest.  

6 In the Targets section, select the target applications to which the study can be deployed. 

7 Click OK. 
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Choosing the phase of a study 
1 In the Project Explorer, select Study Information. 

2 Select the study.  

The Study editor appears in the workspace. 

3 Select the General tab. 

4 From the Phase drop-down list, select the phase of the study. 
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Editing the properties of a study 
To edit the properties of a study: 

1 In the Project Explorer, select Study Information. 

2 Select the study. 

3 Open the Properties Browser (located by default at the far right of the application window).  

4 Modify the properties as necessary.  

To edit the properties of a study project: 

1 In the Project Explorer, select Study Information. 

2 Select the study project. 

3 Open the Properties Browser (located by default at the far right of the application window).  

4 Modify the properties as necessary.  
 



 InForm Design Guide  

Oracle® Health Sciences Central Designer 2.1.2 5 

Setting the primary layout for a study 
Every layout requires a primary layout, or validation fails. An icon on the tab that contains the name 
of the layout (at the bottom of the Layout tab) indicates the primary layout. 

You set the primary layout for a study at the study level. The first layout that you create for a form or 
item is given the name of the primary layout.  

When you convert all layouts or a form with multiple layouts, you are prompted to choose the 
primary layout, and depending on the option you choose, it is or can be renamed to the name of the 
primary layout. 

Note: Changing the name of the primary layout affects all forms. If a form has a layout named 
Main, and you choose to use the layout named Spanish as the primary layout, then all layouts 
named Spanish become the primary layouts. 

1 Select Tools > Layout Names Manager. 

The Layout Names Manager appears. 

2 In the Primary layout name section, select one of the following options: 

• Use Main as the primary layout name—The layout named Main is the primary layout. 

• Use the following as the primary layout name—The layout that you choose from the 
drop-down list is the primary layout. 

3 Click OK. 
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Selecting locales 

Choosing the supported locales for a study 
You must choose locales to create a layout, translate information, and create Help. 

You choose the default locale for a study in the Central Designer application. For more information, 
see Choosing the default locale for a study (on page 7). 

1 In the Project Explorer, select Study Information. 

2 Select the study. 

3 Select the Languages tab. 

4 From the Languages/Locales list, select the locale or locales for the study. 

Note: Only the locales selected in the Central Designer Administrator application appear in 
the list. 
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About choosing the default locale for a study 
About the default locale 

The default locale for a study is used to store study metadata that can be localized. For more 
information, see Choosing the default locale for a study (on page 7). 

• After modifying the default locale, you do not need to restart the Central Designer application. 

• If you do not set the default locale, the regional setting is used. The regional setting is set in the 
Control Panel > Regional and Language Options > Regional Options tab > Standards and 
formats section.  If you modify the regional setting, you must close and reopen the Central 
Designer application to use the new locale. 

• You select from the same list of locales that are available when you specify a regional setting. 

Display properties that the default locale affects 

The default locale affects the display properties of the following: 

• Some fields, such as the Default Question for a form, display the text for the default locale.  

• The title bar in the workspace displays the default locale. For example: Form : Demographics -
- en-US 

• Float numbers are formatted according to the numeric standards for the default locale. 

For more information, see Acceptable formatting for float values (on page 9). 

Typing translated data 

You can enter translated data in the following ways: 

• You can enter translated data without specifying the locale, and the data is saved as data for the 
default locale. For example, you can enter the Default Question of an item in the Item Editor > 
Design tab > Default Question field. 

• You can enter translated data explicitly for a locale, and the data is saved as data for the specified 
locale. For example, you can enter the Default Question of an item in the Item Editor > Design 
tab > Languages section > Question field. 

For more information, see Where to enter translated text (on page 249). 

Making sure that the language in which you develop a study is the default locale for which 
study metadata is saved 

To design a study for any locale, you must make sure that: 

• In the Central Designer Administrator application, the locale is selected. 

• In the Central Designer application, the locale is selected for the study. 

• The user profiles in the Central Designer Administrator application list the locale as a skill. 
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Choosing the default locale for a study 
If you do not specify a locale for localizable study data, the data is saved according to the default 
locale for the study. Study data that is not localizable, such as a RefName, is not saved according to a 
locale. You specify a default locale in the Central Designer application. You do not need to restart 
the Central Designer application after selecting a default locale.  

1 Select Tools > Options. 

The Central Designer Options dialog box appears. 

2 From the Default locale drop-down list, select a locale. 

Note: If you do not select an option, the regional setting is used as the default locale. The 
regional setting is set in the Control Panel > Regional and Language Options > Regional 
Options tab > Standards and formats section. 

3 Click OK. 
 

How to develop a study across multiple locales 
You specify the default locale for a study in the Central Designer application. Localizable study 
metadata is saved according to the default locale. 

Language in which to type text values 

You can enter item questions, labels, and text strings in any language, regardless of the default locale 
for the study. However, in some places, such as the Design tab of the Form Editor, you can enter 
labels and question text without specifying a locale. In these cases, the default locale determines the 
language or locale that is assigned to the entered text. If the default locale is not included in the list of 
supported locales for the study, the entered text is saved for the locale but is not deployed. Only the 
supported locales for the study are deployed.  

Typing text values using an explicit locale 

If you work on a study with a locale that is different from the default locale, you can enter a study 
object's properties with an explicit locale. See the following table for places where the default locale is 
used and where you can specify an explicit locale. 

 

Study object Property Specify a value in the default locale 
here 

Specify a value in an 
explicit locale here 

Study event Title Study Event Editor > General tab Study Event Editor > 
General tab 

 Short Title Study Event Editor > General tab Study Event Editor > 
General tab 

Form Short Title Study Forms Editor Form Editor > General 
tab 

 Form Title Not available. Form Editor > Layout 
tab 
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Study object Property Specify a value in the default locale 
here 

Specify a value in an 
explicit locale here 

Item Question • Form Editor > Design tab  

• Study Items Editor 

Item Editor > Design 
tab 

 Short 
Question 

• Form Editor > Design tab 

• Study Items Editor 

Item Editor > Design 
tab 

 Caption Not available. Form Editor > Layout 
tab 

Codelist item Label • Item Editor > Design tab 

• Codelist Editor > Design tab 

• Study Codelist Items Editor 

Codelist Item Editor > 
Languages tab 

 

 

Rule component Specify a value in the default locale 
here 

Specify a value in an 
explicit locale here 

Query text Not available. Query Action dialog 
box. 

Subject or Message Not available. Email Action dialog 
box. 
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Acceptable formatting for float values 
You can enter float values according to numeric standards for: 

• The default locale for the study (on page 7). 

Note: Oracle recommends entering float data according to the numeric settings of the 
default locale for the study. 

• The invariant locale. The invariant locale is a locale used by applications when a consistent and 
locale-independent result is required. The settings of the invariant locale are similar to English 
(United States).  

For example, if French (France) is the default locale for a study and you want to type a number with 
a decimal point, you can: 

• Type "123,45" according to French numeric standards. 

• Type "123.45" according to numeric standards of the invariant locale. 

The formatting of a float value depends on the default numeric settings for the default locale. For 
example, if the default locale is French (France), and you type a value of "123.45," the number 
appears as "123,45" after you navigate to a different part of the application and return.  

If you change the numeric settings for the default locale—for example, if you change the decimal 
point character for the French locale from a comma to a period—the default settings are still used. In 
this example, a comma is still used as the decimal point character.  

Note: Characters used to separate groups of digits for large numbers (in the United States, a 
comma is used) are never saved with float values. 

You can type float values for: 

• Codelists.  

• Value list numbers for custom properties.  

• Sequence numbers of workflow objects. 
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Saving a study or library project 
When you save a study or library project, any study objects that were modified are saved, along with 
any administrative modifications that were made to the project since it was last saved. 

• Select File > Save Project, or press Ctrl+S. 

Note: If you uninstall a deployment system, you cannot save a project that contains study objects 
for that system. 

 

Deleting a study or project 
When you delete a study, study project, or library project, the contents are permanently removed 
from the database.  

Note: You cannot delete or archive the System Library or its project. 

1 (Optional but highly recommended) Perform a full database backup. 

2 (Optional) Archive the study or project (on page 316). 

3 In the Project Explorer, right-click a study, study project, library, or library project, and select 
Delete. 

A confirmation message appears.  

The message indicates if the latest version of the selected study, or any of the studies or libraries 
in the selected project, has not been archived. 

4 Click Yes. 

You receive a message that recommends performing a full database backup before deleting.  

5 Click Yes. 
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Selecting supported libraries 

Choosing the libraries to use for a study 
Users who are designing a study can search for study objects only in the supported libraries. 

Note: After choosing one or more libraries to use for a study, you can set the order of libraries in 
the Libraries List. For more information, see Setting the order of libraries in the Libraries List for a 
study (on page 12). 

To add a library to the Libraries List: 

1 In the Project Explorer, select Study Information. 

2 Select the study. 

3 Select the Libraries tab. 

4 Click Add. 

The Add Study Library dialog box appears.  

5 Select one or more libraries that you want to add to the study, and click OK. 

To remove a library from the Libraries List: 

1 In the Project Explorer, select Study Information. 

2 Select the study. 

3 Select the Libraries tab. 

4 In the Libraries List, select the library that you want to remove. 

5 Click Remove. 

You cannot remove the System Library. 

 

Setting the order of libraries in the Libraries list for a study 
You must choose libraries before you can set their order in the Library List. For more information, 
see Choosing the libraries to use for a study (on page 12). 

1 In the Project Explorer, select Study Information. 

2 Select the study. 

3 Select the Libraries tab. 

4 In the Libraries list, select a library.  

5 Click one of the following buttons:  

• Up—Move the library up in the list. 

• Down—Move the library down in the list. 
 



 InForm Design Guide  

Oracle® Health Sciences Central Designer 2.1.2 13 

Setting up study teams 

Users Browser searches 
To open the Users Browser: 

• Select the View menu, and make sure Users is selected. 
 

Characteristic Description 
Use To find users and add them to: 

• A study team (in a study project), which an administrator creates as a role 
with a study scope in the Central Designer Administrator application. 

• A library team (in a library project), which an administrator creates as a role 
with a library scope in the Central Designer Administrator application. 

Note: A user must be assigned to the corresponding role to be added to a team. 

Location of the 
Users Browser 

By default, the browser is located to the right in the application window. 

Features You can: 

• Create and save search criteria for personal or global use.  

• Open, close, delete, rename, and switch to different searches. 

Required search 
parameters 

No required parameters. 

Optional search 
parameters 

Use one, several, or none of the following: 

• Text 

• Categories 

• Keywords 

The asterisk (*), percent sign (%), and underscore (_) are wildcard operators, 
which are inserted before and after text. For example, dem automatically 
becomes *dem*. Use a comma as a delimiter. 

How the search is 
performed 

Text, keywords, categories, and libraries are connected with the AND operator. 
Criteria within each parameter are connected with the OR operator. For 
example: 

• Text that you type 

AND 

• Keyword1 OR Keyword2 

AND 

• Category1 OR Category2 
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Characteristic Description 
Which 
information is 
searched 

User names, display names, titles, first names, and last names of: 

• Active users 

• Inactive users 

Note: You can add inactive but not terminated users to teams. View the status 
of users in the Central Designer Administrator application. 

Search results Users are listed in alphabetical order according to display name, with user names 
in parentheses.  

 
 

Finding and adding a user to a study team and saving the search 
An administrator creates study teams as study roles in the Central Designer Administrator 
application. A user must be assigned to the corresponding role to be added to a team. 

For example, if a user is assigned to the Rule Creation study role in the Central Designer 
Administrator application, the user must also be a member of the Rule Creation study team for a 
study to create rules in the study. You assign users to roles in the Central Designer Administrator 
application and to study and library teams in the Central Designer application. You assign a user to a 
study team for the selected study only. 

Note: To view all users, click Find without entering parameters. Depending on the size of the 
repository, this search might take several minutes. For more information on saving a Users 
Browser search, see the User Guide. 

To add a user to a study team: 

1 Select the Users Browser. 

2 Optionally, to name the search: 

a Select Actions > New Search. The Actions menu is located at the top of the browser. 

The New search dialog box appears. 

b Type a name for the search, and click OK. 

The name of the search appears on a tab to the right of the browser. 

3 In the Enter search text field, type text that appears in the user's name or display name, title, first 
name, or last name. 

4 To include categories and keywords as parameters, click the down arrows button ( ) next to the 
Search Filter, and then: 

• Optionally, select the Categories tab, and select one or more categories. 

• Optionally, select the Keywords tab, and select one or more keywords. 

The parameters you select appear in the field below the Search Filter. 

5 Click Find. 
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The Central Designer application performs a search based on your search criteria. For more 
information about how searches work, see Users Browser searches (on page 13). 

6 In the Project Explorer, select Study Information. 

7 Select a study.  

8 Select the Teams tab. 

All study roles created in the Central Designer Administrator application appear. 

9 In the [Study name] - Teams section, select the team to which you want to add the user.  

The name of the team appears above the right section on the tab.  

10 In the Users Browser, select the user that you want to add, and drag the user to the right section. 

The user is added to the team. 

Note: You can also add a user to a team by dragging the user directly to the team name in 
the left section. 

11 Optionally, add the user to more teams, or add different users to teams. 

Note: The user that you added must log out and log on again to have the privileges 
associated with the team. 

 

Saving a search in the Users Browser 
1 Select Actions > Save Search to Repository. The Actions menu is located at the top of the browser. 

The Save Search to Repository dialog box appears. 

2 Optionally, type a description for the search. 

3 Select an option: 

• Just me—Only you can see and use the search. 

• Everyone—Everyone can see and use the search. 

4 Click Save. 
 

Opening a search saved in the repository 
All saved searches are stored in the repository, which contains all data created and saved in the 
application. 

1 Select either the Libraries Browser (for a study object search) or Users Browser (for a user search). 

2 Select Actions > Open Search from Repository. The Actions menu is located at the top of the 
browser. 

The Open Search from Repository dialog box appears. 

3 Select a search, and click Open. 

The search opens. A tab with the name of the search appears to the right of the browser. 
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Clearing search parameters 

Note: If you clear the parameters of a saved search but do not save after clearing, the search is 
saved with parameters. 

• In the Libraries Browser or Users Browser, click Clear Search, which is located at the top of the 
browser. 

The following information is cleared: 

• Text in the Enter search text field. 

• Selected categories and keywords. 

• Selected libraries (in the Libraries Browser only). 
 

Closing an active search 
All saved searches are stored in the repository, which contains all data created and saved in the 
application.  If you close a saved search, the search is removed from your view but is not deleted. 

1 Select either the Libraries Browser (for a study object search) or Users Browser (for a user search). 

2 Select a tab. Tabs are located along the right side of the browser. 

3 Select Actions > Close Active Search. The Actions menu is located at the top of the browser. 

The search is closed. If it is a saved search, it remains in the repository. If it is not saved, it is 
removed and cannot be reopened. 

 

Deleting a search from the repository 
1 Select either the Libraries Browser (for a study object search) or Users Browser (for a user search). 

2 Select Actions > Delete Search from Repository. The Actions menu is located at the top of the 
browser. 

The Delete Search from Repository dialog box appears.  

3 Select a search, and click Delete. 
 

Removing a user from a study or library team 
1 In a study, select the Study Information Explorer bar. 

or 

In a library, select the Library Information Explorer bar.  

2 Select the study or library. 

3 Select the Teams tab. 

4 In the left section, right-click the user, and select Remove from Team. 
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References 
A reference is a text note, a link to a Web page or file (URL), a document, or a combination of all 
three, that is attached to a study project for users to consult during the development of a study. 

You can attach a reference to a study or study project and view references already attached to a study 
or project.  

References include standard operating procedures, protocols, naming or project standard documents, 
and other relevant documents. Study designers can use reference information to construct a study. 

You can attach the following references: 

• A shortcut that references a file. 

For example, you can attach a shortcut to a file if the file is checked in to a version-control 
application and you want all users to view the most recent version.   

• A physical file.  

You can attach a physical file if the file is stored in a location that everyone cannot access.  

• A shortcut that references a URL address. 

You can attach the address of a web site that contains information relevant to a study. 

References attached to a study project are available for all studies in the project, but references 
attached to a study are available only for the study. 

Note: Version control is available only for study objects and is not available for references.   
 

Attaching a reference to a study 
1 In the Project Explorer, select Study Information. 

2 Select a study. 

3 Select the References tab. 

4 In the Title field in the top grid, type a name for the reference. 

5 In the Attachments section (located in the lower-right corner), click the drop-down arrow next to 
the Add File button.  

A menu of attachment options appears.  

6 Attach one of the following references.  
 

To attach the following Perform these steps 

Shortcut to a file 1 Select Attach file. 

The Open dialog box appears.  

2 Navigate to the file that you want to attach, select the file, and 
click Open. 

A reference to the file appears in the Attachments section. 
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To attach the following Perform these steps 

Physical copy of a file 1 Select Copy and Attach File. 

The Open dialog box appears.  

2 Navigate to the file that you want to attach, select the file, and 
click Open. 

The file appears in the Attachments section. 

Shortcut to a URL address 1 Select Attach URL. 

The Attach URL dialog box appears.  

2 In the field, type the URL address.  

A shortcut to the URL appears in the Attachments section. 
  

Note: The maximum size of the attachment is determined by a variety of factors, including 
information defined in the configuration file, available hard disk space, and available memory. To 
determine the approximate maximum attachment size, check the maxRequestLength attribute in 
the machine.config file. 

 

Removing a reference from a study 
1 In the Project Explorer, select Study Information. 

2 Select a study. 

3 Select the References tab. 

4 In the Attachments section, select a reference. 

5 Click Remove. 
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Study administration data 

About study administration data 
For a study that you deploy to the InForm application, you can include the following study 
administration data: 

• Item group—A study object used to combine items so that you can set their display override 
options in the InForm application. 

• Rights group—A study object used to create a set of predefined InForm rights in the InForm 
application. 

• Query group—A study object used to specify the users who can act on queries created by other 
members of the group in the InForm application. 

• Signature group—A study object used to specify the forms that require signature and the 
signature type in the InForm application. 

• Sponsor information—Details about the study sponsor. 

• System settings—InForm-specific system settings. 

You can choose to deploy these settings with your study design, or in their own deployment package. 
For more information, see About deployment packages (on page 279). 
 

Study administration data rights 
To create, update, or remove study administration data, you need the Modify Study Administration 
Data rights. If you do not have the appropriate rights, the information in the editors is read-only. 
 

Sponsor settings 
Both you and the administrator can create sponsors and detailed sponsor information. Sponsor 
information is for documentation and reporting only; this information does not appear in the 
InForm application user interface. 

When the administrator creates sponsors and sponsor details using the Central Designer 
Administration application, the study is propagated to the Central Designer application and is 
available for use in studies. 

In the Central Designer application, when you create new sponsors and detail information, the 
sponsor names, but not the detail information, are propagated back to the Central Designer 
Administration application. You also can override sponsors and details that the administrator creates. 
The changes you make are not propagated back to the Central Designer Administration application. 
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Selecting a sponsor to associate with a study 
1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Sponsor tab. 

The Sponsor editor appears. 

3 From the Sponsor Name drop-down list, select a sponsor to associate with the study. 

The sponsor detail information appears in the fields. 
 

Adding a sponsor to a study 
1 In the Project Explorer, click Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Sponsor tab. 

The Sponsor editor appears. 

3 Choose the information for the organization that is sponsoring the study. 

Note: The only required field in the Sponsor editor is the Sponsor Name. 

For more information, see Sponsor tab of the Administration editor—Option descriptions 
(on page 437). 

 

Editing sponsor detail information 
1 In the Project Explorer, click Study Information> Administration. 

The Study Administration workspace appears. 

2 Select the Sponsor tab. 

The Sponsor editor appears. 

3 From the drop-down list, select the sponsor, and edit the detail information. 
 

Removing a sponsor from a study 
1 In the Project Explorer, click Study Information> Administration. 

The Study Administration workspace appears. 

2 Select the Sponsor tab. 

The Sponsor editor appears. 

3 From the drop-down list, select the sponsor you want to remove from the study. 

4 Click Clear Sponsor. 
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System settings 
System settings specify information that is specific to the InForm release you are using. 

The system settings are installed when the Central Designer application is installed. When you create 
a new study, it does not have system settings. You need to add the system settings to the study. 
 

About the System Settings editor 
The System Settings editor has three columns. You can change only the fields in the Value column; 
the fields in the other columns are read-only. 

The rows in the System Settings editor are fixed. You cannot add or delete any rows. 
 

Adding system settings to a study 
1 In the Project Explorer, select System Settings. 

The Study Administration workspace appears. 

2 Select the System Settings tab. 

The System Settings editor appears. 

3 From the Settings drop-down list, select the settings for an InForm release. 

The System Settings editor is populated with settings for the InForm release you selected.  

For more information, see System settings tab of the Administration editor―Option 
descriptions (on page 438). 

 

Editing system settings 
1 In the Project Explorer, select System Settings > Administration. 

The Study Administration workspace appears. 

2 Select the System Settings tab. 

The System Settings editor appears. The editor is populated with the system settings for the 
InForm release you selected when you added the system settings to the study. 

3 In the Value column, edit the settings either by typing or by selecting from the drop-down lists. 

For more information, see System settings tab of the Administration editor—Option 
descriptions (on page 438). 

 

Restoring default values 
1 In the Project Explorer, select System Settings > Administration. 

The Study Administration workspace appears. 

2 Select the System Settings tab. 

The System Settings editor appears and is populated with the system settings for the InForm 
release you selected when you loaded the system settings. 

3 In the toolbar, click Restore Defaults. 
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Deleting system settings 
You can delete system settings only if they are not currently being used in a study. 

1 In the Project Explorer, select System Settings > Administration. 

The Study Administration workspace appears. 

2 Select the System Settings tab. 

The System Settings editor appears and is populated with the system settings for the InForm 
release you selected when you added the system settings. 

3 From the Settings drop-down list, select the settings to delete. 

4 Click Remove Settings. 

If the selected settings are not currently being used with a study, the Confirm Delete dialog box 
appears. 

5 Click Yes. 
 

Item groups 
Item groups are sets of items you group together so you can assign a display override within a rights 
group to them. 

Using display overrides, you can specify whether the group of items that make up an item group is 
hidden, editable, or read-only to the rights group with which the items are associated. 
 

About the Item Groups editor 
The Item Groups editor has two sections. The top section has a list of item groups, and the bottom 
section has the items that are associated with an item group you select. 
 

Creating an item group 
1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Item Groups tab. 

The Item Groups editor appears. 

3 In the toolbar, click Create item groups(s). 

4 Choose the settings for the item group. 

5 Do one of the following: 

• To create one item group, click Create. 

• To create multiple item groups, click Create/Next. When you finish creating item groups, click 
Create. 

For more information, see Item Groups tab of the Administration editor—Option 
descriptions (on page 439). 
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Editing an item group 
1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Item Groups tab. 

The Item Groups editor appears. 

3 Select the row for the item group you want to edit, and do one of the following: 

• In the toolbar, click Edit. 

• Right-click and select Edit. 

The Edit Item Group dialog box appears. 

4 Edit the item group. 

5 Click OK. 
 

Deleting item groups 
1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Item Groups tab. 

The Item Groups editor appears. 

3 Select one or more rows and do one of the following: 

• In the toolbar, click Delete. 

• Right-click and select Delete. 

• Press the Delete key. 

The Confirm Delete dialog box appears. 

4 Click Yes. 
 

Adding items to an item group 
1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Item Groups tab. 

The Item Groups editor appears. 

3 Select the row for the item group to which you want to add an item. 

4 Select the item or items you want to add to the group. 

5 Click Add. 
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Removing items from an item group 
1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Item Groups tab. 

The Item Groups editor appears. 

3 Select the row for the item group from which you want to remove an item. 

4 Select the row for the item you want to remove. 

5 Click Remove. 

The Confirm Delete dialog box appears. 

6 Click Yes. 
 

Query groups 
A query group specifies a set of users who can work with queries that were created by other 
members of the same group. 
 

Creating a query group 
1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Query Groups tab. 

The Query Groups editor appears. 

3 In the toolbar, click Create query group. 

The New Query Group dialog box appears. 

4 Type a group name and description. 

5 Click Create. 

For more information, see Query Groups tab of the Administration Editor—Option 
descriptions (on page 439). 
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Editing a query group 
1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Query Groups tab. 

The Query Groups editor appears. 

3 Select the row you want to edit, and do one of the following: 

• In the toolbar, click Edit. 

• Right-click the row and select Edit. 

The Edit Query Group dialog box appears. 

4 Edit the information, and click OK. 
 

Deleting one or more query groups 
1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Query Groups tab. 

The Query Groups editor appears. 

Select one or more rows to delete, and do one of the following: 

• In the toolbar, click Delete. 

• Press the Delete key. 

The Confirm Delete dialog box appears. 

3 Click Yes. 
 

Rights groups 
Rights groups allow you to create a set of item groups and use display overrides to specify whether 
the group of items that make up the item groups are hidden, editable, or read-only. 
 

About the Rights Groups editor 
The Rights Group editor has two sections. The top section has a list of rights groups, and the 
bottom shows the associated item groups for the selected rights group. 
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Creating a rights group 
1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Rights Groups tab. 

The Rights Groups editor appears. 

3 In the toolbar, click Create rights group. 

The New Rights Group dialog box appears. 

4 Choose the settings for the rights group. 

5 Do one of the following: 

• To create one rights group, click Create. 

• To create multiple rights groups, click Create/Next. When you finish creating rights groups, 
click Create. 

For more information, see Rights Groups tab of the Administration Editor—Option 
descriptions (on page 439). 

 

Editing a rights group 
1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Rights Groups tab. 

The Rights Groups editor appears. 

3 Select the row for the rights group you want to edit. 

4 In the toolbar, click Edit. 

The Edit Rights Group dialog box appears. 

5 Edit the rights group you selected. 

6 Click OK. 
 

Deleting a rights group 
1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Rights Groups tab. 

The Rights Groups editor appears. 

3 Select the rights group to delete, and in the toolbar, click Delete. 

The Confirm Delete dialog box appears. 

4 Click Yes. 
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Adding item groups to a rights group 
1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Rights Groups tab. 

The Rights Groups editor appears. 

3  Select the rights group to which you want to add item groups. 

4 Click Add. 

The Rights Group – Add Item Groups dialog box appears. 

5 Select the checkbox for each item group you want to add to the rights group. 

6 Click OK. 
 

Deleting item groups from a rights group 
1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Rights Groups tab. 

The Rights Groups editor appears. 

3  Select the rights group from which you want to remove an item group. 

4 Select the item group you want to remove. 

5 Click Remove. 

The Confirm Delete dialog box appears. 

6 Click Yes. 
 

Setting the item group display override 
1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Rights Groups tab. 

The Rights Groups editor appears. 

3 Select the rights group that has the item group for which you want to set a display override. 

The details appear for all the item groups that are assigned to the rights group you selected. 

4 From the Display Override drop-down list, select an override. 
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Signature groups 
A signature group specifies a set of users who can sign case report books and forms in the InForm 
application. You create signature groups and add forms to the group so that users in the signature 
group can sign the forms. 

Note: Adding users to groups occurs outside the Central Designer application. 

For information about the validation checks for signature groups, see Validation checks for 
InForm deployment (on page 266). 
 

About the Signature Groups editor 
The Signature Groups editor lists defined signature groups in the top section and details for the 
selected signature group in the middle section. The bottom section provides options for specifying 
the language to use for the signature meaning and affidavit text and for creating affidavit text.  
 

Creating a signature group 
1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Signature Groups tab. 

The Signature Groups editor appears. 

3 In the toolbar, click Create signature group(s). 

The New Signature Group dialog box appears. 

4 Choose the settings for the signature group. 

5 Do one of the following: 

• To create one signature group, click Create. 

• To create multiple signature groups, click Create/Next. When you finish creating signature 
groups, click Create. 

For more information, see Signature Groups tab of the Administration editor—Option 
descriptions (on page 440). 
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Editing a signature group 
1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Signature Groups tab. 

The Signature Groups editor appears. 

3 Select the row for the signature group you want to edit, and do one of the following: 

• In the toolbar, click Edit. 

• Right-click and select Edit. 

The Edit Signature Group dialog box appears. 

4 Edit the information. 

5 Click OK. 
 

Adding a form to a signature group 
If a signature group is a case report book type, the following restrictions apply to forms that you add 
to the signature group:  

• You cannot add a repeating form to the signature group. 

• You can add only one form to the signature group. 

• The form can belong to only one study event. 

• The form cannot be used in a repeating study event. 

To add a form to a signature group: 

1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Signature Groups tab. 

The Signature Groups editor appears. 

3 Select the signature group to which to add a form. 

4 Click Add. 

The Signature Group – Add Forms dialog box appears. 

5 Select the checkbox for the form you want to add. 

6 Click OK. 
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About choosing settings for signature meaning and affidavit text 
You can translate affidavit text if the language or languages in your skills profile are the same as those 
specified for the study.  

For the signature meaning, if the translation language is English-United States, you can either select 
an option from the Signature Meaning drop-down list or type meanings of your own.  For all other 
languages, you must the type meanings. 

If the translation language is English-United States, you can use the default text for the signature 
affidavit. 
 

Specifying translation text for a signature affidavit 
1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Signature Groups tab. 

The Signature Groups editor appears. 

3 Select the signature group for which to specify translation text for the signature affidavit. 

4 From the Language drop-down list, select the language to use for the Signature Meaning and 
Signature Text. 

5 Do one of the following to specify the signature meaning: 

• If you are using the English-United States language, from the Signature Meaning drop-down 
list, select either Approved or Reviewed. 

• For any language, type a meaning that is appropriate to your study. 

6 In the row for the language you are using, click View/Edit. 

The Signature Text dialog box appears. 

7 Do one of the following to specify the affidavit text: 

• If you are using the English-United States language and want to use the default affidavit text: 

Select the Use default text (available for English – United States Locale only) checkbox. When the 
default text appears in the dialog box, click OK. 

• For any language, to create your own affidavit text: 

Deselect the Use default text (available for English – United States Locale only) checkbox, type the 
text in the Signature Text dialog box, and click OK. 
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Removing a form from a signature group 
1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Signature Groups tab. 

The Signature Groups editor appears. 

3 Select the signature group from which to remove a form. 

4 Select the form to remove. 

5 Click Remove. 

6 Click OK. 
 

Resetting the state of a form 
You can specify whether associating a new signature group with a signed form resets the state of the 
form to unsigned in the InForm application. 

If you reset the state, the original signatures remain valid. However, the form requires a signature 
from a member of the newly associated group in the InForm application. 

1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Signature Groups tab. 

The Signature Groups editor appears. 

3 Select the signature group with which the form is associated. 

4 In the Reset Form State column, select the checkbox. 
 

About the invalidation level of a signature 
The InForm application invalidates a signature if any data items in the form change after signoff.  

In cases in which the data items that changed are marked as hidden from a signer, you can prevent an 
invalidation by using one of the following options in the Invalidation Level drop-down list: 

• User―The signature is invalidated only if the signer from whom the changes were hidden can 
view the data item that changed.  

• Group―The signature is invalidated only if at least one signer in the signature group can view the 
data item that changed. 
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Specifying the invalidation level of a signature 
1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Signature Groups tab. 

The Signature Groups editor appears. 

3 Select the signature group. 

4 From the Invalidation Level drop-down list, select either User or Group. 

Note: If a study is integrated with the Central Coding application, to prevent signature 
invalidation when the Central Coding application updates an item, set the invalidation level 
to User. 

 

Deleting a signature group 
1 In the Project Explorer, select Study Information > Administration. 

The Study Administration workspace appears. 

2 Select the Signature Groups tab. 

The Signature Groups editor appears. 

3 Select the signature group to delete. 

4 In the toolbar, click Delete. 

The Confirm Delete dialog box appears. 

5 Click Yes. 
 

About exporting study administration data to a user management tool 
You can export study administration data to a user management tool using the Export Wizard. The 
exported file contains the definitions of the study administration groups you created in the Central 
Designer application. The definitions are in a pipe-delimited format. 

For more information, see Export Wizard options. 
 

Page Option Description 
Welcome  Introduction page. 

Export Type  Select the output format and export type. 

 Data Type CSML—Export in Clinical Study Markup Language 
format. 

ODM—Export in Operational Data Model-compliant 
format. The Central Designer application supports the 
ODM 1.3 standard. 

Administration data—Export only study administration 
data for the User Management Tool application. 
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Page Option Description 

 Export Type Local—Export to the computer where the Central 
Designer application is installed. 

Export File Path Export 
Directory 

Specify the path name and file in which to save the export 
file, or click Browse to browse for the path name and file 
in which to save the export file. 

Ready to Export 
Central Designer 
Data 

 View a summary of the parameters that will be used for 
the export. 

 
 

About importing study administration data 
When you import CMSL that includes study administration objects you can choose to import study 
objects and administration data, administration data only, or study objects only: 

• Import study objects and administration data—The study objects (StudyAdministration, 
ItemGroups, SignatureGroups, Sponsor, SystemSettings, and RightsGroups) in the CSML you 
are importing overwrite the study objects in the existing study. 

If a study object in the CSML data you are importing has the same identifier as an object in the 
study, the existing object is not deleted. Instead, a new study object is created and its version is 
incremented. 

• Import study administration data only—The study objects are removed from the CSML 
before it is imported. 

Because the study design has changed, some items and forms that the existing Study 
Administration objects reference cannot be part of the study workflow. These references are 
removed from the existing Study Administration objects in the study. 

For more information, see Import Wizard options - CSML or ODM file. 
 

Page Option Description 
Welcome  Introduction page. 

Import Type  Select the source of the data to import. 

 Import CSML or 
ODM file 

Generate study objects from a file in CSML or ODM 
format. 

 Harvest InForm 
Resources 

Generate study objects from the components of an 
InForm study. 

File Location Path of file to import Specify the path of the CSML or ODM import file, or 
click Browse to locate the import file. 

Study 
Administration 
Import Mode 

 This page appears only for the CSML import type, if 
the CSML file contains study administration objects. 

 Import study objects 
and administration 
data. 

Import both study objects and study administration 
objects. 
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Page Option Description 

 Import 
administration data 
only. 

Import only study administration objects. 

 Import study objects 
only. 

Import only study objects. 

Rule Import Mode Rule Import Mode Only the Import as Collaboration Notes option is 
supported. With this option, each imported rule is 
converted to a collaboration note in the Central 
Designer application. 

Note: This option applies only if the Import Type is 
ODM; if the Import Type is CSML, the import 
process creates a Central Designer rule for each 
imported rule. 

IPR Import Mode Import IPR data Select whether to import in-place revision objects. 

Note: This page appears only if the file contains in-
place revision objects. 

Ready to Import 
Data to Central 
Designer 

 View a summary of the import options selected in the 
wizard. 
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Coding administration 

Administering coding tasks 
To create coding maps in the Central Designer application, you must first perform the following 
administrative tasks. 

• Select dictionary types for a study or library (on page 36). 

• Associate dictionary types with verbatim types for a study or library (on page 37). 
 

Creating, modifying, and deleting a coding map 
When you create a coding map, you specify: 

• An item to code. 

• One or more items that will receive code or term information from the Central Coding 
application.  

• One or more items that contain context information. Context information provides assistance to 
the person who codes the item. 

• A query target. When a Central Coding user creates a query, the query appears on the query 
target item in the InForm application. 

Note: If you select a query target item for a coding map, you can only deploy the study to a 
version of the InForm application that supports coding query targets. For more information, 
see the InForm documentation. 

Note: Only text items with no codelists are available for selection in the drop-down lists for 
Item to code and Target Item. 

To create a coding map: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 Select a form.  

3 Select the Coding tab. 

4 Click New Coding Map. 

The New Coding Map dialog box appears. 

5 Fill in the fields in the dialog box.  

6 Click OK. 
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To modify a coding map: 

Note: When you modify a coding map, you cannot modify the dictionary type or the verbatim (the 
item to code). 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 Select a form.  

3 Select the Coding tab. 

4 In the top panel, select a coding map, and click Edit. 

The Edit Coding Map dialog box appears.  

5 Edit the coding map as necessary.  

You can modify information in the following fields: 

• Dictionary type. 

• Item to code. 

• Verbatim type. 

• Coding Results tab: Target Item and Target Question. 

• Context Information tab: Context Item and Context Question. 

• Assign queries to: Query target item. 

6 Click OK. 

To delete a coding map: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 Select a form.  

3 Select the Coding tab.  

4 In the top panel, select a coding map, and click Delete. 

A confirmation dialog box does not appear. 
 



 InForm Design Guide  

Oracle® Health Sciences Central Designer 2.1.2 37 

Selecting and removing dictionary types for a study or library 
Only enabled dictionary types appear in the Dictionary types list. An administrator can import and 
enable additional dictionary types in the Central Designer Administrator application.  For more 
information, see Enabling and disabling a dictionary type (in the Administrator Guide). 

1 In the Project Explorer, select Study Information. 

2 Select InForm. 

3 Select the Coding tab. 

4 In the Dictionary Types list, select or deselect the checkbox to select or remove a dictionary type. 

Note: If a dictionary type is used in a coding map, (in use) appends the dictionary type, and 
you cannot deselect it. 

After selecting a dictionary type, you can associate it with one or more verbatim types. For more 
information, see Associating dictionary types with verbatim types for a study (on page 37). 
 

Associating dictionary types with verbatim types for a study or library 
Before you associate a dictionary type with a verbatim type, you must select dictionary types for a 
study (on page 36). 

Only the selected dictionary types and their associated verbatim types are available for creating 
coding maps. 

You define verbatim types in the Central Designer Administrator application. For more information, 
see Adding, modifying, and deleting a verbatim type (in the Administrator Guide). 

1 In the Project Explorer, select Study Information. 

2 Select InForm. 

3 Select the Coding tab. 

4 In the Dictionary Types list, select or deselect the checkbox to select or remove a dictionary type. 

Note: If the checkbox for the dictionary type is not selected, you cannot associate verbatim 
types with the dictionary type. 

The Verbatim Types list is populated with verbatim types.  

5 In the Verbatim Types list, select the checkboxes for one or more verbatim types. 

Note: If a verbatim type is used in a coding map for the selected dictionary type, (in use) 
appends the verbatim type, and you cannot deselect it. 
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About coding setup activities in the Central Designer application 
Some data that is collected in a study, such as a description of an adverse event, is free-form text. 
This item text is called a verbatim. A verbatim is the original reported text that describes the adverse 
event, disease, drug, or other item to be coded in the Central Coding application. The verbatim text 
must be converted to consistent terminology that is defined in either industry standard or customer-
defined dictionaries for the purposes of statistical analysis. Coding is the process of selecting terms 
and codes from a dictionary for a given verbatim. 

When you design a study in the Central Designer application, you can create items for which an 
InForm user provides a value—the verbatim text—and you can also create additional related items 
that are read-only in the InForm application.  

A coding map is a study object that contains the necessary information to code an item. By creating a 
coding map in the Central Designer application, you can populate the values of the read-only fields 
with codes and terms that are selected in the Central Coding application.  

After you deploy a study from the Central Designer application to the InForm application and begin 
collecting data, you can begin the coding process. All communication between the InForm 
application and the Central Coding application is initiated from the Central Coding application. The 
Central Coding application uses the InForm Adapter application to control communication between 
Central Coding servers and InForm studies. 

For more information about the coding process in the Central Coding application, see the Central 
Coding User Guide. 
 

Coding terms and definitions 
 

Term Definition 

Coding The process of selecting terms and codes from a dictionary for a verbatim. 

Verbatim The original reported text that describes the adverse event, disease, drug, or 
other item to be coded in the Central Coding application. A verbatim is 
typed in the InForm application. 

Coding map A study object that contains the necessary information to code an item. 

Target item An item that holds a term, code, or additional information after a verbatim 
is coded.  

Also called a coding target. 

Context item  An item that provides additional coding information, such as the indication 
and route of administration for drugs, that can be displayed with an item 
coded using the WHO-DD dictionary. 

Dictionary type  A name or identifier for the metadata for a dictionary. 

Verbatim type A classification of a verbatim as defined in a coding dictionary. 

Query target item An item in the InForm application that you designate as the item on which 
to place queries that are created in the Central Coding application. If you 
select a query target for a coding map, you can only deploy the study to a 
version of the InForm application that supports query targets. 
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Coding maps 
 

Characteristic Description 
Definition and 
purpose 

A coding map is a study object that contains the necessary information to 
code an item. You create a coding map for an item that needs to be coded 
in the Central Coding application.  

Where to view and 
create 

You can create, modify, and delete coding maps only when a form is selected. 
When a form is selected, the Coding tab displays all coding maps for the 
form. When a study event is selected, the Coding tab displays all coding 
maps for all of the forms in the study event, and so on. 

You can view, but not edit, coding maps in the Coding tab of the editors 
for the following study objects: 

• Study design 

• Study element 

• Study event 

Creation process To create a coding map, you assign an item to one or more dictionary levels 
and level types—the level type is the term, code, or additional information 
of the dictionary level. 

For more information, see Creating, modifying, and deleting a coding 
map (on page 35). 

Information in a 
coding map 

• Verbatim (the item to be coded). 

• Form on which the verbatim appears.  

• Verbatim type. 

• Dictionary type to use for coding.  

• Any specified context items and target items. 

• Query target item. 

Multiple coding maps 
for a verbatim 

You can create multiple coding maps for a verbatim—one for each 
dictionary type that is installed and selected for a given study or library. 
Therefore, a verbatim, a target item, and a context item can all be part of 
multiple coding maps.  

Reusing When you copy a form to a library or study, the coding maps that are 
defined for items on the form are copied with the form.  



Chapter 1  Setting up and administering a study  
 

40 Oracle® Health Sciences Central Designer 2.1.2 

Characteristic Description 

Deployment Coding maps are deployed to an InForm study as InForm TDE 
CODINGMAP objects. 

If you select a query target item for a coding map, you can only deploy the 
study to a version of the InForm application that supports coding query 
targets. For more information, see the InForm documentation. 

Note: If you create or modify a coding map, use a full deployment package 
to deploy the changes. Changes to coding maps are not supported in 
incremental deployment packages. 

Requirements for 
repeating sections 

For repeating sections, the references in a coding map must all be either in 
the repeating section or outside the repeating section. 

Multi-language studies Coding maps are language neutral. You cannot create a language-specific 
coding map. 

 
 

Dictionary types 
 

Characteristic Description 
Definition and 
purpose 

A dictionary type is a name or identifier for the metadata for a dictionary. 
You create a coding map for a verbatim using a dictionary type.  

The dictionary type specifies the metadata for all versions of a dictionary, 
including: 

• Verbatim types.  

• Dictionary levels.  

• Dictionary level types, such as Term or Code.  

• Where applicable, context meanings.  

Dictionary types in 
the installation 

The following dictionary types are installed with the Central Designer 
application: 

• MedDRA—Medical Dictionary for Drug Regulatory Activities. 

• MedDRAJ—Japanese version of the MedDRA dictionary.  

• WHO-DD—World Health Organization Drug Dictionary (formerly 
WHO-DRL—World Health Organization Drug Reference List). 

• JDrug—Japanese drug dictionary. 

Importing  You can import other standard dictionary types as well as custom dictionary 
types in the Central Designer Administrator application.  

For more information, see Importing and overwriting a dictionary type 
(in the Administrator Guide). 
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Characteristic Description 

Multiple versions  The Central Designer application supports multiple versions of a dictionary 
type.  

A version consists of dictionary metadata and dictionary data. In most 
cases, versions are different only in data, but new versions can also contain 
new metadata. 

Using in a study or 
library 

To use a coding dictionary in a study or library to create coding maps, you 
must use the following process: 

1 Import the dictionary type (in the Administrator Guide). 

2 Enable the dictionary type (in the Administrator Guide). 

3 Select the dictionary type for a study or library (on page 36). 

Association with 
verbatim types 

You can associate multiple verbatim types with a single dictionary type. 

Deployment Dictionary types that are used in the coding maps are deployed to the 
InForm application as MedML DICTIONARY objects. 

 

 
 

Verbatim types 
 

Characteristic Description 
Definition and 
purpose 

A verbatim type is a classification of a verbatim as defined in a coding 
dictionary. 

Verbatim types in the 
installation 

• AE—Adverse Event 

• DISEASE—Disease 

• LABDATA—Lab data 

• MEDPROD—Medical product 

Association with 
dictionary types 

You can associate multiple verbatim types with a single dictionary type. 
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Verbatims, context items, target items, and query target items 
 

Characteristic Verbatims Context items Target items Query target items 

Definition and 
purpose 

A verbatim is the 
original reported 
text that describes 
the adverse event, 
disease, drug, or 
other item to be 
coded in the 
Central Coding 
application. 

You can create 
multiple coding 
maps for a 
verbatim. 

A verbatim can 
have: 

• One or more 
target items. 

• One or more 
context items.  

• A coding map 
for each 
dictionary 
type. 

A context item is 
an item that 
provides 
additional coding 
information, 
such as the 
indication and 
route of 
administration 
for drugs, that 
can be displayed 
with an item 
coded using the 
WHO-DD 
dictionary. 

A target item is 
an item that 
holds a term, 
code, or 
additional 
information after 
a verbatim is 
coded. 

It is a target for 
one and only one 
verbatim per 
dictionary type.  

Target items can 
hold dictionary 
level information 
or additional 
information that 
is defined by a 
dictionary. 

A query target item is 
an item in the InForm 
application that you 
designate as the item 
on which to place 
queries that are 
created in the Central 
Coding application. 
When a Central 
Coding user creates a 
query, the query 
appears on the query 
target item in the 
InForm application. 

You must assign each 
verbatim a query 
target when you create 
a coding map for the 
verbatim.  

Note: To select the 
verbatim item as the 
query target item, 
select <use 
verbatim> in the 
Assign queries to 
drop-down list in the 
New Coding Map 
dialog box.  

Source or result 
item 

A verbatim is a 
source item that 
provides 
information to the 
Central Coding 
application. 

A context item is 
a source item 
that provides 
information to 
the Central 
Coding 
application. 

A target item is a 
result item that 
receives a term 
or code from the 
Central Coding 
application. 

A target item is a 
result item that 
receives a query from 
the Central Coding 
application. 
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Characteristic Verbatims Context items Target items Query target items 

Location in 
Project Explorer 

Can be one of the 
following: 

• Top-level 
item. 

• Child of a 
top-level 
compound 
item. 

• Child of a 
nested 
compound 
item. 

Can be one of 
the following: 

• Top-level 
item. 

• Child of a 
top-level 
compound 
item. 

• Child of a 
nested 
compound 
item. 

Cannot be a 
child of a nested 
compound item. 

Must be one of 
the following: 

• Top-level 
item. 

• Child of a 
top-level 
compound 
item.  

Cannot be the child of 
a top-level compound 
item, but can be the 
top-level compound 
item itself. 

Must be: 

• A top-level item. 

• Visible and 
available for 
editing in the 
InForm 
application. Items 
designated as 
query targets must 
not have the 
Display Override 
property set to 
ReadOnly or 
Hidden in the 
Central Designer 
application. 

Conditional on 
another item 

Can be 
conditional on 
another item. 

Can be 
conditional on 
another item. 

Cannot be 
conditional on 
another item. 

Cannot be conditional 
on another item. 

 

Requirements: 

• A verbatim (the item to code) and its target and context items must be on the same form. 

• If a form has a repeating section, all items referenced in the coding map must all be either in the 
repeating section or outside the repeating section. 

• All verbatims, context items, and target items must be text items. Query target items do not need 
to be text items. 

• You can map each verbatim to only one coding dictionary. For example, to code to both 
Japanese and English dictionaries for the same item on the form, you must create two verbatims 
on the form.  

• You can designate an item as a query target for only one verbatim. 

• If you select a query target item for a coding map, you can only deploy the study to a version of 
the InForm application that supports coding query targets. For more information, see the 
InForm documentation. 
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Setting up InForm review states 

About review states 
In the InForm application, as many as five form-level customizable states, called review states, are 
available in the Data Viewer in addition to the standard InForm states. If defined, custom review 
states can provide users with greater flexibility in tracking the review progress. 

Each custom review state has three customizable stages. For example, you can create two custom 
review states, labeled Medical Review and Data Management Review, each with three stages of 
Needs Review, Pending, and Reviewed. A custom review state is in one of its three stages at any 
time. The first stage is the default stage for a defined custom review state. 

In the Central Designer application, you can create as many as five review states for a study, each 
having three review stages. You can perform the same actions on a review state as on other study 
objects. For example, you can lock, unlock, publish, unpublish, copy, and paste a review state, and 
you can mark it as a template and copy it from a library into a study. 

Additionally, you can write rules that read and set the review stage of a form. 

Review states appear in the Review States editor, which is active when you select the Study 
Information Explorer bar > InForm > Review States folder in the Project Explorer. You define a 
review state and its review stages in the Review State editor. The annotated study book for a study 
optionally includes a listing of the review states defined for the study, along with the review stages of 
each. 
 

Creating, modifying, and deleting a review state 

Note: Review states are supported only in release 5.5 and later of the InForm application. If you 
attempt to deploy a study containing review states to an earlier release of the InForm application, 
deployment fails. 

To create a review state: 

Note: If you create a review state in the Central Designer application to replace a deleted review 
state, the new review state must have the same RefName and state number as the review state 
that was deleted. 

1 In the Project Explorer, select Study Information. 

or 

In the Project Explorer, select the Library Information Explorer bar. 

2 In the InForm folder, right-click Review States, and select New Review State. 

or 

a In the InForm folder, select Review States. 

b In the Review States editor, click New. 

The Object Name dialog box appears. 

3 Enter a title, RefName, and description, and click OK. 
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The Review State editor appears. 

4 Fill in the fields of the editor, and save the study project. 

For more information, see Review State editor—Option descriptions (on page 434). 

Note: The Label and Mnemonic fields for the review state and each review stage are 
required for each InForm product locale (English and Japanese). If a required value is 
missing in a product locale tab, the value from the other locale (if it is defined) appears in 
the field in red, and an icon appears in the tab to indicate that translation is required. Study 
validation also checks for missing translated values. Because both English and Japanese 
locales are always required for review states, the study definition does not need to have the 
Japanese locale selected, and you do not need the Japanese language skill to translate the 
review state fields. 

To modify a review state: 

Before a review state is deployed to the InForm application, you can change any of its values and the 
values of its review stages. 

Note: If you change the RefName property of a stage, you must update any rules that refer to the 
stage. 

After deploying a review state to the InForm application, you cannot change the state number or any 
RefNames. You can only change labels, mnemonics, titles, descriptions, and activation state. If you 
change the RefName of a review state or the name of a review stage and redeploy the study, 
deployment fails. 

1 In the Project Explorer, select Study Information. 

or 

In the Project Explorer, select the Library Information Explorer bar. 

2 In the Review States folder, select a review state. 

The Review State editor appears. 

3 Update the fields as needed. 

To delete a review state: 

You can delete a review state before or after the study is deployed to the InForm application. If you 
delete a review state in the Central Designer application for a deployed study and then redeploy, the 
review state is not removed from the InForm study. If you create a review state in the Central 
Designer application to replace a deleted review state, the new review state must have the same 
RefName and state number as the review state that was deleted. 

1 In the Project Explorer, select Study Information. 

or 

In the Project Explorer, select the Library Information Explorer bar. 

2 Right-click a review state, and select Delete. 

A confirmation dialog box appears. 

3 Click Yes. 
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About study objects in the study workflow 
The study workflow contains: 

• Study design—A study design is a container for the structure of a study. Each study has only 
one study design, which is created automatically when you create a study. The study design study 
object is accessible only in a study, not in a library. 

• Study elements—A study element is a CDISC term for a basic building block of a study. A 
study element represents a segment of a study and can consist of one or more study events. 
Study elements are optional 

In the InForm application, a study element is a collection of visits (or, in Central Designer 
terminology, study events) that are scheduled as a unit. Although you are not required to use 
them, consider whether you might benefit from the following uses of study elements:  

• If you want to simplify a complex workflow diagram, create a study element and include 
several study events in it. Your workflow diagram will have more layers but will be easier to 
navigate. A clinician might be better able to review a simplified workflow to determine if it 
accurately represents the study protocol. 

• Study elements make it easy to reuse a collection of study events. If you add several study 
events to a study element and include the study element in a library, you can reuse all of the 
study events by reusing the study element. 

• Study events—A study event is a subject evaluation checkpoint when data is collected. Study 
events usually correspond to visits, but one visit can span multiple study events. A study event 
can contain one or more forms. 

A study event can be repeating. A repeating study event corresponds to a repeating visit in the 
InForm application. 
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Creating and editing study objects in the study workflow 
A study design is a container for the structure of a study. Each study has only one study design, 
which is created automatically when you create a study. The study design study object is accessible 
only in a study, not in a library.  

To edit the properties of a study design in the Properties Browser: 

1 In the Project Explorer, select the Visit Schedule Explorer bar. 

2 Select the StudyDesign folder. 

3 Select the Properties Browser. 

Note: If the Properties Browser is not visible, select View > Properties.  

4 Edit the properties of the study design. After changing each property, press Enter, or tab to the 
next property. 

Note: The values of editable properties appear in bold, black text, and the values of non-
editable properties appear in gray text.   

For more information, see Study design properties (on page 484). 

You create a study object (study design, study element, study event, form, section, item, codelist, and 
codelist item) in a study or library. You can create a study object outside the hierarchy of a study or 
library, but the study object is not deployed until you add it to a parent study object in a study or 
library. To include a study object in the hierarchy of a study or library, add it to an existing parent in 
the study or library. 

To create a study element: 

1 (Available only in a study) To create a study element on a study design: 

a In the Project Explorer, select the Visit Schedule Explorer bar. 

b Right-click the study design, and select New Element. 

To create a study element outside the hierarchy of a study or library:  

c In the Project Explorer, select the Elements and Events Explorer bar. 

d Right-click the Study Elements folder, and select New Element. 

The Object Name dialog box appears. 

2 Type a title, RefName, and description, and click OK.  
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To edit the properties of a study element in the Properties Browser: 

1 In the Project Explorer, select a study element. 

2 Select the Properties Browser. 

Note: If the Properties Browser is not visible, select View > Properties.  

3 Edit the properties of the study element. After changing each property, press Enter, or tab to the 
next property. 

Note: The values of editable properties appear in bold, black text, and the values of non-
editable properties appear in gray text.  

For more information, see Study element properties (on page 485). 

You create a study object (study design, study element, study event, form, section, item, codelist, and 
codelist item) in a study or library. You can create a study object outside the hierarchy of a study or 
library, but the study object is not deployed until you add it to a parent study object in a study or 
library. To include a study object in the hierarchy of a study or library, add it to an existing parent in 
the study or library. 

To create a study event: 

1 Navigate to the parent study object, as indicated in the following table. 
 

Parent study object Steps 
Study design (only in 
studies) 

1 In the Project Explorer, select the Visit Schedule Explorer bar. 

2 Right-click the study design, and select New Event. 

Study element 1 In the Project Explorer, select the Elements and Events Explorer 
bar. 

2 Right-click the study element, and select New Event. 

No parent (for example, 
in a library) 

1 In the Project Explorer, select the Elements and Events Explorer 
bar. 

2 Right-click the Study Events folder, and select New Event. 
 

The Object Name dialog box appears. 

2 Type a title, RefName, and description, and click OK.  



 InForm Design Guide  

Oracle® Health Sciences Central Designer 2.1.2 51 

To edit the properties of a study event in the Properties Browser: 

1 In the Project Explorer, select a study event. 

2 Select the Properties Browser. 

Note: If the Properties Browser is not visible, select View > Properties.  

3 Edit the properties of the study event. After changing each property, press Enter, or tab to the 
next property. 

Note: The values of editable properties appear in bold, black text, and the values of non-
editable properties appear in gray text.  

To specify the short title of a study event: 

1 In the Project Explorer, select a study event. 

2 Select the General tab. 

3 Type a value in the Short Title field.  

To make a study event repeating or not repeating: 

1 In the Project Explorer, right-click a study event, and select Repeating Event. 

If the study event was nonrepeating, it changes to a repeating study event. If the study event was 
repeating, it changes to a nonrepeating study event.   

To mark a study event as a special InForm visit: 

1 In the Project Explorer, select a study event.  

2 Open the Properties Browser. 

Note: If the Properties Browser is not visible, open the View menu and make sure Properties 
is selected. 

3 From the Special Visits drop-down list, select a value. 
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About disabling a workflow 
You cannot disable an individual workflow rule or global condition. However, if you disable a 
workflow, all workflow rules and global conditions associated with the workflow are disabled.  

Note: This functionality only applies to the current workflow, and does not apply to child 
workflows. For example, if you disable a workflow at the study design level, the child workflows at 
the event or form level are not disabled. 

When you deploy a study with a disabled workflow, the forms associated with that workflow appear 
in the InForm application in the order specified by their sequence numbers in the Workflow 
Diagram. 

If you deploy to an InForm release prior to release 6.1.1: 

• Disabled rules are not validated in the Central Designer application. 

• Disabled rules are excluded from the deployment package. 

• A validation warning appears and indicates that the study contains disabled rules. 

If you deploy a study to InForm release 6.1.1 or later: 

• Disabled rules are deployed to the InForm application as read-only. 

• A validation warning appears and indicates that the study contains disabled rules. 

For more information, see Disabling a workflow rule (on page 169). 
 

Disabling a workflow 
1 In the Project Explorer, select the Visit Schedule Explorer bar. 

2 Select a study design, study element, or study event. 

3 Select the Workflow Diagram tab. 

4 Click Disable Workflow. 

The workflow arrows turn gray, and the study event sequence numbers re-appear and turn gray. 

Note: The Central Designer application only sends a message on validation about disabled rules. 
You will not receive a message that lists the disabled workflows in your study. 
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Working with workflow diagrams 

About study workflows 
On paper, a study designer often charts the major events of a study by using a flow diagram that 
indicates the order in which a subject progresses from one step to another and also shows where any 
branches in the study occur. You can use the study workflow tools to map out the flow of a study in 
a similar way. 

Study workflow tools provide a way to define: 

• The major branches and events of a study. 

• The forms used to collect clinical observations at each study event. 

• Decision points that determine the path a subject follows through the study based on specific 
observations.  

The process of designing the study workflow creates the actual study objects. A lead study designer 
can set up the outline by designing the study workflow and can assign the detail design tasks to other 
members of the team. 

Use the Workflow Diagram tab to create a study workflow.  

About the Workflow Diagram tab 

The Workflow Diagram tab enables you to create graphical study workflow diagrams that specify the 
sequence of steps in a study and the points where the study workflow can branch depending on the 
outcome of specific observations. The Central Designer application keeps the study objects in the 
Workflow Diagram and Workflow Grid tabs synchronized.  

The Workflow Diagram tab appears in the Study Design, Study Element, and Study Event Editors in 
studies, and in the Study Element and Study Event Editors in libraries. Within each editor, the 
Workflow Diagram tab enables you to design a different level of a study workflow. 

Scope of the Workflow Diagram tab for each study object 
 

Editor Scope of workflow 

Study Design • Study elements 

• Study element workflow rules 

• Study events 

• Study event workflow rules 

• Global conditions 

Study Element • Study events 

• Study event workflow rules 

• Global conditions 
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Editor Scope of workflow 

Study Event • Forms 

• Form workflow rules 

• Global conditions 
 

Where to create study workflows 

You can develop study workflows in either a study or a library, and you can use study objects found 
in a Libraries Browser search to define a workflow in a study. 

Schedule of Events tab 

Another component of study workflow design is the Schedule of Events (on page 74) tab, which 
displays a schedule of events for the study. In the Schedule of Events tab, you can indicate the forms 
that appear in each study event. 

Workflow Grid tab 

You can also use the Workflow Grid tab (on page 60) to create workflow information. The Central 
Designer application keeps the information in the Workflow Diagram and Workflow Grid tabs 
synchronized.  
 

Workflow diagram components 
 

Diagram component Purpose 

 

Study element—Can appear in the workflow for a study design.  

 

Study event—Can appear in the workflow for a study design or for a 
study element. 

 

Repeating study event—Can appear in the workflow for a study 
design or for a study element. 

 

Form—Can appear in the workflow for a study event. 

 

Repeating form—Can appear in the workflow for a study event. 
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Diagram component Purpose 

 

Workflow rule—The color of the component indicates the study 
object that precedes the workflow rule in the workflow diagram: 

• Blue—Study element 

• Green—Study event 

• Gray—Form 

 

Global condition—Above a study object, this component indicates 
that a global condition is associated with the study object. 

 Arrow—Connects two workflow diagram components. The arrow 
indicates the order of the workflow between the components. 

 
Sequence number—Indicates the order of workflow diagram 
components that are not at the endpoint of a connecting arrow. 

 Data view icons—In the lower-left corner of a workflow object, 
icons indicate the target application for which a study object and its 
children were designed. 

 

Schedule drop-down list—When you click the clock ( ) icon, a 
summary of the scheduling information for a study object appears. 

 
 

Viewing a workflow diagram 
To view a workflow diagram: 

Note: You can view a workflow diagram for a study only in a study, not in a library. 

1 In the Project Explorer, select a study design, study element, or study event. 

2 Select the Workflow Diagram tab. 

To adjust the size of a workflow diagram: 

1 In the Project Explorer, select a study design, study element, or study event. 

2 Select the Workflow Diagram tab. 

3 Select the arrow to the right of the Zoom button. 

or 

Right-click the workspace. 

4 Select a sizing option. 
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Creating a study object in a workflow diagram 
The editor in which the Workflow Diagram tab appears determines the study objects and 
components that you can create. When you create a study object, the study object is added to the 
Workflow Diagram tab, the Workflow Grid tab, and the Project Explorer. 

Select one of the following Explorer bars and navigate to the Workflow Diagram tab to create the 
specified study object: 

• Study element: 

• Visit Information Explorer bar 

• Elements and Events Explorer bar 

• Study event: 

• Visit Information Explorer bar 

• Elements and Events Explorer bar 

• Form: 

• Forms and Transactions Explorer bar 

To create the study object on the Workflow Diagram tab: 

1 In the Workflow Diagram, click the New <Study Object Type> button. 

The Object Name dialog box appears. 

2 In the Title field, type the title of the study object. 

As you type, the RefName field is filled in, using the Title text but omitting spaces and 
disallowed characters. 

3 Optionally, in the RefName field, type a different RefName from the default. 

4 Optionally, in the Description field, type a description of the study object. 

5 Click OK. 

To change the repeating state of a study event: 

1 In the Project Explorer, select the study design or study element on which the study event exists. 

2 Select the Workflow Diagram tab. 

3 Right-click a study event, and change the selection of Repeating Event as needed. 

To change the repeating or common state of a form: 

1 In the Project Explorer, select the study event on which the form exists. 

2 Select the Workflow Diagram tab. 

3 Right-click a form in the workflow diagram, and select Repeating Form or Common Form. 
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Connecting and ordering study objects in a workflow diagram 
In a workflow diagram, when you connect: 

• Two study objects—You specify the order of the study objects in the workflow. 

• A rule and a study object—You specify the study object that comes next in the workflow based 
on the outcome of the rule.  

When you make a connection to a study event, you can schedule the study event.  

To connect a study object to a study element or a study event: 

1 In the Project Explorer, select the Visit Schedule Explorer bar. 

2 Select a study design, study element, or study event. 

3 Select the Workflow Diagram tab. 

4 Move the cursor over the first of the two objects you want to connect until it changes to a 
pointing finger icon. 

5 Drag the cursor to a connection node in the next component in the sequence, and release it. 

A connection line points from the first object to the study element or study event, and the Edit 
Schedule dialog box appears. 

6 Schedule the interval between study objects, and click OK. 

Note: You can define multiple schedules leading into a study element or event. However, in 
the InForm application, the visit hours are always set to the schedule with the greatest 
amount of time.   

To connect two forms: 

1 In the Project Explorer, select the Visit Schedule Explorer bar. 

2 Select a study event. 

3 Select the Workflow Diagram tab. 

4 Move the cursor over the first of the two forms until it changes to a pointing finger icon. 

5 Drag the cursor to a connection node in the next component in the sequence, and release it. 

The two forms are linked by an arrow. 

To connect a rule to the next study object: 

1 In the Project Explorer, select the Visit Schedule Explorer bar. 

2 Select a study design, study element, or study event. 

3 Select the Workflow Diagram tab. 

4 Move the cursor over the rule workflow diagram object until it changes to a pointing finger icon. 
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5 Drag the cursor to a connection node in the next component in the sequence, and release it. 

A connection line points from the rule to the next object, and one of the following dialog boxes 
appears: 

• If you are connecting a rule to a study event or study element—Edit Schedule and Rule 
Action dialog box. 

• If you are connecting a rule to a form—Edit Rule Action dialog box. 

6 In the If the value is section, select a value. 

7 Click OK. 

8 If the workflow branches differently for different outcomes of the rule, repeat the procedure for 
the other branch. 

For more information, see:  

Edit Schedule dialog box—Option descriptions (on page 413). 

Edit Rule Action dialog box—Option descriptions (on page 411). 

Edit Schedule and Rule Action dialog box—Option descriptions (on page 413). 
 

Changing the sequence number of a study object in a workflow diagram 
Sequence numbers specify the order of disconnected study objects in the Workflow Diagram tab.  

The first study object in each workflow sequence has a sequence number. If a workflow diagram has 
multiple workflow sequences, sequence numbers specify how the workflows are ordered in the 
InForm application, unless an unconnected study object is associated with a global condition. For 
clarity, and to make sure that dynamic study objects deploy in the correct order, connect all study 
objects in a workflow. 

You can use whole numbers as well as numbers with decimal points as sequence numbers, and you 
are not required to use sequential numbers. For example, if you expect to add additional study 
objects to a workflow, you might use only even or odd numbers for existing study objects so you 
have additional whole numbers to use for new additions. Alternatively, you can use sequential 
numbers for existing study objects and use numbers with decimal points for inserted study objects. 

1 In the Project Explorer, select the Visit Schedule Explorer bar. 

2 Select a study design, study element, or study event. 

3 Select the Workflow Diagram tab. 

4 Double-click the sequence number (the numbered gray box that appears to the left of a study 
object). 

The Modify Step Sequence dialog box appears. 

5 In the Step Sequence Number field, type the new sequence number. 

Note: The new sequence number cannot already exist in the workflow. To insert a new study 
object into the sequence, you must renumber other study objects to make the desired 
number available. 

6 Click OK. 
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Creating a reference copy of a study object in a workflow diagram 
You can create a reference copy of a study element, study event, or form in a workflow. A reference 
copy is a duplicate image of a study object in a diagram; it is not a new link to the study object in the 
Central Designer repository. In a workflow diagram with many study objects and connecting lines, 
you can use a reference copy of a study object to separate the tangle of connecting lines and make 
the workflow diagram less cluttered. 

1 In the Project Explorer, select a study design (in a study only), study element, or study event. 

2 Select the Workflow Diagram tab. 

3 Right-click the study object in the workflow diagram, and select the Create Reference Copy 
command for the study element. 

 

Viewing scheduling information 
1 In the Project Explorer, select the Visit Schedule Explorer bar.  

2 Select a study design, study element, or study event. 

3 Select the Workflow Diagram tab. 

4 To view scheduling information for a single workflow object, click the clock icon ( ) on the 
object. 

5 To view scheduling information for the entire workflow, right-click the background of the 
workflow, and select Show Scheduling. 

6 To hide scheduling information, press Esc. 
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Working in the Workflow Grid tab 

Working with study objects in a workflow grid 
In the Workflow Grid tab, you create the principal study objects in the workflow of a study by using 
a grid format. 

You create only study objects (no workflow rules or global conditions) in the Workflow Grid tab. 
You can connect the study objects in a workflow and use workflow rules and global conditions in the 
Workflow Diagram tab. The Central Designer application keeps the study objects in the Workflow 
Diagram and Workflow Grid tabs synchronized. 

The Workflow Grid tab appears in the Study Design, Study Element, and Study Event Editors in 
studies, and in Study Element and Study Event Editors in libraries.  

The selected selection in the View Targets drop-down list determines the workflow objects that 
appear on the Workflow Grid tab. 
 

Creating a study object in a workflow grid 
The editor in which the Workflow Grid tab appears determines the study objects and components 
that you can create.  

Select one of the following Explorer bars and navigate to the Workflow Grid tab to create the 
specified study object: 

• Study element: 

• Visit Information Explorer bar 

• Elements and Events Explorer bar 

• Study event: 

• Visit Information Explorer bar 

• Elements and Events Explorer bar 

• Form: 

• Forms and Transactions Explorer bar 

To create the study object on the Workflow Grid tab:  

1 In the Project Explorer, select the study design, study element, or study event. 

2 Select the Workflow Grid tab. 

3 In the Type column, select the study object type from the drop-down list. 

4 In the Title column, type the name of the study object. 

5 Press Enter, or click the next row, or press the Tab key. 

Note: You cannot reuse the same study event in multiple study elements in the same study. 
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To change the repeating state of a study event: 

1 In the Project Explorer, select the study design or study element on which the study event exists. 

2 Select the Workflow Grid tab. 

3 Click within the gray box, located at the beginning of the row for a study event. 

4 Right-click the study event, and change the Repeating Event selection as needed. 

To change the repeating or common state of a form: 

1 In the Project Explorer, select the study event on which the form exists. 

2 Select the Workflow Grid tab. 

3 Click within the gray box, located at the beginning of the row for a form. 

4 Right-click the study form, and change the Repeating Form or Common Form selection as needed. 
 

Opening a child study object from a workflow grid 
From the Workflow Grid for a study object, you can open the Design tab of any of its child study 
objects. For example, from the Workflow Grid tab for a study design, you can edit its child study 
elements and study events. 

1 Navigate to the study object, as indicated in the following table. 
 

Child study object Parent Workflow Grid Steps 
Study element Study design (studies 

only) 
1 In the Project Explorer, select the Visit 

Schedule Explorer bar. 

2 Select the Workflow Grid tab. 

Study event Study design (studies 
only) 

1 In the Project Explorer, select the Visit 
Schedule Explorer bar. 

2 Select the Workflow Grid tab. 

 Study element 1 In the Project Explorer, select the 
Elements and Events Explorer bar. 

2 Select a study element. 

3 Select the Workflow Grid tab. 

Form Study event 1 In the Project Explorer, select the Visit 
Schedule Explorer bar. 

or 

2 In the Project Explorer, select the 
Elements and Events Explorer bar. 

3 Select a study event. 

4 Select the Workflow Grid tab. 
 

2 Click within the gray box, located at the beginning of the row for the child study object. 

3 Right-click the row of that study object, and select Edit. 
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The Design tab for the selected study object appears. 

4 Update the study object as needed. 
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Study workflows and deployment to the InForm 
application 

The design of a study workflow affects the following characteristics of the InForm study to which it 
is deployed: 

• Order of visits and forms (on page 63)—The order of visits and forms in the InForm 
application depends on the order in which study objects are connected in a workflow and on the 
sequence numbers of study objects that are not connected. 

• Dynamic status of visits and forms (on page 66)—Whether a visit or form is visible in a study 
depends on whether a study event or form is associated with a workflow rule or global condition 
in a study workflow. The outcome of the workflow rule or global condition determines whether 
a dynamic visit or form appears 

• Scheduling of visits (on page 68)—The dates in the Visit Calculator that appears when a 
subject is enrolled in an InForm study and the MedML STARTHOUR value of a visit are 
generated from the scheduling information specified in a study workflow. 

 

InForm visits and forms 

Order of InForm visits and forms 
The order of visits and forms in the InForm application depends on the order in which study objects 
are connected in a workflow and on the sequence numbers of study objects that are not connected. 

Note: If the first object in a sequence is de-emphasized, the sequence number is also de-
emphasized. 

Simple sequence of forms or study events 
 

Simple sequence of forms or study events 

 

Order in the InForm application: Form A, Form B, Form C. 
 

Multiple sequences of forms or study events 

A workflow can contain multiple sequences of connected study objects. The first study object in each 
sequence is labeled with a sequence number. For more information, see Sequence numbers (on 
page 72). 
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Multiple sequences of forms or study events 

 

Order in the InForm application: Form A, Form B, Form C, Form D, Form E. 
 

Workflow with study elements 
 

Workflow with study elements 
(Dotted lines indicate that the study elements contain the study events. These study objects do not 
appear together in the Workflow Diagram.) 

 

Order in the InForm application: Visit 1, Visit 2, Visit 3, Visit 4. 
 

Workflow with study elements and study events 
 

Workflow with study elements and study events 
(Dotted lines indicate that the study elements contain the study events. These study objects do not 
appear together in the Workflow Diagram.) 
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Workflow with study elements and study events 
Order in the InForm application: Visit 1, Visit 2, Visit 3, Visit 4, Visit 5. 

 

Workflow with workflow rule 
 

Workflow with workflow rule 
(Dotted lines indicate that the study elements contain the study events. These study objects do not 
appear together in the Workflow Diagram.) 

 

Order in the InForm application:  

• Initially—Visit 1, Visit 2. Only Visit 1 and Visit 2 are in the Case Book. All other visits are 
dynamic and depend on the outcome of the rule. 

• If the rule evaluates to True—Visit 1, Visit 2, Visit 3, Visit 4. Visit 5 and Visit 6 are dynamic 
and do not appear in the Case Book. 

• If the rule evaluates to False—Visit 1, Visit 2, Visit 5, Visit 6. Visit 3 and Visit 4 are dynamic 
and do not appear in the Case Book. 
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Workflow with workflow rule (2) 
 

Workflow with workflow rule 2 
(Dotted lines indicate that the study elements contain the study events. These study objects do not 
appear together in the Workflow Diagram.) 

 

Order in the InForm application:  

• Initially—Visit 1, Visit 2, Visit 4, and Visit 5. Only Visit 3 is dynamic. 

• If the rule evaluates to True—Visit 1, Visit 2, Visit 3, Visit 4, and Visit 5. 

• If the rule evaluates to False—Visit 1, Visit 2, Visit 4, and Visit 5. Visit 3 is dynamic and does 
not appear in the Case Book. 

 

Workflow with global condition 
 

Workflow with global condition 

 

Order in the InForm application:  

• Initially, or if the condition evaluates to False—Form A, Form C. Form B is dynamic and 
does not appear in the Case Book. 

• If the condition evaluates to True—Form A, Form B, Form C. 
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Dynamic status of InForm visits and forms 
Whether a visit or form is visible in a study depends on whether a study event or form is associated 
with a workflow rule or global condition in a study workflow. The outcome of the workflow rule or 
global condition determines whether a dynamic visit or form appears. 

For information about a workflow with a workflow rule, see Order of InForm visits and forms (on 
page 63). 

Workflow with global condition 
 

Workflow with global condition (dynamic) 

 

Dynamic status in the InForm application:  

• Initially, or if the condition evaluates to False—Form A and Form C are in the Case Book. 
Form B is dynamic and does not appear in the Case Book. 

• If the condition evaluates to True—Forms A, B, and C are in the Case Book. 
 

Complex workflow with global conditions (Example 1) 

Study components 
• Event1 

• Form1  

• Item1  

• Item2 

• Event2 (with a global condition) 

• Form2 (with a global condition) 

Behavior 
• Enter a value for Item1 and submit Form1 without entering a value for Item2: Event2 appears.  

• Enter a value for Item2 and submit Form1 without entering a value for Item1: Neither Event2 
nor Form2 appears. 

• Subsequently enter a value for Item1 and submit Form1; Both Event2 and Form2 appear. 

Complex workflow with global condition (Example 2) 
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Study components 
• Event1 

• Form1 

• Item1 

• Item2 

• Element1 (with a global condition) 

• Event2 

• Event3 (with a global condition) 

Behavior 
• Enter a value for Item1 and submit Form1 without entering a value for Item2: All the visits in 

Element1 appear.  

• Enter a value for Item2 and submit Form1 without entering a value for Item1: None of the visits 
in Element1 appear.  

• Subsequently enter a value for Item1 and submit Form1: All the visits in Element1 appear. 
 

Scheduling of InForm visits 
The dates in the Visit Calculator that appears when a subject is enrolled in an InForm study and the 
MedML STARTHOUR value of a visit are generated from the scheduling information specified in a 
study workflow. 

A study element or study event in a workflow can be: 

• Scheduled—You can schedule a study element or study event in the Workflow Diagram. The 
first study object in a sequence is considered to be scheduled by default. 

• Unscheduled—If you do not schedule a study element or study event in the Workflow 
Diagram, the study element or study event is unscheduled in the InForm application. If a 
workflow has more than one sequence, the first study object in any sequence other than the first 
is considered to be unscheduled. 

If a study object is unscheduled, its STARTHOUR value in the InForm application is set to 1 
hour later than the previous study object in the sequence. This is to make sure that no two visits 
have the same STARTHOUR. 

You can click the drop-down list in the lower-right corner of study elements and study events to 
view scheduling information. 
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Workflows with scheduled and unscheduled study objects 
One sequence of study events with scheduling 

 

One sequence of study events with scheduling 

 

Scheduling in the InForm application: Visit 1 and Visit 2 are scheduled. Visit 2 is scheduled one 
day after Visit 1. 

 

Multiple sequences of study events 
 

Multiple sequences of study events 

 

Scheduling in the InForm application:  

• All visits except Visit 3 are scheduled. Visits 2, 4, and 5 are scheduled one day after the previous 
visit. 

• The STARTHOUR attribute of Visit 3 is one hour after Visit 2. 

• Visit 5 is scheduled three days plus one hour after Visit 1. 
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Workflow rule with scheduled study events 
 

Workflow rule with scheduled study events 

 

Scheduling in the InForm application:  

• Visit 1 is scheduled. 

• The STARTHOUR attribute of Visit 2 is calculated to be one day after Visit 1, but Visit 2 does 
not appear in the Visit Calculator when the value of Rule1 is true. 

• The STARTHOUR attribute of Visit 3 is calculated to be five days after Visit 1, but Visit 3 
does not appear in the Visit Calculator when the value of Rule1 is false. 

 

Global condition with scheduled and unscheduled study event 
 

Global condition with scheduled and unscheduled study event 
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Global condition with scheduled and unscheduled study event 
Scheduling in the InForm application:  

• Visit 1 is scheduled. 

• The STARTHOUR attribute of Visit 2 is calculated to be one hour after Visit 1, but Visit 2 
does not appear in the Visit Calculator. 

• Visit 3 is scheduled as one day after Visit 2 and one day plus one hour after Visit 1. 
 

Scheduled study elements 
 

Scheduled study elements 
(Dotted lines indicate that the study elements contain the study events. These study objects do not 
appear together in the Workflow Diagram.) 

 

Scheduling in the InForm application:  

• Visit 1 is scheduled. 

• Visit 2 is unscheduled. Its STARTHOUR value is one hour after Visit 1. 

• Visit 3 is scheduled as one day after Visit 2. 

• Visit 4 is scheduled as one day after Visit 3, or two days plus one hour after Visit 1. 
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Unscheduled study elements 
 

Unscheduled study elements 
(Dotted lines indicate that the study elements contain the study events. These study objects do not 
appear together in the Workflow Diagram.) 

 

Scheduling in the InForm application:  

• Visit 1 is scheduled. 

• Visits 2, 3, and 4 are unscheduled. The STARTHOUR value of each is one hour after the 
preceding visit. 

 
 

Deploying to the InForm application 

Sequence numbers 

 
When you create a study object in the Workflow Diagram tab, a sequence number appears in a box 
near the upper left corner of the object. Initially, the sequence number indicates the order in which 
you created each study object.  

 

As you connect study objects in a workflow, the sequence number disappears for each connected 
study object after the first. 
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A workflow can contain multiple sequences of study objects. The sequence numbers of the first 
study object in each sequence determine the order in which the sequences appear in a deployed 
study. In the following example, the order in which the forms appear when deployed is Form A, 
Form B, Form C, Form D, Form E. 

 

You can change the sequence number for a study object in a workflow diagram. Changing the 
sequence number of a study object affects only the order in which multiple sequences are deployed. 
Changing the sequence number does not affect the order in which a study object appears in the 
Project Explorer or in the Workflow Diagram tab. 

Note: The new sequence number cannot already exist in the workflow. To insert a new study 
object into the sequence, you must renumber other study objects to make the desired number 
available. 

 

Invalid workflows 
To prevent the creation of an invalid workflow, the Central Designer application enforces the 
following rules: 

• The sequence of workflow steps cannot be circular. The last step cannot point back to the first 
step. 

• A study object that is associated with a global condition can have only one prerequisite step, and 
you cannot associate a global condition with a study object that has more than one prerequisite 
step. 

• A study object can have only one outgoing arrow. Branching to two different study objects 
requires a workflow rule. 

• The workflow action for each branch of a workflow rule outcome must be unique. For example, 
if a step follows a workflow rule when the expression evaluates to True, the other branch of the 
workflow cannot also be based on the expression evaluating to True. 
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Working in the Schedule of Events tab 

Using the Schedule of Events tab to update the study workflow 
The Schedule of Events tab is a matrix that lists the study events in a study and indicates the forms 
that are included in each study event. The Schedule of Events tab is available in studies and not in 
libraries. 

The Schedule of Events tab enables you to create or update a study workflow quickly by selecting 
(with checkboxes) the forms to include in each study event. When you select or deselect the forms in 
a study event and save the study design, the Central Designer application updates the contents of the 
study event and also updates the study event workflow. 

You can also navigate to the Form editor or delete forms from a study using the Schedule of Events 
tab. 
 

Adding or removing a form in the Schedule of Events 
1 In the Project Explorer, select the Visit Schedule Explorer bar. 

2 Select the study design. 

The Study Design Editor appears. 

3 Select the Schedule of Events tab. 

4 For each study event in which the form should be added or be removed, select or deselect the 
checkbox where the row of the study object and the column of the study event intersect. 

The form is added or removed under each applicable Study Event container in the Project 
Explorer and is added to the Workflow Diagram and Workflow Grid tabs of the Study Event 
Editor. 
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Deleting a form from the Schedule of Events 
1 In the Project Explorer, select the Visit Schedule Explorer bar. 

2 Select the study design. 

The Study Design Editor appears. 

3 Select the Schedule of Events tab. 

4 Right-click the row of the form, and select Delete InForm form. 

A message appears, prompting you to confirm the deletion. 

5 Click one of the following: 

• Yes—Delete the study object. 

• Yes, Always Delete—Delete this study object, and do not prompt for confirmation in 
subsequent deletions. 

• No—Do not delete the study object. 

Note: If you click Yes, Always Delete, and later decide that you want to be prompted before 
deletions, you can reset the prompt in the Central Designer Options dialog box, which is 
available from the Tools menu. 

 

Editing a form in the Schedule of Events 
1 In the Project Explorer, select the Visit Schedule Explorer bar. 

2 Select the study design. 

The Study Design Editor appears. 

3 Select the Schedule of Events tab. 

4 Right-click the row of the form, and select Edit InForm form. 

The Form Editor appears in the workspace and displays the definition of the study object you 
selected. 

5 Edit the form. 
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Forms design activities 

About forms 
A form is a container for one or more items. A form can contain one or more sections and supports 
multiple locales and layouts. (A section is a form embedded within a form.) 

Order in which to create forms 

The order in which you can create forms and items depends on the current view of a study: 

• In the Form editor, a form must first exist before you can create or copy its items or sections. 

• In the Study Forms editor, you can create forms and items, or copy them into the study from a 
library, in any order.  

Working with multiple forms 

The topics in this section focus on working with a single form. The Workflow Diagram and the 
Workflow Grid tabs of the Study Event Editor enable you to specify how forms relate to each other 
in the workflow of a study event. For more information, see About study workflows (on page 53). 

Naming conventions 

Sometimes lists of forms in the Central Designer application include sections, and in the Study 
Forms Container Editor, sections and forms have the same icon. To more easily identify sections and 
forms, Oracle recommends that you use a naming convention. For example, you can preface a form 
name with frm and a section name with sct.  

Repeating, common, and associated forms 

Certain types of forms have specialized characteristics when deployed in a study.  
 

Type of form Characteristic Property used to define form 
Repeating The form holds multiple 

instances of the same set of 
data.  

Repeating. 

If this property is set to True, the form is 
repeating. 

Common The same data is visible in all 
study events that contain the 
form.  

Common. 

If this property is set to True, the form is 
common.  

Associated  

(Two repeating 
forms in the same 
study event) 

Data from both forms in the 
association is accessible when 
a study user works with either 
form. 

AssociatedForm. (This property is visible only in 
the Structured view of a study.) 

Two repeating forms in the same study event 
are associated if the AssociatedForm property of 
one form is set to the Title of the other form. 
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Creating and editing a form 
You create a study object (study design, study element, study event, form, section, item, codelist, and 
codelist item) in a study or library. You can create a study object outside the hierarchy of a study or 
library, but the study object is not deployed until you add it to a parent study object in a study or 
library. To include a study object in the hierarchy of a study or library, add it to an existing parent in 
the study or library. 

To create a form: 

1 To create a form on an existing study event:  

• In the Project Explorer, right-click a study event, and select New > Form. 

To create a form outside the hierarchy of a study or library:  

a In the Project Explorer, select the Forms and Transactions Explorer bar. 

b Right-click the Study Forms container, and select Form. 

The Object Name dialog box appears. 

2 Type a title, RefName, and description, and click OK.  

To edit the properties of a form in the Properties Browser: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 In the Forms folder, select a form. 

3 Select the Properties Browser. 

Note: If the Properties Browser is not visible, select View > Properties. 

4 Edit the properties of the form. After changing each property, press Enter, or tab to the next 
property. 

Note: The values of editable properties appear in bold, black text, and the values of non-
editable properties appear in gray text.  

To add one or more items to a form or section: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 In the Forms folder, select a form. 

3 Select the Design tab. 

4 On the toolbar, click Columns, and display the columns that you need in the grid, including 
Codelist and Item Properties.  

5 In the grid, create items on the form or section by typing values in each field. Press Tab to 
advance to the next field and, when you have reached the end of a row, to the next item.  
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Your changes are added to the grid after you move the cursor away from the row but are not 
saved in the database until you explicitly save them. 

Note: To type extended ASCII characters in text fields, press ALT while entering the decimal 
code for the character. You can also add HTML formatting characters (on page 240) to a 
text field to control its appearance when deployed.  

6 To modify the properties of an item: 

a In the Item Properties field, click Edit, or on the toolbar, select Item Properties. 

The Item Properties dialog box appears. 

b Define the properties of the item (on page 381). The fields that appear in the dialog box 
depend upon the type of item that you select. These properties are also available on the 
Design tab for an item. 

To add a codelist to an item: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 In the Forms folder, select the form or section that contains the item, and select the Design tab. 

3 In the grid, select an integer, text, or float item. 

4 Do one of the following: 

• If the codelist already exists, select it from the drop-down list in the Codelist field.  

• Create a codelist on the item. 
 

 

Making a form common or not common 
1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 In the Forms folder, right-click a form, and select Common Form. 

If Common Form is selected, the form is common. If Common Form is not selected, the form is not 
common. 

 

Making a form or section repeating or nonrepeating 
1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 In the Forms folder, right-click a form or section, and select Repeating Form or Repeating Section. 

If Repeating Form or Repeating Section is selected, the form or section is repeating. 
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Marking a form for source verification 
You can indicate that a form requires source verification or that a repeating form is critical for source 
verification in the InForm application by setting its SDV Required and SDV Critical properties. 

Note: All forms that are marked SDV Critical automatically are marked SDV Required. 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 In the Forms folder, select a form. 

3 Select the Design tab. 

4 To indicate that the form requires source verification, select the SDV Required checkbox. 

5 To indicate that the form is critical for source verification, select both the SDV Required and the 
SDV Critical checkboxes. 

 

Marking a form as a special InForm form 
1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 In the Forms folder, select a form. 

3 Open the Properties Browser. 

Note: If the Properties Browser is not visible, open the View menu and select Properties, if it 
is not already selected. 

4 From the Special Forms drop-down list, select the type of special form. 
 

Associating two forms 
1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 Select a form. 

3 In the Properties Browser, select the form you want to associate from the drop-down list in the 
Associated property, and press Enter. 

The Associated property for both forms is updated. 
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Creating and translating instructions and Help for a form 
You can create study documents that are specific to a target application or locale for study designs, 
study elements, study events, forms, sections, and items. 

You can provide instructions and Help information if the study or library supports one or more 
locales, and if you have been given skills to work in the locales (in the Central Designer 
Administrator application). 

To create and delete instructions and Help: 

1 In the Project Explorer, select a study object (study design, study element, study event, form, 
section, item, codelist, or codelist item). 

The editor for the study object appears in the workspace. 

2 Select the Instructions & Help tab. 

3 To select a locale for the study documents, select the tab for the locale. The tabs are located 
along the bottom of the workspace. 

4 To create or edit study documents: 

a Type in the text area. 

b Optionally, use the toolbar to format the appearance of the text. Additionally, you can use 
HTML formatting characters. For more information, see Supported HTML formatting 
tags (on page 240). 

5 To delete study documents: 

a On the toolbar, click the Delete button. 

or 

Select all of the text, and press Delete.  

A dialog box appears. 

b Choose one of the following options: 

• Delete the study documents for only the selected locale. 

• Delete the study documents for all locales. 
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To translate instructions and Help: 

1 In the Project Explorer, select a study object (study design, study element, study event, form, 
section, item, codelist, or codelist item). 

The editor for the study object appears in the workspace. 

2 Select the Instructions & Help tab. 

3 To select a locale for the study documents, select the tab for the locale. The tabs are located 
along the bottom of the workspace. 

4 Optionally, copy and paste study documents from a locale for which the information is already 
written. 

5 Select the locale to which you want to translate. 

6 Translate the study documents. 

7 Optionally, use the toolbar to format the appearance of the text.  
 

Viewing the parents of a linked form 
You can view the parents of a form, section, item, codelist, or codelist item that: 

• You copied using the Copy > Link option.  

• You use on multiple parents. 

To view the parents of a linked study object: 

1 In the Project Explorer, select a study object, and confirm that a blue icon ( ) appears in the 
upper-left corner of the study object's icon. 

Note: If the icon does not appear, the study object could be used multiple times in the study 
but always on the same parent. 

2 Right-click the study object, and select Show Parents. 

The Show Parents dialog box appears.  

3 Review the paths of the parent study objects in the current project. 

The paths begin with the project name and work down; the last study object listed is the parent. 

4 To copy paths to the Microsoft Windows clipboard: 

a To copy one path, select it and click Copy. 

or 

Click Copy All.  

b Paste the information in a text editor. 

Notes: 

• Show Parents is available in both a study and library, but it lists only the parents in the current 
project. 

• Show Parents is not available for a study object on a single parent that appears multiple times, 
such as an item on a form that is used multiple times in a study. 
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Special InForm forms and items 
In the InForm application, certain forms are required, and others have special design requirements to 
make sure that their data is handled correctly in an InForm study: 

• Screening (on page 84). 

• Enrollment (on page 86). 

• Patient Identification (on page 87). 

• Study Completion (on page 89). 

Special InForm items are required for some forms. You can include the following additional special 
InForm items in a regular form: 

• Date of Visit (on page 93). 

• Randomization (on page 94). 

If you do not include special InForm forms and items in your study design, the Central Designer 
application includes default versions of some forms and items when you deploy the study to the 
InForm application. Default versions are included for the following: 

• Screening form (on page 84). 

• Enrollment form (on page 86). 

• Date of Visit item (on page 93). 
 

Screening form 
The Screening form is included in the special InForm Screening visit as the system Screening form.  

 

Design consideration Description 
Form title (value of Special 
Forms property) 

Screening. 

Purpose in the InForm 
application 

Captures subject screening data. 

Required form? Yes. If you include a custom screening form, select Screening in 
the Special Forms custom property list in the Properties Browser. 

Default version generated? Yes. If you do not include a screening form, a default form is 
generated during deployment to the InForm application. The default 
form contains the item listed as a Required item. If you include a 
custom screening form, it must contain the required item. 

Note: Default forms and items appear in English in the InForm 
application. Create custom forms and items if you do not want to 
use the default information or if you want to translate an item or 
form. 
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Design consideration Description 

Required items? • Item—Initials. 

• Item type—Text. 

• Special Fields property—Initials (Screening). 

Optional items • Item—Date of birth. 

• Item type—Date time. 

• Special Fields property—DOB (Screening). 

 

 

• Item—Screening date. 

• Item type—Date time. 

• Special Fields property—Screening date (Screening). 

Hidden items During deployment, the Central Designer application creates two 
hidden items, itmWorkflow and itmVisitHours, which are used 
internally by Central Designer dynamics calculations to store data. 
These data items are not visible during form design or in the 
annotated study book.  

Other requirements • The Screening form must have the Special Forms custom 
property value of Screening and must be the only form in the 
study with this custom property value. 

• The study event that contains the Screening form must have the 
Special Visits custom property of Screening and must be the 
only study event in the study with this custom property value. 
The Screening study event must contain only the Screening 
form and no other forms.  

• The Screening study event must be a standalone study event 
that is not connected to the rest of the workflow.  

• The Screening study event must be the first study event in the 
workflow diagram.  

• Items with the following Special Fields custom property values 
can occur only once in a study and must be in a form with the 
Special Forms custom property value of Screening: 

 Initials (Screening) 

 DOB (Screening) 

 Screening Date (Screening) 

• The Screening form must not contain a repeating section. 
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Enrollment form 
The Enrollment form is included in the special InForm Enrollment visit as the system Enrollment 
form. 

 

Design consideration Description 

Form title (value of Special 
Forms property) 

Enrollment. 

Purpose in the InForm 
application 

Captures subject enrollment data. 

Required form? Yes. If you include a custom enrollment form, select Enrollment in 
the Special Forms custom property list in the Properties Browser. 

Default version generated? Yes. If you do not include an enrollment form, a default form is 
generated during deployment to the InForm application. The default 
form contains an item with a text control called Subject Number. 
This item allows InForm users to specify a patient number. 

Note: Default forms and items appear in English in the InForm 
application. Create custom forms and items if you do not want to 
use the default information or if you want to translate an item or 
form. 

Required items? No. 

Optional items If you include an optional Patient Number item, it must conform to 
the listed specifications. 

Note: If you include the optional Patient Number item and you 
create a Patient Identification form, the Patient Identification form 
must include the same Patient Number item. 

• Item—Patient Number. 

• Item type—Text or Integer. 

• Special Fields property—Patient No. (Enrollment). 
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Design consideration Description 

Other requirements • The Enrollment form must have the Special Forms custom 
property value of Enrollment and must be the only form in the 
study with this custom property value. 

• The study event that contains the Enrollment form much have 
the Special Visits custom property of Enrollment and must be 
the only study event in the study with this custom property 
value. The Enrollment study event must contain only the 
Enrollment form and no other forms.  

• The Enrollment study event must be a standalone study event 
that is not connected to the rest of the workflow.  

• The Enrollment study event must be the second study event in 
the workflow diagram.  

• The Enrollment form must not contain a repeating section. 
 

 

Patient Identification form 
 

Design consideration Description 
Form title (value of Special 
Forms property) 

Patient Identification. 

Purpose in the InForm 
application 

Captures subject identification information that users can edit after a 
subject is enrolled. 

In the InForm application, the items on the special InForm 
Screening or Enrollment forms are not editable after a subject is 
screened or enrolled. If you want users to be able to change the 
patient initials or patient number, you must include those items on a 
form with a Special Forms property value of Patient Identification. 

When a subject is enrolled, the Patient Initials or Patient Number 
data is transferred from the Screening or Enrollment form to the 
Patient Identification form. Subsequently, when a user changes the 
patient identification fields on the Patient Identification form, the 
new information updates the patient object in the study database. 
The updated information is not reflected on the Screening and 
Enrollment forms. 

To transfer other data (for example, to transfer Date of Birth to a 
Demographics form), create a calculation rule to populate the item 
on the target form with the value of the item on the screening or 
enrollment form. When a subject is enrolled, the calculation runs in 
the InForm application.  

Note: The ability to transfer screening and enrollment data other 
than Patient Initials or Patient Number is not available with some 
releases of the InForm application. 

Required form? No. 
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Design consideration Description 
Default version generated? No. 

Required items? The Patient Number item is required if either of the following is true: 

• You have created an Enrollment form with the Special Forms 
custom property of Enrollment, and that Enrollment form 
includes an item with the Special Fields custom property of 
Patient No. (Enrollment). 

• You have not created an Enrollment form with the Special 
Forms custom property of Enrollment. In this case a default 
Enrollment form is generated. 

Otherwise, all items are optional. 

Optional items 

 

The following items, if included, must conform to the listed 
specifications. 

Note: The Patient Identification form can also have other items, 
including items copied from the Screening or Enrollment special 
forms. If you copy Screening or Enrollment items, note the other 
requirements that apply. 

 • Item—Initials. 

• Item type—Text. 

• Special Fields property—Initials (Patient Identification). 

 • Item—Patient Number. 

• Item type—Text or Integer. 

• Special Fields property—Patient No. (Enrollment). 
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Design consideration Description 

Other requirements • The Patient Identification form must have the Special Forms 
custom property value of Patient Identification and must be 
the only form in the study with this custom property value. 

• If the Patient Number and Initials items are included on the 
Patient Identification form, the items must be together in 
either a section or the top-level form.  

• You can copy the Initials item from the Screening form into the 
Patient Identification form. If you copy the Initials item: 

 Do not use the Copy > Link command. Use Copy > With 
new children or Copy > With links to children.  

 Change the Special Fields property value from Initials 
(Screening) to Initials (Patient Identification). 

• If the Enrollment form contains a Patient Number item with the 
Special Fields property of Patient No. (Enrollment), the 
Patient Number item on the Patient Identification form must be 
the same item. You can copy this item with the Copy > Link 
command. 

• If you copy the Date of Birth or Screening date items from the 
Screening form: 

 Do not use the Copy > Link command. Use Copy > With 
new children or Copy > With links to children.  

 Change the Special Fields property value from DOB 
(Screening) or Screening date (Screening) to None. 

• If you copy screening or enrollment items other than Initials, 
Date of Birth, or Screening date, you can copy them with the 
Copy > Link command. 

• The Patient Number and Randomization items cannot be on the 
same section or on the same form, outside a section. If one item 
is on a section, the other item is allowed to be outside the section 
on the same form. 

 
 

Study Completion form 
 

Design consideration Description 

Form title (value of Special 
Forms property) 

Study Completion. 

Purpose in the InForm 
application 

Records the completion of a study by a subject or the reason the 
subject dropped out of the study.  

Required form? No. 

Default version generated? No. 
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Design consideration Description 
Required items? If a form is marked as the Study Completion form, the Completion 

Status or Drop-out Reason special field must also be present: 

• Item—Study completion status. 

• Item type—Integer or Text. 

• Special Fields property—Completion status (Study 
Completion). 

 • Item—Drop-out reason. 

• Item type—Integer or Text. 

• Special Fields property—Drop out reason (Study Completion). 

Other requirements • The Study Completion form cannot be repeating. 

• The Study Completion form must have the Special Forms custom 
property value of Study Completion and must be the only form 
in the study with this custom property value. 

• The item with the Completion status (Study Completion) 
Special Fields custom property must have a codelist that has two 
codelist items: 

 Yes codelist item—The value of the Study Completion 
Status Items custom property for this codelist item must be 
Complete Study (Study Completion). 

 No codelist item—The value of the Study Completion 
Status Items custom property for this codelist item must be 
Incomplete Study (Study Completion). 

• The item with the Drop out reason (Study Completion) 
Special Fields custom property must have a codelist that has at 
least one codelist item. The code on all codelist items must not 
have more than 47 characters. During deployment, the codelist 
item values are converted to InForm resources that are available 
in the InForm application for Reporting and Analysis. The item 
must be able to accept only one value. 

Designing for a CDD If you are implementing a Custom-Defined Database (CDD), note 
that you can map the item with the Drop out reason (Study 
Completion) property to only one column. For mapping each drop-
out reason to a separate CDD column, Oracle suggests the following 
design: 

• Compound item: Did 
the subject complete 
the study? 

Create a compound item in which the No response to the study 
completion status question has multiple-selection child items for each 
drop-out reason. The compound item and its child items do not have 
a value for the Special Fields custom property. 
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Design consideration Description 

• Hidden Yes No item: 
Did the subject 
complete the study? 

Create a hidden item with a codelist that has Yes and No codelist 
items.  

Custom properties: 

• Item—Special Fields property value is Completion status 
(Study Completion). 

• Yes codelist item—Study Completion Status Items value is 
Complete Study (Study Completion). 

• No codelist item—Study Completion Status Items value is 
Incomplete Study (Study Completion). 

• Hidden item: Reason 
for noncompletion 

Create a hidden item with a codelist in which each codelist item 
corresponds to a child item in No response of the visible compound 
item.  

Custom property: 

• Item—Special Fields property value is Drop out reason (Study 
Completion). 

• Calculation rules Create calculation rules that map: 

• The Yes response in the compound item to the Yes codelist item 
in the hidden Yes No item. 

• The No response in the compound item to the No codelist item 
in the hidden Yes No item. 

• The selected child item in the No response of the compound 
item to the corresponding codelist item in the hidden Reason for 
noncompletion item. 

Note: Because the compound item allows multiple selections, 
and the hidden item requires a single selection, the rule must 
contain logic that prioritizes the noncompletion reason to select 
in the hidden item if multiple reasons are selected in the 
compound item. 

• Mapping In a CDD mapping, map each child item in the compound item to a 
different data series. Each data series maps to a separate CDD 
column. 
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Illustration of Study Completion form design for CDD 
 

 



 InForm Design Guide  

Oracle® Health Sciences Central Designer 2.1.2 93 

1—sctSC01 section with study completion data entry items. 

2—COMPREAS compound item with multi-select integer items mapped to separate columns in 
the CDD. 

3—sctSC02 section with special item and controls required for Reporting and Analysis. 

4—COMPLETR hidden item with special custom properties: 

• Item—Special Fields property value is Completion status (Study Completion). 

• Yes codelist item—Study Completion Status Items value is Complete Study (Study 
Completion). 

• No codelist item—Study Completion Status Items value is Incomplete Study (Study 
Completion). 

This item is populated with a calculation rule. 

5—COMPREAR hidden item with dropout reason codelist. Special Fields property value is Drop 
out reason (Study Completion). This item is populated with a calculation rule. 

 
 

Date of Visit item 
 

Design consideration Description 
Item Date of visit. 

Purpose in the InForm 
application 

Captures the visit date for any visit. 

Required form? A Date of Visit form is not required; however, a special Date of 
Visit item must be present on: 

• The first form of each visit, if you want to enable the Enforce 
visit date entry system configuration option in the InForm 
application. 

• The first form of each instance of a repeating visit in the 
InForm application, regardless of whether the Enforce visit 
date entry system configuration option is enabled in the 
InForm application. 

Default version generated? Yes. Validation checks for a Date of Visit item on the first form of 
each repeating study event. If a Date of Visit item is not present, a 
default Date of Visit form containing a Date of Visit item is 
generated for each repeating study event when you deploy a study to 
the InForm application.  

Note: Default forms and items appear in English in the InForm 
application. Create custom forms and items if you do not want to 
use the default information or if you want to translate an item or 
form. 
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Design consideration Description 
Required items? • Item—Date of visit. 

• Item type—Date time. 

• Special Fields property—DOV (Date of Visit). 

Other requirements A study can contain only one Date of visit item. To use the same 
item in multiple forms, use the Copy > Link command. 

 
 

Randomization item 
 

Design consideration Description 
Item Randomization. 

Purpose in the InForm 
application 

Holds a sequence and drug kit number generated by InForm 
randomization processing. 

Required form? No. The special randomization item can appear on any form. 

Default version generated? No. 

Required items? • Item—Randomization. 

• Item type—Text. The field appears in the InForm application 
in the format sequence / drug_kit_number. 

• Special Fields property—Randomization field 
(Randomization). 
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Design consideration Description 

Other requirements • An item with the Special Fields custom property value of 
Randomization field (Randomization) can occur only once 
in a study. 

• The following configuration is required on the computer 
hosting the InForm study: 

 Define a randomization sequence for each different list of 
drug kits used in the study and install it in the study 
database using the MedML Installer tool. 

 Configure the randomization data source manager. 

 Configure the format of each randomization sequence. 

 Set up a randomization source database. 

 Create an ODBC connection for the randomization source 
database. 

For more information, see the InForm documentation (Study 
and Reporting Setup Guide). 

• In the Central Designer application, a randomization rule is 
required to generate the sequence and drug kit number. The 
Randomize function is available to help you create the rule. For 
more information, see Randomize (in the Rules Reference Guide). 

• The Patient Number and Randomization items cannot be on 
the same section or form. If one item is on a section, the other 
item is allowed to be outside the section on the same form. 
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Deciding whether to create custom special InForm forms or use the default 
forms 

Oracle recommends using the default forms if the items they contain meet your needs. You must 
create custom screening and enrollment forms if: 

• You want to collect additional data (other than the default items) in the screening or enrollment 
form or to copy that data into another form in the study. 

• You want users to be able to edit the screening or enrollment form after a subject is enrolled. 

• You do not want to collect the default data on the screening or enrollment form. 

• You want to translate the screening and enrollment forms. 

You must create a form with the special Patient Identification Special Forms property if you want 
users to be able to update the patient number or initials and have the updated information stored in 
the patient object in the study database. If you create a form with the special Patient Identification 
Special Forms property, the form must include the special Patient Number item with a Special Fields 
property value of Patient No. (Enrollment) if: 

• You include the special Patient Number item in a custom enrollment form. 

• You use the default enrollment form containing the special Patient Number item.  
 

Custom properties for special InForm forms and items 
The following custom properties identify special InForm visits (study events), forms, items, and 
codelist items: 

• Special Visits (for study events). 

• Special Forms (for a form). 

• Special Fields (for an item). 

• Study Completion (for the codelist items used in the Completion Status special item in a Study 
Completion form). 

After defining a special InForm study event, form, item, or codelist item, you indicate how the study 
event, form, item, or codelist item will be used in the InForm study by selecting the appropriate 
custom property definition in the Properties Browser. 

When a study event, form, item, or codelist item is defined as a specific type of Special Study Event, 
Form, Special Field, or Study Completion codelist item, the deployment process generates the 
MedML definitions for the required InForm study components, including forms, sections, or items, 
along with the required Universally Unique IDs (UUIDs). 

Note: You can apply the Special Forms custom property only to a form, not to a section. If you 
apply the Special Forms custom property to a section, validation fails. 
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Non-clinical forms 
Regulatory documents and visit reports, which are monitoring forms, are custom forms used by 
monitors when they visit sites. You are not required to create monitoring forms. If you do not create 
the forms, default forms are created and deployed with the study. 

• Visit report form—A form that a CRA uses to report findings from a site visit. A visit report 
form cannot be repeating but can contain a repeating section. 

• Regulatory document form—A form that a CRA uses to record whether required regulatory 
documentation, such as the study protocol, IRB approvals, and electronic signature reporting 
documentation, is available and up to date. A regulatory document form is not repeating by 
default, but you can mark it as repeating. 

During deployment, a study event is created for each monitoring form.  

You can create one of each type of form in a study, and you can create multiple forms in a library.  

Note: You can create monitoring forms only in the NonClinical container in the Project Explorer. 

 

Creating a regulatory document form 
You can create only one regulatory document form in a study. You can create multiple forms in a 
library. When you create a regulatory document or visit report form in the NonClinical container, the 
Special Forms custom property in the Properties Browser is automatically set to the appropriate 
value (either Reg Docs or Visit Report). 

A regulatory document form is not repeating by default, but you can mark it as repeating. 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 Select the Non-Clinical folder. 

3 In the workspace, click New > Reg Docs Form. 

The Object Name dialog box appears. 

4 In the Title field, type the title of the study object. 

As you type, the RefName field is filled in, using the Title text but omitting spaces and 
disallowed characters. 

5 Optionally, in the RefName field, type a different RefName from the default. 

6 Optionally, in the Description field, type a description of the study object. 

7 Click OK. 
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Creating a visit report form 
You can create only one visit report form in a study. You can create multiple forms in a library. The 
form must contain a Date of Visit (DOV) item (on page 93) that is marked as a Date of Visit 
special item and is the first item on the form. The item does not have to be in its own section. When 
you create a regulatory document or visit report form in the NonClinical container, the Special 
Forms custom property in the Properties Browser is automatically set to the appropriate value (either 
Reg Docs or Visit Report). 

A visit report form cannot be repeating but can contain a repeating section. 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 Select the Non-Clinical folder. 

3 In the workspace, click New > Visit Report Form. 

The Object Name dialog box appears. 

4 In the Title field, type the title of the study object. 

As you type, the RefName field is filled in, using the Title text but omitting spaces and 
disallowed characters. 

5 Optionally, in the RefName field, type a different RefName from the default. 

6 Optionally, in the Description field, type a description of the study object. 

7 Click OK. 
 



 InForm Design Guide  

Oracle® Health Sciences Central Designer 2.1.2 99 

Designing sections 

About sections 
If you want to group a set of related items together in a form, you can create a section for those 
items. Sections are not required components of a form. If you do include a section in a form, the 
section must have at least one item. 

In a repeating section, multiple instances of the same set of data appear in the section.  

In a fixed repeating section, multiple instances of the same set of data appear in the section, 
organized by one or more fixed items. For more information, see Designing fixed repeating 
sections (on page 103). 

Sections are managed as forms. When you select a form that has one or more sections in the Project 
Explorer, the Form Editor for the form includes information about the sections in the form. 
 

Creating and editing a section 
You create a study object (study design, study element, study event, form, section, item, codelist, and 
codelist item) in a study or library. You can create a study object outside the hierarchy of a study or 
library, but the study object is not deployed until you add it to a parent study object in a study or 
library. To include a study object in the hierarchy of a study or library, add it to an existing parent in 
the study or library. 

To create a section: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 In the Study Forms folder, right-click a form, and select New Section. 

The Object Name dialog box appears. 

3 Fill in the fields as necessary, and click OK. 

The section is created and appears in the Project Explorer, and the Design tab of the Section 
Editor appears in the workspace.  

To add one or more items to a form or section: 

1 In the Project Explorer, select a form or section, and select the Design tab. 

2 On the toolbar, click Columns, and display the columns that you need in the grid, including 
Codelist and Item Properties.  

3 In the grid, create items on the form or section by typing values in each field. Press Tab to 
advance to the next field and, when you have reached the end of a row, to the next item.  

Your changes are saved after you move the cursor away from the row. 

Note: To type extended ASCII characters in text fields, press ALT while entering the decimal 
code for the character. You can also add HTML formatting characters (on page 240) to a 
text field to control its appearance when deployed.  

4 To modify the properties of an item: 

a In the Item Properties field, click Edit, or, on the toolbar, select Item Properties. 
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The Item Properties dialog box appears. 

b Define the properties of the item (on page 381). The fields that appear in the dialog box 
depend upon the type of item that you select. These properties are also available on the 
Design tab for an item. 

To add a codelist to an item: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 In the Forms folder, select the form or section that contains the item, and select the Design tab. 

3 In the grid, select an integer, text, or float item. 

4 Do one of the following: 

• If the codelist already exists, select it from the drop-down list in the Codelist field.  

• Create a codelist on the item. 

To make a form or section repeating: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 In the Forms folder, right-click a form or section, and select Repeating Form or Repeating Section. 

If Repeating Form or Repeating Section is selected, the form or section is repeating. 

To mark a repeating section as fixed: 

1 Navigate to a repeating section. 

2 Do one of the following: 

• In the Project Explorer, right-click the repeating section and select Fixed Repeating Section. 

• In the <Section name> editor, select the Fixed checkbox. 

To edit the properties of a section in the Properties Browser: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 In the Study Forms folder, select a section. 

3 Select the Properties Browser. 

Note: If the Properties Browser is not visible, select View > Properties.  

4 Edit the properties of the section. After changing each property, press Enter, or tab to the next 
property. 

Note: The values of editable properties appear in bold, black text, and the values of non-
editable properties appear in gray text.   
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Reordering the sections on a form 
1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 In the Study Forms folder, select a form with two or more sections, and then select the Design 
tab. 

3 On the toolbar, click Reorder Sections. 

The Reorder Sections dialog box appears. 

4 Select a section, and use the Move Up and Move Down buttons to reorder the form. 

5 Click OK. 
 

Creating and translating instructions and Help for a section 
You can create study documents that are specific to a target application or locale for study designs, 
study elements, study events, forms, sections, and items. 

You can provide instructions and Help information if the study or library supports one or more 
locales, and if you have been given skills to work in the locales (in the Central Designer 
Administrator application). 

To create and delete instructions and Help: 

1 In the Project Explorer, select a study object (study design, study element, study event, form, 
section, item, codelist, or codelist item). 

The editor for the study object appears in the workspace. 

2 Select the Instructions & Help tab. 

3 To select a locale for the study documents, select the tab for the locale. The tabs are located 
along the bottom of the workspace. 

4 To create or edit study documents: 

a Type in the text area. 

b Optionally, use the toolbar to format the appearance of the text. Additionally, you can use 
HTML formatting characters. For more information, see Supported HTML formatting 
tags (on page 240). 

5 To delete study documents: 

a On the toolbar, click the Delete button. 

or 

Select all of the text, and press Delete.  

A dialog box appears. 

b Choose one of the following options: 

• Delete the study documents for only the selected locale. 

• Delete the study documents for all locales. 
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To translate instructions and Help: 

1 In the Project Explorer, select a study object (study design, study element, study event, form, 
section, item, codelist, or codelist item). 

The editor for the study object appears in the workspace. 

2 Select the Instructions & Help tab. 

3 To select a locale for the study documents, select the tab for the locale. The tabs are located 
along the bottom of the workspace. 

4 Optionally, copy and paste study documents from a locale for which the information is already 
written. 

5 Select the locale to which you want to translate. 

6 Translate the study documents. 

7 Optionally, use the toolbar to format the appearance of the text.  
 

Viewing the parents of a linked section 
You can view the parents of a form, section, item, codelist, or codelist item that: 

• You copied using the Copy > Link option.  

• You use on multiple parents. 

To view the parents of a linked study object: 

1 In the Project Explorer, select a study object, and confirm that a blue icon ( ) appears in the 
upper-left corner of the study object's icon. 

Note: If the icon does not appear, the study object could be used multiple times in the study 
but always on the same parent. 

2 Right-click the study object, and select Show Parents. 

The Show Parents dialog box appears.  

3 Review the paths of the parent study objects in the current project. 

The paths begin with the project name and work down; the last study object listed is the parent. 

4 To copy paths to the Microsoft Windows clipboard: 

a To copy one path, select it and click Copy. 

or 

Click Copy All.  

b Paste the information in a text editor. 

Notes: 

• Show Parents is available in both a study and library, but it lists only the parents in the current 
project. 

• Show Parents is not available for a study object on a single parent that appears multiple times, 
such as an item on a form that is used multiple times in a study.  
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Designing fixed repeating sections 

About fixed repeating sections 
You might want to design a form that allows a user to enter the same piece of data multiple times for 
the same item. For example, a user might need to record a subject's heart rate while the subject is 
sitting and then standing, at specified time intervals after the subject receives a drug. 

To do this, you can create a fixed repeating section in the Central Designer application. A fixed 
repeating section includes items for which predefined values are configured by using codelists at 
study design time, and cannot be modified at runtime. For the above example, the fixed repeating 
section contains the following study objects: 

 

Study object Type Description 
TimePoint item  Text, Integer, or 

Float 
The amount of time before or after a drug is 
administered when data is collected. 

Contains predefined values. 

Time points codelist Text, Integer, or 
Float 

Codelist items for each required time point. 

• Codelist item 1—Pre-dose 

• Codelist item 2—15 minutes post dose 

• Codelist item 3—30 minutes post dose 

• Codelist item 4—45 minutes post dose 

• Codelist item 5—60 minutes post dose 

The codelist items are the predefined values for 
the TimePoint item. 

Position item Text, Integer, or 
Float 

The subject's position when the data is collected. 

Contains predefined values. 

Position codelist Text, Integer, or 
Float 

Codelist items for each required subject position: 

• Codelist item 1—Sitting 

• Codelist item 2—Standing 

The codelist items are the predefined values for 
the Position item. 

HeartRate item Any type, other than 
Date 

The subject's heart rate at each time point, for 
each position. 

Does not contain predefined values. 
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In the Edit Fixed Table dialog box for this example, you might create the following rows: 
 

Row itmTime value itmPosition value itmHeartRate 

1 Pre-dose Sitting  

2 Pre-dose Standing  

3 15 minutes post dose Sitting  

4 15 minutes post dose Standing  

5 30 minutes post dose Sitting  

6 30 minutes post dose Standing BLANK 

7 45 minutes post dose Sitting  

8 45 minutes post dose Standing  

9 60 minutes post dose BLANK  

10 60 minutes post dose Standing  
 

The following illustration shows the fixed repeating section in the form layout. 
 

 

1—HeartRate item that does not contain predefined values. 

2—Fixed TimePoint and Position items that contain predefined values. 
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3—TimePoint codelist item for the Pre-dose predefined value. Each TimePoint codelist item 
contains two rows; each row corresponds to a Position codelist item.  

4—Position codelist with predefined Sitting and Standing values. These predefined values appear 
five times in the fixed repeating section layout; each instance corresponds to a TimePoint 
predefined value 

5—Blank cell for an item in a non-fixed column.  

6—Blank cell for an item in a fixed column. 
 

As noted in the form layout screenshot, you can also specify a data point that you do not want data 
for, but that appears in the fixed repeating section. In addition, in some cases, it might not make 
sense for you to collect certain data points. To do this, when you create a fixed repeating section, you 
locate the cell that corresponds to the data point, and set is as blank. In the annotated form preview, 
a cell that corresponds to data that should not be collected is grayed out. In the target application, 
data cannot be entered for that data point. 
 

About writing rules for fixed repeating sections 
When you create rules that use the study objects in fixed repeating sections, consider the following: 

• For values in fixed columns: 

• You can create a rule that references a value in a fixed column. 

• You can create a rule to check the value in a fixed column. 

• You cannot create a rule with a query, set value, or email action that affects a value in a fixed 
column. 

• For values in non-fixed columns: 

• You can create a rule that references a value in a non-fixed column. 

• You can create a rule to check a value in a non-fixed column. 

• You can create a rule with a query, set value, or email action that affects a value in a non-
fixed column. 

• For blank cells: 

• You can create a rule that references a blank cell in a fixed or non-fixed column. 

• You cannot create a rule with a query, set value, or email action that affects a blank cell in a 
fixed or non-fixed column. 

• You can create a rule for a fixed repeating section to compare data between the rows of data in 
the fixed repeating section.  

For example, you can compare a subject's seated heart rate before receiving a drug to the 
subject's seated heart rate 30 minutes after receiving a drug. 
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Creating and editing a fixed repeating section 
To create a fixed repeating section: 

1 Create a section. 

2 In the Project Explorer, select the Forms and Transactions Explorer bar. 

3 In the Study Forms folder, right-click a form, and select New Section. 

The Object Name dialog box appears. 

4 Fill in the fields as necessary, and click OK. 

The section is created and appears in the Project Explorer, and the Design tab of the Section 
Editor appears in the workspace.  

5 In upper-right corner of the section editor, select the following checkboxes: 

a Repeating 

b Fixed. 

6 Add one or more items to the section. 

7 In the Project Explorer, select a form or section, and select the Design tab. 

8 On the toolbar, click Columns, and display the columns that you need in the grid, including 
Codelist and Item Properties.  

9 In the grid, create items on the form or section by typing values in each field. Press Tab to 
advance to the next field and, when you have reached the end of a row, to the next item.  

Your changes are saved after you move the cursor away from the row. 

Note: To type extended ASCII characters in text fields, press ALT while entering the decimal 
code for the character. You can also add HTML formatting characters (on page 240) to a 
text field to control its appearance when deployed.  

10 To modify the properties of an item: 

a In the Item Properties field, click Edit, or, on the toolbar, select Item Properties. 

The Item Properties dialog box appears. 

b Define the properties of the item (on page 381). The fields that appear in the dialog box 
depend upon the type of item that you select. These properties are also available on the 
Design tab for an item. 

11 For each item that you want to define as a fixed item: 

• Create a codelist (on page 122). 

• Create a codelist item (on page 123). 
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To mark one or more items as fixed in a fixed repeating section: 

1 In the <Fixed repeating section name> editor, do one of the following: 

• In the upper-right corner, click the Fixed Table icon ( ). 

• In the toolbar for the editor, click Fixed Table. 

Note: If there is more than one fixed repeating section on the form, the Fixed Table 
control in the toolbar for the editor is a drop-down list. If there is one fixed repeating 
section on the form, the Fixed Table control is a button. 

The Edit Fixed Table dialog box appears. 

2 In the Define Fixed Columns section, select the items to mark as fixed. 

A fixed item must: 

• Be a top level item with no nested items. 

• Be a text, integer, or float item.  

• Have a control type of radio button or pull-down. 

• Have a codelist and at least one codelist item defined.  

Note: You cannot mark all items in a fixed repeating section as fixed. 

3 Optionally, to view only fixed items in the fixed repeating section in the grid, deselect Show non-
fixed columns. 

4 Click Add Row, or right-click any arrow in the grid and select Add Row to add a row to the grid. 

5 Optionally, to indicate that you do not want a user to enter data for a particular cell, right-click 
the cell and select Set as Blank. 

The cell is grayed out, and when the study is deployed, the cell is disabled so that a user cannot 
enter data for that control. You can set a cell as blank for fixed and non-fixed items. 

6 To modify the rows, use the buttons on the right of the dialog box. 
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Items and codelists 

About items 
An item is a study object used as a container for the collection of clinical data collected in a study. 
You can design different types of items, depending on the type of information you want to collect. 
By default, you can create the following types of items. 

Additional item types might be available in your study if a library user has created and published 
them in a library that your study project uses. 

 

Item type Description 

Blood pressure A specialized type of compound item used to collect blood pressure information 
on a form. 

Compound An item that has one or more child items that can have different data types. 

Date time An item used to collect date and time information on a form. 

Float An item used to collect numerical values with decimal points.  You can also use a 
float item to collect information for a question with a codelist. 

Integer An item used to collect a numerical value without a decimal point. You can also 
use an integer item to collect information for a question with a codelist. The value 
entered in the InForm application must be between -2147483647 and 
+214483647. 

Text An item used to collect alphanumeric information.  You can also use a text item to 
collect information for a question with a codelist. 

Yes no A specialized type of integer item used to collect yes or no answers to questions. A 
yes no item contains a predefined codelist with Yes and No options. 

Note: After you create a yes no item, it is listed as an integer item in the Form 
Editor and the Study Items Editor. 

 
 

Conditional relationships between items 
Conditional relationships between items make it possible to design items in which a user both selects 
one or more options and provides additional information about the selected option or options. You 
can use conditional relationships for collecting: 

• Nested levels of multiple-choice data. 

• User-entered information along with multiple-choice data, when you want to allow user-entered 
information for more than one choice in a list. 

You can use up to five levels of nesting for compound and conditional items.  

You design an item that contains nested information by: 

1 Creating an item for each level of nesting. The parent item must include a codelist. 

2 Making the nested item conditional on one of the codelist items in the parent item. You specify 



 InForm Design Guide  

Oracle® Health Sciences Central Designer 2.1.2 109 

conditional relationships between items on the Design tab of the Form Editor. 

For example, you can design an item that displays as a set of checkboxes nested within a radio group 
and includes text fields in which a user can type other information not covered by the existing 
options. 

To design this item, you could create three items with codelists: 

• An integer item for the Unknown/No/Yes options. 

• An integer item for the family member options. The family member item is conditional on the Yes 
option of the Unknown/No/Yes codelist.  

• A text item for the Other field. The text item is conditional on the Other option of the family 
member codelist. 

 

Illustration of conditional items 

 
1—First item contains Unknown/No/Yes codelist. 

2—Second item contains family members codelist. 

3—In the family members codelist, the text field is associated with the Other, specify codelist item.  
 

For more information, see Design tab of the Form Editor or Section Editor - Option 
Descriptions (on page 366). 
 

About codelists and codelist items 
Codelists enable you to design items in which a user selects from multiple choices. A codelist is a 
collection of code-label pairs that gather together the entry choices for an item. A code-label pair 
consists of a single code (the value that is used for analysis) and a label (the value that is visible to 
users). Each code-label pair makes up a codelist item. 

Certain properties of codelists and codelist items must be unique: 

• Code of a codelist item—Must be unique within a codelist. 

• Label of a codelist item—Must be unique within a codelist. 

• RefName of a codelist or codelist item—Must be unique within study object type. 

• Title of a codelist or codelist item—Must be unique within a codelist. 

You can include a codelist in the definition of a float, integer, or text item, and the Yes No item type 
includes a predefined codelist that contains Yes and No options. When you create a codelist, specify 
whether a study user must select only one option or can select multiple options. 

Codelist data can appear as a drop-down list, as a set of radio buttons, or as a set of checkboxes. You 
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specify the formatting information when you generate the layout of the form or item containing the 
codelist. 

Codelists and conditional item relationships 

If you want to design more complex items in which a user both selects one or more options and 
provides additional information about the selected option or options, you can make an item 
conditional on an option in a codelist. You can use conditional relationships for collecting: 

• Nested levels of multiple-choice data. 

• User-entered information along with multiple-choice data. 
 

Items and units 
When you create integer or float items, you can specify the base unit and one or more conversion 
units in which users can enter data. The available units and their conversion calculations are stored in 
the database. To specify additional units and conversion calculations or to provide locale-specific 
abbreviations, you must export the units file using the Central Designer Administrator application, 
edit it, and import the file using the Central Designer Administrator application. 

For more information, see Adding units and conversion calculations in the Administrator Guide. 
 

Creating and editing an item 
You create a study object (study design, study element, study event, form, section, item, codelist, and 
codelist item) in a study or library. You can create a study object outside the hierarchy of a study or 
library, but the study object is not deployed until you add it to a parent study object in a study or 
library. To include a study object in the hierarchy of a study or library, add it to an existing parent in 
the study or library. 

Note: You can use an item only one time in any level of a particular study object hierarchy. For 
example, you can use the same item in different sections of a form but not twice in the same 
section of the form. In a single section, you can use the same item as a child item in two different 
compound items. To use identical item definitions multiple times in a single form, section, or 
compound item, copy the item as many times as you need, and use the copies. 

To add one or more items to a form or section: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 In the Forms folder, select a form. 

3 Select the Design tab. 

4 On the toolbar, click Columns, and display the columns that you need in the grid, including 
Codelist and Item Properties.  

5 In the grid, create items on the form or section by typing values in each field. Press Tab to 
advance to the next field and, when you have reached the end of a row, to the next item.  
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Your changes are added to the grid after you move the cursor away from the row but are not 
saved in the database until you explicitly save them. 

Note: To type extended ASCII characters in text fields, press ALT while entering the decimal 
code for the character. You can also add HTML formatting characters (on page 240) to a 
text field to control its appearance when deployed.  

6 To modify the properties of an item: 

a In the Item Properties field, click Edit, or on the toolbar, select Item Properties. 

The Item Properties dialog box appears. 

b Define the properties of the item (on page 381). The fields that appear in the dialog box 
depend upon the type of item that you select. These properties are also available on the 
Design tab for an item. 

To create an item outside the hierarchy of a study or library: 

1 In the Project Explorer, select the Items Explorer bar. 

2 Select the InForm Items folder. 

The InForm Items editor appears. 

3 On the toolbar, click New. 

A drop-down list appears with a list of available item types. 

4 Select the type on which to create the item. 

5 Type the title, RefName, and description, and click OK. 

The new item is added to the grid and to the container in the Project Explorer.  

To add a codelist to an item: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 In the Forms folder, select the form or section that contains the item, and select the Design tab. 

3 In the grid, select an integer, text, or float item. 

4 Do one of the following: 

• If the codelist already exists, select it from the drop-down list in the Codelist field.  

• Create a codelist on the item. 
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To make an item conditional on a codelist selection within another item: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 In the Forms folder, select a form, and select the Design tab. 

3 In the grid, select an item. 

4 In the Conditional On column, select the title of the item with which to create a conditional 
relationship. 

5 In the Conditional Value column, select the Code and Label of the codelist item on which to make 
the current item conditional. 

For more information, see Conditional relationships between items (on page 108). 

To mark an item as a special InForm field: 

1 In the Project Explorer, select the Items Explorer bar. 

2 In the InForm Items folder, select an item. 

3 Open the Properties Browser. 

Note: If the Properties Browser is not visible, open the View menu and select Properties. 

4 From the Special Fields drop-down list, select the type of special field. 

To mark an item as critical for source verification: 

You can indicate that an item is critical for source verification in the InForm application by setting its 
SDV Critical property. 

Note: All items that are marked SDV Critical are automatically marked SDV Required. 

1 In the Project Explorer, select the Items Explorer bar. 

2 In the InForm Items folder, select an item. 

The Item Editor appears. 

3 Select the Properties Browser. 

Note: If the Properties Browser is not visible, select View > Properties. 

4 From the SDV Critical drop-down list, select True, and press Enter. 
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To mark an item as collapsible: 

You can indicate that an item is collapsible, meaning that it does not appear in the InForm 
application until specified conditions are met, by setting its Collapsible property. 

Note: The Collapsible property is only available for child items that are conditional on parent 
items. 

1 In the Project Explorer, select the Items Explorer bar. 

2 In the InForm Items folder, select an item. 

The Item Editor appears. 

3 Select the Properties Browser. 

Note: If the Properties Browser is not visible, select View > Properties. 

4 From the Collapsible drop-down list, select True, and press Enter. 

To mark an item as containing Personal/Protected Health Information (PHI): 

You can indicate that an item contains Personal/Protected Health Information (PHI) so that, during 
rule design and validation, the Central Designer application can verify that no PHI is transmitted 
through email in the InForm application because of a rule with an email action. For more 
information, see Item properties (on page 480). 

1 In the Project Explorer, select the Items Explorer bar. 

2 In the InForm Items folder, select an item. 

The Item Editor appears. 

3 Select the Properties Browser. 

Note: If the Properties Browser is not visible, select View > Properties. 

4 From the PHI drop-down list, select True, and press Enter. 

To edit the properties of an item in a form: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 In the Forms folder, select a form, and select the Design tab. 

3 In the grid, select an item. 

4 In the Item Properties field, click Edit, or, on the toolbar, select Item Properties. 

The Item Properties dialog box appears. 

5 Define the properties of the item (on page 381). The fields that appear in the dialog box 
depend upon the type of item that you select. These properties are also available on the Design 
tab for an item. 
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To edit the properties of an item in the Properties Browser: 

1 In the Project Explorer, select the Items Explorer bar. 

2 In the InForm Items folder, select an item. 

3 Select the Properties Browser. 

Note: If the Properties Browser is not visible, select View > Properties.  

4 Edit the properties of the item (on page 480). After changing each property, press Enter, or tab 
to the next property. 

Note: The values of editable properties appear in bold, black text, and the values of non-
editable properties appear in gray text.  

Default maximum input field lengths: 

When you create an item, you specify the length of the input field. The Central Designer application 
supports the following maximum field lengths as a default. 

 

Type of input field Maximum length 
Text item 2000 

Integer item 10 

Float item 18 

Float precision 10 
 

 

Adding a child item to a compound item 
Compound items collect data in two or more data fields. The items that make up a compound item 
are its child items. The child items of a compound item can be different data types; for example, you 
can create a compound item with a date time and a text item. 

Note: A blood pressure item is a specialized type of compound item, collecting a blood pressure 
measurement in two child items called Systolic Variable and Diastolic Variable. 
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To create and add a child item to a compound item: 

1 In the Project Explorer, select the Items Explorer bar. 

2 In the InForm Items folder, select a compound item. 

The Design tab of the Item Editor appears in the workspace. 

3 In the Child Items section, complete a row in the Compound Item grid for each child item in the 
compound item: 

a Type the Question and Title. 

b Select the Type. 

4 After you complete each row, and after the final row, press Enter, or tab or click in the next row. 

The child item is added to the compound item. 

To add an existing child item to a compound item: 

1 In the Project Explorer, select the Items Explorer bar. 

2 In the InForm Items folder, select a compound item. 

The Design tab of the Item Editor appears in the workspace. 

3 Drag an item from the Project Explorer, and drop it onto the Child Items grid. 
 

Reordering an item in a form or section 
1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 In the Forms folder, select the form or section containing the item to reorder. 

The Design tab of the Form Editor opens. 

3 In the leftmost column of the grid, drag and drop the button of the item to move onto the 
button of the item to appear below it. 

The items are reordered so that the item you moved appears above the item you dropped it on. 
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Specifying column heading text for an item in a repeating form or section 
If an item is included in a repeating form or section, you must specify a value to be used as the 
column heading for the item in the layout of the form or section. Specify this value in the Short 
Question property of the item. 

Note: If your InForm installation includes the Reporting and Analysis module, do not use the 
words Subject Number or Subject Initials as the value of the Short Question property for an item 
in a repeating form or section. Subject Number and Subject Initials are reserved terms in the 
Reporting and Analysis module. Using the words Subject Number or Subject Initials as a column 
heading in a repeating form or itemset definition causes an error when you generate the clinical 
reporting model. If the Question property of an item in a repeating form or section is Subject 
Number or Subject Initials, use a different formulation for the Short Question, (for example, 
Subject Num or Subject Init). 

1 Create the item (on page 110). 

2 Select the Properties Browser. 

Note: If the Properties Browser is not visible, select View > Properties. 

3 In the Properties Browser, type the column heading text in the Short Question property. 

4 Press Enter. 
 

Reserved words for an item question or short question 
The reserved words below cannot be used for the following item properties: 

• Short question. 

• Default question or Question if a Short question is not provided, or is populated with a reserved 
word. 

If you specify a reserved word for the item Default question or Question you must provide a Short 
question that is not a reserved word, or the clinical model in the Reporting and Analysis module fails 
to generate.  

Note: You cannot use the English reserved words or Japanese reserved characters for any locale. 

For example, to design an item for which a reserved word appears as the question on the form in the 
InForm application, specify the following: 

• Question—Reserved word such as Subject Number. 

• Default question or Short question—A word that is not on the reserved words list, such as Subj 
Number. 

Subject Number appears as the question on the form, and Subj Number appears in the clinical model 
in the Reporting and Analysis module and as the itemset column header on the form in the InForm 
application. In addition, the clinical model is successfully generated. 
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A warning does not appear in the Central Designer application if a reserved word is used incorrectly. 
 

English words Japanese characters 
SITECOUNTRY 施設の国名 

SITENAME 施設名 

SITEMNEMONIC 施設略称 

SUBJECTINTIALS 症例イニシャル 

SUBJECTNUMBERSTR 症例番号 

VISITMNEMONIC ビジット略称 

VISITORDER ビジットオーダー 

VISITIDX ビジットインデックス 

FORMMNEMONIC フォーム略称 

FORMIDX フォームインデックス 

DELETED 削除フォーム 

ITEMSETIDX アイテムセットインデックス 

DELETEDITEMSET 削除アイテムセット 

DOV ビジット日時 

NOTDONE 未実施 

CREATEDBYUSERID 基本データ 

CREATEDDATETIME その他のデータ 

MODIFIEDBYUSERID 不完全データの理由 

MODIFIEDDATETIME 内部ID 

SITEID 施設 

SUBJECTID 症例 

VISITID ビジット 

VISITINDEX フォーム 

SUBJECTVISITID セクション 

FORMID アイテム 

FORMREV ルール 

FORMINDEX クエリ 

SECTIONID コメント 

ITEMSETID 定義済フィルタ 
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English words Japanese characters 
ITEMSETINDEX すべての登録済症例 

FORMASSOCID 脱落者を除いたすべての登録済症例 

CD_COUNT 有効症例 

Basic Data クリニカルビジット 

Additional Data クリニカルフォーム 

Incomplete Data Reasons 開始フォーム 

Internal Id's 見込フォーム:予定ビジット 

Sites 見込フォーム:予定ビジットまたは開始ビ

ジット 

Subjects 見込フォーム:現在までの予定ビジットま

たは開始ビジット 

Visits 見込フォーム:現在までの予定ビジットま

たは開始フォーム 

Forms データ完了(クエリを含む) 

Sections データ完了(オープンクエリを含まない) 

Items クリーンデータ:完了かつSDV済み 

Rules  

Queries  

Comments  

Predefined Filters  

All Enrolled Subjects  

All Enrolled Subjects except Dropped  

Active Subjects  

Clinical Visit  

Clinical Form  

Started Forms  

Expected Forms: Scheduled Visits  

Expected Forms: Scheduled or Started Visits  

Expected Forms: Scheduled or Started Visits to 
Date 

 

Expected Forms: Scheduled Visits or Started 
Forms to Date 

 

Data Complete (Queries Allowed)  
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English words Japanese characters 

Data Complete, No Open Queries  

Data Clean: Complete and SV  

Site Country  

Site Name  

Site Mnemonic  

Subject Initials  

Subject Number  

Visit Mnemonic  

Visit Order  

Visit Index  

Form Mnemonic  

Form Index  

Deleted Form  

Itemset Index  

Deleted Itemset  

DOV  

Not Done  

 
 

About key items in a repeating form or section 
In repeating forms and repeating sections, you can identify certain items as key items. In the InForm 
application, key items are used to: 

• Simplify navigation to a specific instance of a repeating form. The values of key items appear in a 
drop-down list in the summary view of the repeating form, and users can navigate to a specific 
instance of the form by clicking the key item values for that instance. 

• Verify that the values of certain items are unique among instances of a repeating form or an 
itemset. 

 

Key items for navigating to an instance of a repeating form 
When you identify an item as a key item in a repeating form, regardless of whether it is used to 
establish data uniqueness, the value of the item appears in a drop-down list in the summary view of 
the repeating form in the InForm application. When an InForm user selects a specific set of key item 
values, the instance of the repeating form containing those key item values appears. 

Note: Key items in a repeating section must always be defined as having individual or group 
uniqueness and are not used as navigation tools for instances of itemsets in the InForm 
application. 

 



Chapter 3  Designing forms  
 

120 Oracle® Health Sciences Central Designer 2.1.2 

Unique keys 
Key items can have individual or group uniqueness: 

• If key items are defined with individual uniqueness, an InForm user cannot add an instance of a 
repeating form or itemset in which the value of any key item is identical to the value of that item 
in another instance. For example, if the DATE and PROCEDURE items are defined as 
individually unique keys in a repeating form or section, the following table shows how the 
DATE and PROCEDURE items are evaluated when a user attempts to add new instances. 

 

DATE value PROCEDURE value Result when data is 
submitted 

May 1, 2009 Hematocrit Instance or row added 

May 1, 2009 Hemoglobin Instance or row rejected 

June 14, 2009 Hematocrit Instance or row rejected 

June 15, 2009 Platelet count Instance or row added 
 

Note: A set of key items for a repeating form can include both items that are individually 
unique and items that appear in the drop-down list for navigation but are not used to 
enforce uniqueness. The key items can come from the repeating form or from a non-
repeating section in the form. 

• If key items are defined with group uniqueness, they make up a composite key. An InForm user 
cannot add an instance of a repeating form or itemset in which the values of all of the items in 
the composite key are the same as the values of all of the composite key items in another 
instance. For example, if the DATE and PROCEDURE items are defined as group unique keys 
in a repeating form or section, the following table shows how the DATE and PROCEDURE 
items are evaluated when a user attempts to add new instances. 

 

DATE value PROCEDURE value Result when data is 
submitted 

May 1, 2009 Hematocrit Instance or row added 

May 1, 2009 Hemoglobin Instance or row added 

June 14, 2009 Hematocrit Instance or row added 

May 1, 2009 Hemoglobin Instance or row rejected 
 

Note: If a group of key items is defined with group uniqueness, no other items in the 
repeating form or section can be defined as non-unique key items. Only the items that are 
defined with group uniqueness appear in the drop-down list of a repeating form. 
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Key item requirements 
A key item must: 

• Be in a repeating section if the key is for an itemset. 

• Be in a non-repeating section if the key is for a repeating form. 

• Be unique in a repeating section. 

A key item must not: 

• Be a hidden item or be attached to a read-only control. 

• Be a child in a compound item. 

• Be a child of a conditional item. 

• Have a combination of composite keys and individually unique keys in the same repeating form 
or section. 

• Have a conditional child that is a compound item or is formatted as a checkbox or radio control. 

• Be formatted as a checkbox. 

• Have a caption that is aligned at the top or bottom of the control, including captions for 
conditional items. 

• Be in a nested control structure, unless it is at the top of the hierarchy and conforms to other 
eligibility requirements. 

• Be in a repeating section, if the key is for a repeating form. 
 

Creating keys in a repeating form or section 
1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 Select a repeating form or section, and select the Design tab. 

3 Right-click the row of an item, and select Keys. 

The Keys dialog box appears. 

4 In the Data uniqueness for selected keys section, select one of the following: 

• None—Key items appear in a drop-down list in the summary view of a repeating form as 
navigation aids. The key items are not used to enforce uniqueness of key values across 
instances of the repeating form. 

• Individual—Each key item must be unique across all instances of the repeating form or 
itemset in the InForm application. 

• Group—The combination of all key items evaluated together must be unique across all 
instances of the repeating form or itemset in the InForm application. 

5 In the Key selection section, move the key items from the Items available as keys list to the 
Selected keys list. 

6 If you are creating keys for a repeating form, and you selected Individual in the previous step, 
select the Unique checkbox for each item to designate as a unique key. (In a repeating section, the 
Unique checkbox is selected and disabled for all selected key items.) 
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Note: A set of key items for a repeating form can include both items that are individually 
unique and items that appear in the drop-down list for navigation but are not used to 
enforce uniqueness. The key items can come from the repeating form or from a non-
repeating section in the form. 

7 To change the order in which the items appear in the InForm application in the drop-down 
summary list of a repeating form, select an item and click the Move Up or Move Down button. 
Repeat this step for each item you want to move. 

8 Click OK. 
 

Creating and editing a codelist 
You create a study object (study design, study element, study event, form, section, item, codelist, and 
codelist item) in a study or library. You can create a study object outside the hierarchy of a study or 
library, but the study object is not deployed until you add it to a parent study object in a study or 
library. To include a study object in the hierarchy of a study or library, add it to an existing parent in 
the study or library. 

To add a codelist to an item: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 In the Forms folder, select the form or section that contains the item, and select the Design tab. 

3 In the grid, select an integer, text, or float item. 

4 Do one of the following: 

• If the codelist already exists, select it from the drop-down list in the Codelist field.  

• Create a codelist on the item. 

To create a codelist outside the hierarchy of a study or library: 

1 In the Project Explorer, select the Codelists Explorer bar. 

2 Select the Codelists folder. 

The Codelists Editor appears. 

3 In the toolbar, click New. 

The Object Name dialog box appears. 

4 Type a title, RefName, and description, and click OK. 

The codelist appears in the grid. 

5 Double-click the codelist. 

The codelist is selected in the Project Explorer, and the Codelist Editor appears. 

6 To add codelist items: 

a In the rows and columns of the grid, type information about each codelist item to include in 
the codelist. 

b After you complete each row, and after the final row, press Enter, or tab to the next row. 
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To edit the properties of a codelist in the Properties Browser: 

1 In the Project Explorer, select the Codelists Explorer bar. 

2 In the Codelists folder, select a codelist. 

3 Select the Properties Browser. 

Note: If the Properties Browser is not visible, select View > Properties.  

4 Edit the properties of the codelist (on page 475). After changing each property, press Enter, or 
tab to the next property. 

Note: The values of editable properties appear in bold, black text, and the values of non-
editable properties appear in gray text.    

 

Creating and editing a codelist item 
You create a study object (study design, study element, study event, form, section, item, codelist, and 
codelist item) in a study or library. You can create a study object outside the hierarchy of a study or 
library, but the study object is not deployed until you add it to a parent study object in a study or 
library. To include a study object in the hierarchy of a study or library, add it to an existing parent in 
the study or library. 

To add codelist items to a codelist: 

1 In the Project Explorer, select the Codelists Explorer bar. 

2 In the Codelists folder, select a codelist. 

The Codelist Editor appears in the workspace. 

3 In the rows and columns of the grid, type information about each codelist item to include in the 
codelist. 

4 After you complete each row, and after the final row, press Enter, or tab to the next row. 

To edit the properties of a codelist item in the Properties Browser: 

1 In the Project Explorer, select the Codelists Explorer bar. 

2 In the Codelist Items folder, select a codelist item. 

3 Select the Properties Browser. 

Note: If the Properties Browser is not visible, select View > Properties.  

4 Edit the properties of the codelist item (on page 476). After changing each property, press 
Enter, or tab to the next property. 

Note: The values of editable properties appear in bold, black text, and the values of non-
editable properties appear in gray text.   
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About rules 
The two classes of rules are: 

• Data-entry rule—A rule that checks whether data is valid or that sets the value of an item based 
on a calculation. You can create a data-entry rule for study designs, study elements, study events, 
forms, and items. 

• Workflow rules and global conditions 

• Workflow rule—A logical construct that tests data values to determine the study element, 
study event, or form to which a subject progresses next. 

You can create a workflow rule for a study element, study event, or form only. 

• Global condition—A logical construct that, when applied to a study object, determines 
whether the study object will appear for a particular subject. 

 

About data-entry rules 
 

Characteristic Description 
Creating You create the following rules in the Rules tab (on page 135): 

• An intrinsic rule (on page 149). 

• A rule without a function (on page 154). 

• A rule using a function (on page 159). 

About A data-entry rule is a rule that checks whether data is valid or that sets the value 
of an item based on a calculation. Different actions occur as a result of the 
evaluation of the rule expression. For example, an email can be sent or a query 
can be created. 

A data-entry rule is part of a study object and not a separate component that is 
attached to the study object. Rules can be part of study designs, study elements, 
study events, forms, and items. 

Because rules are part of study objects, when you reuse a study object from the 
library, you reuse the rules that are defined on that study object. 

• When a rule is part of a study object template or type, the rule is 
automatically part of all study objects created from the template or type. 

• When a rule is part of a study object and the study object is copied into 
another project, the rule is copied with the study object. 

• For valid data-entry rules, if you modify the RefName of a study object 
referenced by the rule, the data-entry rule is automatically updated with the 
change. 

Note: Modifying the RefName of a study object from within the rule 
expression prevents the study object from being updated in rules that 
reference the study object. 
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Characteristic Description 
Types You can create the following types of rules.  

• Intrinsic rules (on page 128). 

• Calculation rules (on page 131). 

• Constraint rules (on page 129). 

Depending on the rule, it might be better to use an intrinsic rule, an 
expression rule, or a function (on page 134). 

Structure All data-entry rules consist of three parts. 

• Precondition 

The event that causes a rule to execute, such as On Demand (Batch 
Mode) or Form Submission. 

• Expression 

The expression (on page 145) that is evaluated. 

• Action 

The action or actions to take depending on the result of evaluating the rule 
expression, such as create a query, store a value, or send an email message. 

Note: The action clause is similar to an If statement in C++, C#, or Java. 

Scope (on page 
135) 

A rule that is part of a study object can refer only to: 

• The study object and its children.  

• Properties and values of the study object and its children. 

This concept is called scope.  

Running order You cannot set the order in which data-entry rules are run. 

Rule deployment Rules created with two or more different actions are deployed to the InForm 
application as multiple rules. For example, a rule might call for: 

• A query to be sent. 

• An email message to be sent. 

• A value to be set. 

A different rule is created in the InForm application for each type of action. In 
the previous example, three rules are created: 

• One rule sends a query. 

• One rule sends an email message. 

• One rule sets a value. 
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Characteristic Description 
Deciding among 
hard-coded 
values, 
constants, and 
data mappings 

Oracle recommends that you do not use hard-coded values or hard-coded 
constants in rules, as the rule might be less reusable. Consider using constants or 
data mappings instead. A data mapping is another name for an item that has 
been added to a data series and has a global scope for the purposes of rule 
creation. 

If the value of an item is constant for every subject in a study, such as lab normal 
ranges, use constants. For example, if you expect blood pressure ranges to be 
uniform for all subjects in a study, you can use a constant for blood pressure. 

If you want to capture dynamic values, such as gender, which varies from subject 
to subject, use data mappings. For example, acceptable hemoglobin ranges differ 
for men and women, so it makes more sense to use data mappings for these 
values in a rule. 

Testing rules You create test cases in the Rule Test Cases dialog box to test data-entry rules, 
workflow rules, and global conditions before deploying a study. Depending on 
the rule, you might create several or many test cases.  

You can create test cases either after writing each rule or after all rules are 
finished.  

To make sure that a rule is written correctly, consider writing and running a 
single test case for it, so you do not write many test cases for a rule that needs to 
be modified. 

Naming 
conventions 

You are not required to use a naming convention for rules, but conventions can 
help you distinguish one type of rule from another and avoid duplicate 
RefNames. If you want to adopt a naming convention, consider prefixing rules 
with the following: 

• wr - workflow rule 

• gc - global conditions 

• rul - data-entry rules (for example, rulDMConsDtCompare)  
 

 

Intrinsic rules 
 

Characteristic Description 
Definition An intrinsic rule is a constraint rule or calculation rule based on a 

predefined rule template. Rule templates can be created for constraint rules 
and calculation rules. If no rule templates have been defined for the 
selected study object, then you cannot create an intrinsic rule for the study 
object. 

Study objects that can 
have intrinsic rules 

• Forms. 

• Form templates. 

• Items. 

• Item templates and types. 
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Characteristic Description 
Programming 
experience necessary 

• To create intrinsic rules—Programming knowledge is not required. 

• To create rule templates—Programming knowledge is required.  

What to define The rule expression is defined by the rule template. You must define:  

• When to evaluate the rule. 

• Parameters for the rule template. 

If the rule template contains parameters, you indicate the source of the 
values to be substituted in the parameter with:  

 Numeric values. 

 Values of study objects and their rule model properties. 

 Constants. 

 Another function. 

 Data mapping study objects and their rule model properties. 

• The action to take after the rule executes. 

Example An intrinsic rule evaluates whether a weight value falls within a range that 
you specify using parameters. 

A programmer writes the rule expression in a rule template, and a non-
programmer provides the following information to create the rule: 

• When to evaluate the rule—On form submission.  

• Parameters for the rule template—Provide the range. In this case, it 
is 45 to 125 kilograms. 

• The action to take after the rule executes—When the value is false, 
a query is issued. You can create additional actions to occur under 
different circumstances, such as an action to take when the value is 
true.  

The following information appears in the Rule Summary section: 

 evaluate on Form Submission 
 value = Is the item between {MinValue:45} and {MaxValue:125} 
 when value is false 
    issue query: Out of range 

Alternatively, you can use a constraint rule (on page 129) to create this 
rule. 
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Constraint rules 
 

Characteristic Description 
Definition A constraint rule checks whether data is valid. 

Note: There is no real difference between a calculation rule and a constraint 
rule. Each offers different starting points in the Rule Wizard; the options on 
the Actions tab change depending on the rule type that you select. 

Study objects that 
can have constraint 
rules 

• Study designs 

• Study elements 

• Study events 

• Forms 

• Items 

Programming 
experience 
necessary 

Creating a constraint rule is comparable to writing formulas in the 
Microsoft Excel spreadsheet software. 

What to define You must define: 

• When to evaluate the rule. 

• The rule expression. 

For calculation and constraint rules, you can use the following to define 
the rule expression: 

 Study objects and their rule model properties. 

 Functions. If you use a function, you define values for its 
parameters using numeric values, values of study objects and their 
rule model properties, constants, and data mapping study objects 
and their rule model properties. 

 Constants. 

 Data mapping study objects and their rule model properties. 

• The action to take after the rule executes. 
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Characteristic Description 
Example 

(without a function) 

A constraint rule determines if a calculated BMI value is below the expected 
value of 30. You create the rule on the form that contains the weight and 
height items. 

You provide the following information to create the rule: 

• When to evaluate the rule—On form submission.  

• The rule expression—To create the rule expression, which calculates 
body mass index, either drag the weight and height items from the Data 
tab to the Expression workspace, or type the expression.  

• The action to take after the rule executes—You specify the 
constraint in the action. When the BMI is below 30, an email is sent. 

The following information appears in the Rule Summary section: 

evaluate on Form Submission 

 value = this.weight / (this.height)*(this.height) 
 when value < 30 
     send email: Subject has reached target BMI. 
You could create the rule with a function, as described in the next example, 
or with a rule template (on page 128). 

Example 

(with a function) 

A constraint rule uses a function (_CalculateBMI) and determines if a 
calculated BMI value is below the expected value of 30. You create the rule 
on the form that contains the weight and height items. 

A programmer creates the function, and a non-programmer provides the 
following information to create the rule: 

• When to evaluate the rule—On form submission.  

• The rule expression—After you drag the function to the Expression 
workspace, the Invoke Function dialog box appears, and you can 
provide values for the parameters. In this case, you provide the weight 
and height items as parameters.  

• The action to take after the rule executes—When the BMI is below 
30, an email is sent. 

The following information appears in the Rule Summary section: 

 evaluate on Form Submission 
 value = _CalculateBMI(this.height.value, this.weight.value)  
 when value < 30 
     send email: Subject has reached target BMI. 

You could create the rule without a function, as described in the previous 
example, or with a rule template. For more information, see Intrinsic rules 
(on page 128). 
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Calculation rules 
 

Characteristic Description 
Definition A calculation rule sets the value of an item based on a calculation. 

Note: There is no real difference between a calculation rule and a constraint 
rule. Each offers different starting points in the Rule Wizard; the options on 
the Actions tab change depending on the rule type that you select. 

Study objects that 
can have calculation 
rules 

• Study designs 

• Study elements 

• Study events 

• Forms 

• Items 

Programming 
experience 
necessary 

Creating a calculation rule is comparable to writing formulas in the 
Microsoft Excel spreadsheet software. 

What to define You must define: 

• When to evaluate the rule. 

• The rule expression. 

For calculation and constraint rules, you can use the following to define 
the rule expression: 

 Study objects and their rule model properties. 

 Functions. If you use a function, you define values for its 
parameters using numeric values, values of study objects and their 
rule model properties, constants, and data mapping study objects 
and their rule model properties. 

 Constants. 

 Data mapping study objects and their rule model properties. 

• The action to take after the rule executes. 
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Characteristic Description 
Example  

(without a function) 

A calculation rule calculates BMI using height and weight values with 
RefNames of HT and WT. You create the rule on the form that contains 
the items. 

You provide the following information to create the rule: 

• When to evaluate the rule—On form submission.  

• The rule expression—The rule expression divides the weight value by 
the height value squared. 

• The action to take after the rule executes—The rule calculates BMI 
and stores the value in the BMI field. 

The following information appears in the Rule Summary section: 

 evaluate on Form Submission 
 value = this.WT.Value / (this.HT.Value * this.HT.Value) 
 always 
     set this.BMI.Value = value 

You could create the rule with a function, as described in the next example. 

Example  

(with a function) 

A calculation rule uses a function (_BMI) to calculate BMI from height and 
weight values with RefNames of HT and WT. You create the rule on the 
form that contains the items. 

A programmer creates the function, and a non-programmer provides the 
following information to create the rule: 

• When to evaluate the rule—On form submission.  

• The rule expression—After you drag the function to the Expression 
workspace, the Invoke Function dialog box appears, and you can 
provide values for the parameters. In this case, you provide the weight 
and height items as parameters.  

• The action to take after the rule executes—The rule calculates BMI 
and stores the value in the BMI field. 

The following information appears in the Rule Summary section: 

 evaluate on Form Submission 
 value = _BMI(this.HT.Value,this.WT.Value) 
 always 
     set this.BMI.Value = value 

You could create the rule without a function, as described in the previous 
example. 
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When to use intrinsic rules, expression rules, and functions 
The following table helps you to decide whether to use an intrinsic rule, expression rule, or a rule 
with a function. The table also provides guidance about whether rule developer or programming 
skills are required to create the rule. In many cases, form developers are able to create rules.  

 

Rule When to use it Who can create it 
Intrinsic rule Intrinsic rules are most helpful for simple 

functionality that is already defined in a 
rule template.  

Anyone who can write a logical 
expression. Typically, form 
designers are able to create intrinsic 
rules.  

Expression rule 
(constraint or 
calculation rule) 

If the functionality of a rule can be 
created in a rule expression and is not 
already defined in a rule template, create 
an expression rule.  

Expression rules are more complex 
than intrinsic rules. However, many 
form designers are able to create 
expression rules.  

Function If the functionality of a rule is too 
complex for a rule expression and cannot 
be created using logical operators, the 
rule requires a function. If the 
functionality is not available in an existing 
function, the function must be created. 
Functions are built outside of the Central 
Designer application in a .NET 
environment. 

A user with .NET skills.  

 
 

Rule collaboration 
Some tasks for rule creation require programming knowledge, while others require some or no 
programming knowledge. 

 

Skill level Experience Typical tasks 
Programmer Ability to program in a 

.NET language (for 
example, C#) and create 
.NET assemblies. 

• Creates functions. 

• Creates complex rule templates. 

Some 
programming 
skills 

• Understanding of C# 
or similar (for 
example, Java, C, or 
C++) expression 
syntax. 

• Ability to incorporate 
functions in 
expressions. 

• Creates calculation and constraint rules and 
specifies:  

 When the rule fires. 

 The action to take. 

 A simple rule expression.  

• Creates less-complex rule templates, with or 
without functions.  

• Creates constants. 

• Checks rule syntax. 
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Skill level Experience Typical tasks 

No programming 
experience 

None. • Creates intrinsic rules and specifies:  

 When the rule fires. 

 What action to take.  

 The parameters of the rule template. 

• Checks rule syntax. 
 

 

Rules tab 
The Rules tab lists all the rules that are part of the selected study object. The tab can also display the 
rules on each child study object of the selected study object.  

When a rule is selected in the Rules tab, the Rule Summary at the bottom of the tab shows a 
structured specification of the rule. 

The Rules tab is part of the editors for study designs, study elements, study events, forms, sections, 
and items. In the Rules tab, you can view, search, and manage rules at the study object level. As in 
most grids, you can filter and sort the columns. 

For more information, see Rules tab - Option descriptions (on page 424). 
 

Rule design considerations 

Rule scope 

About scope 

A rule that is part of a study object can refer only to: 

• The study object and its children.  

• Properties and values of the study object and its children. 

This concept is called scope. 

Child items of a compound item 

The child items of a compound item are in the scope of the compound item. 

Study objects that are outside the scope of a rule 

If a study object falls outside the scope of a rule, you have the following options:  

• Create the rule on a study object that is higher in the hierarchy and that has the necessary study 
object in its scope.  

• Move the necessary study object within the scope of the study object on which you create the 
rule.  

• Add the study object to a data series. Study objects that are part of mappings can be included in 
any rule in a study.   

For more information, see: 

• Mappings for rule creation (on page 194). 
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• Rule mappings (on page 204). 

Tips 

• To allow for reuse, create data-entry rules on the lowest-level study object that is reasonable 
based on scope requirements. For example, if an item requires a range check, create the range 
check on the item, not on the form that contains the item.  

• Do not create all rules on the study design. Although all study objects in the study are in scope, 
you cannot reuse the rules because you cannot reuse study designs.  

• If one or more study objects are outside the scope of a study object, Oracle recommends 
creating the rule on a higher-level study object that has all required study objects in its scope.  

If you choose this option, the data-entry rule might be less likely to be reused because it is 
created on a study object that might not be reused in many other studies, but you are no longer 
limited by the scope of a particular study object. 

• As early as possible, plan the study object on which every rule will be created. 

For example, if a study event contains two forms, and you have a rule that requires data from 
both forms, the scope of the rule will allow you to create the rule on the study event or a higher 
study object. 

 

Rules and calculated fields 

To write a rule that sets a value and sends an email, program the edit check in two separate rules, one 
to perform the calculation and another to contain the email action.  

For example, consider the scenario where a rule should send an Initial email when a Serious Adverse 
Event has occurred and should also send a Follow-up email when subsequent changes are made to 
the Adverse Event form after the initial email has been sent. 

In this scenario, you should create two rules:  

• Rule 1: Calculate the value of a hidden item that stores the date the Initial email versus Follow-
up email needs to be sent. 

• Rule 2: Create an explicit trigger dependency on this hidden item, and specify an action to send 
email based on its value (Initial or Follow-Up). 

 

About overriding Screening and Enrollment failures 

To design a rule that causes a subject to fail Screening and Enrollment in the InForm application: 

• Create a rule on the Screening and Enrollment form or any of its child study objects (such as an 
item on the form).  

• Add a query action to the rule. 

When a subject fails Screening and Enrollment, an InForm user with the appropriate rights can 
override the failure if the study is configured to permit screening and enrollment overrides. 
 



 InForm Design Guide  

Oracle® Health Sciences Central Designer 2.1.2 137 

Rules with multiple actions 

You can create a rule with multiple actions, with some exceptions. 

For a rule, you can create: 

• Multiple calculation actions using the Set Value Action dialog box.  

• Multiple query actions, as long as the queries are on the same item. 

• A combination of the previous two. 

You cannot create multiple query actions if the queries are on different items. 

Note: Multiple query actions appear as additional lines in the Rules report. 

 

Rules on repeating study objects 

When you create a rule on a repeating study object, and data is entered or updated in the InForm 
application: 

• The rule executes only on the instance of the itemset, repeating form, or repeating visit where 
the data changes. It does not execute on all instances of the study object.  

• The rule action (such as issuing a query) occurs only on the instance of the itemset, repeating 
form, or repeating visit where the data changes, not on all instances. 

However, if the rule has a dependency on another study object, and data is entered or changed on 
the other study object, the InForm application executes the rule against all instances of the itemset, 
repeating form, or repeating visit. 
 

About copying and moving data-entry rules 
You can copy and paste a data-entry rule or move a data-entry rule. 

• Copy and paste a data-entry rule.  

When you copy and paste a data-entry rule, a new instance of the data-entry rule is created. The 
copy of the data-entry rule has: 

• A RefName in the following format: 

• [Original rule RefName]_[Number to uniquely identify the copied rule] 

For example, if you copy a data-entry rule with the RefName chkDOV, the RefName 
for the copied rule is chkDOV_1. The appended number is incremented with each 
subsequent copy of the rule so that each rule has a unique RefName. 

Note: For library rules, a data-entry rule RefName must only be unique among 
sibling rules with the same parent object. 

• New instances of rule test cases associated with the original rule. 

On a copied or moved data-entry rule, the Central Designer app deletes the test cases and does 
not modify the rule expression or action parameters. When you copy or move a rule, you must 
edit the rule as necessary and create new test cases. 

• Move a data-entry rule to another study object, using the cut and paste functionality.  

When you move a data-entry rule to another study object using the cut and paste functionality, a 
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new instance of the data-entry rule is not created. The following occurs: 

• In the Rules tab, the data-entry rule is grayed out.  

• When you paste the data-entry rule to a new study object, the data-entry rule is moved from 
the original study object to the target study object. The Central Designer application does 
not create a new instance of the rule. The RefName and ID for the rule remain unchanged. 

Note: The cut and paste functionality for moving a data-entry rule from the Rules tab 
is different behavior than using the cut and paste functionality for study objects in the 
Project Explorer.  

Notes: 

• You cannot copy or move rule templates, workflow rules, or global conditions. You can only 
copy or move intrinsic rules to study objects for which the rule template (on which the intrinsic 
rule is based) is defined. However, a rule that is based on a function might not work as expected 
if you move or copy and paste the rule onto a study object with a rule that is based on a function 
with the same name and parameters but with a different expression. 

• If you copy or cut a data-entry rule with rule test cases, the test cases are not copied with the 
rule.  

• If you move a data-entry rule, rename any type of rule, or rewrite a rule so that its dependencies 
change, and then install a deployment package over an existing study, you must manually remove 
old rule attachments from the InForm application. If you do not change the name of the rule 
and the study contains old attachments, the StudyInstaller.log file lists warnings about them. 

 

About locking data-entry rules, workflow rules, and global conditions 
You lock study objects and rules, including data-entry rules, workflow rules, and global conditions, 
independently of each other. Only the user who holds the lock can modify a data-entry rule, 
workflow rule, or global condition. The following types of locks are available: 

• An automatic lock, also known as an implicit lock, is applied to a rule when you modify it and 
is released when you cancel or close without saving or when you save the study object or the 
project. 

• A requested lock, also known as an explicit lock, is applied to a rule when you explicitly lock it 
and is released only when you unlock the rule. You might request a lock if you plan to work on a 
rule for an extended period of time.  

Note: A lock icon is red if someone else holds the lock and green if you hold the lock. To view 
details about the lock, including the person who holds it, point to the lock icon.  
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About deleting, deactivating, and disabling rules 
For a rule that you no longer want to use with a study, you can delete, deactivate, or disable the rule. 
The behavior of the rule in the InForm application depends on the action that you choose. 

• Delete—Removes the rule from the study. Deleted rules are not validated or deployed to the 
InForm application. 

• If you deploy to an InForm release prior to release 6.1.1, the rule is not deleted in the 
InForm application. 

• If you deploy to InForm release 6.1.1 or later, the InForm application marks the rule as 
Inactive when you deploy your study. The rule does not appear in the InForm user interface. 

Note: If you deactivate a rule in any release of the InForm application after deployment, it is 
not deleted in the Central Designer application. As a result, if you do not delete, deactivate, 
or disable the rule in the Central Designer application, the next time you deploy the study, 
the rule is deployed to the InForm application in the Active state. 

• Deactivate—Retains the rule in the database, but prevents the rule from running in the InForm 
application. Deactivating a rule also allows you suspend execution of the rule on a temporary 
basis. 

• Deactivated rules are: 

• Validated in the Central Designer application. 

• Deployed to the InForm application in the Inactive state. 

• Run only manually in the InForm application. 

Note: To deactivate a rule, set the Evaluate on Event precondition to On demand (batch 
mode). 

• Disable—Allows you to more easily perform testing for a study during a development process 
in which forms and rules are being developed collaboratively by different users, by viewing the 
study in the InForm application, without having to validate rules.  

Disabling a rule does not prohibit you from performing rule-related tasks, such as editing the 
rule, and creating and running test cases for the rule. You can successfully run a test case for a 
single disabled rule. However, if you run more than one rule at a time, the Central Designer 
application will not run the test cases for disabled rules. 

• If you deploy to an InForm release prior to release 6.1.1: 

• Disabled rules are not validated in the Central Designer application. 

• Disabled rules are excluded from the deployment package. 

• A validation warning appears and indicates that the study contains disabled rules. 

• If you deploy a study to InForm release 6.1.1 or later: 
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• Disabled rules are deployed to the InForm application as read-only. 

• A validation warning appears and indicates that the study contains disabled rules. 

Note: If you disable a rule in any release of the InForm application after deployment by 
marking it Inactive, it is not disabled in the Central Designer application. As a result, if you 
do not delete, deactivate, or disable the rule in the Central Designer application, the next 
time you deploy the study, the rule is deployed to the InForm application in the Active state. 

 

About workflow rules and global conditions 

Workflow rules 
Definition 

A workflow rule is a logical construct that tests data values to determine the study element, study 
event, or form to which a subject progresses next. 

Example 

For example, a workflow rule on a group of lab values could determine whether a subject branches 
to a set of extended visits or to a termination visit. 
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When you deploy a study to the InForm application, both study workflow branches that follow the 
rule are dynamic; no study objects in the workflow that come after the rule appear in the study until 
activated by the rule. When the workflow in the previous example is deployed, the Termination study 
event and all of the study events in the Extended study element do not exist until the ExtRule is 
executed. If the rule evaluates to true, the visits in the Extended study element appear in the Case 
Book, and if the rule evaluates to false, the Termination visit appears in the Case Book. 

Workflows and workflow rules 

A workflow rule is part of the workflow in which it is created. If you want to use the logic of a 
workflow rule in multiple workflows, you must create it in each workflow separately. 

For valid workflow rules, if you modify the RefName of a study object referenced by the rule, the 
workflow rule is updated with the change. 

Note: Modifying a study object RefName from within the workflow rule expression prevents the 
study object from being updated in rules that reference the study object.   

Where to define 

You can define workflow rules in the Workflow Diagram and Workflow Grid tabs. 

Naming conventions 

You are not required to use a naming convention for rules, but it can help you distinguish one type 
of rule from another. If you want to adopt a naming convention, consider prefixing workflow rules 
with wr and global conditions with gc to differentiate them from data-entry rules. 

Deployment 

Workflow rules and global conditions are deployed to the InForm application as trigger 
dependencies. 
 

Global conditions 
A global condition is a logical construct that, when applied to a study object, determines whether the 
study object will appear for a particular subject. You can use a global condition instead of a workflow 
rule if, for example, multiple workflows depend upon the value of the same observation. 

Using a global condition in a study workflow involves two steps: 

1 Creating the global condition and its expression.  For more information, see Creating a g lobal 
condition (on page 171). 

2 Assigning the global condition by associating it with a study object and specifying how its 
outcome affects the workflow. For more information, see Assigning and removing a g lobal 
condition (on page 172).  



Chapter 4  Designing rules  
 

142 Oracle® Health Sciences Central Designer 2.1.2 

When you create a global condition, you specify the system with which you will use it.  

You can assign an InForm global condition to any: 

• Study element 

• Study event 

• Form 

Example 
In the following example, a global condition checks whether the subject is female, based on the 
Gender item in the Demographics form. If the condition is true, the Pregnancy form is presented. 
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Global condition: Is subject female?  

(this.Demographics.Gender.Value == this.Demographics.Gender.GenderCodeList.Female)  

When you deploy a study to the InForm application, only the study object assigned to the global 
condition is dynamic. Study objects that follow the study object with the global condition in the 
workflow appear in the study. When the workflow in the example is deployed, the Vital Signs, 
Medical History, and Physical Exam forms appear in the visit after the Demographics form. The 
Pregnancy Test form appears in the visit only if the global condition outcome is True. 

Copying study objects with global conditions using the Libraries Browser 
Global conditions appear to be attached to study objects but are actually part of a workflow. They 
are copied with study objects in the following way: 

• If a study event contains a form with a global condition, the global condition is actually part of 
the study event. When you use the Libraries Browser to copy the study event from a study to a 
library, the global condition is copied. The global condition is not copied if you copy only the 
form.   

• If you use the Libraries Browser to copy the study event from a study to a library, publish only 
the form, and copy only the form into a study, the global condition is not copied into the study 
because the global condition is part of the workflow at the study event level. 

Note: When a global condition is on a study element or study event that is created directly under 
the study design in the Project Explorer, the global condition cannot be copied from a study to a 
library. The global condition is actually on the study design, and you cannot copy a study design 
from a study to a library.  

Notes 
• You can apply only one global condition per study object, so you must create an expression that 

evaluates all relevant data points in one global condition. Therefore, you cannot apply the global 
condition to multiple study objects if the other study objects require other actions. When you 
need to apply the same action to multiple study objects, Oracle recommends creating a workflow 
rule instead of applying a single global condition to multiple study objects. A workflow rule is 
evaluated only once.  

• For valid global conditions, if you modify the RefName of a study object referenced by the rule, 
the global condition is updated with the change. 

If you modify a study object RefName in the global condition expression, the study object is not 
automatically updated in other rules that reference it. 

• You are not required to use a naming convention for rules, but it can help you distinguish one 
type of rule from another. If you want to adopt a naming convention, consider prefixing 
workflow rules with wr and global conditions with gc to differentiate them from data-entry 
rules.  

• Workflow rules and global conditions are deployed to the InForm application as trigger 
dependencies. 
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Deciding between a workflow rule and a global condition 
When to use workflow rules 

Use a workflow rule to determine the branch of a study workflow that a subject should follow. For 
example, you can use a workflow rule to determine whether a subject completes a study with the 
standard termination visit or continues on to a set of extended visits.  

When you need to apply the same action to multiple study objects, Oracle recommends creating a 
workflow rule instead of applying a single global condition to multiple study objects. A workflow rule 
is evaluated only once. 

When a study is deployed, the study objects that follow the workflow rule do not appear in the study 
book until the rule outcome determines the branch a study subject should follow.  

When to use global conditions 

Use a global condition when you want a single study workflow object to be dynamic. For example, 
you can use a global condition to generate a pregnancy test form for female subjects.  

Because you can apply only one global condition per study object, you must create an expression that 
evaluates all relevant data points in one global condition. Therefore, you cannot apply the global 
condition to multiple study objects if the other study objects require other actions. 

When a study is deployed, the study object to which the global condition is applied does not appear 
in the study book until the outcome of the global condition determines whether it is needed. 
 

About disabling workflow rules 
You cannot disable an individual workflow rule or global condition. However, if you disable a 
workflow, all workflow rules and global conditions associated with the workflow are disabled.  

Note: This functionality only applies to the current workflow, and does not apply to child 
workflows. For example, if you disable a workflow at the study design level, the child workflows at 
the event or form level are not disabled. 

When you deploy a study with a disabled workflow, the forms associated with that workflow appear 
in the InForm application in the order specified by their sequence numbers in the Workflow 
Diagram. 

If you deploy to an InForm release prior to release 6.1.1: 

• Disabled rules are not validated in the Central Designer application. 

• Disabled rules are excluded from the deployment package. 

• A validation warning appears and indicates that the study contains disabled rules. 

If you deploy a study to InForm release 6.1.1 or later: 

• Disabled rules are deployed to the InForm application as read-only. 

• A validation warning appears and indicates that the study contains disabled rules. 

For more information, see Disabling a workflow rule (on page 169). 
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About the rule expression language 
Use the rule expression language to create the expression component of a data-entry rule, workflow 
rule, or global condition. 

You create rule expressions in: 

• The Expression tab of the Rule Wizard. 

• The Expression workspace of the dialog boxes used to create or edit a workflow rule or global 
condition. 

As you type, a list of the rule model components that you can use in the expression (study objects 
and their properties, functions, constants, and data mappings) appears in the Expression workspace. 
When you select a rule model component, a tooltip appears to indicate its usage (for example, the 
parameters and their data types required for using a function). The list changes dynamically to 
support the contents of the expression as you create it. 

You can also use the following methods for creating a rule expression: 

• Drag rule model components into the Expression workspace from the tabs that appear on the 
right side of the workspace. 

• Type an expression directly in the Expression workspace. 

A rule expression can include any valid C# expression that can appear on the right side of the equals 
sign (=), including: 

• Operators and literals. 

• Study objects and their rule model properties. 

• Functions. 

• Constants defined for the study. 

• Data mapping study objects and their rule model properties. 

• Methods. You can use any method, including:  

• Math methods. 

• Data set methods. 

• Methods for repeating study objects. 
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 A rule expression cannot include: 

• Complex structures, such as if statements (conditionals are allowed) and looping statements.  

Use functions to build more complex rule expressions. For more information, see Functions 
tab of the Rule Wizard (in the Rules Reference Guide). 

• Multi-line expressions.  

The rule expression does not allow flow-of-control operators, such as like, if, then, for, or while. 
You can use parentheses to provide better readability and grouping. 

An expression must evaluate to one of the following types: 

• Integer 

• Float 

• Boolean 

• Text 

• Date time 

Note: A rule expression is similar to a switch statement in C++, C#, or Java. 

 



 InForm Design Guide  

Oracle® Health Sciences Central Designer 2.1.2 147 

Dynamic prompts in the Expression workspace 
When you create an expression, you can type directly in the Expression workspace, and you can drag 
rule model objects from the tabs at the right side of the windows where you create a data-entry rule, 
workflow rule, or global condition. 

When you type in the Expression workspace, prompts appear dynamically as you type, listing the rule 
model objects that are available for you to use based on the scope of the rule and the content of the 
expression. As an alternative to dragging rule model objects from the tabs, you can select the objects 
from the prompts. 

A dynamic expression prompt appears when you type a period. The prompt contains a list of rule 
model objects that you can select.  

• To use the value of a study object or rule model property, type this., and select the study object 
or property from the dynamic expression prompt. 

• To use a function, type Functions., and select the function from the dynamic expression prompt. 

• To use a constant, type Constants., and select the constant from the dynamic expression prompt. 

• To use a data mapping study object or a rule model property, type DataMappings., and select the 
study object or rule model property from the dynamic expression prompt. 

When you select a rule model object that requires parameter values (for example, a function or 
method), an open parenthesis mark follows the name of the rule model object, and a tooltip indicates 
the parameters and their data types. The tooltip also appears when you point to the name of the rule 
model object. 

The following illustration shows a dynamic expression prompt and tooltip that appear when you 
create a rule expression with a function on a study event that includes several forms. The Rule 
Wizard tabs containing the same options are visible on the right. 

 

Dynamic expression prompt and tooltip 

 

1—Dynamic expression prompt. Constants, functions, data mappings, and child study objects are 
available for selection. 

2—Standard Rule Wizard tabs. 

3—Tooltip showing format and data types of required parameters for the function. 
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Selecting a rule model object from a dynamic expression prompt 
When a dynamic expression prompt appears: 

• Double-click a rule model object. 

or 

Select a rule model object, and press the Tab or Enter key. 

Note: You can navigate the list in the dynamic expression prompt with arrow keys or by 
typing the first letter of a rule model object. 
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Designing data-entry rules 

Creating an intrinsic rule 
An intrinsic rule is a constraint rule or calculation rule based on a predefined rule template. Rule 
templates can be created for constraint rules and calculation rules. If no rule templates have been 
defined for the selected study object, then you cannot create an intrinsic rule for the study object. 

You can create intrinsic rules (on page 128) for: 

• Forms 

• Form templates 

• Items 

• Item templates 

• Item types  

Note: As you create a rule, the Rule Summary reflects the structure of the rule, including 
precondition, action, and expression information. Click a link in the Rule Summary to navigate 
through the Rule Wizard. 

Step 1: Select a study object and open the Rule Wizard 

1 In the Project Explorer, select a study design (in a study only), study element, study event, form, 
section, or item. 

The editor for the selected study object appears in the workspace. 

2 Select the Rules tab. 

3 Click New Rule. 

The Rule Wizard appears with the Quick Start tab selected. 

Step 2: Select the rule type and templates 

1 In the Select a rule type area, select Intrinsic Rule. 

2 From the list, select a rule template. 

3 Click Next. 

The Properties tab appears. 

Step 3: Name the rule 

• Type a name and, optionally, a description for the rule, and click Next. 

The Preconditions tab appears. 

Step 4: Select the preconditions for the rule 

1 From the Evaluate on Event drop-down list, select one:  

• Form submission—(Default selection) Rule executes on form submission. To figure out 
the form that causes the rule to execute, the InForm application determines rule 
dependencies by detecting the study objects on which the rule depends. 
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• On demand (batch mode)—Rule is validated and deployed to the InForm application with 
a deactivated status, so the rule does not run in the InForm application. 

2 Click Next. 

The Expression tab appears. 

Step 5: Provide values for the parameters 

1 Provide values for the parameters. 

• To provide a value, type it in the Value field. 

• To use the value of a study object or a rule model property, drag the study object from the 
Data tab to the Expression workspace. To view the rule model properties of all of the study 
objects, click Show All. 

• To use a constant, drag the constant from the Constants tab to the Expression workplace. 

• To use a data mappping study object or a rule model property, drag the data mapping study 
object or rule model property from the Data Mappings tab to the Expression workspace. 

For more information, see Rule Wizard—Option descriptions (on page 421). 

2 Click Next. 

The Actions tab appears.  

Note: In the Actions tab, you specify a condition and an action to take when the condition 
occurs. 

Step 6: Define one or more actions for the rule 

1 From the If the value is section, select one of the following options: 

• False—If the rule calculates a False value, the action occurs. 

• True—If the rule calculates a True value, the action occurs. 

• Always—(Default for calculation rules) The action always occurs. 

• Only if no other action executes—The action occurs only if no other action occurs. Select 
this option only if you define at least two actions. 

• Values to specify: 
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• Equals—If the rule calculates a value that is equal to the provided value, the action 
occurs. 

• Not Equals—If the rule calculates a value that is not equal to the provided value, the 
action occurs. 

• Less Than—If the rule calculates a value that is less than the provided value, the action 
occurs. 

• Greater Than—If the rule calculates a value that is greater than the provided value, the 
action occurs. 

• Between—If the rule calculates a value that is between the provided values, the action 
occurs. 

• Inclusive checkbox—Select this option to make the number comparisons inclusive. For 
example, Less Than becomes Less Than or Equal To. 

Note: You can include string values in the Equals and Not Equals fields. Enclose the string in 
double quotes. For example, "text". 

2 In the Execute these actions section, choose the action or actions that will occur when the rule 
executes. 

Note: Instructions for defining a query, specifying email information, and setting a value 
follow this procedure. 

• SetValue—(Default for calculation rules) Set the value of an item. 

• Email—Send an email message to a distribution list.  

• Query—Issue a query. A query is a text string that appears on a CRF item in the InForm 
application when a rule on that item fails. 

• UpdateWorkflow—Recreate the state of a workflow rule. For more information, see 
Updating the state of a workflow rule (on page 169). 

3 Optionally, to specify multiple actions, click Add Action. For more information, see Rules with 
multiple actions (on page 137). 

The condition and action to take appear in the Fire Event grid.  

     Step 6A: Defining a query 

1 In the Rule Summary section, click the query link. 

The Query Action dialog box appears. 

2 From the Initial Query State drop-down list, select one: 

• Open—The query is visible on the form and available for response.  

• Candidate—The query is not visible on the form until someone reviews and explicitly 
opens it. 

3 In the Item field, type a value or drag an item from the Data tab to the field. 
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Note: You can type an expression in the Item field if it satisfies rule expression 
requirements. For more information, see About the rule expression language (on page 
145). 

You cannot define a query on a fixed item. 

4 From the Locale drop-down list, select a locale.  

5 In the Message field, type the query message. Optionally, to use a parameter in the message, 
do the following in the Message Parameters section: 

1 To define a value for a parameter, either type a value or drag information from the Data, 
Functions, Constants, and Data Mappings tabs to the Value field.  

2 Select the parameter, and drag the parameter to the Message field.  

or 

Double-click the parameter. 

The parameter is added to the message. Parameters are enclosed by curled braces. 

6 Click OK. 

For more information, see Query Action dialog box—Option descriptions (on page 417). 

     Step 6B: Specifying email information 

1 In the Rule Summary, click the email link, or press CTRL+M. 

The Email Action dialog box appears. 

2 To choose the item that triggers the email action, either type a value or drag an item from 
the Data tab to the Item field. 

Note: You cannot trigger an email action from a fixed item. 

3 Type the To email addresses, separated by semicolons. 

4 Type a From email address.  

Note: If you do not provide an email address, an address is taken from the registry. If 
the registry does not contain an email address, <studyname>@<default_webserver> 
is used. 

5 Select a Locale. 

6 Type an email Subject and Message. Optionally, to use a parameter, create one or more 
parameters in the Message and Subject Parameters section: 

a To define a value for a parameter, either type a value or drag information from the Data, 
Functions, Constants, and Globals tabs to the Value field. 

b Select the parameter, and drag the parameter to the Message or Subject field. 

The parameter is added to the message. Parameters are enclosed by curled braces.  

7 Click OK. 
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For more information, see Email Action dialog box—Option descriptions (on page 414). 

     Step 6C: Setting a value 

1 In the Rule Summary section, click the [select] = value link. 

The Set Value Action dialog box appears. 

2 In the Item field, type a value or drag an item from the Data tab.   

Note: The value must be set on an item. You cannot set the value of a fixed item. 

3 In the Value to set the Item area, do one of the following: 

• To use the value that is calculated in the expression, leave the default value text.  

• To modify the value that is calculated in the expression, type a value or an expression 
that will return a value for the item. For example, value + 2 adds two to the value 
returned by the expression. 

Note: You can type an expression in the Item field if it satisfies rule expression 
requirements. For more information, see About the rule expression language (on page 
145).  

4 Click OK. 

Note: Set value actions run in the InForm software in the order in which you define 
them. 

For more information, see Set Value Action dialog box—Option descriptions (on page 428). 

    Step 6D: Setting the stage of a review state 

1 In the Rule Summary section, click the SetReviewState link. 

The Set Review State Action dialog box appears. 

2 In the Form field, type a value or drag a form from the Data tab. 

3 From the ReviewState drop-down list, select a review state. 

4 Do one of the following: 

• Select the Review Stage radio button, and select a review stage from the drop-down list. 

• Select the Review Stage expression radio button, and in the text box, create a rule expression 
that evaluates to a valid review stage. You can use the objects and properties in the 
References window. 

5 Optionally, enter a comment in the Comment field. 

6 Click OK. 

For more information, see Set Value Action dialog box—Option descriptions (on page 428). 

Step 7: Finish creating the rule 

1 Click Finish.  
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Creating a rule without a function 
You create rules in the Rule Wizard. The Rule Wizard includes a Quick Start tab containing rule 
types, including constraint rule and calculation rule, which populate the Actions tab with information. 
You can override the default information and provide additional information. 

Note: As you create a rule, the Rule Summary reflects the structure of the rule, including 
precondition, action, and expression information. Click a link in the Rule Summary to navigate 
through the Rule Wizard. 

Step 1: Select a study object and open the Rule Wizard 

1 In the Project Explorer, select a study design (in a study only), study element, study event, form, 
section, or item. 

The editor for the selected study object appears in the workspace. 

2 Select the Rules tab. 

3 Click New Rule. 

The Rule Wizard appears with the Quick Start tab selected. 

Step 2: Select the type of rule to create 

1 In the Select a rule type area, select Constraint Rule or Calculation Rule. 

Note: Selecting a rule type populates information in the Actions tab. You can override the 
default information.  

2 Click Next. 

The Properties tab appears. 

Step 3: Name the rule 

• Type a name and, optionally, a description for the rule, and click Next. 

The Preconditions tab appears. 

Step 4: Select the preconditions for the rule 

1 From the Evaluate on Event drop-down list, select one:  

• Form submission—(Default selection) Rule executes on form submission. To figure out 
the form that causes the rule to execute, the InForm application determines rule 
dependencies by detecting the study objects on which the rule depends. 

• On demand (batch mode)—Rule is validated and deployed to the InForm application with 
a deactivated status, so the rule does not run in the InForm application. 

2 Click Next. 

The Expression tab appears. 

Step 5: Create the rule expression  

1 Create the rule expression in the Expression workspace with the following: 

• Operators and literals.  
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For more information, see Operators and literals (in the Rules Reference Guide). 

• Study objects, rule model properties for study objects, constants, global study objects, or rule 
model properties for global study objects. 

• To use the value of a study object or a rule model property: 

Type this., and select the study object from the dynamic expression prompt. 

or 

Drag the study object from the Data tab to the Expression workspace. To view the rule 
model properties of all of the study objects, click Show All Properties. 

• To use a constant: 

Type Constants., and select the constant from the dynamic expression prompt. 

or 

Drag the constant from the Constants tab to the Expression workspace. 

• To use a data mapping study object or a rule model property: 

Type DataMappings., and select the data mapping study object or rule model property 
from the dynamic expression prompt. 

or 

Drag the data mapping study object or rule model property from the Data Mappings tab 
to the Expression workspace. 

 For more information, see Rule Wizard—Option descriptions (on page 421). 

• Methods. 

• To use a method for a repeating study object: 

Type this., and select the method from the dynamic expression prompt. 

or 

Drag the method from the Data tab to the Expression workspace.  

• To use a method for a global study object: 

Type DataMappings., and select the (from the dynamic expression prompt. 

or 

Drag the method from the Data Mappings tab to the Expression workspace. 

• To use a math method, type the method in the Expression workspace. 

For more information, see Methods (in the Rules Reference Guide). 

2 Click Next. 

The Actions tab appears.  

Note: In the Actions tab, you specify a condition and an action to take when the condition 
occurs. 

Step 6: Define one or more actions for the rule 

1 From the If the value is section, select one of the following options: 
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• False—If the rule calculates a False value, the action occurs. 

• True—If the rule calculates a True value, the action occurs. 

• Always—(Default for calculation rules) The action always occurs. 

• Only if no other action executes—The action occurs only if no other action occurs. Select 
this option only if you define at least two actions. 

• Values to specify: 

• Equals—If the rule calculates a value that is equal to the provided value, the action 
occurs. 

• Not Equals—If the rule calculates a value that is not equal to the provided value, the 
action occurs. 

• Less Than—If the rule calculates a value that is less than the provided value, the action 
occurs. 

• Greater Than—If the rule calculates a value that is greater than the provided value, the 
action occurs. 

• Between—If the rule calculates a value that is between the provided values, the action 
occurs. 

• Inclusive checkbox—Select this option to make the number comparisons inclusive. For 
example, Less Than becomes Less Than or Equal To. 

Note: You can include string values in the Equals and Not Equals fields. Enclose the string in 
double quotes. For example, "text". 

2 In the Execute these actions section, choose the action or actions that will occur when the rule 
executes. 

Note: Instructions for defining a query, specifying email information, and setting a value 
follow this procedure. 

• SetValue—(Default for calculation rules) Set the value of an item. 

• Email—Send an email message to a distribution list.  

• Query—Issue a query. A query is a text string that appears on a CRF item in the InForm 
application when a rule on that item fails. 

• UpdateWorkflow—Recreate the state of a workflow rule. For more information, see 
Updating the state of a workflow rule (on page 169). 

3 Optionally, to specify multiple actions, click Add Action. For more information, see Rules with 
multiple actions (on page 137). 

The condition and action to take appear in the Fire Event grid.  

     Step 6A: Defining a query 

1 In the Rule Summary section, click the query link. 

The Query Action dialog box appears. 

2 From the Initial Query State drop-down list, select one: 
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• Open—The query is visible on the form and available for response.  

• Candidate—The query is not visible on the form until someone reviews and explicitly 
opens it. 

3 In the Item field, type a value or drag an item from the Data tab to the field. 

Note: You can type an expression in the Item field if it satisfies rule expression 
requirements. For more information, see About the rule expression language (on page 
145). 

You cannot define a query on a fixed item. 

4 From the Locale drop-down list, select a locale.  

5 In the Message field, type the query message. Optionally, to use a parameter in the message, 
do the following in the Message Parameters section: 

1 To define a value for a parameter, either type a value or drag information from the Data, 
Functions, Constants, and Data Mappings tabs to the Value field.  

2 Select the parameter, and drag the parameter to the Message field.  

or 

Double-click the parameter. 

The parameter is added to the message. Parameters are enclosed by curled braces. 

6 Click OK. 

For more information, see Query Action dialog box—Option descriptions (on page 417). 

     Step 6B: Specifying email information 

1 In the Rule Summary, click the email link, or press CTRL+M. 

The Email Action dialog box appears. 

2 To choose the item that triggers the email action, either type a value or drag an item from 
the Data tab to the Item field. 

Note: You cannot trigger an email action from a fixed item. 

3 Type the To email addresses, separated by semicolons. 

4 Type a From email address.  

Note: If you do not provide an email address, an address is taken from the registry. If 
the registry does not contain an email address, <studyname>@<default_webserver> 
is used. 

5 Select a Locale. 

6 Type an email Subject and Message. Optionally, to use a parameter, create one or more 
parameters in the Message and Subject Parameters section: 

a To define a value for a parameter, either type a value or drag information from the Data, 
Functions, Constants, and Globals tabs to the Value field. 

b Select the parameter, and drag the parameter to the Message or Subject field. 
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The parameter is added to the message. Parameters are enclosed by curled braces.  

7 Click OK. 

For more information, see Email Action dialog box—Option descriptions (on page 414). 

     Step 6C: Setting a value 

1 In the Rule Summary section, click the [select] = value link. 

The Set Value Action dialog box appears. 

2 In the Item field, type a value or drag an item from the Data tab.   

Note: The value must be set on an item. You cannot set the value of a fixed item. 

3 In the Value to set the Item area, do one of the following: 

• To use the value that is calculated in the expression, leave the default value text.  

• To modify the value that is calculated in the expression, type a value or an expression 
that will return a value for the item. For example, value + 2 adds two to the value 
returned by the expression. 

Note: You can type an expression in the Item field if it satisfies rule expression 
requirements. For more information, see About the rule expression language (on page 
145).  

4 Click OK. 

Note: Set value actions run in the InForm software in the order in which you define 
them. 

For more information, see Set Value Action dialog box—Option descriptions (on page 428). 

     Step 6D: Setting the stage of a review state 

1 In the Rule Summary section, click the SetReviewState link. 

The Set Review State Action dialog box appears. 

2 In the Form field, type a value or drag a form from the Data tab. 

3 From the ReviewState drop-down list, select a review state. 

4 Do one of the following: 

• Select the Review Stage radio button, and select a review stage from the drop-down list. 

• Select the Review Stage expression radio button, and in the text box, create a rule expression 
that evaluates to a valid review stage. You can use the objects and properties in the 
References window. 

5 Optionally, enter a comment in the Comment field. 

6 Click OK. 

For more information, see Set Value Action dialog box—Option descriptions (on page 428). 

Step 7: Finish creating the rule 

1 Click Finish.  
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Creating a rule using a function 
You create rules in the Rule Wizard. The Rule Wizard includes a Quick Start tab containing rule 
types, including constraint rule and calculation rule, which populate the Actions tab with information. 
You can override the default information and provide additional information. 

Note: As you create a rule, the Rule Summary reflects the structure of the rule, including 
precondition, action, and expression information. Click a link in the Rule Summary to navigate 
through the Rule Wizard. 

Step 1: Select a study object and open the Rule Wizard 

1 In the Project Explorer, select a study design (in a study only), study element, study event, form, 
section, or item. 

The editor for the selected study object appears in the workspace. 

2 Select the Rules tab. 

3 Click New Rule. 

The Rule Wizard appears with the Quick Start tab selected. 

Step 2: Select the type of rule to create 

1 In the Select a rule type area, select Constraint Rule or Calculation Rule. 

Note: Selecting a rule type populates information in the Actions tab. You can override the 
default information.  

2 Click Next. 

The Properties tab appears. 

Step 3: Name the rule 

• Type a name and, optionally, a description for the rule, and click Next. 

The Preconditions tab appears. 

Step 4: Select the preconditions for the rule 

1 From the Evaluate on Event drop-down list, select one:  

• Form submission—(Default selection) Rule executes on form submission. To figure out 
the form that causes the rule to execute, the InForm application determines rule 
dependencies by detecting the study objects on which the rule depends. 

• On demand (batch mode)—Rule is validated and deployed to the InForm application with 
a deactivated status, so the rule does not run in the InForm application. 

2 Click Next. 

The Expression tab appears. 

Step 5: Create the rule expression using values from the dynamic expression prompt 

1 To use a function, type Functions., and select the function from the dynamic expression prompt. 
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The function name appears in the Expression workspace, along with a tooltip showing the 
syntax of the function. 

2 Provide values for the parameters: 

• To provide a value, type it as a parenthetic expression following the function name. 

• To use the value of a study object or rule model property, type this., and select the study 
object or property from the dynamic expression prompt. 

• To use a constant, type Constants., and select the constant from the dynamic expression 
prompt. 

• To use a data mapping study object or a rule model property, type DataMappings., and select 
the study object or rule model property from the dynamic expression prompt. 

3 To add other components to the rule expression, use the following: 

• Operators and literals.  

For more information, see Operators and literals (in the Rules Reference Guide). 

• Study objects, rule model properties for study objects, constants, global study objects, or rule 
model properties for global study objects. 

• To use the value of a study object or rule model property, type this., and select the study 
object or property from the dynamic expression prompt. 

• To use a constant, type Constants., and select the constant from the dynamic expression 
prompt. 

• To use a data mapping study object or a rule model property, type DataMappings., and 
select the study object or rule model property from the dynamic expression prompt. 

 For more information, see Rule Wizard—Option descriptions (on page 421). 

• Methods. 

• To use a method for a repeating study object, type this., and select the method from the 
dynamic expression prompt. 

• To use a method for a data mapping study object, type DataMappings., and select the 
method from the dynamic expression prompt. 

• To use a math method, type the method in the Expression workspace. 

For more information, see Methods (in the Rules Reference Guide). 

4 Click Next. 

The Actions tab appears.  

Note: In the Actions tab, you specify a condition and an action to take when the condition 
occurs. 

or 

Step 5: Create the rule expression by dragging values from the reference tabs 

1 Select the Functions tab, and drag the function you want to use for the rule expression to the 
Expression workspace. 

The Invoke Function dialog box appears. It contains the parameters that must be defined for the 
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expression. 

2 Provide values for the parameters. 

• To provide a value, type it in the Value field. 

• To use the value of a study object or a rule model property, drag the study object from the 
Data tab to the Expression workspace. To view the rule model properties of all of the study 
objects, click Show All. 

• To use a constant, drag the constant from the Constants tab to the Expression workplace. 

• To use a data mappping study object or a rule model property, drag the data mapping study 
object or rule model property from the Data Mappings tab to the Expression workspace. 

For more information, see Rule Wizard—Option descriptions (on page 421). 

3 Click OK. 

You return to the Rule wizard. In the Expression workspace, the function name is preceded by 
the word Functions. 

4 To add other components to the rule expression, use the following: 

• Operators and literals.  

For more information, see Operators and literals (in the Rules Reference Guide). 

• Study objects, rule model properties for study objects, constants, global study objects, or rule 
model properties for global study objects. 

• To use the value of a study object or a rule model property, drag the study object from 
the Data tab to the Expression workspace. To view the rule model properties of all of 
the study objects, click Show All Properties. 

• To use a constant, drag the constant from the Constants tab to the Expression 
workspace. 

• To use a data mapping study object or a rule model property, drag the data mapping 
study object or rule model property from the Data Mappings tab to the Expression 
workspace. 

For more information, see Rule Wizard—Option descriptions (on page 421). 

• Methods. 

• To use a method for a repeating study object, drag the method from the Data tab to the 
Expression workspace.  

• To use a method for a data mapping study object, drag the method from the Data 
Mappings tab to the Expression workspace. 

• To use a math method, type the method in the Expression workspace. 

For more information, see Methods (in the Rules Reference Guide). 

5 Click Next. 

The Actions tab appears.  

Note: In the Actions tab, you specify a condition and an action to take when the condition 
occurs. 
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Step 6: Define one or more actions for the rule 

1 From the If the value is section, select one of the following options: 

• False—If the rule calculates a False value, the action occurs. 

• True—If the rule calculates a True value, the action occurs. 

• Always—(Default for calculation rules) The action always occurs. 

• Only if no other action executes—The action occurs only if no other action occurs. Select 
this option only if you define at least two actions. 

• Values to specify: 

• Equals—If the rule calculates a value that is equal to the provided value, the action 
occurs. 

• Not Equals—If the rule calculates a value that is not equal to the provided value, the 
action occurs. 

• Less Than—If the rule calculates a value that is less than the provided value, the action 
occurs. 

• Greater Than—If the rule calculates a value that is greater than the provided value, the 
action occurs. 

• Between—If the rule calculates a value that is between the provided values, the action 
occurs. 

• Inclusive checkbox—Select this option to make the number comparisons inclusive. For 
example, Less Than becomes Less Than or Equal To. 

Note: You can include string values in the Equals and Not Equals fields. Enclose the string in 
double quotes. For example, "text". 

2 In the Execute these actions section, choose the action or actions that will occur when the rule 
executes. 

Note: Instructions for defining a query, specifying email information, and setting a value 
follow this procedure. 

• SetValue—(Default for calculation rules) Set the value of an item. 

• Email—Send an email message to a distribution list.  

• Query—Issue a query. A query is a text string that appears on a CRF item in the InForm 
application when a rule on that item fails. 

• UpdateWorkflow—Recreate the state of a workflow rule. For more information, see 
Updating the state of a workflow rule (on page 169). 

3 Optionally, to specify multiple actions, click Add Action. For more information, see Rules with 
multiple actions (on page 137). 

The condition and action to take appear in the Fire Event grid.  

     Step 6A: Defining a query 

1 In the Rule Summary section, click the query link. 
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The Query Action dialog box appears. 

2 From the Initial Query State drop-down list, select one: 

• Open—The query is visible on the form and available for response.  

• Candidate—The query is not visible on the form until someone reviews and explicitly 
opens it. 

3 In the Item field, type a value or drag an item from the Data tab to the field. 

Note: You can type an expression in the Item field if it satisfies rule expression 
requirements. For more information, see About the rule expression language (on page 
145). 

You cannot define a query on a fixed item. 

4 From the Locale drop-down list, select a locale.  

5 In the Message field, type the query message. Optionally, to use a parameter in the message, 
do the following in the Message Parameters section: 

1 To define a value for a parameter, either type a value or drag information from the Data, 
Functions, Constants, and Data Mappings tabs to the Value field.  

2 Select the parameter, and drag the parameter to the Message field.  

or 

Double-click the parameter. 

The parameter is added to the message. Parameters are enclosed by curled braces. 

6 Click OK. 

For more information, see Query Action dialog box—Option descriptions (on page 417). 

     Step 6B: Specifying email information 

1 In the Rule Summary, click the email link, or press CTRL+M. 

The Email Action dialog box appears. 

2 To choose the item that triggers the email action, either type a value or drag an item from 
the Data tab to the Item field. 

Note: You cannot trigger an email action from a fixed item. 

3 Type the To email addresses, separated by semicolons. 

4 Type a From email address.  

Note: If you do not provide an email address, an address is taken from the registry. If 
the registry does not contain an email address, <studyname>@<default_webserver> 
is used. 

5 Select a Locale. 

6 Type an email Subject and Message. Optionally, to use a parameter, create one or more 
parameters in the Message and Subject Parameters section: 

a To define a value for a parameter, either type a value or drag information from the Data, 
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Functions, Constants, and Globals tabs to the Value field. 

b Select the parameter, and drag the parameter to the Message or Subject field. 

The parameter is added to the message. Parameters are enclosed by curled braces.  

7 Click OK. 

For more information, see Email Action dialog box—Option descriptions (on page 414). 

     Step 6C: Setting a value 

1 In the Rule Summary section, click the [select] = value link. 

The Set Value Action dialog box appears. 

2 In the Item field, type a value or drag an item from the Data tab.   

Note: The value must be set on an item. You cannot set the value of a fixed item. 

3 In the Value to set the Item area, do one of the following: 

• To use the value that is calculated in the expression, leave the default value text.  

• To modify the value that is calculated in the expression, type a value or an expression 
that will return a value for the item. For example, value + 2 adds two to the value 
returned by the expression. 

Note: You can type an expression in the Item field if it satisfies rule expression 
requirements. For more information, see About the rule expression language (on page 
145).  

4 Click OK. 

Note: Set value actions run in the InForm software in the order in which you define 
them. 

For more information, see Set Value Action dialog box—Option descriptions (on page 428). 

     Step 6D: Setting the stage of a review state 

1 In the Rule Summary section, click the SetReviewState link. 

The Set Review State Action dialog box appears. 

2 In the Form field, type a value or drag a form from the Data tab. 

3 From the ReviewState drop-down list, select a review state. 

4 Do one of the following: 

• Select the Review Stage radio button, and select a review stage from the drop-down list. 

• Select the Review Stage expression radio button, and in the text box, create a rule expression 
that evaluates to a valid review stage. You can use the objects and properties in the 
References window. 

5 Optionally, enter a comment in the Comment field. 

6 Click OK. 
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For more information, see Set Value Action dialog box—Option descriptions (on page 428). 

Step 7: Finish creating the rule 

1 Click Finish.  
 

Modifying a rule 
1 In the Project Explorer, select a study design (in a study only), study element, study event, form, 

section, or item. 

The editor for the study object appears in the workspace. 

2 Select the Rules tab. 

3 In the grid, select a rule, and click Edit. 

The Rule Wizard appears without the Quick Start tab. 

4 Modify the rule as necessary. Navigate by selecting the tabs or clicking the links in the Rule 
Summary.  

For more information about modifying the rule, see: 

• Rule Wizard (on page 421). 

• Creating an intrinsic rule (on page 149). 

• Creating a rule without a function (on page 154). 

• Creating a rule using a function (on page 159). 

5 Click Finish. 
 

Translating query and email information for rules 
The following rule-related information can be translated: 

• Query messages.  

• Email messages and subjects. 

To translate information, you must have the necessary language skills defined in the Central Designer 
Administrator application. 

1 In the Rules tab, select a rule. 

2 Click Edit, or double-click the rule. 

The Rule Wizard appears. 

3 In the Rule Summary (located at the bottom of the Rule Wizard), click one of the following links: 

• issue query—Translate a query message.  

The Query Action dialog box appears. 

• send email—Translate an email subject and message. 

The Email Action dialog box appears. 

4 From the Locale drop-down list, select a locale. 
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5 Type translated text for the fields requiring translation. 

Note: The field that requires translation is read-only when you do not have the necessary 
language skills to translate in the locale. You specify language skills in the Central Designer 
Administrator application. 

6 Click OK. 

7 In the Rule Wizard, click Finish. 
 

Viewing all rules for a study object and its children 
In the Rules tab, you view all rules that are part of a study object and, optionally, its children. 

1 In the Project Explorer, select a study design (in a study only), study element, study event, form, 
section, or item. 

2 In the Rules tab, select Show Child Rules.  

All rules that are part of the children of the study object appear in the Rules tab. 
 

Selecting multiple rules 
You can select multiple rules in the Rules Editor and perform actions that affect all selected rules. 

1 In the Project Explorer, select a study design (in a study only), study element, study event, form, 
section, or item. 

The editor for the study object appears in the workspace. 

2 Select the Rules tab. 

3 Select one or more rules, pressing CTRL or Shift to select multiple rules. 

4 To select all rules, press CTRL+A. 
 

Deactivating a rule 
1 In the Project Explorer, select a study design (in a study only), study element, study event, form, 

section, or item. 

The editor for the study object appears in the workspace. 

2 Select the Rules tab. 

3 In the grid, select a rule, and click Edit. 

The Rule Wizard appears without the Quick Start tab. 

4 Select the Preconditions tab. 

5 In the Evaluate on Event drop-down list, select On Demand (Batch Mode). 

6 Click Finish. 
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Deleting a rule 
1 In the Project Explorer, select a study design (in a study only), study element, study event, form, 

section, or item. 

2 The editor for the study object appears in the workspace. 

3 Select the Rules tab. 

4 In the grid, select a rule, and click Delete. 
 

Disabling or enabling one or more rules 
1 In the Project Explorer, select a study design (in a study only), study element, study event, form, 

section, or item. 

2 The editor for the study object appears in the workspace. 

3 Select the Rules tab. 

4 Select one or more rules, pressing CTRL or Shift to select multiple rules. 

5 Do one of the following: 

• On the toolbar, click Disable, or press CTRL+D. 

• On the toolbar, click Enable, or press CTRL+E. 

The Central Designer application disables or enables all unlocked and unprotected rules, and the 
following occurs: 

• A dialog box appears and lists the rules that could not be disabled or enabled. 

• For disabled rules, a gray X appears in the grid in the first column of the row for the 
disabled rules, and the row is grayed out.  

• For enabled rules, the gray X disappears in the grid in the first column of the row for the 
rule, and the row text becomes black. 
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Designing workflow rules 

Creating a workflow rule in a workflow diagram 
You can create a workflow rule for a study element, study event, or form.  

Note: A study object can include only one workflow rule.  

1 In the Project Explorer, select a study design (in a study only), study element, or study event. 

2 Select the Workflow Diagram tab. 

3 Right-click a study object, and select Add Rule. 

The Workflow Expression Editor dialog box appears. 

4 Type a name and description for the workflow rule. 

5 Using either or both of the following methods, create an expression in the Expression section: 

• Type directly in the Expression section. As you type, prompts appear dynamically, listing the 
rule model objects that are available for you to use based on the context. 

• To use the value of a study object or rule model property, type this., and select the study 
object or property from the dynamic expression prompt. 

• To use a function, type Functions., and select the function from the dynamic expression 
prompt. The function name appears in the Expression workspace, along with a tooltip 
showing the syntax of the function. 

Provide values for the parameters. 

• To use a constant, type Constants., and select the constant from the dynamic expression 
prompt. 

• To use a data mapping study object or a rule model property, type DataMappings., and 
select the study object or rule model property from the dynamic expression prompt. 

• Drag in components from the Data, Functions, Constants, or Data Mappings tabs. 

A reference to the study component, function, constant, or data set appears in the Expression 
section in the appropriate format. 

6 If you dragged a function into the Expression section, use the Invoke Function dialog box to 
specify the values of the required parameters, and click OK. 

7 Click OK. 

A workflow rule object appears in the Workflow Diagram tab, connected to the study object for 
which you defined the workflow rule. 

For information about connecting the workflow rule to workflow objects, see Connecting and 
ordering study objects in a workflow diagram (on page 57).  

For more information, see: 

Workflow Expression Editor dialog box - Option descriptions (on page 428). 

Invoke Function dialog box - Option descriptions (on page 416). 
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Editing a workflow rule in a workflow diagram 
1 In the Project Explorer, select a study design (in a study only), study element, or study event. 

2 Select the Workflow Diagram tab. 

3 Right-click the rule in the workflow diagram, and select Edit Rule. 

The Workflow Expression Editor dialog box appears. 

4 Edit the definition of the expression using the options in the Workflow Expression Editor dialog box 
and, if applicable, the Invoke Function dialog box.  

5 Click OK. 

For more information, see Components of the rule expression language (in the Rules Reference 
Guide). 

For more information, see: 

Workflow Expression Editor dialog box - Option descriptions (on page 428). 

Invoke Function dialog box - Option descriptions (on page 416). 
 

Updating the state of a workflow rule 
To instruct the InForm application to re-evaluate the workflow for a subject after workflow rules and 
global conditions run: 

• If you are deploying a study to an InForm release prior to 6.1.1, you can create a rule with the 
Update Workflow action. 

For example, if you change the parameters on a workflow rule that assigns subjects to treatment 
arms at the beginning of a study, you can use the UpdateWorkflow action to retrigger all the 
rules after that point in the workflow and determine which forms and visits should appear. 

To implement this functionality, you can add a checkbox to a form at the beginning of the study, 
and then create a rule with the UpdateWorkflow action that fires when a user selects the 
checkbox. 

• If you are deploying a study to InForm release 6.1.1 or later, the InForm application re-evaluates 
the workflow without user interaction.  

When you validate a study that contains a rule with the UpdateWorkflow action, a warning 
appears and indicates that the rule is not required for studies that are deployed to InForm release 
6.1.1 or later. 
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Disabling a workflow rule 
To disable a workflow rule, you must disable the workflow with which the rule is associated. For 
more information, see About disabling workflow rules (on page 144). 

1 In the Project Explorer, select the Visit Schedule Explorer bar. 

2 Select a study design, study element, or study event. 

3 Select the Workflow Diagram tab. 

4 Click Disable Workflow. 

The workflow arrows turn gray, and the study event sequence numbers re-appear and turn gray. 

Note: The Central Designer application only sends a message on validation about disabled rules. 
You will not receive a message that lists the disabled workflows in your study. 
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Designing global conditions 

Creating a global condition 
1 In the Project Explorer, select a study design (in a study only), study element, or study event. 

2 In the Workflow Diagram tab, click Global Conditions. 

The Edit Global Conditions dialog box appears. 

3 To the right of the grid, click Add. 

The Add Global Condition dialog box appears. 

4 Type a name and description (optional), and select the target application with which you will use 
the global condition. 

5 Click OK. 

The condition appears in the list. 

6 Using either or both of the following methods, create an expression in the Expression section: 

• Type directly in the Expression section. As you type, prompts appear dynamically, listing the 
rule model objects that are available for you to use based on the context. 

• To use the value of a study object or rule model property, type this., and select the study 
object or property from the dynamic expression prompt. 

• To use a function, type Functions., and select the function from the dynamic expression 
prompt. The function name appears in the Expression workspace, along with a tooltip 
showing the syntax of the function. 

Provide values for the parameters. 

• To use a constant, type Constants., and select the constant from the dynamic expression 
prompt. 

• To use a data mapping study object or a rule model property, type DataMappings., and 
select the study object or rule model property from the dynamic expression prompt. 

• Drag in components from the Data, Functions, Constants, or Data Mappings tabs. 

A reference to the study component, function, constant, or data set appears in the Expression 
section in the appropriate format. 

7 If you dragged a function into the Expression section, use the Invoke Function dialog box to 
specify the values of the required parameters, and click OK. 

8 Click OK. 

After you create a global condition, you can assign the g lobal condition (on page 172). 

For more information, see: 

Workflow Expression Editor dialog box - Option descriptions (on page 428). 

Invoke Function dialog box - Option descriptions (on page 416). 
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Assigning and removing a global condition 
Before you can assign a global condition, you must create a g lobal condition (on page 171). 

1 In the Project Explorer, select a study design (in a study only), study element, or study event. 

2 Select the Workflow Diagram tab. 

3 Right-click the study object on which to add or remove a global condition, and select Assign 
Conditions. 

The Assign Conditions dialog box appears. 

4 To assign a global condition: 

a In the Global Conditions list, select the global condition. 

b Click the add button (>>). 

The global condition name moves to the Assigned Conditions list. 

c Below the Expression field, indicate when the rest of the workflow after the global condition 
will be executed, based on the outcome of the expression. For example, select False if you 
want a subject to progress to the next study object if the expression evaluates to False. 

d Click OK. 

In the workflow, the name of the global condition appears in a box above the study object. 

5 To remove a global condition assignment: 

a In the Assigned Conditions list, select the global condition. 

b Click the remove button (<<). 

The global condition name moves to the Global Conditions list. 

c Click OK. 

For more information, see Assign Conditions dialog box - Option descriptions (on page 406). 
 



 InForm Design Guide  

Oracle® Health Sciences Central Designer 2.1.2 173 

Viewing and editing a global condition 
1 In the Project Explorer, select a study design (in a study only), study element, or study event. 

2 Select the Workflow Diagram tab. 

3 On the toolbar, click Global Conditions, or right-click in the workflow, and select Global Conditions. 

The Edit Global Conditions dialog box appears. 

4 To edit a global condition: 

a Select a global condition from the list and click Edit. 

The Edit Global Conditions dialog box appears. 

b Update the global condition as needed. You can change the target application with which 
you plan to use the global condition only if the global condition is not assigned in a 
workflow. 

c Click OK. 

For more information, see Edit Global Conditions dialog box - Option descriptions (on page 
410). 
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Testing rules 

About test cases 
 

Characteristic Description 
About You create test cases in the Rule Test Cases dialog box to test data-entry 

rules, workflow rules, and global conditions before deploying a study. 

How many to create Depending on the rule, you might create several or many test cases. 

When to create You can create test cases either after writing each rule or after all rules are 
finished.  

To make sure that a rule is written correctly, consider writing and running 
a single test case for it, so you do not write many test cases for a rule that 
needs to be modified. 

Running test cases You can run test cases on demand in the Rule Test Cases dialog box. 
Additionally, test cases are run during study validation. 

Modifying rules If you modify a rule, make sure that you modify its test cases, as well.  

You can also filter the tree so that you see only the rules that were 
modified since you created its test cases. Use the list to check that the test 
cases are still accurate for the modified rules.  

Locking When you select a test case, the following are locked: 

• All test cases on the rule. 

• The data-entry rule, workflow rule, or global condition for which the 
test case was created. 

If you save the study object in the study, your changes in the Rule Test 
Cases dialog box are also saved, and the locks are released. 

Rules for which you 
cannot create test cases 

You cannot create test cases for a rule if: 

• The rule does not have an action.  

• The rule has no item paths; for example, if the rule uses a function 
that finds the current date.  

Additionally, you cannot perform unit conversions in the Rule Test Cases 
dialog box. 

Repeating study objects When a rule expression references a repeating study object, such as a 
repeating form or section, you can provide test values for each instance.  
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Characteristic Description 
Results • The progress indicator is green if all test cases are valid, red if 

one or more test cases are not valid, or yellow if one or more test 
cases have warnings. 

• Red circles (for invalid test cases), green circles (for valid test 
cases), or yellow triangles (for test cases with warnings) appear 
next to the name of the test case in the grid. 

• In the Syntax column, either valid, invalid, or incomplete (for 
rules or global conditions that have valid syntax but are not 
complete; for example, if the rule has no action defined) appears. 

Saving Saving a study also saves all changes in the Rule Test Cases dialog box, 
including any changes that you did not save in the Rule Test Cases dialog 
box before closing.  

Troubleshooting failed 
test cases 

A test case fails when the parameters that you enter are run in the rule, 
and the result that you expected does not occur. To troubleshoot failed 
test cases, consider the following: 

• Does the test case reflect the expected behavior of the rule? 

• Is the rule written correctly? 

You can sort the results of test cases by the Status field and use the failed 
test cases as a checklist of rules or test cases to review.  

When you close the Rule Test Cases dialog box, test case results are not 
saved. To view results, you must run the test cases again the next time 
you open the Rule Test Cases dialog box. The results of the test cases 
appear in the Jobs Browser after validation is performed.  

 
 

Opening the Rule Test Cases dialog box 
1 In the Project Explorer, select a study design (in a study only), study element, study event, form, 

section, or item. 

2 Perform one of the following steps: 

• In the Workflow Diagram tab (for a study design, study element, or study event only), click 
Rule Tests, or right-click a workflow rule, and select Rule Tests. 

• In the Rules tab, click Rule Tests, or right-click a data-entry rule, and select Rule Tests. 

The Rule Test Cases dialog box appears.  

• The default filter (on page 181) displays the rules that are in the scope of the study object 
that was selected in the Project Explorer.  

• In the Rules tab, if Show Child Rules is selected, child rules appear in the tree of rules.  

• If you opened the Rule Test Cases dialog box by right-clicking a rule, the rule is selected in 
the Rule Test Cases dialog box. 
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Viewing rules in the Rule Test Cases dialog box 
The Rule Test Cases dialog box lists all data-entry rules, workflow rules, and global conditions in a 
study, listed in alphabetical order. 

1 Open the Rule Test Cases dialog box (on page 175). 

Rules appear in the left tree, organized by rule type.  

2 To change your view of rules, click the Structured and Flat buttons, located to the right above the 
tree: 

• Structured icon—Group rules by type, then study object type, and then study object. 

• Flat icon—Group rules by type. 
 

Opening a rule from the Rule Test Cases dialog box 
All edits to rules are reflected immediately in the Rule Test Cases dialog box; you do not need to 
close and reopen it.  

• In the Rule Test Cases dialog box toolbar, click Go to Rule, or double-click the rule in the tree. 

The Rule Test Cases dialog box is minimized, and you are brought to the following location: 

• Data-entry rules—The study object on which the rule is created. 

• Workflow rules—The Workflow Diagram tab that contains the workflow rule. The 
workflow rule is selected in the diagram. 

• Global conditions—The study object on which the global condition was created (in a 
study, the study design). The Edit Global Conditions dialog box opens with the global 
condition selected. All edits to rules are reflected immediately in the Rule Test Cases dialog 
box; you do not need to close and reopen it. 
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Checking rule syntax 
Check rule syntax to ensure that the code in the rule expression is written correctly. 

1 Create a rule. For more information, see: 

• Creating an intrinsic rule (on page 149). 

• Creating a rule without a function (on page 154). 

• Creating a rule using a function (on page 159). 

2 In the Rules tab, click Check Syntax. 

Syntax is checked for all rules in the grid. One of the following icons appears next to each rule: 

• —Rule syntax is valid. 

• —Rule syntax has one or more warnings associated with it, or the rule could not be 
compiled. 

• —Rule syntax contains one or more errors and is not valid. 

3 To view the error or warnings associated with a rule, look in the Rule Summary section, located at 
the bottom of the Rules tab.  

Note: To hide the errors, click Hide Errors. 

 

Viewing the errors for a rule 
You can view the errors for a rule only after you have checked the syntax of the rule. The errors are 
displayed by default. For more information, see Checking rule syntax (on page 176). 

• In the Rules tab, select Show Errors.  

The errors appear in the Rule Summary, located at the bottom of the Rules tab. 
 

Checking syntax for one or more rules or global conditions 
In the Rule Test Cases dialog box, you can check the syntax of data-entry rules, workflow rules, and 
global conditions. 

1 Open the Rule Test Cases dialog box (on page 175). 

2 Select the Run tab. 

The rule that is selected in the Design tab and its test cases are selected. Optionally, to expand or 
collapse the tree, right-click the tree, and select Expand All or Collapse All. 

3 Optionally, in the tree to the left, select additional rules. 

Note: To select or deselect all rules and test cases, right-click the tree and select Check All or 
Uncheck All. 

4 Click Check Syntax. 
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The syntax of the selected rules is checked. 

• The progress indicator is green if all rules are valid, red if one or more rules are not valid, or 
yellow if one or more rules have warnings. 

• Red circles (for valid rules), green circles (for invalid rules), or yellow triangles (for rules with 
warnings) appear next to the name of the test case in the grid. 

• In the Validation column, valid, invalid, or incomplete (for rules or global conditions that 
have valid syntax but are not complete; for example, if the rule has no action defined) 
appears. 

Related errors appear in the Execution Results section at the bottom. 
 

Writing a test case for a rule or global condition 
You can write test cases for data-entry rules, workflow rules, and global conditions. 

1 Open the Rule Test Cases dialog box (on page 175). 

2 In the list of rules, select a data-entry rule, workflow rule, or global condition. 

3 In the toolbar, click Create. 

A test case is created.  

4 Optionally, rename the test case. 

5 Provide test values for the items that are used in the rule: 

• Item with a single-select codelist—From the drop-down list, select a codelist item to 
test. The code and label appear in the drop-down list. To view the RefName, select the 
Test Properties tab, and then point to the item in the grid. 

• Item with a multi-select codelist—Click the box at the end of the field, and select one 
or more codelist items to test.  

• Item without a codelist—Type the value to test. For an integer, float, or text item, you 
must follow the item's requirements, which appear in the Test Properties tab when you 
point to an item. 

• Date time item—Provide values for the parts of the date time item that are allowed.  

• To test for an empty date, select Empty date, or select Empty for a date time 
component.  

• To test for an unknown value, select Unknown for a date time component. Unknown is 
available only if an unknown value is allowed for the date time part and if the date time 
part is not required.  

• Item on a repeating section, form, or study event—Click the box at the end of the field, 
and provide values in the dialog box that appears.  

Note: To provide an empty value for an item with a codelist, select the <empty> option. For 
items without a codelist, do not enter a value in the field. The field changes to <empty>.  

Note: To enter test cases without using a mouse, use the Tab key to advance to cells. Use 
the spacebar to open dialog boxes from within cells, such as the date picker dialog box. 

6 In the Expected Result field, do one of the following: 
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Note: For data-entry rules, one Expected Result field appears for each of the rule actions. 

For data-entry rules: Select the expected result or type the expected value, based upon the 
values that you provided in the test case. For example: 

• Rule issues a query—Select QUERY or NOQUERY. 

• Rule sends an email message—Select Sent or Not Sent. 

• Rule sets a value—Calculate and type the expected value. For example, for a BMI rule, use 
the Height and Weight values in the test case to calculate the value. 

For workflow rules: Select the study object that you expect to appear next in the workflow, 
based upon the test case. 

For global conditions: Select True or False, depending on how you expect the expression to 
evaluate based on the test case. 

7 Write additional test cases as necessary. Optionally, use Copy and Paste on the toolbar to create 
test cases. 

Note: To run test cases for a rule that references third-party code (for example, ODP.NET), the 
referenced third-party components must be installed on the client computer. 

 

Selecting values for an item on a repeating study object 
When you write a test case and one of the items in a rule is on a repeating study object, you can 
provide test values for each instance of the item. For more information about writing test cases, see 
Writing a test case for a rule or g lobal condition (on page 178). 

1 In the Rule Test Cases dialog box, in the cell that contains <repeating>, click the box at the end 
of the cell.  

The Define Test Values for Repeating Instances dialog box appears.  

2 To create a test instance for an additional instance of the repeating study object: 

a Select the study object. 

b Click either Add Repeating Instance or Copy Repeating Instance. 

• For example, if a rule refers to an item on a repeating form, you can specify an item path 
for each instance of the repeating form on which the item exists.   

3 To mark an instance of the repeating study object as current or deleted: 

• Right-click the study object path, and select either Mark as Current or Mark as Deleted.  

The current instance is preceded by a green checkbox icon, and deleted instances are 
preceded by a red X icon. 

Note: The first repeating instance is marked as current after you create a test case. 

4 To remove an instance of a repeating study object: 

• Select the instance, and on the toolbar, click Remove Repeating Instance.  

If you remove the last instance, it becomes grayed out and has an X icon next to it to 
indicate that you are testing using zero instances. 
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5 Provide test values for the items that are used in the rule: 

Note: You can select any study object in the tree to provide values. Values of child study 
objects also appear in the grid for their parents. If the rule contains multiple items that are 
children of repeating study objects, they are listed in the Repeating Items section; select an 
item to provide its test values in the grid. 

• Item with a single-select codelist—From the drop-down list, select a codelist item to test. 
The code and label appear in the drop-down list. To view the RefName, select the Test 
Properties tab, and then point to the item in the grid. 

• Item with a multi-select codelist—Click the box at the end of the field, and select one or 
more codelist items to test.  

• Item without a codelist—Type the value to test. For an integer, float, or text item, you 
must follow the item's requirements, which appear in the Test Properties tab when you point 
to an item. 

• Date time item—Provide values for the parts of the date time item that are allowed.  

• To test for an empty date, select Empty date, or select Empty for a date time component.  

• To test for an unknown value, select Unknown for a date time component. Unknown is 
available only if an unknown value is allowed for the date time part and if the date time 
part is not required.  

6 Click OK. 

You return to the Rule Test Cases dialog box. Continue writing the test case. 
 

Running test cases and viewing the results 
When you run test cases, the syntax of the selected rules is checked. 

Note: To skip a written test case, select the test case, open the Test Properties tab on the Run tab, 
and set the IgnoreTest property to True. 

1 Open the Rule Test Cases dialog box (on page 175). 

2 Write one or more test cases (on page 178). 

3 Select the Run tab. 

The rule that is selected in the Design tab and its test cases are selected. Optionally, to expand or 
collapse the tree, right-click the tree, and select Expand All or Collapse All. 

4 In the tree to the left, select test cases to run. Selecting a rule also selects its test cases. 

Note: To select or deselect all rules and test cases, right-click the tree and select Check All or 
Uncheck All. 

5 Click Execute Tests. 

The test cases run. 

• The progress indicator is green if all test cases are valid, red if one or more test cases are not 
valid, or yellow if one or more test cases have warnings. 

• Red circles (for invalid test cases), green circles (for valid test cases), or yellow triangles (for 
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test cases with warnings) appear next to the name of the test case in the grid. 

• In the Validation column, either valid, invalid, or incomplete (for rules or global 
conditions that have valid syntax but are not complete; for example, if the rule has no action 
defined) appears. 

Related errors and warnings appear in the Execution Results section at the bottom. 

Note: To run test cases for a rule that references third-party code (for example, ODP.NET), 
the referenced third-party components must be installed on the client computer. 

 

Addressing rule compilation errors 
When you run a rule test case, the rule is compiled, and you might receive errors even if the syntax is 
correct. If the syntax check succeeds but the rule compilation fails: 

• Attempt to resolve the errors using the error messages generated by the Rule Test Cases dialog 
box. 

• Validate the study, and attempt to resolve the errors using the error messages generated by the 
validation. 

• Make sure that any review states you have defined for the study are complete. 
 

Filtering the rules that appear in the Rule Test Cases dialog box 
Several filters, including a view of all rules and all rules with test cases, are available by default. 

1 Open the Rule Test Cases dialog box (on page 175). 

Note: Disabled rules appear grayed out with a gray X to the left of the rule name. You can 
still create and run test cases for the disabled rules. 

2 Click Filters.  

The Define Rule Search Filters dialog box appears. 

3 (Optional) To create a named filter: 

a From the Filters drop-down list, select the All Rules filter, and click Clone.  

b Type a name, and click OK. 

4 To filter by study object, in the Filter on objects section: 

a Using the first drop-down list, filter by rules that are created on the type of study object, 
such as all study objects or the study design. 

b (Optional) Using the second drop-down list, filter by the following characteristics: 

• Enabled or disabled. 

• Object with children. 

• Contain specified text in the RefName, title, or description. 

• The date range within which the rule was saved. 

c If you selected a text or date information option from the second drop-down list, type the 



Chapter 4  Designing rules  
 

182 Oracle® Health Sciences Central Designer 2.1.2 

text or select a date in the blank field.  

d To add additional filtering rows, select the plus sign (+) button at the end of the row.  

5 Next to Filter on rules/conditions, select one of the following options: 

• AND Filters—Search results appear only if they satisfy all filters.  

• OR Filters—Search results appear if they satisfy only one filter.  

Note: These options apply only when you add additional filtering rows to the Filter on 
rules/conditions section.  

6 To filter by the type of rule, do the following in the Filter on rules/conditions section: 

a Using the first drop-down list, you can filter by the type of rule: 

• All rules and global conditions (data-entry rules, workflow rules, and global conditions).  

• Data-entry rules. 

• Global conditions. 

• Workflow rules.  

b (Optional) Using the second drop-down list, you can filter by the following characteristics. 
Depending on the type of rule that you selected, some options might not be available.  

• Enabled or disabled. 

• With or without test cases, or with older tests. 

• Specified text information, such as the rule or condition name.  

• Action information, such as whether a query or set value action is defined for the rule. 

• The date range within which the rule was saved.  

c If you selected a text or date information option from the second drop-down list, type the 
text or select a date in the blank field.  

d To add additional filtering rows, select the plus sign (+) button at the end of the row.  

7 Click OK. 
 

Finding a rule 
1 Open the Rule Test Cases dialog box (on page 175). 

2 In the Find field, type all or part of the rule name. The field is not case-sensitive. The field finds 
only exact text matches unless you type an asterisk as a wildcard operator. For example: 

• *BMI finds all rules that end in BMI. 

• Calc* finds all rules that begin with Calc. 

• *End* finds all rules that contain End. 

3 Press Enter. 

The first rule that matches the search value is selected in the tree. 

4 (Optional) To advance to the next rule that matches the search value, press F3. 
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Deleting and renaming filters in the Rule Test Cases dialog box 
You cannot delete default filters.  

1 Open the Rule Test Cases dialog box (on page 175). 

2 Click Filters.  

The Define Rule Search Filters dialog box appears. 

3 Click Manage. 

The Manage Search Filters dialog box appears. 

4 Select a filter, and click one of the following: 

• Rename. Type a name, and click OK. 

• Delete. 

5 Click OK. 
 

Deleting a test case 
1 Open the Rule Test Cases dialog box (on page 175). 

2 Make sure the Design tab is selected. 

3 Select a rule. 

4 In the grid, select a test case, and on the toolbar, click Delete. 

or 

Right-click the beginning of the row, and select Delete. 
 

Saving test cases 
You can save test cases in the Rule Test Cases dialog box at any time, but the results of test cases are 
removed when you close the Rule Test Cases dialog box. 

1 Open the Rule Test Cases dialog box (on page 175). 

2 Write one or more test cases (on page 178). 

3 Click Save Tests (in the lower-right corner). 
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About data mappings, data sets, and data series 
You use data mappings, data sets, and data series to group items into abstract associations. The 
associations that you create are independent of the way that you collect data values in forms. 

• Data mappings—A data mapping is a data grouping that provides an alternate data view of a 
study. For example, you can group data sets to form an SDTM (Study Data Tabulation Model) 
data mapping. 

• Data sets—A data set is a grouping of one or more related data series. For example, the 
Temperature data series and Weight data series might comprise a Vital Signs data set. 

• Data series—A data series is a grouping of one or more items with the same clinical meaning, 
such as one or more items that measure weight. 

Example—Data mapping: Vital signs 
 

Data set: Vital signs initial Data set: Vital signs final 

• Data series: Temperature 

• Data series: Weight 

• Data series: Pulse rate 

• Data series: Blood pressure 

• Data series: Temperature 

• Data series: Weight 

• Data series: Pulse rate 

• Data series: Blood pressure 
 

 

About data mappings 
A data mapping is a data grouping that provides an alternate data view of a study. For example, you 
can group data sets to form an SDTM (Study Data Tabulation Model) mapping. 

A data mapping is an independent definition of the data structure. Data mappings are not affected 
when you move items between forms.  

You can create a data mapping before you design your study or as part of the study design process. 
For example, a study administrator might create a data mapping that study designers use as a 
checklist to make sure that a study is complete.  

You can create one or more mappings in a study or library, but they are not required for any project. 
You can include an item in one or more mapping definition. 

In a data mapping, items are added to a data series. The association remains with the item whenever 
it is used. You can compare the parts of a data mapping to database concepts with which you are 
already familiar. 

 

Compare a mapping to Compare a data set to Compare a data series to 

A database schema A database table A column in a table 

A Microsoft Excel workbook A worksheet A column in a worksheet 
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Note: The analogies are to physical objects, whereas data associations are abstract associations 
with items for which data has not yet been collected. 

You can create the following types of data mappings: 

• Rule data mappings (on page 204). 

• CDD data mappings (on page 209). 

• CIS data mappings (on page 214). 
 

Creating a data mapping 
You can create data mappings in both studies and libraries.  

1 In the Project Explorer, select the Data Mappings Explorer bar. 

2 Right-click one of the mapping containers, and select the appropriate option: 

• Rule Mappings container > New Rule Mapping.  

Mappings definitions are not generated or validated. 

• CDD Mappings container > New CDD Mapping.  

Mappings are generated and validated for a Customer-Defined Database. 

• CIS Mapping container > New CIS Mapping.  

Mappings are generated and validated for synchronizing between the InForm application 
and the Clintrial application. 

The Object Name dialog box appears. 

3 Fill in the fields in the dialog box.  

4 Click OK. 

You can now create a data set (on page 195) in the data mapping. 
 

Persistence of data mappings 
After you add an item to a data series in a data mapping, the association between the item and data 
mapping persists wherever the item and data mappings are used. Therefore, you can create a data 
mapping between an item and a data series once and never have to recreate it in other studies. 

Even when a mapped item and data mapping are not used together in a study, the association still 
exists. If you use the data mapping in another study and later add the item to the study, the item's 
mapping to the data mapping is restored. Similarly, the data mapping is restored if a study contains 
an item and the data mapping is later added to the library. 
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Different ways to set up data mappings 
Grouping data using data mappings provides flexibility to set up data mappings that are customized 
to fit your needs. For example, consider a study in which a weight value is collected for every subject. 
To group all weight information, you have several options:  

• If a single Weight item appears on multiple forms, you can add a Weight item to a Weight data 
series. 

• If multiple Weight items appear in the study, you can: 

• Add all Weight items to a Weight data series. 

• Add one or several Weight items to multiple Weight data series. 

If you create three data series (one for each value type), you have the ability to map a different value 
type to each data series. Consider using naming conventions to indicate the data series used for the 
different value types. For example, for Weight data series, you could create the following data series: 
Weight_Normalized, Weight_Entered, and Weight_Units. 

For more information, see: 

• About adding and mapping items to data series (on page 188) 

• About mapping data values to data mappings (on page 189) 
 

About adding and mapping items to data series 
 

Characteristic Add an item to a data series Specify when an item is mapped to a 
data series 

Purpose The data values for the item can be 
used when you use the data mapping. 

The data value of the item is part of the 
data series and can be used in several 
ways: 

• In a rule data mapping, you can use all 
data values for the item in rules.  

• In a CDD data mapping, all values of 
the item appear in the CDD. 

• In a CIS data mapping, normalized 
values are mapped to the Clintrial 
application. 



 InForm Design Guide  

Oracle® Health Sciences Central Designer 2.1.2 189 

Characteristic Add an item to a data series Specify when an item is mapped to a 
data series 

How to do it • Drag the item from the Project 
Explorer to the Data Series 
Editor.  

By default, all data values 
collected for the item are 
automatically mapped to the data 
series. 

• Select a form or study event and 
then select the Data Series 
Summary tab.  

You can add an item to a data 
series at the same time as you map 
the item to a data series.  

Select a form or study event and then 
select the Data Series Summary tab.  

You can add an item to a data series at the 
same time as you map the item to a data 
series.  

 

 

Example If an item appears on a form that is 
used three times in a study, you can 
add an item to the data series so the 
data values collected for the item can 
be used when you use the data 
mapping. 

If an item appears on a form that is used 
three times in a study, you can specify that 
the item is mapped to the data series only 
when the item appears on the specific 
form and only when the form appears in a 
specific study event.  

 

You have the following options for mapping an item to a data series:  

• The item is always mapped to the data series, on every form, in every study, and in the library. 

• (Available only when a study event is selected.) The item is mapped to the data series only when 
it appears on any form in a specific study event. You can select this option for multiple study 
events.  

• The item is mapped to the data series only when the item appears on a specific section (or form, 
if the form has no sections). You can select this option for multiple sections or forms. 

• (Available only when a study event is selected.) The item is mapped to the data series only when 
it appears on a specific form in a specific study event. 

• The item is not added to the data series. For example, an item can be mapped to one data series 
in a study but not another. 

Note: When a data series is copied within a study or library, the items that are part of a data 
series are not copied, but data series mappings to items are copied. For example, if an item is 
added to a data series, and the item is mapped to be part of the data series only when the item 
appears in a specific form, the mapping of the item to the data series for the form is copied. 
Similarly, if you copy a data set or mapping definition containing a data series, the mappings are 
also copied. If you use the new data series in another study, the mappings are retained. If you 
later add the item and form that are mapped to the data series to the study containing the data 
series, the mapping appears in the Data Series Summary tab. 
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About mapping data values to data mappings 

When an integer or float item that has data collected in multiple units is added to a data series in a 
mapping, the Item has units dialog box appears, prompting you to choose the data value to map to 
the data series. You have the following options. 

 

Option Description 
Normalized 
Value 

Map the normalized value of the item with the data series. Normalization is the 
process of converting data to a required format. The normalized units appear in 
parentheses. 

Entered Value Map the entered value of the item with the data series. The entered value can be 
the same as or different from the normalized value. 

Entered Unit Map the unit in which a value is entered. 
 

For example, a Weight item appears on three forms. Two forms collect the weight value in 
kilograms, and one form collects the weight value in pounds. The Weight items are normalized to 
kilograms. You can map different types of values to different data series, as shown in the following 
example. 

 

Values collected or mapped Source Values in data series 
Values collected for the Weight items Form 1 

Form 2 

Form 3 

75 kg 

155 lb 

62 kg 

Normalized values mapped to a data series Form 1 

Form 2 

Form 3 

75 

70.45 

62 

Entered values mapped to a data series Form 1 

Form 2 

Form 3 

75 

155 

62 

Entered units mapped to a data series Form 1 

Form 2 

Form 3 

kg 

lb 

kg 
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About copying study objects grouped by data mappings 
The following table explains how study objects are copied when they are part of a data mapping. You 
can copy study objects from a library to a study or another library as well as from a study to another 
study. You also can copy study objects in the Project Explorer.  

When you copy a data mapping, data set, or data series within a study or library, the new study object 
contains item mappings. 

 

Copied study 
object 

Copied within a study or library Copied from one study or library to 
another 

Data mapping, 
data set, or data 
series 

Mappings to items that are part of 
the data series are retained in the new 
study object. 

Item mappings are not copied to the 
new study object. 

Item, Form, or 
study event that is 
mapped to a data 
series 

The new study object is mapped to 
the data series. 

If you break the link between the 
original and the new study object, the 
new study object is still mapped to 
the data series.  

The study object is copied, but data 
mappings are not copied. 

Note: If you drag and drop a study 
object that is mapped to a data series, 
and the study object already exists in the 
library, the database contains a data 
point for the study object, and the drop 
operation reuses that data point as is. 
The application warns you that the drag 
and drop operation is not supported. If 
you continue, any data mappings in the 
dropped study object that are different 
from the data mappings that are 
associated with the study object that 
already exists in the library are removed. 

 

Note: When a data series is copied within a study or library, the items that are part of a data 
series are not copied, but data series mappings to items are copied. For example, if an item is 
added to a data series, and the item is mapped to be part of the data series only when the item 
appears in a specific form, the mapping of the item to the data series for the form is copied. 
Similarly, if you copy a data set or mapping definition containing a data series, the mappings are 
also copied. If you use the new data series in another study, the mappings are retained. If you 
later add the item and form that are mapped to the data series to the study containing the data 
series, the mapping appears in the Data Series Summary tab. 
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Example—Creating a data mapping to create an SDTM model 
The following sample data mapping creates an SDTM model. 

 

Mapping Data set Data series Items 

SDTM VS_OBS tempEnteredValue 

tempNormalizedValue 

tempEnteredUnit 

The temp item is always part 
of all three data series. 

  weightEnteredValue 

weightNormalizedValue 

weightEnteredUnit 

The weight item is always part 
of all three data series. 

  systolicValueEnteredValue 

systolicValueNormalizedValue 

systolicValueEnteredUnit 

The systolicValue item is 
always part of all three data 
series. 

 DM BRTHDT Date of birth 

  SEX Sex 

  ETHNIC Ethnicity 
 

 

Data mappings for data extraction 
Data mappings in the Central Designer application allow you to collect data parts separately and then 
group them in a way that makes sense. The ability to create mappings is similar to functionality in the 
InForm application. Data collected in the InForm application is saved in a database, but you must 
map data to a customer-defined database (CDD) in order to view the data in an organized way.  

When you create a data series, you are prompted to provide a title, RefName, and alias for the data 
series. If an alias is present, it is used as the column name in the customer-defined database (CDD) 
or as the Clintrial item name in CIS mappings. If an alias is not present, the RefName is used as the 
column header. Because RefNames must be unique throughout a study, you must create an alias if 
the RefName is used by a study object. Data series aliases must be unique within a data set. 

Checking for RefName and alias uniqueness is case insensitive; that is, the names BP and bp are 
considered identical.  

CIS and CDD data mappings 

You can create a data mapping when you design your study to define what your data will look like. 
When you create a deployment package, you choose the data mappings to include in the package, and 
the selected data mappings are deployed as CDDs in the InForm application. 

You can also use mapping definitions to create CIS mappings. CIS mappings are used to transfer 
data from an InForm study to a Clintrial protocol using the CIS application. 

SDTM data mappings 

You cannot create complete SDTM data mappings with a data mapping in the Central Designer 
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application; however, the ability to create SDTM data mappings is available as a Oracle Services 
offering. 

Rules and data mappings 

You can write a rule that references a data mapping, but you cannot use rules to manipulate data 
mappings. 

Rule creation 

Data mappings can also be used for rule creation. 
 

About using CDD and CIS data mapping definitions 
Data mappings created for Customer-Defined Databases (CDDs) or for TDE data mappings are 
deployed to the InForm application but must be enabled in the InForm application.  

Similarly, CIS data mappings must also be enabled. To enable your data mappings in the InForm 
application, you must create a synchronization connection in the CIS application. 
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Data mappings for rule creation 
You can create data mappings to classify and query data more easily in rules. Data mappings behave 
like global variables, allowing rules to access data outside their normal scope. Any rule in a study can 
refer to any item that is part of a data mapping in the study.  

This functionality might make it possible to move rules to lower-level study objects. You can use an 
item in any rule in a study when you add the item to a data series, which is part of a data mapping. 

Using data mappings for rules also simplifies the process of looking at arrays of data, such as data 
that is collected over time. When a single item is used in multiple forms, you can use the array of data 
collected for the item in rules. For example, you can check that dates of visits are sequential or 
calculate aggregate values for the data. 

Useful structure for rule creation 

The first data mapping that you create for the purpose of rule creation should contain subject 
information, as you are most likely to need this information to be available for all rules. Over time, 
you will probably add and subtract information in the data mapping. The following data sets provide 
a useful structure: 

• A data set for single-item data series. 

In this data set, include items for which the data does not change in the study, including 
enrollment-type items, demographics items, and any other items that are static for a subject. 
Examples of items that you might include in the data set include Initials and Date of Birth. 

When a data series contains an item on a single form, and the item is not part of a repeating form 
or a repeating section, the data series is treated as an alias for the item itself and can be accessed 
as if it were a single global variable.  

• A data set for ongoing, per-visit information. 

In this data set, include items with values that change for the subject from study event to study 
event. This type of information is an array of data. For example, you might include items that 
appear on a Vital Signs form or a Physical Exam Results form, or items that are related to 
adverse events or concomitant medications.  

Mappings and data extraction 

Mappings can also be used for data extraction. 
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Data sets 
A data set is a grouping of one or more related data series. For example, the Temperature data series 
and Weight data series might comprise a Vital Signs data set. 

When you create a data set, you can specify standard and custom dimensions. 
 

Creating a data set 
The only place to create a data set is in a data mapping. 

1 In the Project Explorer, select the Data Mappings Explorer bar. 

2 Right-click a data mapping, and select New Data Set. 

The Data Set Properties dialog box appears.  

3 Fill in the fields of the dialog box. Title and RefName are required. 

4 To specify standard data dimensions, select one or more from the Standard Data Dimensions 
section. 

5 To specify custom data dimensions for the data set: 

a In the Custom Dimensions section, type a name and description and choose a data type for 
each custom data dimension.  

b In the Codelist Lookup column, click the ellipsis button. 

The Custom Dimension Labels - Select Codelist dialog box appears.  

c From the drop-down list, select a codelist, or to create a codelist, click New, and type the 
Code and Label pairs in the grid. 

d To require users to select only the codelist labels that are in the codelist, select Use only listed 
labels. If you do not select it, a user-defined codelist label can be used. 

Note: If you select Use only listed labels, the codelist must have at least one codelist 
item. 

e Click OK. 

You return to the Data Set Properties dialog box. 

6 Click OK. 

7 If the data set is in a CDD or CIS data mapping, in the Properties Browser, set the values of the 
appropriate CDD or CIS custom properties. 

You can now create a data series (on page 198) in the data set. 

For more information, see: 

Data Set Properties dialog box - Field descriptions (on page 390). 

Custom Dimension Labels - Select Codelist dialog box - Option descriptions (on page 386). 
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Standard and custom data dimensions 
When you create a data set, you specify standard data dimensions, which indicate the additional 
information that will be saved when study data is collected. Data dimensions are the keys to the data. 
The way the keys are defined determines how you can view the data that is collected.  

For example, a Vital signs data set contains several data series, including Weight. After data is 
collected, the Weight data series provides the weight values that were recorded in the study. The data 
series does not include context information, such as identifying information for the subject and the 
study event in which weight was recorded. To provide this information, you can specify standard 
data dimensions for a data set.  

Note: Clintrial users might find it helpful to compare specifying data dimensions to choosing a 
panel type. Data dimensions are similar to panel keys.  

You can specify the following standard data dimensions when you create a data set. 
 

Standard data dimension Information saved 
Study RefName of the study. 

Subject Subject ID. 

Section RefName of the section. 

Section Index Instance of a repeating section. 

Event RefName of the study event. 

Event Index Instance of a repeating study event. 

Form RefName of the form. 

Form Index Instance of a repeating form. 

Item RefName of the item. 
  

You can also specify custom data dimensions. Like standard data dimensions, custom data 
dimensions specify additional information that is saved when study data is collected. You can provide 
names and values for custom data dimensions by selecting or creating a codelist, and you can allow a 
user-defined value. When you add an item to a data series contained by the data set, you are 
prompted to select a custom dimension label. You can choose a label from the list of codelist items, 
or, if providing a user-defined value is allowed, you can type a label name. 

Note: In CIS data mapping definitions, custom dimensions are used to identify a subset key item 
for pages with multiple sections that contain the same panel items. The value of the subset key 
item determines the section in which data appears. 
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Example—Standard and custom data dimensions 
To understand how you might use custom data dimensions, consider the following example, which 
illustrates how you can use standard and custom data dimensions to look at your data in different 
ways. 

The following sample form collects information about eye cloudiness and color in a glaucoma study. 
 

Item Options 
Left eye cloudiness  Clear 

 Moderately cloudy 

 Very cloudy 

Left eye color  Brown 

 Blue 

 Green 

Right eye cloudiness  Clear 

 Moderately cloudy 

 Very cloudy 

Right eye color  Brown 

 Blue 

 Green 
 

If you select Subject as a standard data dimension, the data collected in the form might be stored in 
the following manner. 

 

Subject  Left cloud Left color Right cloud Right color 
A Moderately cloudy Blue Clear Blue 

B Very cloudy Brown Very cloudy Brown 

C Clear Green Clear Blue 
 

Alternately, you might want to pivot your data on a piece of information, such as Eye.  

In the following example, Subject is selected as a standard data dimension. In addition, a custom data 
dimension of Eye has been created with the values of Left and Right. When you add items that 
collect data for the left eye to the data series, you select the Left value for the custom dimension. 
When you add items that collect data for the right eye to the data series, you select the Right value 
for the custom dimension. 

 

Subject Eye Cloudiness Color 
A Left Very cloudy Blue 

A Right Clear Blue 
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Subject Eye Cloudiness Color 
B Left Very cloudy Brown 

B Right Very cloudy Brown 

C Left Clear Green 

C Right Clear Blue 
 

 

Data series 
A data series is a grouping of one or more items with the same clinical meaning, such as one or more 
items that measure weight. You can add items to a data series, and the items that you add can appear 
on multiple forms and study events. A data series provides you with a grouping of all study data 
collected for the item or items.  

When you create a data series, you choose a data type for it. 
 

Creating a data series 
The only place to create a data series is in a data set. 

Note: In CDD and CIS data mappings, the order in which you add data series to a data set 
determines the order of items in the CDD or Clintrial target table. You cannot change the order 
after a data series is added to a data set except by modifying the Item Order property in the 
Clintrial Design module after the data mappings are synchronized to the Clintrial application. 

1 In the Project Explorer, select the Data Mappings Explorer bar. 

2 Right-click a data set, and select New Data Series.  

or 

Select a data set, and in the Data Set Editor, right-click the grid, and select New Data Series. 

The Data Series Properties dialog box appears.  

3 Fill in the fields in the dialog box, and click OK. 

4 If the data series is in a CDD or CIS data mapping, in the Properties Browser, set the values of the 
appropriate CDD or CIS custom properties.  

You now can add one or more items to the data series (on page 199). 

For more information, see Data Series Properties dialog box - Option descriptions (on page 
387). 
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Data types for data series 
When you create a data series, you choose a data type for it. 

The data types of an item and data series must be compatible for you to add the item to the data 
series. The following table indicates the item types that you can add to each data series type.  

 

Item type Text Integer Float Date time 

Text item Yes No No No 

Integer item Yes Yes Yes No 

Float item Yes No Yes No 

Date time item Yes. You are asked if 
you want to choose 
part of the date or 
the whole date. 

Yes. You are asked 
to choose the part 
of the date. 

No Yes 

 

You can add any item to a data series with a text type, but if the data mapping is for a CDD, the 
value that is provided for an item (in the InForm application) is saved in the customer-defined 
database (CDD) as the data type of the data series. Therefore, if you add a float item to a text data 
series, the float item is saved as a text item in the CDD. 

In a rule data mapping, Oracle recommends creating data series with a type that matches the type of 
the item or items that will be added to the data series. 
 

Adding an item to a data series 
After you add an item to a data series in a data mapping, you can specify the circumstances for which 
the item is mapped to the data series. For example, an item that appears on several forms in a study 
can be added to a data series, but you might want to analyze data collected for the item only when it 
appears on a specific form. In that situation, you can map the item to the data series for the specific 
form. 

You have the following options for adding an item to a data series: 

• At the form level, you indicate whether the item is mapped to the data series only when it 
appears on a specific form.  

• At the study event level, you indicate whether the item is mapped to the data series only when it 
appears on a specific study event or form. 

Note: The data types of an item and data series determine whether the item can be added to a 
data series. For more information, see Data types for data series (on page 198). 

To add an item to a data series by selecting a data series: 

1 In the Project Explorer, select the Data Mappings Explorer bar. 

2 In the Project Explorer, select one of the following: 

• Rule Mappings 

• InForm Mappings > CDD 
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• InForm Mappings > CIS 

3 Select a data series. 

The Data Series Editor appears in the workspace, and all items in the data series appear in the 
grid.  

4 Select the Add To tab to open the Add To browser. 

5 Do one of the following: 

• In the Filter field, type a keyword. 

• Click Advanced Filtering. 

a Specify the properties on which to apply the filter. 

b Specify the display format for the filtered results. 

• Click Refresh Results (  ). 

The item is added to the data series. If custom data dimensions were defined for the data set that 
contains the data series, the Select Custom Dimension dialog box appears.  

6 If the Select Custom Dimension dialog box appears, select the custom data dimension to use, and 
from the Labels drop-down list, choose a codelist label for the custom data dimension. 
Optionally, depending on how the custom data dimensions were set up, you might be able to 
provide a user-defined label in the Labels field. Click OK. 

Note: If you type a label or modify an existing label, a new codelist item is created for the 
codelist. 

7 Optionally, add more items to the data series. 

To add an item to a data series by selecting a study event or form: 

Note: When you add an item to a data series by selecting a study event or form, you can 
determine when the item is mapped to the study event or form. 

1 In the Project Explorer, select the form or study event containing the item to be added to a data 
series. 

Either the Form Editor or Study Event Editor appears in the workspace. 

2 Select the Data Series Summary tab.  

If a form is selected, its items appear in the grid. 

If a study event is selected, its forms appear in the grid.  

3 Optionally, to change your view of the grid, use the filters at the top of the grid. 

4 In the item's row in the grid, click the cell in the column for the data series to which you want to 
add the item.  

A drop-down arrow appears at the end of the cell.  

Note: If the item cannot be added to the data series—for example, if the data types for the 
item and data series are not compatible—None compatible appears in the cell. 

5 Click the drop-down arrow, and select one of the following options from the list: 
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• None—The item is not added to the data series. 

• Always—The item is always mapped to the data series, on every form, in every study, and in 
the library. 

• Form—The item is mapped to the data series only when the item appears on a specific 
section (or form, if the form has no sections). You can select this option for multiple 
sections or forms. 

• Study Event—(Available only when a study event is selected.) The item is mapped to the 
data series only when it appears on any form in a specific study event. You can select this 
option for multiple study events.  

• Study Event & Form—(Available only when a study event is selected.) The item is mapped 
to the data series only when it appears on a specific form in a specific study event. 

If you select a data series that has custom data dimensions, the Select Custom Dimension dialog 
box appears. Otherwise, skip the next step.  

6 Select a value for each custom dimension, or, if providing a user-defined value is allowed, type a 
value for each custom dimension. 

If the item is an integer or float, you are asked if you want to map the normalized value, entered 
value, or entered unit to the data series.  

Note: You can create one data series for each type of value, so you can map the item to 
three data series (one for each representation of the unit). 

7 For an integer or float item with a selected unit, select the item representation to map to the data 
series. You have the following options: 

• Normalized value 

• Entered value 

• Entered unit 

8 Optionally, add the item to more data series, or add other items to data series.  

For more information, see: 

Data Series Summary tab - Option descriptions (on page 388). 

Select Custom Dimension dialog box - Option descriptions (on page 393). 
 

Removing an item from a data series 
You can remove an item from a data series by selecting a data series, study event, or form. To keep 
the item in the data series but remove the data mapping for a study, unmap the item (on page 202). 

To remove an item from a data series by selecting a data series: 

1 In the Project Explorer, select a data series.  

The Data Series Editor appears in the workspace.  

2 Right-click the item with an association to remove, and select Remove. 

A confirmation message appears. 

3 Click Yes. 



Chapter 5  Designing data mappings  
 

202 Oracle® Health Sciences Central Designer 2.1.2 

To remove an item from a data series by selecting a study event or form: 

1 In the Project Explorer, select the form or study event containing the item to remove.  

The editor for the study object appears in the workspace.  

2 Select the Data Series Summary tab.  

If a form is selected, its items appear in the grid. 

If a study event is selected, its forms appear in the grid.  

3 Optionally, to change your view of the grid, use the filters at the top of the grid.  

4 In the grid, follow the row containing the item across until you reach the column of the data 
series from which you want to remove the item, and point to the cell.  

A drop-down arrow appears at the end of the cell.  

5 Click the drop-down arrow, and select None. 

For more information, see Data Series Summary tab - Option descriptions (on page 388). 
 

Unmapping and restoring an item mapping with a data series 
When you unmap an item in a study, the item is no longer part of the data series for the study, but it 
is still part of the data series in the library in which it is saved. You might unmap an item from a data 
series if you have added both to a study from a library and do not want the item to be part of the 
data series for the particular study. 

You can restore an unmapped item if you want the item to be part of the data series for a study. 

To unmap an item and a data series: 

1 In the Project Explorer, select a data series.  

The Data Series Editor appears. 

2 Right-click the item, and select Unmap the Data Series. 

The mapping between the item and data series is removed, and the value in the State column 
changes to Unmapped for the item. 

To restore an item data mapping with a data series: 

1 In the Project Explorer, select a data series.  

The Data Series Editor appears in the workspace.  

2 Right-click the item that you want to map, and select Map the Data Series. 

A mapping is created between the item and data series, and the value in the State column changes 
to Mapped for the item. 

For more information, see Data Series Editor - Field descriptions (on page 386). 
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Opening an item from the Data Series Editor 
1 In the Project Explorer, select a data series.  

The Data Series Editor appears. 

2 In the grid, right-click an item, and select Go to [item name] item. 

The Item Editor, with information about the item, appears in the workspace. 
 

Changing the data value that is associated with a data series 
When you add an integer or float item with a selected unit to a data series, you choose if you want to 
map the normalized value, entered value, or normalized units to the data series. You can change the 
data value that is mapped at any time.  

1 In the Project Explorer, select a data series.  

The Data Series Editor appears. 

2 Right-click an integer or float item, and select Modify data point value collected. 

The Item has units dialog box appears. 

3 Select the value to associate with the data series, and click OK. 

For more information, see Item has units dialog box - Option descriptions (on page 391). 
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Rule data mappings 

About rule data mappings 

Deciding when to use a data mapping and when to move a rule to a higher-
level study object 

If you need to create a rule on a study object, such as a form, but an item that the rule must reference 
is not in the scope of the study object, you have the following options: 

• Add the item to a data series, so you can use the item in any rule in the study. 

• Move the rule to a higher-level study object that includes all study objects that are needed for the 
rule in its scope. 

There is no set guideline for which approach is better. The Central Designer application does not 
require you to use data mappings for rule creation, and you must weigh the benefits and limitations 
of using data mappings when making this decision.  

• Benefits and limitations of using a data mapping. 

You can create the rule on a lower-level study object, thus improving the likelihood that the rule 
will be reused. 

However, you must include the data mapping in every study that uses the study object on which 
the rule is created. 

• Benefits and limitations of moving a rule to a higher-level study object. 

You can create the rule on the study object with all study objects in its scope without adding 
another item to the data mapping. 

However, if the rule is created at a higher-level study object, the likelihood that it will be reused 
might be low. For example, some organizations might be more likely to reuse an item or form 
rather than an entire study event. 

• Oracle recommendation. 

Oracle recommends that you create a data mapping and use it for rule creation if you use: 

• Every instance of a study object in one or more rules. Add the study object to a data 
mapping.  

For example, you should create a data mapping if you have a repeating Adverse Event form 
and a rule must reference the event description or event ID from every single instance of the 
form.  

• An item frequently in a study. Add the item to a data mapping. 

• An item and a rule in many studies. Consider adding the item to a data mapping. 
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Data mappings and the rule engine 
The Central Designer rule engine handles forms and items that have been mapped to a data mapping 
the same as study objects that have not been mapped to a data mapping—the rule engine follows the 
data mappings to access the data in the original items. There is no physical representation of the data 
mapping in the InForm application. 

The Central Designer application determines the data that is in a data mapping and uses the 
information to analyze rule dependencies. In some situations, more triggers (ATTACHRULESET 
objects) might be created for rules that use data mappings in comparison to rules that do not use data 
mappings. 

Keep in mind the following when brainstorming different ways to use data mappings: 

• The data in the data mapping comes from the standard InForm data model, and the Central 
Designer rule engine refers to the InForm database for study objects that are in a data mapping. 

• The InForm application allows you to work with data for a single subject at a time, and data 
mappings provide the same functionality. You cannot use data mappings to access site 
information or information from other subjects. 

 

Example of data mappings for rule creation 
The following sample data mappings can be used for rule creation.  

 

Data mapping Data 
set 

Data 
series 

Items Sample rule expressions 

Rules 

(Single data 
point in data 
mapping) 

BMI Weight • Weight item always part 
of the data series. 

• Weight item appears on 
only one form. 

BMI.Weight.Value / 
Math.Pow(BMI.Height.Value, 
2) 

  Height • Height item always part 
of the data series. 

• Height item appears on 
only one form. 

 

Rules 

(Multiple data 
points in data 
mapping) 

BMI Weight • Weight item always part 
of the data series.  

• Weight item appears on 
multiple forms, so you 
must specify which 
value to use in the rule 
expression. 

BMI.StudyEvent(StudyEvents.
Visit1).Weight.Values[0] / 
Math.Pow(BMI.Height.Value, 
2) 

BMI.StudyEvent(StudyEvents.
FinalVisit).Weight.Values[0] / 
Math.Pow(BMI.Height.Value, 
2) 

  Height • Height item always part 
of the data series.  

• Height item appears on 
only one form. 
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Notes: 

• Math.Pow computes the power of a value. You can also define functions for calculating a 
squared value. 

• As with any calculation rule, in data mapping rules you should check for empty values and for 
division by zero. 

 

Modifying labels of mapped custom data dimensions 
When you add an item to a data series in a data set with a custom data dimension, you are prompted 
to select a value for the custom data dimension and the data mapping. You can change the value at 
any time.  

1 In the Project Explorer, select a data series.  

The Data Series Editor appears in the workspace. 

2 Right-click an item, and select Modify labels. 

The Select Custom Dimension dialog box appears. 

3 From the Labels drop-down list, choose a codelist label for the custom data dimension. 
Optionally, depending on how the custom data dimensions were set up, you might be able to 
provide a user-defined label in the Labels field.  

Note: If you type a label or modify an existing label, a new codelist item is created for the 
codelist. 

4 Click OK. 
 

Deleting a custom data dimension 
1 In the Project Explorer, select a data mapping. 

The Data Mappings Editor appears in the workspace. 

2 Right-click a data set, and select Properties. 

The Data Set Properties dialog box appears. 

3 In the Custom Data Dimensions section, right-click a custom data dimension, and select Delete Row. 
 

Mappings and the Data Mappings tab 
Data mappings make study objects available to rule expressions on a global level, without regard to 
the scope of a particular study object. Global study objects defined in a data mapping appear on the 
Data Mappings tab. 

The Data Mappings tab (on the Expression tab of the Rule Wizard) lists: 

• RefNames of the data mappings (on page 186), data sets (on page 194), and data series (on 
page 198) in the study or library. 

• Rule model properties for data series. 

A data series has the properties of the item that is mapped to it. If a data series contains an item 
that collects more than one value, the rule model properties for repeating study objects appear so 
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you can access an array of all of the values of the item. 

• Methods for data sets. 

A method appears if you select the corresponding standard data dimension of the data set. You 
can use data set methods to return a subset of the data in the data set. 

• Study events, forms, sections, and items that are mapped to each data set.  

• Study objects appear if you select the corresponding standard data dimension of the data set. The 
properties of the study objects are used as parameters of data set methods. 

 

Data mapping setup for referencing specific instances of an item 
If an item that you will use in a rule appears multiple times in a study, you can use either of the 
following approaches to setting up a data mapping so that you can reference specific instances of the 
item: 

• When you add an item to a data series in the Data Series Summary tab of the Form or Study 
Event editor, specify the instances of the item that you want to be mapped to the data series. 

• When you create a data set, select standard data dimensions that enable the data set methods you 
need in the Data Mappings tab. 

 

Data series mapping options and the Data Mappings tab 
When you add an item to a data series in the Data Series Summary tab of the Form or Study Event 
editor, you can specify the instances of the item that you want to be mapped to the data series: 

• None—The item is not added to the data series. 

• Always—The item is always mapped to the data series, on every form, in every study, and in the 
library. 

• Form—The item is mapped to the data series only when the item appears on a specific section 
(or form, if the form has no sections). You can select this option for multiple sections or forms. 

• Study Event—(Available only when a study event is selected.) The item is mapped to the data 
series only when it appears on any form in a specific study event. You can select this option for 
multiple study events.  

• Study Event & Form—(Available only when a study event is selected.) The item is mapped to 
the data series only when it appears on a specific form in a specific study event. 

This approach is recommended if the specifications for your rules are well known at the time when 
you are designing your data mappings. For example, if an item occurs in more than one form, and 
you know that your rules will reference the item in a specific form, you can map the item to a data 
series in the Form editor with a Form data mapping type. 
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Standard data dimensions and data set methods on the Data Mappings 
tab 

When you create a data set (on page 194), you can select standard data dimensions that enable the 
data set methods you need in the Data Mappings tab. Each data set method enables you to reference 
a particular subset of the instances of an item in a study. For example, the StudyEvent(StudyEvents) 
data set method returns a data set subset with data from only the specified study event. To enable the 
StudyEvent(StudyEvents) data set method, you select the Event standard data dimension when 
creating the data set. 

You can use this approach if you design your data mappings (on page 186) before the complete 
specifications for your rules are known. With this approach, you can add an item to a data series 
without considering all of the forms and study events in which it is used. In your rule expression, you 
can use data set methods to select specific instances of the item.  

Note: This approach is less efficient than adding an item to a data series (on page 198) with a 
data mapping type that narrows the selection of instances of the item. When possible, select for 
specific instances of an item when adding it to a data series. 

 

Study object nodes in the Data Mappings tab 
When you select a standard data dimension for a data set, the study objects included in the standard 
data dimension appear as nodes in the Data Mappings tab: 

• Under the data set (on page 194). 

• Under each data set method. 

For example, if you select the Form standard data dimension, a list of the RefNames of all forms that 
contain items mapped to the data series in the data set appears in the Data Mappings tab.  

Study object nodes enable you to drag RefNames of specific study objects into the expression 
window, instead of typing them. Additionally, when you drag a data series (on page 198) property or 
data set method into the expression window, the same study object RefNames appear in the 
References tab of the Invoke Function dialog box and are available for use as parameter values. 
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CDD data mappings 

About CDD mappings 

Example—Creating a CDD mapping 
The following data mapping could be used to create a customer-defined database (CDD) in the 
InForm application. 

 

Data mapping Data set Data series Items Standard data 
dimensions 

Study name Vital Signs BP Blood pressure Subject 
Study 
Event 

  Temp Temperature  

  PulseRate Pulse Rate  

 Demographics Gender Gender Subject 
Study 

  DOB Date of Birth  

  Race Race  
 

 

How data mappings are deployed to CDD tables 
When you create a deployment package and choose one or more data mappings to create CDD data 
mappings: 

• Each data set becomes a target table, and each data series becomes a column in the table. 

• The key columns of the target tables are defined by the value of the Target Key Type CDD 
custom property on the data set. 

• Additional attributes of the target tables and columns are defined by the values of CDD custom 
properties on the item, data set, and data series. 

• When you map an item with a unit into a text data series, you must choose whether to map the 
entered value, normalized value, or entered unit. However, all items are mapped as the entered 
value regardless of what is specified when the item is mapped. The InForm CDD supports the 
mapping of the different parts, but there is no option in the InForm application to choose the 
column names or which parts to include, so the CDD data mapping from data mapping 
definitions ignores this setting.  

• All values in a multi-select codelist are mapped to a single column. It is not possible to define a 
data series mapping in such a way that each possible value of a multi-select codelist appears in a 
different CDD table column. 

• When you define a data set, you can specify one or more standard data dimensions and custom 
data dimensions. Standard and custom data dimensions are not used in CDD data mappings. 
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• You can define CDD data mappings for associations by associating two forms and selecting 
those forms as the value of the Associated Forms property on a data set. 

 

Mapping associated forms to a CDD 
The target table for an association has a fixed format that consists of ID and index columns to 
identify the visit instance, form instance, and patient for the data in the two associated forms. Instead 
of specifying data sets and data series for the data in each form, you specify the association. 

1 Create two repeating, common forms, and associate them. 

2 Create a data set (on page 195). 

Note: Do not create any data series in the data set. You can create mappings for 
associations only in a data set that has no data series. 

3 In the Properties Browser, select the associated forms as the value of the Associated Forms property, 
and press Enter. 

Note: If you change the association between two forms, you must manually update the data 
mapping by changing the value of the Associated Forms CDD custom property of the data set. 

 

Target keys in CDD data mappings 
When you create a data set to use for CDD data mappings, you specify the target key type. Target 
key types control how data is grouped in a CDD. Target key types are used for tables that do not 
pivot and for pivot tables. 

• Target key types for tables that do not pivot—These target key types enable you to define 
CDD tables in which data is grouped by a portion of the control path of the data point in the 
InForm application. For example, to capture all of the data for a single patient in one row, you 
might define a target table with the Patient Only target key type. To capture the data for each 
form in a single row, with a new row for each patient and visit, you might define a target table 
with the Patient to Form target key type. 

The primary key of the target table determines how data is inserted into CDD target tables. 
When you create a CDD target table definition, the primary key of the table is a set of database 
IDs (DBUIDs) and indexes that correspond to the components of a data point’s control path or 
a subset of the control path. When the InForm application loads data into a CDD table, it 
creates a new row each time the value of the primary key changes.  

• Target key types for pivot tables—These target key types enable you to define CDD tables in 
which you can: 

• Map multiple data points to the same CDD table column. 

• Associate a particular data point with each row in the table. 
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In pivot tables, insertion of data is organized around a set of rows called a pivot set. The data 
points that make up a pivot set share the same values in specified parts of their control paths. 
The target key type of a pivot table determines where each pivot set breaks by defining which 
parts of the control path are the same within a pivot set. For example, in a table with a target key 
type of Pivot Section, a pivot set is made up of all data points in which the patient, visit, form, 
and section components of the control path match. 

One of the columns in a pivot table is identified as the pivot column. Each time the InForm 
application loads one pivot set of data into a pivot table, it creates a new row for each data point 
mapped to the pivot column, and it duplicates data points mapped to nonpivot columns in each 
of those rows. 

 

Target key types for tables that do not pivot 
In tables that do not pivot, each target key type specifies the components of the primary key of the 
target table. For example, the primary key of a table with a target key type of Patient to Form consists 
of columns containing the PatientID, VisitID, ItemsetIndex, VisitIndex, and FormID.  

 

Target key type Primary key components Data grouping in target table 
Patient Only PatientID, FormIndex, ItemsetIndex. All data for a patient in one row. 

Patient Visit PatientID, VisitID, FormIndex, 
ItemsetIndex, and VisitIndex. 

All data for a visit in one row, with a 
new row for each patient or visit. 

Patient to Form PatientID, VisitID, FormIndex, 
ItemsetIndex, VisitIndex, and 
FormID. 

All data for a form in one row, with a 
new row for each patient, visit, or form. 

Patient to Section PatientID, VisitID, FormIndex, 
ItemsetIndex, VisitIndex, FormID, 
and SectionID. 

All data for a section in one row, with a 
new row for each patient, visit, form, or 
section. 

Patient to Itemset PatientID, VisitID, FormIndex, 
ItemsetIndex, VisitIndex, FormID, 
SectionID, and ItemsetID. 

All data for an itemset instance in one 
row, with a new row for each patient, 
visit, form, section, or itemset row. 

Patient to Item PatientID, VisitID, FormIndex, 
ItemsetIndex, VisitIndex, FormID, 
SectionID, ItemsetID, and ItemID. 

All data for an item in one row, with a 
new row for each patient, visit, form, 
section, itemset, or item. 

Patient to Control PatientID, VisitID, FormIndex, 
ItemsetIndex, VisitIndex, FormID, 
SectionID, ItemsetID, ItemID and 
five ControlIDs.  

Note: A target table with the Patient 
to Control key type also contains a 
data label that can be used for data 
selection. The data label is specified in 
the Data Label custom property of the 
item. 

Each control on a separate row. 
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Target key types for pivot tables 
In pivot tables, the target key type determines the composition of a pivot set. Within a pivot set, data 
points mapped to the columns that are not in the pivot set are repeated in each row. You might 
choose one of these target key types to be able to select all data values that have some related data 
value in common, for example, to select all lab values for a specific test that were collected on the 
same date.  

The primary key columns are PatientID, VisitID, ItemsetIndex, VisitIndex, FormID, SectionID, 
ItemsetID, ItemID, and five ControlIDs. Pivot target tables also contain a data label that can be used 
for data selection. The data label is specified in the Data Label custom property of the item. 

 

Target key type Pivot set components 

Pivot Patient PatientID and VisitIndex. 

Pivot Visit PatientID, VisitID, and VisitIndex. 

Pivot Form PatientID, VisitID, FormID, and VisitIndex 

Pivot Section PatientID, VisitID, FormID, SectionID, and VisitIndex 
 

 

Setting up a pivot table with CDD data mappings 
1 Create a data set (on page 195) for the target table. 

2 In the Properties Browser, select a Target Key Type value that begins with Pivot, and press Enter. 

3 Create a data series (on page 198) for each column in the target table. 

4 In the Properties Browser, select True as the value of the Pivot Column property for the data series 
to use as the pivot column, and press Enter. 

5 For each text data series, in the Properties Browser, specify the maximum length of the target 
column as the value of the Target Column Max Length property, and press Enter. 

For more information, see CDD mapping properties (on page 470). 
 

CDD data mappings for date time items 
You can set up CDD data mappings for date time items so that: 

• The entire date appears in a single database column in the CDD. 

• Each date time part appears in a separate database column in the CDD. The data mappings that 
the Central Designer application generates include the SPLITDATE attribute of the 
TARGETCOLUMNTYPE tag. 

 

Modifying CDD date time part data mappings 
1 In the Project Explorer, select a data series.  

The Data Series Editor appears. 

2 Right-click an item, and select Modify data point date part. 
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The Date-Time Data Point dialog box appears. 

3 Select one of the following: 

• All in one column—Changes the data mapping from multiple columns to one column. 

• Split columns—Changes the data mapping from one column to a column for each date time 
part. 

4 Click OK. 
 

CDD data mapping setup for date time items 
The following table describes how to set up the mappings in a CDD data mapping definition. 

 

CDD database result Data series and mapping setup 

Entire date appears in a DATE 
database column. 

• Map the date time item to a data series with a type of 
Date Time. 

Entire date appears in a TEXT 
database column. 

1 Map the date time item to a data series with a type of 
Text. 

2 In the Date-Time Data Point dialog box, select All in one 
column, and click OK. 

Each date time part appears in a 
separate TEXT database column. 

1 Map the date time item to a data series with a type of 
Text. 

2 In the Date-Time Data Point dialog box, select Split columns, 
and click OK. 

Each date time part appears in a 
separate INTEGER database 
column. 

• Map the data time item to a data series with a type of 
Integer. 

The Central Designer application creates a separate 
column mapping for each date time part. 

 
 



Chapter 5  Designing data mappings  
 

214 Oracle® Health Sciences Central Designer 2.1.2 

CIS data mappings 

How data mappings are deployed to Clintrial study objects 
When you create a deployment package and choose one or more data mappings to use to create CIS 
data mappings: 

• Each data set becomes a panel, and each data series becomes an item in the panel.  

• A custom data dimension on a data set is mapped to the Subset Item in the Clintrial application. 
Only one custom data dimension is supported for each data set.  

• The Panel Type is defined by the value of the Panel Type CIS custom property on the data set. 

• Other panel and panel item attributes are defined by the values of CIS custom properties on the 
study event, form, data set, and data series. 

• Only normalized values mapped to the Clintrial application. 
 

CIS data mappings and Clintrial subsets 

About Clintrial subsets 
In the Clintrial application, subsets provide a way to group similar items together in a page section. A 
subset page section can occur multiple times on a study page in a Type 0, Type 2, or Type 4 panel, 
with each different value of a subset key item representing distinct rows (subsets) of data. Each 
occurrence of a subset page section constitutes a separate observation. 

You might want to set up data mappings for a subset if both of the following are true: 

• Your InForm study collects identical data items on multiple forms (for example, lab test results 
for different body systems). 

• You want to store the data in a single panel in the Clintrial application. 

For example, in the Medika-Clinical sample study in the Clintrial application, the LABLNG page 
template has subset page sections for blood chemistry (LABCHEM), hematology (LABHEM), and 
urinalysis (LABURN). Each of these sections is made up of the same panel items, including the 
subset key item TEST_TYPE. The value of TEST_TYPE distinguishes the type of lab test 
represented by each subset of lab data. 
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Subset keys and subset values in the Central Designer application 
When subsets are used in the Clintrial application, one item in a panel is designated as the subset key 
item. The value of the subset key item determines the record in which to store a set of subset data.  

In the CIS data mappings generated by the Central Designer application: 

• The panel (CTPanel) data mapping identifies the subset key item. The Central Designer 
application obtains the name of the subset key item from the name of a custom dimension 
defined on a data set. An unmapped item with the name of the custom dimension is added to the 
data mappings for the panel and becomes a column in the panel when synchronized to the 
Clintrial application. 

• The item (CTItem) data mappings hold the subset value (the value of the subset key item). The 
Central Designer application obtains the subset value from the custom dimension label that you 
associate with an item when you map it to a data series within the data set. 

 

Setting up data mappings for a Clintrial subset 
1 Create a data set (on page 195) for the panel that contains the subset, and: 

a In the Custom Data Dimensions section of the Data Set Properties dialog box, add a custom data 
dimension for the subset key item. 

The name of the custom data dimension becomes the name of the subset key item in the 
data mappings and in the Clintrial panel. This name must not be the same as the RefName 
or alias of any data series in the data set. 

b In the Custom Dimension Labels - Select Codelist dialog box, select or create a codelist that has a 
codelist item label for each value that the subset key item can have. 

2 Create a data series (on page 198) for each item in the subset. 

3 Add the items (on page 199) that participate in the subset to the appropriate data series. 

The Select Custom Dimension dialog box appears. 

4 In the Select Custom Dimension dialog box for each item: 

a Select the custom data dimension you created for the subset key item. 

b In the Labels column, select the label that corresponds to the subset key item value with 
which the item will be stored in the Clintrial application.  

c Click OK. 
 

Block keys and page keys in CIS data mappings 
Block keys are identifiers for Clintrial blocks, which correspond to Central Designer study events and 
InForm visits. Page keys are identifiers for Clintrial pages, which correspond to Central Designer and 
InForm forms. All data that is synchronized to the Clintrial application must have a block key and a 
page key associated with it. The context panel in a Clintrial study contains items that hold the values 
of the block key and page key. These items are called the block key item and the page key item. 

In the Central Designer application, the data series in the data set that marked as the context panel 
(the value of the Panel Type custom property is Context Panel) identify the block key item and the 
page key item. 
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How block key values are assigned 
Any of the following definitions can be used as the value of the block key item: 

• By default, the RefName of the study event. 

• If the RefName of the study event contains a double underscore (for example, Week2__21), the 
value that follows the double underscore. 

• The Block Key Value custom property for the study event. If a value is specified for the Block 
Key Value custom property, that value overrides the block key value formed from all or a part of 
the RefName. 

For common visits, the value of the Shared Form Block Key custom property on the study design 
becomes the value of the block key in data mappings for the internal visit definition (the 
CommonCRF visit) that the InForm application requires for common forms. 

The resulting block key value must conform to the specifications of the data series for the block key 
item in the context panel: 

• The data type must convert to a compatible data type. 

• The length must be within the length specified in the DB Format Length CIS custom property. 

• If the data type of the data series is float, the precision must be within the precision specified in 
the DB Format Float Precision CIS custom property. 

For example, validation fails if: 

• The block key value is First but the block key item has a type of Integer. 

• The block key value is 99 but the page key item has a Length of 1. 
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How page key values are assigned 
Any of the following definitions can be used as the value of the page key item: 

• By default, the RefName of the study form. 

• If the RefName of the study form contains a double underscore (for example, Hema__21), the 
value that follows the double underscore. 

• The Page Key Value custom property for the study form. If a value is specified for the Page Key 
Value custom property, that value overrides the page key value formed from all or a part of the 
RefName. 

The resulting page key value must conform to the specifications of the data series for the page key 
item in the context panel: 

• The data type must convert to a compatible data type. 

• The length must be within the length specified in the DB Format Length CIS custom property. 

• If the data type of the data series is float, the precision must be within the precision specified in 
the DB Format Float Precision CIS custom property. 

For example, validation fails if: 

• The page key value is First but the page key item has a type of Integer. 

• The page key value is 99 but the page key item has a Length of 1. 
 

CIS data mappings for specialized Clintrial panels 
The setting of the Panel Type CIS customized property for data sets determines how data mappings 
are generated for specialized Clintrial panels. 

 

Panel Type 
value 

How panel is used What is included in CIS data mappings 

Context Contains context items, 
which are included in every 
record in a clinical data 
table. The context items 
form the primary key of 
the clinical data record. 

• If selected—Custom context panel made up 
of the items that are mapped to the data series 
in the data set.  

• If not selected (default)—Default context 
panel created during deployment. 

For more information, see MedML definition 
of the default context panel (on page 219). 

Note: A data mapping can have only one data set 
with a Context panel type. 
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Panel Type 
value 

How panel is used What is included in CIS data mappings 

Enrollment Contains screening and 
enrollment data for each 
study subject. The Clintrial 
application does not use 
separate records for 
screening and enrollment 
data. 

• If selected—Custom enrollment panel made 
up of the items that are mapped to the data 
series in the data set. The data mappings for 
the custom enrollment panel exist only in the 
data mapping where the data set is defined. 

• If not selected (default)—Enrollment panel 
made up of: 

 The items in the combined screening and 
enrollment forms in the study design, if 
they exist. 

 The items in the combined default 
screening and enrollment forms generated 
by the Central Designer application, if the 
forms are not defined in the study design. 

The data mappings for either version of the 
default enrollment panel are included in the 
mappings for all data mappings for a study. 

Non-Patient 
Data 

Contains data that is not 
related to a particular 
subject or visit, such as 
standard coding 
thesauruses, view codelists, 
or laboratory normal 
ranges. 

If selected, the Central Designer application 
generates data mappings for a non-patient data 
panel that has a column for each data series in the 
data set. 

Note: The data series in a non-patient data set 
must not have any items mapped to them. 

 
 

Creating a custom Clintrial context panel 
1 Create a data set (on page 195) for the context panel. 

2 Create a data series (on page 198) for each context item.  

3 In the Properties Browser, set the values of custom properties for the data set and each data series, 
and press Enter. 

4 Optionally, map items to the data series (on page 199). 

If you do not map specific items to a data series, the values of the key items are derived from the 
control path of each InForm transaction as it is processed. 

Note: The validation process checks the design of a custom context panel for compliance with 
Clintrial design rules. However, the Central Designer user interface does not enforce similar 
checking. Therefore, make sure that your definition of a custom Clintrial context panel does not 
violate Clintrial design considerations (on page 220). 
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Creating a Clintrial enrollment panel 
1 Create a data set (on page 195) for the enrollment panel. 

Note: Master-detail relationships are not supported in enrollment panels. If the Detail Key 
Item, Detail Panel, Master Item, or Master Panel CIS custom properties have values in the data 
set for an enrollment panel, validation fails. 

2 In the Properties Browser, set the value of the Panel Type CIS custom property to Enrollment, and 
press Enter. 

3 Create a data series (on page 198) for each screening or enrollment item to include in the 
panel. (The Clintrial application does not have a separate panel for screening and enrollment 
data.) 

4 Add items to the data series (on page 199). 
 

Creating a non-patient data (Type 0) panel 
1 Create a data set (on page 195) for the non-patient data panel. 

Note: Master-detail relationships are not supported in non-patient data panels. If the Detail 
Key Item, Detail Panel, Master Item, or Master Panel CIS custom properties have values in the 
data set for a non-patient data panel, validation fails. 

2 In the Properties Browser, set the value of the Panel Type CIS custom property to Non-Patient 
Data, and press Enter. 

3 Create a data series (on page 198) for each item to include in the panel. 

Note: Do not map items to any of the data series in the panel. 

 

MedML definition of the default context panel 
If you do not create a data set as a custom context panel definition, the Central Designer application 
generates the following context panel definition during deployment: 

 <CONTEXTPANEL REFNAME="CISLS2"> 
 

<CTITEM REFNAME="PATNUM" ITEMDATATYPE="TEXT" ISREPEAT="false" 
ISREQUIRED="true"  
DBFORMAT="VARCHAR2(20)" CONTEXTTYPE="1" ISKEY="true" /> 
<CTITEM REFNAME="VISITID" ITEMDATATYPE="TEXT" ISREPEAT="false" 
ISREQUIRED="true"  
DBFORMAT="VARCHAR2(20)" CONTEXTTYPE="2" ISKEY="true" /> 
<CTITEM REFNAME="FORMID" ITEMDATATYPE="TEXT" ISREPEAT="false" 
ISREQUIRED="true"  
DBFORMAT="VARCHAR2(20)" CONTEXTTYPE="3" ISKEY="true" /> 
<CTITEM REFNAME="VISITINDEX" ITEMDATATYPE="FIXED" ISREPEAT="true" 
ISREQUIRED="false"  
DBFORMAT="NUMBER(38)" CONTEXTTYPE="2" ISKEY="true" /> 
<CTITEM REFNAME="FORMINDEX" ITEMDATATYPE="FIXED" ISREPEAT="true" 
ISREQUIRED="false"  

DBFORMAT="NUMBER(38)" CONTEXTTYPE="3" ISKEY="true" /> 
 
</ CONTEXTPANEL> 
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Design considerations for a custom context panel 
 

Design consideration Custom property settings Design rules 

Data set Panel Type—Context panel. A data mapping can have only one data 
set for which the Panel Type value is 
Context panel. 

Data series for:   

• Subject key item • Context Type—Subject-
related context item. 

• Is Key—True. 

• A context panel can have only one 
subject key item. 

• If the data type of the data series is 
Text, the value of the DB Format 
Length custom property cannot be 
greater than 80. 

• Block key item • Context Type—Visit-
related context item. 

• Is Key—True. 

A context panel can have only one block 
key item. 

• Page key item • Context Type—Page-
related context item. 

• Is Key—True. 

A context panel can have only one page 
key item. 

Data series for the 
following key items for 
repeating visits and 
forms: 

  

• Block repeat key 
(visit index) item 

• Context Type—Visit-
related context item. 

• Is Key—True. 

• Repeated—True. 

A context panel can have only one block 
repeat key item. 

• Page repeat key 
(form index) item 

• Context Type—Page-
related context item. 

• Is Key—True. 

• Repeated—True. 

A context panel can have only one page 
repeat key item. 



 InForm Design Guide  

Oracle® Health Sciences Central Designer 2.1.2 221 

Design consideration Custom property settings Design rules 

Additional data series Context Type—Other 
context item. 

Use for additional data points to be 
collected for every record. 

Note: Data series with a Context Type of 
Other context item are designed to be 
used in hybrid studies in which users can 
enter data using either the Clintrial or the 
InForm application. When you deploy a 
study that contains a data series with a 
Context type property of Other context 
item, the item definition for that data 
series is created in the Clintrial context 
panel, but the CIS application does not 
synchronize data from the InForm 
application to that context item. To enter 
data into a context panel item that is 
defined using the Other context item 
Context type property, users must use the 
Clintrial Enter module. 

Context Type custom 
property 

 • Must not be set to Not a Context 
Item for any data series in the context 
panel. 

• Must not be set to Other Context 
Item if the value of the Is Key 
property is True. 

Data series data type  • Must be Text, Fixed, or Float if the 
value of the Is Key property is True. 

• Must be compatible with the data 
type of the corresponding item in the 
Clintrial context panel, if the Clintrial 
context panel already exists. 

 
 

CIS data mappings for date time items 
You can set up CIS data mappings for date time items so that: 

• The entire data appears in a single database column in the Clintrial database. 

• Each date time part appears in a separate database column in the Clintrial database. To split data 
mappings for a date time item into date part components, you define a separate data series and 
mapping for each date part. The data mappings that the Central Designer application generates 
include the DATEPART attribute of the CTITEM tag. 
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CIS data mapping setup for date time items 
The following table describes how to set up a CIS data mapping. 

 

Clintrial database result Data series and data mapping setup 

Entire date appears in a DATE database 
column. The DATE data type corresponds to 
the Oracle DATE database format. 

1 In the Item Editor for the date time item, select 
the Required and Allowed checkboxes for each 
date part. 

2 Map the date time item to a data series with a 
type of Date Time. 

Entire date appears in a DATETIME database 
column. The DATETIME data type 
corresponds to the Oracle DATE database 
format. 

1 In the Item Editor for the date time item, select 
the Required and Allowed checkboxes for each 
date and time part. 

2 Map the date time item to a data series with a 
type of Date Time. 

Entire date appears in a TEXT database 
column. The TEXT data type corresponds to 
the Oracle VARCHAR(n) format. 

1 Map the date time item to a data series with a 
type of Text. 

2 In the Date-Time Data Point dialog box, select All 
in one column, and click OK. 

Each date time part appears in a separate 
TEXT database column. The TEXT data type 
corresponds to the Oracle VARCHAR(n) 
format. 

1 Map the date time item to a data series with a 
type of Text. 

2 In the Date-Time Data Point dialog box, select 
Split columns. 

3 In the CIS Date Part list, select the date time 
part to map, and click OK. 

4 Repeat these steps for each date time part. 
Place each date time part in a different data 
series. 

Each date time part appears in a separate 
FIXED database column. The FIXED data 
type corresponds to the Oracle NUMBER(n) 
database format. 

1 Map the date time item to a data series with a 
type of Integer. 

2 In the Date-Time Data Point dialog box, select 
Split columns. 

3 In the CIS Date Part list, select the date time 
part to map, and click OK. 

4 Repeat these steps for each date time part. 
Place each date time part in a different data 
series. 
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Modifying CIS date time part data mappings 
1 In the Project Explorer, select a data series.  

The Data Series Editor appears. 

2 Right-click an item, and select Modify data point date part. 

The Date-Time Data Point dialog box appears. 
 

Action Steps 

Change the data mapping from multiple 
columns to one column. 

• Select All in one column. 

Change the data mapping from one 
column to a column for each date time 
part. 

1 Select Split Columns. 

2 In the CIS Date Part list, select the date time 
part to map. 

 

3 Click OK. 
 

CIS data mappings for unmapped items and no items in a data series 
A data series can have mapped items, unmapped items, or no items. When generating CIS data 
mappings, the Central Designer application processes data series with unmapped items and data 
series with no items as follows: 

• Unmapped items—The Central Designer application generates the panel mappings for the data 
set where the data series is created. The item mappings for the panel have no control path 
specifications. 

• No items—The Central Designer application does not generate mappings for the data series. If 
none of the data series for a data set have any items, the Central Designer application does not 
generate a panel mapping for the data set. However, note the following exceptions: 

• Enrollment panel—The Central Designer application always generates mappings for the 
Clintrial enrollment panel. If a data set for a custom enrollment panel does not exist, the 
enrollment panel mappings are made up of: 

• The items in the combined screening and enrollment forms in the study design, if they 
exist. 

• The items in the combined default screening and enrollment forms generated by the 
Central Designer application, if the forms are not defined in the study design. 

• Non-patient data panel—If a data set has a Panel Type property value of Non-Patient 
Data, the data series have no items by definition. The Central Designer application generates 
mappings for a non-patient data panel and does not generate item mappings. 

• Derived item—If a data series in the data set has a Derived property value of True, the 
Central Designer application generates an item mapping with no control path. 
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About layouts and the Layout tab 
 

Characteristic Description 
Locales and 
translation 

Every layout supports all locales. You do not need to create a unique layout 
for every form and locale in the study. Use the Locales drop-down list on the 
toolbar in the Layout tab to switch between locales and provide translations. 

For more information, see: 

• Translating text in the Layout tab (on page 254). 

• Previewing a locale (on page 254). 

Styles and 
inheritance 

Styles specified for the study, individual forms, and individual controls 
determine the appearance of each layout.  

For more information, see About styles and inheritance (on page 227). 

Creating and 
deleting 

You can create and delete layouts, and you can reset an existing layout to use 
the styles of another layout for a form. 

Automatic 
refreshing 

The Layout tab automatically refreshes its display after you change the 
structure of a form. For example, the layout refreshes after you add or delete 
an item, codelist, or codelist item; reorder items; or mark an item as 
conditional or not conditional. 

If you modify an item layout, the changes are not propagated to the form 
unless you reset the form layout. Similarly, if a compound item has an item 
layout and one of its child items also has an item layout, changes to the child 
item's layout are not propagated to the layout for the compound item unless 
you reset or create the layout for the compound item.  

Note: If a form contains a compound item with an item layout, and the 
compound item has a child item with an item layout, the form reads only the 
item layout from the compound item. 

Primary layouts Every layout requires a primary layout, or validation fails. An icon on the tab 
that contains the name of the layout (at the bottom of the Layout tab) 
indicates the primary layout. 

For more information, see Setting the primary layout for a study (on page 
5). 

Deployment options When you create a deployment package, an additional page appears if the 
study contains one or more new layouts. The page, called Select Layouts, 
appears after the Select Locales page. On the page, you choose the layout to 
deploy. If the layout does not exist for a form, the primary layout for the 
form is deployed instead. 

For more information, see Creating a deployment package (on page 288). 

Note: The rendering of content in the Layout tab is not an exact 
representation of the appearance of content in the InForm application. 

Importing When you import a study for which study styles have been set, the styles in 
the imported study overwrite the study styles in the existing study. 
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About styles and inheritance 
Two factors determine the appearance of a layout, the data design of the form and the styles that are 
defined on the study, form, or controls. Styles are inherited in the following way: 

• Study styles apply to all forms and items in the study. For studies created in release 1.3 or later, 
study styles are created when the study is created. For studies created in release 1.2 or earlier, 
study styles are created with default values the first time that you create or convert a layout. A 
change to the study styles is immediately reflected in all forms that inherit the study styles. 

• Form styles override study styles and apply to all layouts for a form. 

• Control styles override form and study styles for one control only. Keep in mind that some 
items, such as compound items, contain multiple controls. If you modify a control style, only the 
selected control is changed. 

You set study styles in the Study Styles dialog box, and you set form styles in the Form Styles dialog 
box. The options in both dialog boxes are identical, except the Form Styles dialog box contains 
Inherit checkboxes for all options. If you select Inherit for an option, the value that is set in the study 
styles is automatically applied in the form styles. This option simplifies the process of overriding 
study styles because you can leave Inherit selected for all options except those that you want to 
override. 

Styles can significantly reduce the time that you spend customizing a layout because you can set a 
style, such as caption alignment, in the study styles once, and all captions use the alignment. For 
example: 

• To align all captions on a form in the same way, you can provide a value in the form styles. 

• To align all captions on a form differently, you can provide a different value for each control in 
the control styles.  

You can set most settings in the study, form, and control styles only, with the following exceptions:  

• Specifying the question width for a specific layout (on page 245). 

• Specifying the year range for a single date time item (on page 247). 

• Specifying the display override status of a single item (on page 248). 
 

Editing the appearance of layouts using study, form, and control styles 
The appearance of a layout is determined by study, form, and control styles. For more information, 
see About styles and inheritance (on page 227). 

To edit study styles: 

1 Select Tools > Edit Study Level Styles. 

Note: You can also open the Study Level Styles dialog box from the Form Styles dialog box, 
using the Edit Study Level Styles button in the lower-left corner. 

The Study Level Styles dialog box appears.  

2 Edit the fields as necessary. For more information, see Study Level Styles and Form Level 
Styles dialog boxes—Option descriptions (on page 398). 
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To edit form styles: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 Select a form, and select the Layout tab. 

3 On the toolbar, click Edit Styles.  

The Form Level Styles dialog box appears. 

4 Edit the fields as necessary. For more information, see Study Level Styles and Form Level 
Styles dialog boxes—Option descriptions (on page 398). 

To edit control styles: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

or 

In the Project Explorer, select the Items Explorer bar. 

2 Select a form or item, and select the Layout tab. 

3 Double-click a control. Controls appear in the right column of a layout.  

or 

Right-click a control, and select Edit Control Styles. 

The Control Styles dialog box appears. 

4 Edit the fields as necessary. For more information, see Control Styles dialog box—Option 
descriptions (on page 394). 

 

Adding and removing names for layouts 
A layout name is global for a study, and you can use it once for each form in a study. Layout names 
are case-insensitive; for example, you cannot have two layout names called ABC and abc. You can 
add a name for a layout: 

• When you create the layout. 

• At any time using the Layout Names dialog box. 

You can remove the name of a layout at any time, even if the name of the layout is used in the study 
or library. However, you can no longer deploy layouts with the name, and you cannot use the name 
for new layouts that you create 

Note: You cannot remove the Main layout name. By default, this name is used as the name of the 
primary layout, though you can change the name of the primary layout. 

1 Select Tools > Layout Names Manager. 

The Layout Names Manager appears. 

2 To add a layout name, click Add, type the name of the layout, and click OK. 

To remove a layout name, from the list of layout names, select a layout, and click Remove. 

3 Click OK. 
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Restricting the text that an InForm user can type in a text field 
You can restrict the text that an InForm user can type for a text item without a codelist.  

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

or 

In the Project Explorer, select the Items Explorer bar. 

2 Select a form or item, and select the Layout tab. 

3 Do one of the following: 

• To set the option in the study styles—Select Tools > Edit Study Level Styles, and on the left, 
select Text Item. 

• To set the option in the form styles—On the toolbar, select Edit Styles, and on the left, select 
Text Item. 

• To set the option in the control styles—Right-click a text control without a codelist, and 
select Edit Control Styles, then select the Advanced tab. 

4 Under Character set restriction, select one of the following options: 

• Unrestricted (Default)—Do not restrict the entry of values in text fields without codelists. 

• ASCII Only—In release 5.0 and later of the InForm application, restrict the entry of values 
in text fields without codelists to the complete ASCII character set (byte range 0 to 127). 
Items with restricted values are marked with a star () in the Annotated Study Book. 

5 Click OK. 
 

Removing a layout 
You can delete any layout, including the primary layout. If you delete all layouts for a form, the 
Layout tab displays the initial work area with the Create Layout button.  

All text strings, including captions, notes, section titles, form titles, and codelist item label overrides, 
are saved until you delete the last layout for a form, even if you created the text strings on a layout 
that you then deleted. However, after you delete the last layout for a form, all of the text strings that 
you created for the form in the Layout tab are deleted. Questions are not deleted, even if you delete 
the last layout for a form.  

Note: If someone removes the primary layout, you can recreate it. For more information, see 
Creating a layout for a form or item (on page 233). 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

or 

In the Project Explorer, select the Items Explorer bar. 

2 Select a form or item, and select the Layout tab. 

3 If the layout is in the old format, convert it. For more information, see Converting layouts (on 
page 231). 

4 On the toolbar, select Layouts > Remove Layout. 
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The Remove Layout dialog box appears.  

5 From the Layout name drop-down list, select the name of the layout to delete, and click OK. 
 

Resetting a layout 
When you reset a layout, all control styles that you have set for the controls on the form are 
discarded. All styles in the Control Styles dialog box are modified to inherit the settings from form 
styles and study styles.  

Note: Text strings in the layout, including captions, notes, section titles, form titles, and codelist 
item label overrides, are not affected when you reset.  

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

or 

In the Project Explorer, select the Items Explorer bar. 

2 Select a form or item, and select the Layout tab. 

3 On the toolbar, select Layouts > Reset Layout. 

The Reset Layout dialog box appears. 

4 From the Layout to reset drop-down list, select the name of a layout. 

5 Select one of the following options: 

• Recreate layout using form-level styles and item layouts (if any)—Recreate the layout 
using the form styles and existing item layouts. 

• Replace all control styles with the styles from the following layout—Recreate the 
layout using the form styles (which might inherit styles from the study styles) from another 
layout for the same form. If you select this option, existing item layouts are not used to 
recreate the layout.  

If you select this option, select a layout from the drop-down list. 

6 Click OK. 
 

Renaming a layout 
When you rename a layout, you can choose from existing layout names or provide a new name. You 
cannot choose a layout name that is already used for the form. You rename a layout for a single form 
or item only. 

Note: If you rename the primary layout, the layout is no longer the primary layout because the 
name of the layout determines whether it is the primary layout. You must set a primary layout for 
every layout in the new format, or validation will fail. 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

or 

2 In the Project Explorer, select the Items Explorer bar. 

3 Select a form or item, and select the Layout tab. 
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4 On the toolbar, select Layouts > Rename Layout. 

The Rename Layout dialog box appears. 

5 From the Layout to rename drop-down list, select a layout.  

6 From the New layout name drop-down list, do one of the following: 

• To use a new layout name, select New, and type a name for the layout. The name is added to 
the list of registered names for the study, and you can select it from the drop-down list. 

• To use an existing name, select it from the drop-down list. The list includes all of the study's 
registered names that have not been used for the form or item. 

 

Undoing and redoing an action in a layout 
You can undo every action that you perform in the Layout tab. You can redo an action that you have 
undone.  

Note: You can undo the conversion of an individual layout. However, you cannot undo the 
conversion of all layouts in a study or library. 

To undo an action: 

• After performing an action in the Layout tab, do one of the following: 

• On the toolbar, click Undo. 

• Press Ctrl+Z. 

• Select Edit > Undo. 

To redo an action: 

• After undoing an action in the Layout tab, do one of the following: 

• On the toolbar, click Redo. 

• Press Ctrl+Y. 

• Select Edit > Redo. 
 

Converting layouts 
Optionally, you can convert layouts that were created in release 1.2 and earlier. 

Note: Before converting all layouts in a study, instruct all other users to exit the application. 
Converting all layouts locks all forms and items in the study or library. 

To convert all layouts: 

1 Open a study or library. 

2 Select Tools > Convert Layouts. 

The Convert Layouts dialog box appears, allowing you to specify how the layouts should be 
converted. Select one of the following options, and click Convert. 

• Convert the layout for one locale, rename it to [name of primary layout], and set it as 
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the primary layout. 

The names of other layouts are discarded, but the translations are saved. You can view them 
in the Layout tab by using the Locale drop-down list on the toolbar. If you have not explicitly 
chosen a primary layout, the primary layout is named Main. 

The layout that you convert, the primary layout, is renamed to the name of the primary 
layout for the study.  

• Convert all layouts, and set one layout as the primary layout. 

All translations are saved and viewable from all of the layouts by using the Locale drop-down 
list on the toolbar.  

Optionally, to rename the primary layout to the name that is currently selected as the primary 
layout, select Rename the primary layout to [name of primary layout]. If you have not explicitly 
chosen a primary layout, the primary layout is named Main. 

The status of the conversion appears under Conversion results. 

Note: If an item is locked by another user, it does not convert. If an item fails to convert, you 
can convert the layouts in the study again. 

3 After the conversion is complete, click Close. 

To convert the layouts for a single form or item: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

or 

In the Project Explorer, select the Items Explorer bar. 

2 Select a form or item, and select the Layout tab. 

If the layout was created in release 1.2 or earlier, a note below the toolbar indicates that the 
layout is read-only and that you must convert it before you can modify it. 

3 Click Convert Layout. 

4 If the study supports a single locale, the layout is converted and is set as the primary layout. 

If the study supports multiple locales, all the layouts are converted, and the following occurs:  

• If you have not yet converted any layouts in the study, you are prompted to choose the 
layout to set as the primary layout.  

• If you have converted one or more layouts in the study, the layout with the same name as 
the primary layout is set as the primary layout. 

Note: The first layout that you create for a form is given the name of the primary layout. 
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About layout design 

Creating a layout for a form or item 
Every layout requires a primary layout, or validation fails. An icon on the tab that contains the name 
of the layout (at the bottom of the Layout tab) indicates the primary layout. A layout name is global 
for a study, and you can use it once for each form in a study. Layout names are case-insensitive; for 
example, you cannot have two layout names called ABC and abc. You can add a name for a layout: 

• When you create the layout. 

• At any time using the Layout Names dialog box.  

To create a layout for a form or item without any layouts: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

or 

In the Project Explorer, select the Items Explorer bar. 

2 Select a form or item, and select the Layout tab. 

If a layout has not been created, the Create Layout button appears in the workspace. 

3 Click Create Layout.  

To create a layout for a form or item with one or more or more layouts: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

or 

In the Project Explorer, select the Items Explorer bar. 

2 Select a form or item, and select the Layout tab. 

3 On the toolbar, select Layouts > Create Layout. 

The Create Layout dialog box appears. 

4 Do one of the following: 

• To use an existing layout name, select the name from the Name of new layout drop-down list. 
The list includes all of the study's registered names that have not been used for the form or 
item. The list includes the primary layout if it does not exist for the form or item. 

• To use a new layout name, select New, and type a name for the layout. The name is added to 
the list of registered names for the study, and you can select it from the drop-down list. 

Note: Registered names enforce the selection of the correct layout name.  

5 From the Initialize styles from the following layout drop-down list, select a layout. The layout is 
copied and named according to the name that you provide. 

6 Click OK. 
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Ease of use and navigation in the Layout tab 
The Layout tab provides several visual cues to help you navigate and modify a layout. 

• A toolbar contains many of the most commonly performed actions, including managing 
controls. Also available from the right-click menu, the actions include the following: 

• Caption alignment. 

• Control orientation. 

• Control type. 

• The Layout tab provides visual cues that indicate the caption or control that you are pointing to 
or have selected. For example, a selectable area becomes highlighted when you point to it. 
Additionally, when you point to a control, a tooltip appears, identifying the item that is 
associated with the control. The tooltip includes relevant information for the control, such as 
RefName, Display Override settings, and control styles. A dotted line around a control indicates 
that it is hidden.  

• You can navigate through the Layout tab using the arrows on the keyboard, and you can perform 
all actions using the keyboard. 

• The Layout tab displays either the titles or RefNames of study objects, depending on your Display 
Names Using selection in the Project Explorer. 

 

About creating site-specific layouts 
A layout supports every locale in a study; however, you can change only the text strings in each 
layout. If you need different control styles for a specific locale, you must create a new layout. 
Creating a new layout is necessary if, for example, you cannot ask a question at a particular site. 
Consider using the following workflow to deploy the correct layouts for your study. 

1 Set the primary layout for the study, and make sure that a primary layout exists for every form in 
the study, even the forms for which you have to hide one or more questions for a specific locale.  

2 For the form that contains the question that you cannot ask at a site, create a new layout. For 
example, you might call the layout Hidden Question. This form still requires a primary layout, 
even though you will not deploy it. 

3 In the Hidden Question layout, select the locale for the site that does not allow the question, 
and hide the question.  

4 Create additional layouts called Hidden Question for any other forms that must not ask certain 
questions for the site.  

5 When you create a deployment package, choose the Hidden Question layout as the layout to 
deploy. 

The Hidden Question layout is deployed for all forms that have it. For all other forms, the 
primary layout is deployed. 
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Form previews 
You can generate and print a preview of a form, showing how it will appear when deployed to the 
target application. In a form preview, the layout of questions and controls is different for a regular 
form and a repeating form or section: 

• Regular form—Questions and controls are laid out vertically. 

• Repeating form or section—Short titles for the questions are arranged horizontally across the 
top of the preview, and the questions and controls are laid out vertically. 

• Fixed repeating section—The preview for a fixed repeating section contains two views. 

Grid landscape view—Short questions for top-level items are arranged horizontally across 
the top of the preview, and the labels for codelist items are laid out vertically for each fixed 
item. 

In the grid landscape view, blank cells have a gray background. 

• Portrait view—Short questions for top-level items are laid out vertically, and the labels for 
codelist items are laid out horizontally for each fixed item. 

You can generate a form preview with or without annotations.  

Notes:  

• The form preview feature of the Layout tab allows you to view a preview of one form at a time. 
To view a preview of all forms in a study, you can generate an annotated study book. 

• In the Annotated Study Book and Form Preview window, if a row contains many components, 
the browser that displays the page might wrap text to fit all components onto the page. 
Consequently, for Asian languages, a wrapped text label might appear to have vertical 
orientation, with a single character on each line, because the browser wraps text on a word 
boundary, and a single character can represent a word. To compensate, you can make the 
question portion of the row smaller so the labels in the control section are wide enough not to 
wrap. 

 

Annotated form previews 
The options that are selected for an annotated study book determine the information that appears in 
the annotated preview of a form. 

 

Annotated Study 
Book option 

What appears in the annotated preview of a form 

Inline CRF 
annotations 

• If selected—The annotations described below.  

• If not selected—Titles or RefNames that appear in square brackets. 

The annotated forms display RefNames if Show Object RefNames is 
selected and titles if Show Object RefNames is not selected. 
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Annotated Study 
Book option 

What appears in the annotated preview of a form 

Item formats • Text—A plus maximum character length (for example, A128). 

• Integer—N plus maximum field length (for example, N3). 

• Float—Significant digits and decimal places. The decimal point is 
included as a character in the length of an item. For example, if the 
length of a float item is 5 and the precision is 0, the annotation appears 
as xxxx. (the decimal point appears).  

Captions on 
compound items 

A caption for the parent item of a compound item appears with the 
alignment specified on the Layout tab. 

Hidden, 
ReadOnly, or 
Editable display 
overrides 

The word hidden, read-only, or editable appears in square brackets below 
the item question. 

Minimums and 
maximums for 
integer and float 
items 

Specifications set in the MinProperty, MinValue, MaxProperty, and 
MaxValue item properties are represented as values and operators and listed 
along with the item format. For example, the notation is 2.0 <= xx.xx < 
100.0 if: 

• MinProperty—GREATERTHANEQUAL 

• MinValue—2.0 

• Float length—5 

• Float precision—2 

• MaxProperty—LESSTHAN 

• MaxValue—100.0 

Date time items Required and unknown specifications appear in the date and time controls, 
and year ranges appear in parentheses following the controls. 

Date format The date format that you select in the Select date variable format field 
appears in parentheses before the controls. 

Required items An asterisk appears after the item number. In the grid view of fixed repeating 
sections, an asterisk appears in the column header for each required item. 

Items that 
require source 
verification 

For an item in a form or non-repeating section, a check mark appears under 
the item number. 

Repeating 
sections that 
require source 
verification 

A check mark appears in the following locations: 

• For a repeating section—Under the number in the repeating section 
header row. 

• For a fixed repeating section—Under the # symbol in the fixed-item 
section header. 
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Annotated Study 
Book option 

What appears in the annotated preview of a form 

Forms and items 
that are critical 
for source 
verification 

For an item in a form or non-repeating section, a check mark inside a circle 
appears under the item number. 

For a form, a check mark inside a circle appears to the right of the form 
name. 

Forms and items that are source-verification critical are also source-
verification required, so these forms and items show only the check mark 
inside the circle and not an additional check mark denoting their source-
verification required status. 

A footnote indicates that settings for critical source verification that are made 
in the InForm application override settings made in the Central Designer 
application. 

Collapsible 
items 

A collapsible item icon ( ) appears after the item RefName. 

Note: In the InForm application, a collapsible item is called a dynamic 
control. 

Key items A key icon appears under the item number. 

Base units A superscript b in square brackets appears to the right of the control for the 
base unit. 

Repeating forms 
and sections 

A summary item layout containing top-level items appears (for example, the 
children of compound items and conditional items do not appear), followed 
by a form layout. 

Fixed repeating 
sections 

A fixed item icon ( ) appears after the item number. 

The following views appear: 

• Grid view containing a column for each top-level item and, for each 
fixed item, a row for each combination of item and codelist items. 
Depending on the definitions that exist in the study, column headers 
show the short question in the specified locale, the long question in the 
specified locale, or an empty cell. 

 For a hidden item, the text in the column header is grayed out.  

 The cell for a blank instance of a fixed or non-fixed item is grayed 
out and includes a blank icon ( ). 

• Data entry preview containing controls for each fixed item.  

Associated 
forms 

The name of the associated form, if it exists, appears at the bottom of the 
annotated form. 
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Annotated Study 
Book option 

What appears in the annotated preview of a form 

Codelist Values and 
Tables 

Annotations on the form for codelist controls that are formatted as radio 
buttons or checkboxes. The data type and value appears in square brackets 
and italic font to the left of each option (for example, [N:1] indicates an 
integer data type and a codelist item value of 1). Data types are: 

• A—Text 

• F—Float 

• N—Integer  

Additionally, this section includes a table that lists the specifications of each 
codelist and codelist item along with the title or RefName of the item with 
which they are associated. 

The table displays RefNames if Show Object RefNames is selected and 
titles if Show Object RefNames is not selected. 

Include All Codelist Control Types option: 

• If selected—The codelist table includes all codelist formats. 

• If not selected—The codelist table includes only codelists that are 
formatted as a drop-down list. 

Study Object 
Description Tables 

A table that lists the type (Form, Section, or Item), title or RefName, and 
description for the form and any sections or items that the form contains. 

The table displays RefNames if Show Object RefNames is selected and 
titles if Show Object RefNames is not selected. 

If Only Show Properties with Values is selected, the study object 
description table lists only study objects that have descriptions. 

Coding Summary 
Tables 

A table that lists verbatim, dictionary, coding item, and context item data for 
each item that is coded.  

The table displays RefNames if Show Object RefNames is selected and 
titles if Show Object RefNames is not selected. 

RDE Analytics 
Tables 

A table that displays the titles or RefNames, table column names, and data 
types that are generated in the InForm Reporting Database Extract (RDE) 
for each data object in a form. The format of each table column name 
consists of the RefName of the data object, concatenated with a suffix that 
depends on the data object type. 

The table displays RefNames if Show Object RefNames is selected and 
titles if Show Object RefNames is not selected. 

For more information, see RDE Analytics tables in the Annotated Study 
Book (on page 332). 
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Annotated Study 
Book option 

What appears in the annotated preview of a form 

Data Series 
Summary Tables 

A table that lists the following information for each data series: 

• Item number, based on the order of the item in the form. 

• Item title or RefName, depending on whether Show Object RefNames 
is selected. 

• Mapping RefName. 

• Data set alias if available, otherwise RefName. 

• Data series alias if available, otherwise RefName. 

• Data series type. 

Show Object 
RefNames 

• Uses study object RefNames, rather than titles, to identify study objects. 
The following areas are affected: 

• The RefName for a form or section is appended to the form or section 
title that is displayed in the annotated form header. RefNames are 
enclosed in square brackets.  

• Items are identified with RefNames. 

• Data tables that follow the annotated form use a column header of 
RefName instead of Title, and the column contains RefNames. 
However, the Data Series Summary Table always uses RefName to 
identify mappings and data sets, regardless of whether this option is 
selected. 

 
 

Choosing the default view for a fixed repeating section 
1 In the main application toolbar, select Tools > Options. 

The Options dialog box appears. 

2 In the Environment section, click Fixed Repeating Section. 

3 In the Default view type field, select one of the following: 

• Grid landscape—Short questions for top-level items are arranged horizontally across the 
top of the preview, and the labels for codelist items are laid out vertically for each fixed item. 

In the grid landscape view, blank cells have a gray background. 

• Portrait—Short questions for top-level items are laid out vertically, and the labels for 
codelist items are laid out horizontally for each fixed item. 
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Supported HTML formatting tags 
HTML formatting tags, including but not limited to the following examples, are supported in the 
InForm application when deployed from a Central Designer study. 

 

HTML tag Use 

<b ></b> Bold text. 

<br> Line break. 

<center></center> Centering text. 

<i></i> Italic text. 

<li></li> List items. 

<ol></ol> Numbered list. 

<p></p> Paragraphs. 

<pre></pre> Preformatted plain text, for example, computer output. 

<s></s> Strikethrough text. 

<strike></strike> Strikethrough text. 

<tt></tt> Monospace font. 

<u></u> Underlined text. 

<ul></ul> Bulleted list.  
 

 
 

Generating and printing a preview or annotated preview of a form 

Note: To print a form preview, you need the Adobe Acrobat PDF Distiller print driver. 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 Select a form, and select the Layout tab. 

If the layout is not generated, click Create Layout. 

3 To generate a preview: 

a Right-click a section header or the area below the layout table, and select Preview Form. 

or 

b On the toolbar, select Preview > Preview Form. 

The Preview Form window appears. 

4 To generate an annotated preview: 

a Right-click a section header or the area below the layout table, and select Preview Form. 

or 

b On the toolbar, select Preview > Preview Form. 
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The Preview Form window appears. 

5 To print the preview, click Print. 

The Microsoft Windows Print dialog box appears. 

6 Specify the printer and print options, and click Print. 
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Formatting questions and controls 

Editing and translating a question 
1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

or 

In the Project Explorer, select the Items Explorer bar. 

2 Select a form or item, and select the Layout tab. 

3 From the Locale menu on the toolbar, select a locale for which you want to edit or translate text. 

4 Right-click a question, and select Edit Question. 

The text of the question becomes editable. 

5 Type the question text, and press Enter. 
 

Creating, editing, translating, and removing a section note 
You can add section notes to the layouts for forms only.  

Note: For a form with multiple layouts, if you add or edit a section note or caption for a locale, the 
text is visible in all of the layouts. For example, if a study supports English and French, and you 
have two layouts, Layout1 and Layout2, both layouts support both English and French. If you edit 
a note or caption in Layout1 for the French locale, the note or caption is always visible in Layout2 
for the French locale.  

To create a note: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 Select a form, and select the Layout tab. 

3 Right-click a form or section header, and make sure that Section Note is selected. 

An editable note field appears below the header. 

To edit or translate a note: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 Select a form, and select the Layout tab. 

3 From the Locale menu on the toolbar, select a locale for which you want to edit or translate text. 

4 Double-click within the text field of a note. 

or  

Right-click the note, and select Edit Note. 

or  

Select the note, and on the toolbar, click Edit Text. 

The note becomes editable. 

5 Type the note, and press Enter. 
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To remove a note: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 Select a form, and select the Layout tab. 

3 Right-click a form or section header, and make sure that Section Note is not selected. 
 

Showing and hiding a section header 
A form can have multiple section headers. The top section header on a form contains the form title. 
An additional section header appears for each section on the form, and it displays the section title. 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 Select a form, and select the Layout tab. 

3 From the Locale menu on the toolbar, select a locale for which you want to edit or translate text. 

4 Right-click a section header or question, and view the selection of Section Header: 

• If Section Header is selected, the header is shown. 

• If Section Header is not selected, the header is hidden. A dashed line around the header 
indicates that the header is hidden. 

 

Editing and translating a form or section title 
1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 Select a form, and select the Layout tab. 

3 From the Locale menu on the toolbar, select a locale for which you want to edit or translate text. 

4 Right-click a section header or question, and make sure that Section Header is selected. 

5 To edit the section or form title, double-click the section header. 

or  

Right-click the section header, and select Edit Title. 

or 

Select the section header, and on the toolbar, select Edit Text. 

The text becomes editable.  

6 Type the new section or form title, and press Enter. 
 

Working with captions 
You can add a caption to every control. 

Note: For a form with multiple layouts, if you add or edit a section note or caption for a locale, the 
text is visible in all of the layouts. For example, if a study supports English and French, and you 
have two layouts, Layout1 and Layout2, both layouts support both English and French. If you edit 
a note or caption in Layout1 for the French locale, the note or caption is always visible in Layout2 
for the French locale.  
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To edit or translate a caption: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

or 

In the Project Explorer, select the Items Explorer bar. 

2 Select a form or item, and select the Layout tab. 

3 From the Locale menu on the toolbar, select a locale for which you want to edit or translate text. 

4 In the layout, select a control. 

5 Right-click a control, and select Edit Caption. 

or 

Select a control, and on the toolbar, click Edit Text. 

The Edit Caption dialog box appears. The name of the dialog box is appended with the name of 
the layout for which you are editing a caption. 

Note: You can also edit a caption in the Control Styles dialog box, which appears when you 
double-click a control. 

6 Type the caption. You can type up to 1000 characters. 

7 Click one of the following buttons: 

• Apply/Next—Apply the caption, and advance to the next control, so that you can edit its 
caption. The control for which you are editing a caption is outlined with a dotted black line 
on the Layout tab. 

• Apply—Apply the caption, and close the dialog box. 

To align a caption: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

or 

In the Project Explorer, select the Items Explorer bar. 

2 Select a form or item, and select the Layout tab. 

3 In the layout, select a control. 

4 On the toolbar, select Align Caption, and select Top, Left, Right, or Bottom, depending on where you 
want the caption to be placed in relation to the control. 

To remove a caption: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

or 

In the Project Explorer, select the Items Explorer bar. 

2 Select a form or item, and select the Layout tab. 

3 Right-click a control or section header with a caption, and select Remove Caption. 
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Editing and translating a codelist item label override 
You can override the label for a codelist item in a layout.  

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

or 

In the Project Explorer, select the Items Explorer bar. 

2 Select a form or item, and select the Layout tab. 

3 Right-click the control for codelist items, and select Edit Label Override. 

4 From the Codelist item drop-down list, select a codelist item. 

5 In the Label override field, type the new label for the codelist item. 

6 Click OK. 
 

Editing the size of a text box 
1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

or 

In the Project Explorer, select the Items Explorer bar. 

2 Select a form or item, and select the Layout tab. 

3 Right-click the control for a float, integer, or text control, and select Edit Textbox Size. 

The Textbox Size dialog box appears. 

4 To inherit the settings from the form styles (which might inherit from the study-level styles), 
select Inherit size. 

To override the form and study styles, deselect Inherit size, and provide the number of characters 
in the Width field and the number of lines in the Height field. 

5 Click OK. 
 

Editing the width of the question column 
The following procedure describes how to edit the width of the question column for an individual 
layout only. Additionally, you can set this information as part of the form and study styles (on 
page 398). 

Note: If the contents of the control column exceed the specified width, the page might not display 
in the InForm application as you specify. For example, if you specify a 50 percent column width 
but an item has many radio buttons that are displayed horizontally, the web browser will adjust 
the width of the question column so that the entire control column fits on the page. 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 Select a form, and select the Layout tab. 

3 Right-click a question or a section header, and select Edit Question Column Width.  
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The Question Column Width dialog box appears.  

4 To use the option set in the Form- or Study-Level styles, select Inherit. 

To override the Form- and Study-Level styles, deselect Inherit, and specify a percent value for the 
question column. 

5 Click OK. 
 

Formatting codelist items and items with units 
You have the following formatting options: 

• Codelist items.  

The codelist settings for an item with a codelist determine the formatting that you can use. 

• If Select Single Value is selected on the Design tab, you can format the codelist items using 
radio buttons or a pulldown control only.  

Note: You cannot format single-select codelist items using checkboxes. 

• If Select Multiple Values is selected on the Design tab, the codelist items are formatted using 
checkboxes.  

• Integer and float items with units. 

You can format the units as radio buttons or pulldown controls. 

You can display radio buttons and checkboxes vertically or horizontally. 

To format codelist items: 

1 In the Project Explorer, select the Items Explorer bar. 

2 Select an item with a codelist, and select the Design tab. 

3 Under Codelist Settings, select an option: 

• To format the codelist items using checkboxes, select Select Multiple Values. 

The codelist items are automatically formatted as checkboxes in the layout.  

• To format the codelist items using radio buttons or a pulldown control, select Select Single 
Value, and then do the following: 

1 In the Project Explorer, select a form or item, and select the Layout tab. 

2 Right-click a control and select Control Type > Radio Button or Pulldown. 

or  

Select the control in the layout table, and on the toolbar, select Control Type and then 
either Radio Button or Pulldown. 

To format the units for integer and float items: 

1 In the Project Explorer, select the Items Explorer bar. 

2 Select an integer or float item for which a base unit is selected.  

Note: You select a base unit in the Design tab. 
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3 Select the Layout tab.  

4 Select the control for the item. 

5 Right-click a control and select Control Type > Radio Button or Pulldown. 

or 

Select the control in the layout table, and on the toolbar, select Control Type and then either Radio 
Button or Pulldown. 

To change the orientation (vertical or horizontal) of radio buttons or checkboxes: 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

or 

In the Project Explorer, select the Items Explorer bar. 

2 Select a form or item, and select the Layout tab. 

3 Right-click a codelist that is formatted using radio buttons or checkboxes, and select Orientation > 
Horizontal or Orientation > Vertical. 

 

Changing the orientation of a group control 
A group control is the collection of controls for: 

• A compound item. 

• An item with a codelist. 

The child items of a compound item and the items in a codelist can appear either horizontally or 
vertically in a layout. 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

or 

In the Project Explorer, select the Items Explorer bar. 

2 Select a form or item, and select the Layout tab. 

3 Right-click a group control, point to Orientation, and select either Horizontal or Vertical. 

or 

On the toolbar, select Orientation, and then select either Horizontal or Vertical. 
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Specifying the year range for a date time item 
The following procedure describes how to specify the year range for an item. This setting overrides 
the value specified in the form and study styles. You can override this setting using control styles. 

For more information, see Study Level Styles and Form Level Styles dialog boxes—Option 
descriptions (on page 398) and Control Styles dialog box—Option descriptions (on page 394). 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 Select a form, and select the Design tab. 

3 In the grid, select a date time item. 

4 On the toolbar, click Item Properties. 

The Item Properties dialog box appears. 

5 Under Year Range, specify a start and end year. 

6 Click OK. 
 

Marking an item as hidden or read-only 
The following procedure describes how to mark an item as hidden or read-only. This setting 
overrides the value specified in the form and study styles. You can override this setting using control 
styles. 

For more information, see Study Level Styles and Form Level Styles dialog boxes—Option 
descriptions (on page 398) and Control Styles dialog box—Option descriptions (on page 394). 

Note: Setting this value in a layout affects the layout only and does not change the value of the 
Display Override setting in the Properties Browser for an item. 

1 In the Project Explorer, select the Items Explorer bar. 

2 Select a date time item. 

3 Open the Properties Browser. 

4 Under the InForm grouping, expand the drop-down list next to Display Override and select either 
Hidden or ReadOnly. 

5 Save your changes. 
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Translating text 
You can translate the titles, questions, labels, and captions of a study object to the languages 
associated with the locales defined for a study: 

• Through the Central Designer user interface. The type of text (for example, item question or 
caption) determines whether locale-specific text can be specified in: 

• The definition of the study object. 

• The layout of the study object. 

• Both locations. 

With the exception of captions, which are defined only in the layout and do not update the study 
object definition, the changes you make in either location update the other location. 

• By exporting the text strings to a CSV file, translating them, and reimporting the file. The 
translated text strings are added to the study objects to which they belong. For more 
information, see Exporting and importing text for translation (in the User Guide). 

 

Where to enter translated text 
 

Type of text Where to translate Translation saved 
with study object 
definition? 

Study event short title General tab of the Study Event Editor. Yes 

Form or section title 
(header) (on page 
243) 

Layout tab of Form Editor. No 

Form short title General tab of Form Editor. 

Note: The Short Title does not appear in the 
layout for a form. 

Yes 

Note (on page 242) Layout tab of Form Editor. No 

Item Default 
Question (on page 
242) 

• Design tab of Item Editor. 

• Layout tab of Item Editor. 

Yes 

Item Short Question • Design tab of Item Editor. 

• Layout tab of Item Editor. 

Yes 

Codelist item label 
(on page 253) 

• Design tab of Codelist Item Editor. 

• Design tab of the Item Editor. 

Yes 

Caption (on page 243) Layout tab of Form Editor or Item Editor. No 

Query text Query Action dialog box, which is accessible from 
the Rule Wizard. 

Yes 
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Type of text Where to translate Translation saved 
with study object 
definition? 

Email subject and 
message 

Email Action dialog box, which is accessible from 
the Rule Wizard. 

Yes 

Instructions and Help 
text 

Instructions and Help tabs for study designs, study 
elements, study events, forms, and items.  

Yes 

InForm review state 
and review stage labels 
and mnemonics 

Product locale tabs of Review State editor. Yes 

 
 

Examples of data that cannot be translated 
The following information is stored in the database for the English (United States) locale and cannot 
be translated into any other language: 

• Custom properties and groupings.   

• Categories and keywords.  

• Roles. 

Note: You can translate units in the units file, but not in the Central Designer application. For 
more information, see Editing the units file (in the Administrator Guide). 

 

Creating and translating instructions and Help for a study design 
You can create study documents that are specific to a target application or locale for study designs, 
study elements, study events, forms, sections, and items. 

You can provide instructions and Help information if the study or library supports one or more 
locales, and if you have been given skills to work in the locales (in the Central Designer 
Administrator application). 

To create and delete instructions and Help: 

1 In the Project Explorer, select a study object (study design, study element, study event, form, 
section, item, codelist, or codelist item). 

The editor for the study object appears in the workspace. 

2 Select the Instructions & Help tab. 

3 To select a locale for the study documents, select the tab for the locale. The tabs are located 
along the bottom of the workspace. 

4 To create or edit study documents: 

a Type in the text area. 

b Optionally, use the toolbar to format the appearance of the text. Additionally, you can use 
HTML formatting characters. For more information, see Supported HTML formatting 
tags (on page 240). 
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5 To delete study documents: 

a On the toolbar, click the Delete button. 

or 

Select all of the text, and press Delete.  

A dialog box appears. 

b Choose one of the following options: 

• Delete the study documents for only the selected locale. 

• Delete the study documents for all locales. 

To translate instructions and Help: 

1 In the Project Explorer, select a study object (study design, study element, study event, form, 
section, item, codelist, or codelist item). 

The editor for the study object appears in the workspace. 

2 Select the Instructions & Help tab. 

3 To select a locale for the study documents, select the tab for the locale. The tabs are located 
along the bottom of the workspace. 

4 Optionally, copy and paste study documents from a locale for which the information is already 
written. 

5 Select the locale to which you want to translate. 

6 Translate the study documents. 

7 Optionally, use the toolbar to format the appearance of the text.  
 

Entering and translating the title and short title of the Common Visit 
In the Common Visit tab, which is part of the editor for the study design, you can enter, edit, and 
translate the title and short title for a study's common visit. A common visit is created during 
deployment when a study contains common forms. 

Specifying a title and short title is optional. For studies with common forms, if you translate a title or 
short title for one language, you must translate values for all languages. 

1 In the Project Explorer, select the Visit Schedule Explorer bar. 

2 Select the study design.  

The Study Design Editor appears. 

3 Select the Common Visit tab. 

4 Enter title and short title values in the fields at the top.  

5 Optionally, in the Languages column of the Languages section, select the drop-down arrow at the 
end of the cell, and select a language for translation.  

Note: For studies with common forms, if you translate a title or short title for one language, 
you must translate values for all languages. 

6 Type a translated title and short title.  
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7 Press Enter, or click the next row. 

8 Type translations for all languages in the study.  
 

Translating the short title of a study event 
You can translate the short title of a study event into the languages and locales with which you have 
been associated in your skills profile. An administrator sets up this profile in the Central Designer 
Administrator application. The short title of a study event is deployed as the visit mnemonic in the 
InForm application. 

1 In the Project Explorer, select the Elements and Events Explorer bar. 

2 Select a study event. 

The Study Event Editor appears. 

3 Select the General tab. 

4 In the Language column of the Short Title Languages section, click the arrow that appears when 
you move the cursor over the far-right side of the cell in the first available row, and select the 
language for translating the short title. 

5 In the Short Title column, type the translated text. 

6 Press Enter, or click the next row. 
 

Translating the short title of a form 
You can translate the short title of a form into the languages and locales with which you have been 
associated in your skills profile. An administrator user sets up this profile in the Central Designer 
Administrator application. The short title of a form is deployed as the form mnemonic in the InForm 
application. 

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 Select a form. 

The Form Editor appears. 

3 In the Language column of the Short Title Languages section, click the arrow that appears when 
you move the cursor over the far-right side of the cell in the first available row, and select the 
language into which to translate the short title. 

4 In the Short Title column, type the translated text for the short title. 

5 Press Enter, or click the next row. 
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Translating the question text of an item 
1 In the Project Explorer, select the Items Explorer bar. 

2 Select an item. 

The Design tab of the Item Editor appears. 

3 In the Language column of the Languages section, click the arrow that appears when you move 
the cursor over the far-right side of the cell in the first available row, and select the language into 
which you want to translate the question text. 

4 In the Question column, type the translated text for the item question. 

5 In the Short Question column, type the translated text for the short version of the item question. 

6 Press Enter, or click the next row. 
 

Translating a codelist item label 
You can translate the text of a codelist item label into the languages and locales with which you have 
been associated in your skills profile. An administrator sets up this profile in the Central Designer 
Administrator application.  

1 In the Project Explorer, select the Items Explorer bar. 

2 Select a codelist item. 

The Codelist Item Editor appears. 

3 In the Language column, click the arrow that appears when you move the cursor over the far-
right side of the cell in the first available row, and select the locale for which to translate the 
codelist item label. 

4 In the Label column, type the translated text for the codelist item label. 

5 Press Enter, or click the next row. 

The translated text appears in the Codelist Item Editor and in the Layout tab of the Form or 
Item Editor for the selected locale. 
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Translating text in the Layout tab 
Every layout supports all locales. You do not need to create a unique layout for every form and locale 
in the study. Use the Locales drop-down list on the toolbar in the Layout tab to switch between 
locales and provide translations. 

Translations are not layout-specific. Every layout supports every locale that is supported by the study. 
For example, if you have two layouts, you can view the translations for every supported locale in 
each layout. 

You can provide translations for the following components in a layout: 

• Captions (on page 243). 

• Section notes (on page 242). 

• Form and section titles (on page 243). 

• Questions (on page 242). 

• Codelist item label overrides (on page 245). 

Note: You can also provide translations for questions in the Design tab of the Item Editor. 

You can translate codelist item labels (on page 253) in the Codelist Editor. 
 

Viewing locale-specific translations in a layout 
Every layout supports all locales. You do not need to create a unique layout for every form and locale 
in the study. Use the Locales drop-down list on the toolbar in the Layout tab to switch between 
locales and provide translations. 

Note: Layouts that you created in release 1.2 display text in the locale for which the layout was 
created. 

When you select a locale other than the default locale for a study, the locale name appears above the 
work area, and all captions and questions appear in the language for the locale. If the values are not 
translated for the locale, the text for the primary locale appears in red.  

1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

or 

In the Project Explorer, select the Items Explorer bar. 

2 Select a form or item, and select the Layout tab. 

3 On the toolbar, select Layout, and then select the locale to view. 

The locale appears, along with all locale-specific text strings. 

Note: Text that you modify is saved for the selected locale only. For example, you can modify 
captions, notes, and section titles, and the values are saved for the locale. 
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About study validation and deployment 
Study validation and deployment is the process of: 

1 Preparing a study to be moved from the design environment to a test or production 
environment. 

2 Moving the study into the test or production environment. 

Studies only 

You can validate and deploy a study but not a library. 

Deployment packages 

You must validate a study before you can create a deployment package. The process of validation 
checks for conditions that would make it impossible to deploy the study. When you validate a study, 
the Central Designer application creates a validation baseline. 

Frequency of validation 

Validate as often as needed to make sure that the design will be deployable. When deciding how 
frequently to validate, consider that validation requires you to save the study. 

For validation to succeed, a study must contain the following study objects at a minimum: 

• One study event. 

• One form for each study event. 

• One item for each form. 

• A label for each codelist item. 
 

Validation and deployment definitions 
Study validation and deployment use the following terms. 

 

Term Definition 
Approval Consent to deploy a study directly to the InForm application, given by a user 

with the appropriate rights. 

Baseline A snapshot of all components in a study. Validation creates a baseline.  

Baselines Browser A browser in which you view the results of validation and make temporary 
baselines public so that other users can work with them. 

Deployment The process of sending a study to a target application. To collect data, a study 
must be deployed into a target application as a complete deployment package. 

There are two types of deployment: 

• Automated—A study design is moved directly from the Central Designer 
application to the InForm environment. 

• Manual—You must deliver and install a deployment package to the 
InForm environment. 
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Term Definition 

Deployment 
instance 

The environment to which you deploy a study.  

Deployment 
request 

A request to deploy a study directly to the InForm application. 

• If your study is configured so that deployment requests require approval, 
the user who makes the request must have the appropriate rights to 
deploy the study to the InForm application. 

• If your study is configured so that deployment requests do not require 
approval, the user who makes the request does not need to have the 
appropriate rights to deploy the study to the InForm application. 

Jobs Browser A browser in which you view the results of asynchronous jobs, such as 
validation or import. 

Pending Approvals 
tab 

A tab on the Home page in which you view, approve, or reject deployment 
requests that are waiting your approval, and review approval records. 

Study validation The process of checking the status of a study to indicate if the study is ready 
for deployment. The study validation process determines whether all essential 
components exist and are consistent. 

Target application The application (for example, the InForm application) on which a completed 
deployment package runs. 

 
 

Validation and deployment workflow summary 
The process of validating and deploying a study consists of the following steps: 

1 Validate the study, creating a validation baseline (on page 260). 

2 Create a deployment package from a validation baseline (on page 288). 

3 Deploy the study to the InForm application (on page 279). 
 

Upgrade considerations 
• A baseline that is valid in a previous release is not necessarily valid after an upgrade. For 

example, if you upgrade from a previous release, the study could contain RefNames that you 
could create in an earlier release but that you cannot create and are not valid in the current 
release. A study that contains such RefNames does not pass validation. 

• You cannot download deployment packages that are created in Central Designer release 2.1. 

• If you are deploying a study to InForm release 6.1.1 or later and the most recent baseline for the 
study was created in a Central Designer release prior to 2.1.2, you must recreate and deploy the 
deployment package for the study. 
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Validating a workflow or study 

Validating a workflow 
You can validate a workflow to make sure that it is valid and that all of the study objects that it 
references still exist in the study. If you receive an error during validation about an invalid workflow, 
perform this step to correct the issue. 

1 In the Project Explorer, select the Visit Schedule Explorer bar. 

2 Select a study design, study element, or study event. 

3 Select the Workflow Diagram tab. 

4 Right-click the workspace, and select Refresh Workflow. 

• The application corrects issues with the workflow. For example, if a workflow arrow is not 
pointing to anything, it is removed. You receive a message that tells you about any visible 
changes that have been made.  

• If the application does not detect issues with the workflow, the workflow is not changed. 
 

Validating a study and creating a baseline 
1 Do one of the following: 

• Right-click the study, and select Validate > Study. 

• In the Project Explorer, select any object in the study and click the Validate button in the 
main toolbar. 

A study validation job starts. 

Note: If the job scheduling service is not running on the server, the job is placed in a queue. 

2 In the message box that indicates a validation job has started, click OK. 

A slide-up message appears to indicate when the job starts and finishes. 

3 After the job finishes, check the status in the Baselines Browser, located by default at the bottom 
of the Central Designer window. 

 

Running the study repair tool 
If you have the Run study repair right, you can run the study repair tool: 

• From the Baselines Browser, after you validate a study. 

• From the Tools menu, at any time during study development. 

To run the study repair tool from the Baselines Browser: 

1 In the Baselines Browser, view the messages for the validation baseline. 

2 Review the Description for each message for which the Validation Type is Internal Error. 
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Note: To view the complete text of a message that is truncated because of column size, 
hold the cursor over the portion of text that is visible. Alternately, select a row, and then 
right-click it and select Properties. 

3 Right-click the error or warning. 

4 Select Repair Study. 

A confirmation dialog box appears. 

5 Click OK. 

Note: You cannot undo this action. 

6 Do one of the following: 

• Click OK—To close the dialog box if the Study Repair tool resolves all issues or does not 
find any issues. 

• Click Save Log—To save a copy of the event log if the Study Repair tool cannot resolve all 
issues. After you save the event log, contact customer support to resolve outstanding issues. 

To run the study repair tool from the Tools menu: 

1 Select Tools > Repair Study. 

A confirmation dialog box appears. 

2 Click OK. 

Note: You cannot undo this action. 

3 Do one of the following: 

• To close the dialog box if the Study Repair tool resolves all issues or does not find any 
issues, click OK. 

• To save a copy of the event log if the Study Repair tool cannot resolve all issues, click Save 
log. After you save the event log, contact customer support to resolve outstanding issues. 

 

Saving validation messages to a CSV file 
From the Baselines Browser or the Jobs Browser, you can save the processing messages for all 
validation baselines to a comma-separated value (CSV) file that can be opened in a Microsoft Excel 
spreadsheet.  

This file contains all of the columns that the Baselines Browser or the Jobs Browser can display. This 
information differs between the Baselines Browser and the Jobs Browser. Additionally: 

• A file saved from the Baselines Browser contains messages only from validation jobs. 

• A file saved from the Jobs Browser contains messages from all types of jobs that appear in the 
Jobs Browser. These messages can include information from validation, deployment, and import 
jobs. 

To save validation baseline messages from the Baselines Browser: 

1 Open the Baselines Browser. 
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Note: If the Baselines Browser is not visible, select View > Baselines.  

2 Click Save As, or right-click the browser, and select Save As. 

The Save As dialog box appears. 

3 Browse to the location in which to save the file. 

4 Specify a file name, and click Save. 

To save validation baseline messages from the Job Log Browser: 

1 In the row of browser tabs, select the Jobs Browser. 

The Jobs Browser appears. 

2 Click Save As, or right-click the browser, and select Save As. 

The Save As dialog box appears. 

3 Browse to the location in which to save the file. 

4 Specify a file name, and click Save. 

For more information, see: 

Baselines Browser - Option descriptions (on page 447). 

Job Log Browser - Option descriptions (on page 467). 
 

Baseline 

Validating a study and creating a baseline 
When you validate a study, the Central Designer application creates a baseline.  

A validation baseline is temporary until you make it public, either explicitly or by using it to create a 
deployment package. Subsequent validation jobs that you run create a new temporary validation 
baseline and replace the previous one. Only you can view, edit, or delete a temporary validation 
baseline that you created, or use that baseline in a deployment package.  
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Viewing baseline validation errors and warnings 
Validation can produce errors and warnings, as well as informational messages. You can read the 
errors and warnings to find out if any modifications are necessary for your study to pass validation 
and be deployed. 

You can deploy a study that has received validation warnings, but you must acknowledge the 
warnings to indicate that you understand them and choose to ignore them in order to proceed with 
building the deployment package.  

A validation baseline can have the following statuses: 

• Invalid—One or more errors. The validation baseline cannot be used in a deployment package. 

• Invalid with warnings—One or more warnings. A user must indicate that the warnings can be 
ignored before using the validation baseline in a deployment package. 

• Pending—Validation is in process. 

• Valid—No errors. The validation baseline can be used in a deployment package. 

• Valid with warnings—One or more warnings. A user has indicated that the warnings can be 
ignored, and the validation baseline can be used in a deployment package. 

To view validation errors and warnings in the Baselines Browser: 

1 Open the Baselines Browser. 

Note: If the Baselines Browser is not visible, select View > Baselines.  

2 Click Refresh. 

3 Select the baseline validation to view. 

4 Click Show Validation, or right-click in the browser, and select Show Validation. 

The baseline row shifts to the right, and an expandable node appears to the left of the row. 

5 Expand the node at the left of the baseline row. 

Validation information, warning, and error messages appear below the baseline row. 

Note: To view the complete text of a message that is truncated because of column size, 
hold the cursor over the portion of text that is visible. Alternately, select a row, and then 
right-click it and select Properties. 

To view validation errors and warnings in the Jobs Browser: 

1 In the row of browser tabs, select the Jobs Browser. 

The Jobs Browser appears. 

Note: In the Jobs Since list, you can select the period for which you want to view job results. 
You can also sort the list by the Name or Start Time column to locate a job quickly by a 
specific starting date. 

2 Click Refresh. 

The list of jobs is refreshed from the database.  

3 On the toolbar, click Show Job Results, and expand the results for an individual job. 
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4 Scroll to the beginning of messages for the baseline validation. The name Validation baseline and 
the date and time appear in the Name column for validation baseline jobs. 

Validation information, warning, and error messages appear. 

Note: To view the complete text of a message that is truncated because of column size, 
hold the cursor over the portion of text that is visible. Alternately, select a row, and then 
right-click it and select Properties. 

 

Ignoring and resolving baseline validation errors and warnings 
You can build a deployment package only if validation produces no errors and no warnings, or if you 
resolve or acknowledge and choose to ignore all warnings. Oracle recommends that you examine and 
analyze all warnings before deploying a baseline. A warning indicates that the study is valid, but the 
behavior of the study in the InForm application might not be expected or desired. You ignore all 
warnings as a group. You cannot select specific warnings to ignore. You can also view errors and 
resolve them by running the Study Repair tool from the Baselines Browser or from the Tools menu. 
For more information, see Running the study repair tool (on page 258). 

To ignore validation warnings: 

1 Open the Baselines Browser. 

Note: If the Baselines Browser is not visible, select View > Baselines.  

2 In the Baselines Browser, select a baseline (with a status of Invalid with Warnings). 

3 Examine the warning messages. 

4 If you decide to ignore the warnings, click Ignore Warnings, or right-click the browser, and select 
Ignore Warnings. 

The status of the validation baseline changes to Valid with Warnings. 

Note: You ignore all warnings as a group. You cannot select specific warnings to ignore. 

To resolve validation errors and warnings: 

1 In the Baselines Browser or Jobs Browser, view the messages for the validation baseline. 

2 Review the Description for each message for which the Validation Type is Error or Warning. 

Note: To view the complete text of a message that is truncated because of column size, 
hold the cursor over the portion of text that is visible. Alternately, select a row, and then 
right-click it and select Properties. 

3 Double-click the error or warning. 
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If you can or must correct the issue in multiple locations, a dialog box appears, displaying the 
locations. Multiple locations appear if you can correct an issue in any of them, even if you have 
to correct the issue in only one place. Double-click a location. This dialog box remains open so 
you can navigate to additional locations. 

If you can correct the issue in only one location, the application takes you to the location.  

Note: Double-clicking a validation message does not take you to a location in the 
application if the job result is from a previous release’s validation baseline, the issue is in 
the library, or you select an information message.  

4 Update the study definition as necessary to correct each error or warning, and save your changes. 
For more information, see Checks performed during validation (on page 264). 

 

Editing a validation baseline description 
1 Open the Baselines Browser. 

Note: If the Baselines Browser is not visible, select View > Baselines. 

2 In the Baselines Browser, select a baseline. 

3 Click Edit, or right-click the browser, and select Edit. 

The Edit Baseline dialog box appears. 

4 In the Name field, type the name of the baseline. 

5 In the Description field, type a description for the baseline. 

6 Click OK. 
 

Deleting a validation baseline 
You can delete a validation baseline only if no deployment packages are associated with it. Baselines 
associated with a deployment package are retained for auditing. 

1 Open the Baselines Browser. 

Note: If the Baselines Browser is not visible, select View > Baselines.  

2 In the Baselines Browser, select a baseline to delete. 

3 Click Delete, or right-click the browser, and select Delete. 
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Making a validation baseline public 
When you create a validation baseline, it is considered temporary. Only you can view and work with a 
temporary validation baseline that you created, and subsequent validation jobs that you run overwrite 
it. To enable other users to view and work with a validation baseline, you make it public. 

Note: When you use a validation baseline to create a deployment package, it is made public. 

1 Open the Baselines Browser. 

Note: If the Baselines Browser is not visible, select View > Baselines.  

2 In the Baselines Browser, select a baseline to make public. 

3 Click Make Public, or right-click the browser, and select Make Public. 

The Edit Baseline dialog box appears. 

4 In the Name field, type the name of the baseline. 

5 In the Description field, type a description for the baseline. 

6 Click OK. 
 

Checks performed during validation 
For a study to be deployed to the InForm application, it must pass a series of validation checks. For 
more information, see: 

• General validation checks (on page 264). 

• Validation checks for InForm deployment (on page 266). 

• Validation for special InForm forms and items (on page 271). 

• Validation for coding (on page 277). 

• Validation for monitoring forms (on page 273). 

• Validation for data mappings (on page 273). 

• Validation for in-place revisions (on page 277). 

Some information is not validated. For more information, see Information not validated (on page 
278). 
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General validation checks 
 

Validation area Must be true for successful validation 
Study objects • All study object RefNames are valid and unique. 

• Reserved words are not used as RefNames. 

• References to study objects are valid (for example, if you delete an 
item from a form, you make sure that the layout does not continue to 
refer to the deleted item). 

• The study does not contain: 

 Duplicate references to a study object (for example, if you import 
an archived study that contains duplicate references). 

 References to study objects that are not included in the study. 

 Empty string resources. 

• A study object is not a child of itself. 

• Parent/child study object relationships are valid. 

Locale and translation • At least one locale is selected in the Study Editor as a deployment 
target. 

• Translations to all study languages are complete. 

• Notes on sections are translated for all locales. If you provide a 
translation and then clear the value, the translation is considered valid.  

Layout • The study contains form layout definitions for all deployable locales. 

• You have provided translations for captions and notes for all 
supported locales for the study. 

• An error has not occurred with any layouts. 
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Validation area Must be true for successful validation 
Rules • Rules compile successfully, including rule templates and workflow 

rules, whether or not they are used. 

• Rules do not refer to study objects that have been deleted. 

• Rules reference the current RefNames of study objects. If a RefName 
is not updated automatically, you must manually update the RefName 
in the rule. 

• Only one current instance of a repeating form is referenced in a rule. 

• If the Current() method is used in the rule expression, the target of the 
rule action is a child of the study object referenced by the Current() 
method. In addition, validation considers the lowest level of Current() 
that you use. For example, for Visit1 and Form1: 

 The following expression is valid only if you apply the rule to a 
child study object of Visit1. 

this.Visit1.Current().Form1.I1 == 1 

 The following expression is valid only if you apply the rule to a 
child study object of Section1. 

this.Visit1.Current().Form1.Current().Section1.Current()I1 
== 1 

 The following expression is valid only if you apply the rule to a 
child study object of Form1. 

this.Visit1.Current().Form1.Current().I1 == 1 

For more information, see the Rules Reference Guide. 
 

 
 

Validation checks for InForm deployment 
 

Validation area Must be true for successful deployment to the InForm application 
Study The study has at least one study event. 

Study design A warning occurs if the title or RefName of the study design, when appended 
with the version and locale of the study design, might exceed 63 characters. If 
the warning occurs, shorten the title or RefName, or the deployment process 
truncates the title or RefName in the InForm application.  

Common visit For studies with common forms, if you translate a title or short title of the 
common visit for one language, the title and short title are translated for all 
languages. 

Study event • Each study event has at least one form. 

• A study event is not used on both a study element and a study design. 



 InForm Design Guide  

Oracle® Health Sciences Central Designer 2.1.2 267 

Validation area Must be true for successful deployment to the InForm application 

Form • Each form: 

 Contains at least one item.  

 Has a layout defined for each locale that is deployed.  

 Does not contain duplicate items. 

 Is included in a study event no more than once. 

• Each Study Completion form has a Completion Status item. 

• Checks for form associations: 

 Associated forms in a repeating study event must have the same 
type; that is, both are repeating forms or repeating, common forms. 

 Forms in repeating study events can only be associated with forms in 
the same repeating study event. 

 A repeating, common form can be associated with more than one 
form if the forms are repeating, common forms in the same study 
event. 

 A form that is not repeating or common can only have one form 
association. 

 A warning occurs when associated forms are in different study 
events, and indicates that this functionality is available for InForm 
release 6.0.1 or later. 

Section Each section has a layout defined for each locale that is deployed. 
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Validation area Must be true for successful deployment to the InForm application 
Item • Questions for top-level items are not blank.  

• Year range for date time items is valid (for example, start year cannot be 
later than end year).  

• The precision value of a float item is not longer than the specified length 
of the item.  

• The nesting of compound and conditional items is not greater than five. 
If an item holds more than one child control, a group control is created, 
and each group control counts as one level of nesting.  

• Each compound item has at least one child item.  

• An item that is designated as a key item is not: 

 Formatted as a checkbox. 

 An item on which other items are conditional.  

 Conditional on another item if the key item is a child of a compound 
item.  

• The study does not contain any items for which NA or UNK is the 
RefName. 

• An item that is designated as Personal/Protected Health Information 
(PHI) is not included in the subject line or body of an email to be sent by 
a rule. 

Codelist and 
codelist item 

• Each codelist has codelist items.  

• Each codelist item has a label for the appropriate locale.  

• The codes of codelist items are unique within a codelist. 

• The codes for codelist items on text items do not exceed the length that 
is specified for the text item.  

• The codes for codelist items match the type of the codelist. For example, 
the codes for an integer codelist cannot contain letters. 

• The code of a codelist item that is conditional on another item has not 
been modified since the codelist item was made conditional.  

• Codelist labels do not contain apostrophes. 

• The Study Completion Status Item custom property is not set for 
codelist items in multiple items. 

• Each instance of a copied or linked codelist item has the same codelist 
type. 
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Validation area Must be true for successful deployment to the InForm application 

Review state • The maximum number of review states is not exceeded, and there are no 
duplicate State values. 

• State, Label, and Mnemonic are defined for a review state. 

• Label and Mnemonic are defined for each review stage. 

• Label and Mnemonic fields for a review state and each of its review 
stages have values for each required product locale. Values for an 
InForm product locale (English [United States] or Japanese [Japan]) are 
required if the locales specified for the study include a locale with the 
same language. For example, English translations are required if the study 
includes en-US or en-GB locales. 

• Label and Mnemonic for each review state are unique across locales. 

• Label and Mnemonic for each review stage are unique for each review 
state across locales. 

• Review stage names exist for each review stage and are unique within a 
review state. 

• Each review state has three defined review stages. 

Workflow • A study object does not have multiple global conditions. 

• A workflow object does not have two outgoing arrows without a rule. 

• All study objects in a workflow reference study objects that still exist in 
the study. If validation fails due to an invalid workflow, go to the 
Workflow Diagram tab for the workflow with the issue, and right-click in 
the white space of the diagram and select Refresh Workflow to correct the 
issue. 

• A warning occurs if a rule contains the UpdateWorkflow action. The 
UpdateWorkflow action is not required for studies deployed to InForm 
release 6.1.1 or later. 

• Each workflow rule is connected to a study element or study event. 

Data-entry rule • No rules are created on a linked item that is in multiple compound items. 

• The query message of a rule has 255 characters or fewer, not including 
the parameters. 

• For each data-entry rule, an item that triggers the rule is selected. If an 
item is not selected, you receive a warning during validation.  

• Each constant has a value (the length of the value must be greater than 
0). 

• No email rules refer to items designated as Personal/Protected Health 
Information (PHI) in the subject or body of the email message. 

Note: If two rules (on different study objects) have the same name, in release 
2.1 of the Central Designer application, you receive a warning during 
validation. Using the same rule name for rules on different study objects is 
not recommended, and future releases may not support the practice. 
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Validation area Must be true for successful deployment to the InForm application 
Function • All functions that are used in rules exist in the DLL file for user-defined 

functions. 

• A warning occurs if a study or library contains a user-defined function 
that uses an incorrect version of the Log4Net application. 

• A warning occurs if a study or library contains a user-defined function 
with an assembly that is: 

 Unsigned. 

 Not signed with a strong named signature. 

 Signed with an invalid or untrusted signature. 

Note: If you ignore the warning for a user-defined function with an 
assembly that requires signing with a strong named, valid, and trusted 
signature, an error occurs when the rule executes in the InForm 
application. For more information about user-defined function 
assemblies that require signing, see the Rules Reference Guide. 

• A warning occurs if a study or library contains a user-defined function 
with invalid references to ExternalFunctions.dll. 

Unit • All units that are used in the study are in the units file. The file must have 
a symbol for each unit in each locale that is deployed, and a conversion 
map must exist to convert between the base unit and the conversion unit.  

• All units are translated for all of the supported locales for a study. 

• In the units file, unit names are 31 characters or fewer.  

In-place revision • The study objects associated with in-place revisions exist. 

• No more than one in-place revision exists for each study object. 

• Every in-place revision is associated with an existing deployment instance 
and a study version. 
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Validation area Must be true for successful deployment to the InForm application 

Study administration 
data 

General checks: 

• Imported study administration CSML does not contain more than one 
StudyAdministration object, which contains the study administration 
configuration settings. 

Item group checks: 

• Each item group contains one or more item. 

• Each item in an item group is a top-level item on at least one form in the 
study design. 

• Each item in an item group exists on a form in the study design. 

• Each item in an item group exists in only one item group. 

Rights group checks: 

• Each rights group contains one or more item groups. 

• Each item group in a rights group exists in the study. 

Signature group checks: 

• Each signature group contains a form. 

• Each form in a signature group exists in the study design. 

• For each signature group, a translation is provided for the Signature 
Meaning and Signature Text for each locale in the study. 

Other Oracle reserved words are not used as RefNames of any study object or 
Aliases of data sets and data series.  

 
 

Validation for special InForm forms and items 
 

Validation area Error or warning 
All special forms 
(Screening, Enrollment, 
Patient Identification, and 
Study Completion) 

Error if: 

• The study contains multiple instances of the form.  

• The form contains multiple instances of any item.  

• Required fields are not on the form.  

• The form is marked as repeating or appears in a repeating study 
event.  

• The Special Forms property is defined on a section that is on the 
form. 
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Validation area Error or warning 
Screening and Patient 
Identification forms 

Error if: 

• (For a Screening form only) The form is used in multiple study 
events. 

• (For a Screening form only) The form contains a repeating section. 

• (For a Patient Identification form only) The Patient Number and 
Initials items are included on the form and are not together in 
either a section or the top-level form.  

• All items are not on the same section or form. 

• The item types for special items are not correct. 

Warning if the special items are on a non-special form. 

Enrollment form Error if the: 

• Form is used in multiple study events. 

• Item types for special items are not correct. 

• Form contains a repeating section. 

Warning if the special items are on a non-special form. 

Study Completion form • Error if all items are not in the same form.  

• Warning if the special items are on a non-special form. 

DOV item Error if the item: 

• Is used multiple times in a study, unless it was copied using Copy > 
Link. 

Note: You can use the Copy > Link option to reuse the DOV 
item in a study. However, an error occurs if you use the DOV item 
multiple times in a study event, even if you copied it using Copy > 
Link.  

• Was copied using the Copy > Link option and pasted onto a form 
in the same study event. 

• Has an incorrect item type. 

• Is not on the first form in a study event.  

• Is in a repeating section or form. 

• Is in a common form or a section of a common form.  

• Is in a section in a repeating study event.  

Randomization item • Error if the item appears multiple times in a study. 

• Error if the Patient Number and Randomization items are on the 
same section or form. If one item is on a section, the other item is 
allowed to be outside the section on the same form. 

Patient Initials item Warning if the item has 4 characters.  
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Validation area Error or warning 

Drop Out Reason item Error if the code for its codelist item has more than 47 characters.  
 

 

Validation for monitoring forms 
If you create a custom regulatory document form and a visit report form, the following must be true 
for the study to pass validation: 

• Only one regulatory document form and one visit report form exist in the study. 

• (For visit report forms only) The form contains a Date of Visit item that is marked as a Date of 
Visit special item and is the first item on the form. 

• If the study supports multiple locales, the regulatory document form and visit report form are 
translated for all locales. A warning occurs if the forms are missing translations for one or more 
locales. 

• The visit report form is not repeating. 
 

Validation for data mappings 
The type of data mapping, either CDD, CIS, or rules, determines whether the data mapping 
definition is validated against criteria for CDD data mappings, CIS data mappings, or no data 
mappings, respectively. 

 

Validation area Must be true for successful validation 

CDD data 
mappings 

 

Data type 
compatibility 

• All components of a date time item must be required and must not 
allow unknowns if the date time item is mapped to a data series with a 
data type of DateTime. 

• If one or more parts of a date time item are not required or allowed to 
be unknown, the data series to which the item is mapped must have a 
type of Text. 

• The length of an item mapped to a data series must not be longer than 
the value set in the DB Format Length custom property of the data 
series. 

• The precision of a float item mapped to a float data series must not be 
greater than the value set in the DB Format Float Precision custom 
property of the data series. 

• If a float item is mapped to an integer data series, the precision must be 
0. 

Date part and split 
date 

If any item is mapped to a data series with the split date option, all items 
mapped to the data series must use the split date option. 
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Validation area Must be true for successful validation 
Target key types • Data series mapped to items in a repeating section cannot have a pivot 

target key type. Pivot tables are not supported for itemset data. 

• If the target key type of the data set is a pivot target key type, one (and 
only one) data series must be identified as the pivot column. 

Data sets and data 
series 

Custom dimensions and custom dimension labels do not reference deleted 
codelists or codelist items. 

CIS data mappings  

Block key and page 
key 

The block key and page key must conform to the specifications of the data 
series for the block key item or page key item in the context panel: 

• The data type must convert to a compatible data type. 

• The length must be within the length specified in the DB Format 
Length CIS custom property. 

• If the data type of the data series is float, the precision must be within 
the precision specified in the DB Format Float Precision CIS custom 
property. 

Context panel • A data mapping can have only one custom context panel. 

• The data series in a context panel must have data types of Text, Fixed, 
or Float. 

• The value of the Context Type property of a data series in a context 
panel cannot be: 

 Other context item if the value of the Is Key property is True. 

 Not a context item. 

• A context panel can have only one: 

 Subject key item. 

 Block key item. 

 Page key item. 

 Block repeat key item. 

 Page repeat key item. 

• For a subject key item, if the data type of the data series is Text, the 
value of the DB Format Length custom property cannot be greater than 
80. 

• Data set aliases used in a context panel cannot be used in data sets for 
noncontext panels. 

• If the study contains a data set that is a custom context panel, and the 
study contains a common form with one or more items that are mapped 
to any data series, you must specify a value in the Shared Form Block 
Key custom property on the study design.  
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Validation area Must be true for successful validation 

Data type 
compatibility 

• All components of a date time item must be required and must not 
allow unknowns if the date time item is mapped to a data series with a 
data type of DateTime. 

• If one or more parts of a date time item are not required or allowed to 
be unknown, the data series to which the item is mapped must have a 
type of Text. 

• The length of an item mapped to a data series must not be longer than 
the value set in the DB Format Length custom property of the data 
series. 

• The precision of a float item mapped to a float data series must not be 
greater than the value set in the DB Format Float Precision custom 
property of the data series. 

• If a float item is mapped to an integer data series, the precision must be 
0.  

Date part and split 
date 

If any item is mapped to a data series with the split date option, all items 
mapped to the data series must use the split date option. 

Enrollment panel A data mapping can have only one enrollment panel. 

Non-patient data 
panel 

The data series in a non-patient data panel cannot have any mapped items. 
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Validation area Must be true for successful validation 
Other validation for 
CIS data mappings 

• The following CIS custom data series properties must be mutually 
exclusive: 

 Checklist and CIS Codelist. 

 Derived and Item Required. 

• RefNames of data sets and data series that are used for: 

 CIS data mappings must not be longer than 20 characters. 

 CDD data mappings must not be longer than 25 characters. 

• Aliases for data sets and data series must not be longer than 20 
characters. 

• RefNames and aliases for data sets must be unique within a data 
mapping, and RefNames and aliases for data series must be unique 
within a data set. Checking for RefName and alias uniqueness is case 
insensitive; for example, the names BP and bp are considered identical. 

• The RefName and alias of a custom data dimension that is used as a 
subset key must not be the same as the RefName or alias of any data 
series in the data dimension. 

• If the value of the Is Key custom property of a data series is True, the 
value of the Item Required custom property must also be True. 

• If you do not create mappings for a CIS enrollment panel, the Central 
Designer application creates a an enrollment panel from the items in the 
special screening and enrollment forms. The RefNames of the special 
screening and enrollment items used to create the enrollment panel 
must not be longer than 20 characters. 

• If a data set is marked as an enrollment or non-patient data panel, the 
value of the Detail Key Item, Detail Panel, Master Item, and Master 
Panel custom properties of all data series in the data set must not be 
True. 

Data sets and data 
series 

Custom dimensions and custom dimension labels do not reference deleted 
codelists or codelist items. 
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Validation for coding 
To be valid, a study must pass the following coding-related checks: 

• A form can contain only one copy of an item.  

• Items in a coding map must all be either in or not in a repeating section.  

• A coding map must include at least one target item. 

• A target item must be a top-level item or a child of a top-level compound item. It cannot be a 
child of a nested compound item and cannot be conditional on another item. 

• All query target items must be: 

• Top-level items. 

• Visible and available for editing in the InForm application. Items designated as query targets 
must not have the Display Override property set to ReadOnly or Hidden in the Central 
Designer application. 

• All items in a coding map, except the query target item, must be text items.  

• Each coding map is valid in the dictionary type from which it was created.  

• The dictionary metadata in the study CSML must be in the dictionaries that are supported in the 
Central Designer application. 

 

Validation for in-place revisions 
The following in-place revision changes cause validation warnings. If you make these changes using 
in-place revision, you must ensure that the changes do not result in data loss, do not compromise 
data integrity, and do not have regulatory impact.  

• Reduce the length of an alphanumeric, numeric, or float study object. 

• Reduce the minimum or maximum limit for a numeric or float study object. 

• Remove an item for which data was entered in the InForm application. 

Note: The Central Designer application does not check whether data has been entered for a 
study in the InForm application. Oracle recommends creating or using an existing manual 
process to determine whether data loss, data integrity or regulatory impact occurs. 
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• Modify the precision for a numeric or float study object. 

• Modify a codelist label. 

• Decrease the date range for a date control. 

• Remove a date part such as hours or minutes from a date control. 

• Modify item text to correct spelling or punctuation errors. 

• Add an item to an existing section. 

The following in-place revision changes cause validation errors. You cannot deploy your study 
successfully if you make these changes by performing an in-place revision. 

• Remove a unit selection for an item. 

• Modify a codelist selection value. 

• Modify a fixed repeating section by doing the following: 

• Add an additional row. 

• Change a predefined value. 

• Remove a row. 

• Rearrange rows. 

• Change an existing item cell from non-blank to blank. 

• Change an existing item cell from blank to non-blank. 

• Add new items that have blank cells. 

• Modify the structure of a control by adding a level of nesting or changing a radio control to a 
pulldown control. 

• Remove a special item. 
 

Information not validated 
 

Validation area Information not validated 
Layout • Non-EDC layouts.  

• Item layouts.  

• Layouts for a locale that is not supported in a study (for example, if a 
layout is created for a locale that is later deselected for the study).  

Instructions and help Instructions and help information for a locale that is not supported in a 
study. 
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Deploying a study to the InForm application 

About deploying to the InForm application 
To deploy a study to the InForm application, you do the following: 

1 Create a deployment instance. 

For more information, see Setting up deployment instances (on page 291). 

2 Create a deployment package and transfer a deployment package to the InForm server.  

For more information, see About deployment packages (on page 279). 

There are two methods for deploying to the InForm application: 

• Automated deployment—A study design is moved directly from the Central Designer 
application to the InForm environment. 

For more information, see Automated deployment (on page 291). 

• Manual deployment—You must deliver and install a deployment package to the InForm 
environment. 

For more information, see Manual deployment (on page 297). 
 

About deployment packages 
When you can create a deployment package 

When a validation baseline is free from errors and warnings, or if you have indicated that warnings 
can be ignored, you can create a deployment package from it. A deployment package is a ZIP file 
that contains: 

• Metadata that describes the study and the files required to create the MedML for the metadata. 

• Deployment options specific to the target application. 

• A list of all files in the deployment package. 

• InForm rule engine assemblies. 

• Rule assembly and user-defined functions. 

• Assemblies required to deploy the study. 

You install the deployment package on the computer where the InForm server is running. 

Types of deployment packages 

Full and incremental deployment packages both contain the definitions for every study object in the 
study. Consider the following: 

• Full package—Deployment package that contains everything needed to deploy a complete 
study, including study administration data. 

• Incremental package—Deployment package that contains everything needed to deploy a 
complete study, including study administration data, plus additions and changes to the study, 
reflected in Alternate forms in the InForm application. Alternate forms are not created when you 
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install an incremental deployment package that contains additions to repeating forms or fixed 
repeating sections (Repeating Data itemsets in the InForm application). 

• Administration data—Deployment package that contains only study administration data. 

Note: If you deactivate a rule in the InForm application, do one of the following in the Central 
Designer application before creating a new deployment package: 

• Remove the rule from the study.  

• Disable the rule.  

• Change the triggering event to On Demand (Batch Mode). 

Rule-related changes that you make in the InForm application are overridden when you install a new 
deployment package. 

Note: If you create or modify a coding map, use a full deployment package to deploy the changes. 
Changes to coding maps are not supported in incremental deployment packages. 

Before you can create a deployment package, you must specify deployment options for the study in 
the Study Editor. Deployment options indicate the target applications, format, and languages or 
locales for which the study is being designed. 

Naming conventions for baselines and deployment packages 

Developing naming conventions for validation baselines and deployment packages is recommended. 
For example, you might want to name validation baselines that are created while testing the study 
design differently from validation baselines that are actually deployed. 
 

Deployment package processing in the InForm application 
 

Characteristic Description 
What the deployment 
process creates 

• For a manual deployment, an InForm server and a study, if they do 
not already exist. The process of creating the InForm study creates 
an Oracle user for the study database tables. 

• MedML definitions for CDD or CIS mappings, if the deployment 
package includes CDD or CIS mappings.  

• A log file called StudyInstaller.log in the InForm installation folder. 
This log file contains information that can be used to debug 
problems with deployment. Messages from each subsequent 
deployment are appended to the log. 

What the deployment 
process does not create 

The Oracle user and system DSN for a CDD or for a Clintrial protocol 
that is the target of CIS mappings. You must create the CDD Oracle user 
and DSN through the InForm Service. The Oracle user and DSN for a 
Clintrial protocol are created through the Clintrial application or through 
CIS synchronization. 
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Characteristic Description 

Deployment package 
processing 

The deployment process for deployment in the InForm application: 

1 Creates the InForm application server, if it does not already exist. 

2 Creates the InForm study database, if it does not already exist. 

3 Installs the MedML (InForm-specific metadata XML) definitions for 
the Base study components, if the deployment package is for a full 
deployment. The Base study components include system resources, 
settings, and form definitions common to all InForm studies. 

Note: Do not create the Base study with the dbsetup utility before 
running the Deployment Wizard. Deployment processing does not 
succeed if the Base study already exists. If you install a deployment 
package using command-line options, you can override this 
restriction. For more information, see Installing a deployment 
package using command-line options (on page 299). 

You can follow the progress of the deployment in the message box on 
the last page of the Deployment Wizard. 
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Central Designer and InForm study component correspondences 
When you deploy a study created in the Central Designer application to the InForm application, the 
Central Designer study components and workflow are translated to InForm study components. The 
conversion to InForm study components is based on both the data definition of each study 
component and the layout specified for each form or item in the Central Designer application. 

 

Central Designer 
study component 

Corresponding InForm 
study component 

Notes 

Codelist Radio, checkbox, or 
pulldown control 

The following codelist specifications determine 
how codelist items deploy to the InForm 
application: 

• Single selection—Deploys as a radio or 
pulldown control. 

• Multiple selection—Deploys as a checkbox 
control. 

• The Layout section of the Central Designer 
Options dialog box (available from the Tools 
> Options menu) specifies the following 
defaults: 

 Automatic formatting of codelist-based 
controls based on the number of codelist 
items. 

 Default control sizes. 

• The layout specification in the Central 
Designer application determines whether a 
radio control is displayed vertically or 
horizontally. You can also use the layout 
specification to indicate whether a codelist is 
single selection, single selection with user, or 
multiple selection, and whether codelist items 
in a single-selection codelist deploy as a radio 
control or a pulldown control. 

Codelist item Simple control  

Collaboration note No corresponding 
component 

This type of study object is not deployed to the 
InForm application. 

Data series • Table column in 
CDD mapping 
definition. 

• Panel item in CIS 
mapping definition. 
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Central Designer 
study component 

Corresponding InForm 
study component 

Notes 

Data set • Table in CDD 
mapping definition. 

• Panel in CIS 
mapping definition. 

The data dimensions of a data set form the key for 
each row of a CDD table. Data values defined as 
custom dimensions form pivot columns around 
which the data in the table is organized. 

Description No corresponding 
component 

Study object descriptions are visible only in a 
Central Designer annotated study book. 

Form Form • In the Central Designer application, a form 
note is specified in the layout definition. 

• The Short Title specified in the Central 
Designer application deploys as the form 
mnemonic in the InForm application. 

• The form RefName is used in Reporting and 
Analysis and in CDD table columns for which 
no data series alias exists. 

 Alternate form • In the InForm application, an alternate form 
is used to collect new or changed information 
for those subjects who have started the 
original version of the form. 

• A form containing new or changed items in a 
subsequent, incremental deployment deploys 
as an alternate form for those subjects who 
have started the original version of the form. 

• Alternate forms are not created when you 
install an incremental deployment package 
that contains additions to repeating forms or 
itemsets. 

 Associated forms Two forms defined as repeating and linked with 
the AssociatedForm property in the Central 
Designer application deploy as associated forms in 
the InForm application. 

 Common form A form defined as a common form deploys as a 
common form. 

 Date of Visit form If you do not include a special Date of Visit item 
in the study, a default Date of Visit form is 
deployed to the InForm application. 

 Dynamic form A form for which the precondition is the outcome 
of a workflow rule or global condition deploys as 
a dynamic form in the InForm application. 

 Enrollment form If you do not include a special Enrollment form in 
the study, a default Enrollment form is deployed 
to the InForm application. 
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Central Designer 
study component 

Corresponding InForm 
study component 

Notes 

 Regulatory report forms 
and visit report forms 

You can create regulatory report and visit report 
forms in the NonClinical container in the Project 
Explorer. If you do not create the forms, default 
versions are generated and deployed.   

 Repeating form A form defined as repeating in the Central 
Designer application deploys as a repeating form 
in the InForm application. 

 Screening form If you do not include a special Screening form, a 
default Screening form is deployed to the InForm 
application.  

Global condition Rule The deployment process treats a global condition 
as a rule and creates rule attachments, arguments, 
and dependencies in the InForm application as 
necessary based on the items referenced in the 
global condition definition. 

Help text CRF Help Instructions and Help defined for forms or items 
in the Central Designer application deploy as CRF 
Help in the InForm application. Instructions and 
Help defined for other study objects (for example, 
study events) in the Central Designer application 
do not deploy to the InForm application. 
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Central Designer 
study component 

Corresponding InForm 
study component 

Notes 

Item Item Item deployment considerations: 

• The Central Designer application includes the 
following custom properties (on page 480) 
for InForm deployment: 

 Collapsible (for items)—Defaults to 
False in the InForm application. 
Collapsed items in the Central Designer 
application become dynamic controls in 
the InForm application. 

 Display Override (for items)—Defaults 
to False in the InForm application. 

 Required (for items)—Defaults to True 
in the InForm application. 

 SDV Critical (for forms and items)—
Defaults to False in the InForm 
application. 

 SDV Required (for items)—Defaults to 
True in the InForm application. 

 Special Fields (for items)—Identifies 
items that have a special meaning in the 
InForm application, including special 
Date of Visit and Randomization items 
and items that appear on special forms. 

• Layout specifications determine how controls 
appear in the InForm application. For date 
time items, layout specifications include the 
specification of year ranges. 

 Date/time control Date time items in the Central Designer 
application become date/time controls in the 
InForm application.  

 Group control A compound item defined with child items in the 
Central Designer application deploys in the 
InForm application as a group control consisting 
of the child items. 

 Nested control An item in the Central Designer application that is 
conditional on another item deploys in the 
InForm application as a nested control within the 
item on which it is conditional. 

 Text control Text, integer, and float items in the Central 
Designer application become the appropriate text 
controls in the InForm application.  
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Central Designer 
study component 

Corresponding InForm 
study component 

Notes 

 Unit • A base unit or a base unit and a single 
conversion unit specified in an integer, float, 
or yes no item definition in the Central 
Designer application deploy as units in the 
InForm application.  

• If more than one conversion unit is selected 
in the item definition, the conversion units 
deploy in the InForm application as a radio or 
pulldown control, depending on the layout 
option selected. 

Library No corresponding 
component 

This type of study object is not deployed to the 
InForm application. 

Library project No corresponding 
component 

This type of study object is not deployed to the 
InForm application. 

Mapping CDD or CIS mapping 
definition object 

 

Rule Rule The deployment process creates rule attachments, 
arguments, and dependencies in the InForm 
application as necessary based on the items 
referenced in the rule definition. 

Section Section • In the Central Designer application, a section 
note is specified in the layout definition. 

• If you do not create a section for a form in 
the Central Designer application, a section 
with the same title as the form is automatically 
generated when the study is deployed to the 
InForm application. 

 Itemset The items in a section defined as repeating in the 
Central Designer application are grouped into an 
itemset in the InForm application. 

 Repeating Data itemset The items in a section defined as fixed and 
repeating in the Central Designer application are 
grouped into a Repeating Data itemset in the 
InForm application. 

Short Question Itemset column header • If a Short Question is specified, the value is 
used for the column header that appears in 
the itemset.  

• If a Short Question is not specified, the value 
of the Default Question is used. 
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Central Designer 
study component 

Corresponding InForm 
study component 

Notes 

Study  Study The study version (VERSIONDESCRIPTION 
attribute in InForm MedML) is a concatenation 
of: 

• The Title property of the study object. 

• The revision number of the validation 
baseline used to create the deployment 
package. 

• An abbreviation for the locale, if the 
deployment package is created for multiple 
locales. 

Study element No corresponding 
component 

This type of study object is not deployed to the 
InForm application. 

Study event Visit The Short Title of a study event is used as the visit 
mnemonic in the InForm application. 

 Dynamic visit A study event for which the precondition is the 
outcome of a workflow rule or global condition 
deploys as a dynamic visit in the InForm 
application. 

 Enrollment visit A special InForm visit that must be included in 
the Central Designer study design. 

• The enrollment form must belong to the 
enrollment visit. 

• The enrollment visit must be a standalone 
visit in the study workflow. 

• The enrollment visit must be the second visit 
in the workflow after the screening visit. 

 Regulatory report and 
visit report visits 

The deployment process creates regulatory report 
and visit report visits. 

 Repeating visit A study event defined as repeating in the Central 
Designer application deploys as a repeating visit in 
the InForm application. 

 Screening visit A special InForm visit that must be included in 
the Central Designer study design. 

• The screening form must belong to the 
screening visit. 

• The screening visit must be a standalone visit 
in the workflow. 

The screening visit must be the first visit in the 
workflow and the enrollment visit must be 
second. 
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Central Designer 
study component 

Corresponding InForm 
study component 

Notes 

Study project No corresponding 
component 

This type of study object is not deployed to the 
InForm application. 

Task No corresponding 
component 

This type of study object is not deployed to the 
InForm application. 

Template No corresponding 
component 

This type of study object is not deployed to the 
InForm application. 

Type No corresponding 
component 

This type of study object is not deployed to the 
InForm application. 

No corresponding 
component 

Calculated control You cannot create calculated controls in the 
Central Designer application. You can create a 
read-only control that serves the same purpose as 
a calculated control in that it uses a rule to fill in 
data.  

 

Note: Components in MedML are named based on the RefNames of study objects in the Central 
Designer application, with the following two exceptions: 

• PFElements. The RefName from the codelist item is concatenated with an underscore and a 40-
character identifier that the application creates using the RefName, code, and translations of the 
codelist label. If you modify the RefName, code, or codelist label, the application creates a new 
PFElement.  

• Group controls are prefaced with "GC_" only when multiple items are conditional on the same 
item. 

 

Saving the job log to a CSV file 
You can save contents of the Jobs Browser to a comma-separated value (CSV) file that can be 
opened in a Microsoft Excel spreadsheet. Saving the job log enables you to review job log messages 
for validation, deployment, and import jobs. 

1 In the row of browser tabs, select the Jobs Browser. 

The Jobs Browser appears. 

2 Click Save As, or right-click the browser, and select Save As. 

The Save As dialog box appears. 

3 Browse to the location in which to save the file. 

4 Specify a file name, and click Save. 
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Creating a deployment package 
1 In the Project Explorer, select Study Information. 

2 Select a study, and select Actions > Create Deployment Package. 

or 

Right-click a study, and select Create Deployment Package. 

3 In the Deployment Editor, click New Package. 

The Create Deployment Package Wizard appears. 

4 Complete the pages of the Create Deployment Package Wizard: 

• Click Next when you complete each page. 

• On the Select a Deployment Package Type page, specify the type of deployment package to 
create (full, incremental, or administration data). 

Based on your choice on the Select a Deployment Package Type page, the Create Deployment 
Package Wizard prompts for different information as you progress through the wizard. 

5 On the final page of the Create Deployment Package Wizard, click Finish. 

A deployment package job starts, and a slide-up message appears to indicate when the job starts 
and completes. 

6 When the job completes, check the status in the Jobs Browser. 

For more information, see: 

Create Deployment Package Wizard - full deployment package (on page 449). 

Create Deployment Package Wizard - incremental deployment package (on page 453). 

Create Deployment Package Wizard - administration data deployment package (on page 456). 
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Deployment Editor 

Use the Deployment Editor to create and manage the deployment packages and automated 
deployments for a study. The Deployment Editor lists all existing deployment packages in a 
hierarchical display that indicates how incremental deployment packages relate to the full deployment 
package on which they are based. 

Using the Deployment Editor, you can: 

• Create a deployment package. 

• Save a deployment package to the file system. 

• Delete a deployment package and all its children. 

• Create an automated deployment request. 

• View the status of a deployment request. 

• Cancel an automated deployment. 

• View a history of automated deployments for a deployment package. 

To open the Deployment Editor: 

• In the Project Explorer, select the Study Information Explorer bar > Deployment folder. 

For more information, see Deployment Editor—Option descriptions (on page 457). 
 

Deleting a deployment package 
You can delete a deployment package for a LIVE or UAT deployment instance when the following 
is true: 

• The deployment package was not transferred to the InForm environment.   

Note: If the deployment package was transferred to the InForm environment but the 
deployment was cancelled you cannot delete the package. 

• The deployment package is not associated with a rejected deployment request.  

• The deployment package is not associated with a locked deployment request approval.  

1 In the Project Explorer, select Study Information. 

2 Select the Deployment folder. 

The Deployment Editor appears. 

3 In the Deployment Editor, select the deployment package to delete. 

4 Click Delete, or right-click the row containing the deployment package, and select Delete. 

A confirmation message prompts you to confirm the deletion. 

Note: To delete a deployment package with a deployment request to a UAT or LIVE 
deployment instance, the status of the deployment must be Not Applicable or Unknown. 

5 Click OK. 
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When you delete a deployment package, the following are also deleted: 

• Any incremental deployment packages associated with the package. 

• Any automated deployment data associated with the package, including deployment requests; 
deployment approvals and rejections; deployment cancelations and deployment request 
cancelations; and deployment logs. 

 

Automated deployment 
Automated deployment is the process through which a study design is moved directly from the 
Central Designer application to the InForm environment. 

Note: Automated deployment is supported only in release 6.1 and later of the InForm application. 

The deployment request is the basis of the automated deployment process. To initiate an automated 
deployment: 

1 Set up the InForm environment. For example, you must create the InForm server and study 
before you use the automated deployment feature. For more information, see the InForm Study 
and Reporting Setup Guide. 

2 Create a deployment instance to define the InForm servers to which to deploy the study. For 
more information, see Creating a deployment instance (on page 292). 

3 Create a deployment request for a deployment package. In the request, you define where the 
study is deployed, what the deployment options and schedule are, and who is notified of the 
deployment. For more information, see Creating a deployment request (on page 293). 

4 If the deployment requires an approval, obtain approval by a user with the appropriate right. For 
more information, see Approving or rejecting a deployment request (on page 295). 

If the deployment does not require an approval, skip the next step. 

5 The Central Designer application transfers the deployment package to the InForm server and 
installs the package according to the schedule configured in the deployment request. 

Before you can perform automated deployments to the InForm application, the following 
prerequisites must be met: 

• In the Central Designer Administrator application, roles must exist with the Create deployment 
request and Approve deployment request rights, and users must be assigned to these roles. For 
more information, see the Administrator Guide. 

• Users assigned to roles with the Create deployment request and Approve deployment requests 
rights must be on the study team. For more information, see Setting up study teams (on page 
13). 

• The deployment instance to which the deployment will be performed must be set up. For more 
information, see Setting up deployment instances (on page 291). 

• In the Central Designer Administrator application, the default deployment options are 
configured for each type of deployment instance. 
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Setting up deployment instances 
To perform automated deployments to the InForm application, you must define the InForm servers 
to which to deploy by creating a deployment instance study object for each server. 
 

Creating a deployment instance 

1 In the Project Explorer, select Study Information. 

2 Select a study. 

3 Select the Deployment Setup tab. 

4 On the toolbar, click New ( ). 

The New Deployment Instance dialog box appears. 

5 In the Name field, type the RefName of the deployment instance. 

The name that you choose is used when you deploy the study manually. 

6 In the Type drop-down list, select the type of deployment instance: 

• UAT—User acceptance testing 

• QA—Quality assurance 

• DEV—Development 

• LIVE—Production 

• TRN—Training 

7 In the Trial URL field, type the URL used to log on to the machine on which to deploy the 
InForm study. 

8 In the Status URL field, type the URL used to query for the deployment status of the study. 

Note: You can add one deployment instance for each server type. 

9 To require deployment approval for the deployment instance, select the Approvals Required 
checkbox.  

Note: This option is available only if you configured the Central Designer application to 
allow a user to override the default setting for the type of server. For more information, see 
the Administrator Guide. 

10 In the Description field, type a description for the deployment instance. 

11 Click OK. 
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12 Optionally, to test the deployment instance URL: 

a Select the URL. 

b Click the Test URL button on the toolbar.  

A message appears with the test results. 

Note: To reference a deployment instance in a deployment request, the deployment instance 
must not have any unsaved changes. 

For more information, see Deployment Setup—Option descriptions (on page 436). 
 

Editing or deleting a deployment instance 

1 In the Project Explorer, select Study Information. 

2 Select a study. 

3 Select the Deployment Setup tab. 

4 In the grid, select a deployment instance. 

• To remove the instance, on the toolbar, click Delete ( ). 

• To edit the instance, on the toolbar, click Edit ( ). 

Notes: 

• Editing or deleting an instance does not affect deployment requests created before the edit or 
deletion. 

• You cannot delete an instance that is associated with in-place revisions. If you edit an instance 
with in-place revisions, the changes affect the in-place revisions. 

 

Creating a deployment request 
1 In the Project Explorer, select Study Information. 

2 Select the Deployment folder. 

The Deployment Editor appears. 

3 In the Deployment Editor, select the deployment package to deploy. 

4 On the toolbar, click Deployment, and select Request. 

The Deployment Request dialog box appears. 

5 In the Name drop-down list, select the target deployment instance. 

6 Set the deployment schedule. You can select to perform the deployment immediately, or at a 
specific time based on your local time. 

Note: For a LIVE deployment, if you configure the study to deploy immediately, the 
deployment is delayed five minutes. 

7 In the Deployment option drop-down list, select whether you are deploying to a new study, or 
modifying an existing study. 

8 In the Reason for deployment drop-down list, select the reason for creating the deployment 
request. 
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9 Optionally, enter additional information about the deployment in the corresponding text box. 

Note: This information is not included in the email notifications.  

10 In the Email distribution list table, select the users who receive email notifications about the 
deployment. 

If approvals are required for the deployment instance, you must select at least one user with the 
right to approve deployments. 

11 Optionally, select the Advanced tab to set the deployment start delay option. 

For more information, see Deployment Request—Option descriptions (on page 465). 

12 Click OK. 

The Deployment Request Summary dialog box appears. 

13 Do one of the following: 

• If your study requires deployment request approval, click Request Approval. 

You must wait for approval before continuing with the deployment request. 

• If your study does not require deployment request approval, click Deploy. 

The Deployment Request Summary dialog box appears. 

14 Review the deployment information, and click Deploy. 

Note: Make sure the schedule of deployments to the LIVE deployment instance does not 
interfere with the operation of the production environment. 

15 If the deployment request does not require an approval, the InForm Login dialog box appears. 

16 Type your InForm user name and password, and click Login. 
 

Canceling a deployment 

After you create a deployment request, you can cancel the deployment request or deployment in the 
following two scenarios: 

• If the deployment request requires an approval but it has not been approved or rejected yet, and 
you have the appropriate rights, you can cancel the deployment request. 

• If the deployment request has been approved, or it does not require an approval, and you have 
the appropriate rights, you can cancel the deployment if the status of deployment is either 
Scheduled or Submitted. 

To cancel a deployment or a deployment request: 

1 In the Project Explorer, select Study Information. 

2 Select the Deployment folder. 

The Deployment Editor appears. 

3 Select a deployment package. 

4 On the toolbar, click Deployment and select History. 
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The Deployment Package History dialog box appears. 

5 Select a deployment and do one of the following: 

• To cancel a deployment with the status of Scheduled or Submitted, click Cancel Deployment. 

• To cancel a deployment request that has not been approved or rejected yet, click Cancel 
Deployment Request. 

6 Enter a reason for the cancelation and, optionally, additional information, and click OK. 

If you are canceling a deployment with the status of Scheduled or Submitted, the InForm Login 
dialog box appears. 

7 Type your InForm user name and password and click Login. 

A confirmation message appears. 

8 Click Yes. 
 

Approving or rejecting a deployment request 
If you have the appropriate rights, you can view all the deployment requests that you can approve in 
the Pending Approvals tab of the Home page. Additionally, if you are a team member for a study, 
you may receive an email notification when a deployment request is created for that study. 

1 On the toolbar, click the Home Page button ( ). 

2 Select the Pending Approvals tab. 

3 In the grid, select a deployment request. 

4 On the toolbar, click Approve/Reject. 

The Approve Request dialog box appears. 

Note: As long as the dialog box is open, the request is locked and cannot be accessed by 
other users. 

5 Do one of the following: 

• To approve the request, select Approve, sign the approval affidavit by providing your 
password, and click Approve. 

• To reject the request, select Reject, select a reason for rejecting, optionally, type additional 
information in the corresponding text box, and click Reject. 

6 If you selected Approve, the InForm Login dialog box appears. 

7 Type your InForm user name and password, and click Login. 

The deployment package will be transferred to the InForm server immediately and installed 
according to the schedule specified in the deployment request. 

For more information, see Pending Approvals tab—Option descriptions (on page 458). 
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Email notifications 
The Central Designer application sends email notifications whenever one of the following events 
related to automated deployments occurs: 

• Deployment request is created. 

• Deployment request is canceled. 

• Deployment request is approved or rejected. 

• Deployment is canceled. 

• Deployment starts. 

• Deployment completes successfully or with failures. 

You select the users who receive email notifications when you create the deployment request. For 
more information, see Creating a deployment request (on page 293). 

Note: An administrator must configure the Central Designer application to send email 
notifications. For more information, see the Installation Guide. 

 

Viewing the history of deployments associated with your user account 
In the Deployment History dialog box, you view detailed information about the deployment requests 
that are: 

• Created by you. 

• Waiting for your approval. 

• Approved or rejected by you. 

If you are assigned to a role with the View deployments across studies right, the Deployment History 
dialog box displays a complete record of automated deployments from all studies, including those on 
which you are not a team member. However, you must be a team member for a study to approve or 
reject a deployment request for the study. 

To open the Deployment History dialog box: 

• Select Tools > Deployment History. 

Or 

• On the Home Page, select the Pending Approvals tab, and then click Deployment History on the 
toolbar. 

The Deployment History dialog box appears. For more information, see Deployment History 
dialog box—Option descriptions (on page 460). 
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Viewing the history of deployments for a package 
The Deployment Package History dialog box displays a complete history of all the deployment 
requests created for a deployment package, and any approvals, rejections, or cancelations associated 
with the deployment requests. 

To open the Deployment Package History dialog box: 

1 In the Project Explorer, select Study Information. 

2 Select the Deployment folder. 

The Deployment Editor appears. 

3 In the Deployment Editor, select a deployment package. 

4 On the toolbar, click Deployment, and select History. 

The Deployment Package History dialog box appears. For more information, see Deployment 
Package History dialog box—Option descriptions (on page 462). 

 

Viewing and exporting the deployment log 
To follow the progress of a deployment after the deployment package has been transferred to the 
InForm server, you can view the deployment log. The deployment log contains an entry for steps 
reached in the deployment process. The following information is available for each entry: 

• Deployment Step—Description of step reached in the deployment process. 

• Timestamp—Time when the step was reached and the entry was added to the log. 

To view and export the deployment log for a deployment: 

1 In the Project Explorer, select Study Information. 

2 Select the Deployment folder. 

The Deployment Editor appears. 

3 In the Deployment Editor, select a deployment package. 

4 On the toolbar, click Deployment and select History. 

The Deployment Package History dialog box appears. 

5 Select a deployment and click View Log on the toolbar. 

The View Deployment Log dialog box appears. 

6 To export the complete deployment log to a CSV file, click Export. 
 

Manual deployment 
You must use manual deployment to deliver and install a deployment package to a study in InForm 
release 6.0 or earlier. You can also use manual deployment as an alternative to automated deployment 
for studies in the InForm release 6.1 or later. However, if you do not use automated deployment, you 
might notice differences in functionality when using the View Differences dialog box and performing 
in-place revisions. 

For more information, see Viewing the differences between two versions of a form (on page 
349). 
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Saving a deployment package 
1 In the Project Explorer, select Study Information. 

2 Select the Deployment folder. 

The Deployment Editor appears. 

3 In the Deployment Editor, select the deployment package to deliver. 

4 Click Save as. 

The Save as dialog box appears. 

5 If you are deploying to InForm release 6.1 or later:  

• In the Deployment options section, in the Deployment Start Delay field, specify a time in 
milliseconds to delay deployment. 

• Select a deployment instance to which to deploy the study. 

The Type and URL fields are populated with the deployment type and deployment URL for 
the selected deployment instance. 

The Central Designer application does the following:  

• Determines whether the InForm application needs to update the study workflow. 

• Identifies rules that were deleted or disabled since the most recent successful 
deployment so that the rules in the InForm application can match what is in the Central 
Designer application. 

6 Click Save, and specify the location in which to save the deployment package ZIP file. 
 

Installing a deployment package 
To manually install a study in the InForm application: 

1 If you are deploying to an InForm release prior to 6.1, you must use the PKGInst.exe file from 
the Central Designer software distribution to process the deployment package and install the 
study to the InForm application. 

a Copy the PKGInst.exe file in the InstallSupport folder on the software distribution. 

b Paste the file to the InForm server, and run the deployment from that location. 

2 Save a deployment package to the file system. 

3 Save the package in a location from which it can be retrieved (for example, a folder on a shared 
network). 

4 Install the deployment package on the computer where the InForm application is running. You 
must have the following administrative privileges on the InForm computer: 

• Permission to install and register COM objects. 

• Permission to write to the \bin and \Trials folders in the InForm directory structure. 

You can install a deployment package: 

• Using the Deployment Wizard (on page 299). 

• Using command-line options (on page 299). Using this feature, you can execute a 
deployment package by running a script that contains command-line deployment options or 
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a reference to a configuration file of deployment options. 

• From the Deployment page in the InForm application (for InForm release 6.1 and later). 
For more information, see the InForm User Guide. 

5 If you migrated to Central Designer release 2.1.2 or later and this is the first time you are 
deploying to InForm release 6.1.1 or later, you must do one of the following to update the 
workflow rules for the study. 

• Run the pfadmin updateworkflow command. 

For more information, see the InForm Installation Guide or the InForm Study and Reporting 
Setup Guide. 

• In the InForm application, run rules in batch mode. 

For more information, see the InForm User Guide. 
 

Installing a deployment package using the Deployment Wizard 

1 Log on to the computer where the InForm server software is installed. 

2 If you are deploying to an InForm release prior to 6.1, you must use the PKGInst.exe file from 
the Central Designer software distribution to process the deployment package and install the 
study to the InForm application. 

a Copy the PKGInst.exe file in the InstallSupport folder on the software distribution. 

b Paste the file to the InForm server, and run the deployment from that location. 

3 Open a command prompt and run the following command: 

PKGInst.exe [/df File] 

where File is the full path to the deployment package ZIP file. 

The welcome page of the Deployment Wizard appears. 

4 Click Next to complete the pages of the Deployment Wizard. 

5 Click Finish. 

6 If you migrated to Central Designer release 2.1.2 or later and this is the first time you are 
deploying to InForm release 6.1.1 or later, you must do one of the following to update the 
workflow rules for the study. 

• Run the pfadmin updateworkflow command. 

For more information, see the InForm Installation Guide or the InForm Study and Reporting 
Setup Guide. 

• In the InForm application, run rules in batch mode. 

For more information, see the InForm User Guide. 

For more information, see Deployment Wizard for InForm deployment (on page 466). 
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Installing a deployment package using command-line options 

1 Log on to the computer where the InForm server software is installed. 

2 If you are deploying to an InForm release prior to 6.1, you must use the PKGInst.exe file from 
the Central Designer software distribution to process the deployment package and install the 
study to the InForm application. 

a Copy the PKGInst.exe file in the InstallSupport folder on the software distribution. 

b Paste the file to the InForm server, and run the deployment from that location. 

3 Open a Microsoft Windows command window. 

4 Do one of the following: 

• In the directory where the deployment package is saved, run the PKGInst.exe executable, 
along with the desired deployment options. 

• Execute a script that contains the desired deployment options. 

• Execute a script that refers to an XML configuration file containing the desired deployment 
options. 

5 If you migrated to Central Designer release 2.1.2 or later and this is the first time you are 
deploying to InForm release 6.1.1 or later, you must do one of the following to update the 
workflow rules for the study. 

• Run the pfadmin updateworkflow command. 

For more information, see the InForm Installation Guide or the InForm Study and Reporting 
Setup Guide. 

• In the InForm application, run rules in batch mode. 

For more information, see the InForm User Guide. 

For more information, see: 

Deployment command-line options (on page 301). 

Deployment ConfigFile options (on page 304). 
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Executing the deployment package 

Deployment command-line options 

The usage for the deployment command-line feature is as follows: 

/help | 
/testconversion | /testc | 
/silent [/ConfigFile filename] | 
[[/LogFileName filename][/UnpackDirectory directoryname][/ForceBASEInstall 
(TRUE | FALSE)][/CheckInFormVersion (TRUE | FALSE)][/DontExitIfUnsuccessful 
(TRUE | FALSE)][/Server ServerName][/Trial TrialName][/responsefile File] 
[/Strict (TRUE | FALSE)][/TrialCreateModeValue (DB [/Connect 
DatabaseConnectString]| DSN [/TRIDSN DSNString])]] 
 

For example, the following statement installs the ASM916S deployment package located in the C:\ 
directory, without prompting for user input, to a study called ASM916 on an InForm server called 
INF916: 

Oracle.Designer.DeploymentInstaller /DeploymentFile C:\ASM916S.zip/silent 
/LogFileName ASM916S.log /ForceBASEInstall TRUE /Server INF916 /Trial ASM916 
/User ASM916uid /Password ASM916pid /Strict TRUE /TrialCreateModeValue DB 
/Connect APPSRV_dev1 

 

Option Description 
/help Display a dialog box summarizing the command-line usage and 

options. 

/CsmlToMedml 

or 

/medml [filename] 

Convert the study to MedML. 

Note: Optionally, you can specify a file name. If you do not specify a 
file name, an XML file is saved in the directory that holds the 
deployment package. 

/FullCsml [filename] Extract the CSML from the deployment package. 

Note: Optionally, you can specify a file name. If you do not specify a 
file name, a CSML file is saved in the directory that holds the 
deployment package. 

/InFormCsml Extract the CSML that was deployed to InForm. 

/RuleAssembly 

or 

/rule [directoryname] 

Extract the rule assembly and all function DLL files. 

Note: Optionally, you can specify a directory in which to store the 
files. If you do not specify a directory, a rule directory is created in the 
directory that holds the deployment package, and all extracted files are 
saved in the directory. 

/DesignerUnit 

or 

/unit [directoryname] 

Export the units file.  

Note: Optionally, you can specify a directory in which to store the 
file. If you do not specify a directory, the file is saved in the directory 
that holds the deployment package. 

/CustomProperties 

or 

/CP 

Extract the custom properties. 
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Option Description 
/Target targetid 
[foldername] 

Extract the CSML to the specified folder. 

/TargetList Target applications for the deployment package. 

/Version 

or 

/ver 

Obtain the release number of the Central Designer application from 
which the deployment package was created. 

/silent Run in silent mode (without prompting for user input), using the 
options specified either on the command line or in the configuration 
file named in the /ConfigFile option. 

/ConfigFile filename Use the specified configuration file to obtain deployment options. 

/LogFileName filename Create a log file in the specified location. By default, a log file called 
StudyInstaller.log is created in the InForm installation folder. 

/UnpackDirectory 
directoryname 

Unzip the deployment package in the specified local directory. 
Deployment files include: 

• Deployment package. 

• Deployment DLLs. 

• MedML.xml file containing the MedML generated by the 
deployment process if the deployment is unsuccessful. 

If you do not specify this option, the files are unzipped to a temporary 
system directory. The StudyInstaller.log file includes the location of the 
deployment files. 

/ForceBASEInstall 
(TRUE | FALSE) 

• TRUE—Clear the study database, if the study exists, and install 
the Base study. 

• FALSE—(Default) Do not force the Base study to be installed. 

/CheckInFormVersion 
(TRUE | FALSE) 

• TRUE—(Default) Check the InForm version to make sure that it 
is compatible with the current version of the Central Designer 
application. If the software versions are not compatible, 
deployment does not continue. 

• FALSE—Do not check the InForm version to make sure that it is 
compatible with the current version of the Central Designer 
application. You might select this option if you are running 
deployment with the /testconversion option, which does not install 
the study MedML. 

/DontExitIfUnsuccessful 
(TRUE | FALSE) 

• TRUE—Keep the Deployment Wizard open if the deployment is 
unsuccessful. 

• FALSE—(Default) Close the Deployment Wizard if the 
deployment is unsuccessful. 
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Option Description 

 The following values are required if you run deployment in silent mode; 
otherwise, they are optional. If you specify any of the following 
command-line options and do not run in silent mode, the 
corresponding fields in the Deployment Wizard are populated with the 
values you specify. 

/Server ServerName Name of the InForm application server. 

/Trial TrialName Name of the InForm study. 

/responsefile File Name of the TXT file that contains the Oracle user name and 
password for the InForm study database. 

/Strict (TRUE | FALSE) • TRUE—Only complete MedML definitions of study components 
can be loaded into the study; an incomplete definition causes the 
installation to fail. 

• FALSE—Incomplete study component definitions are permitted. 

/TrialCreateModeValue 
(DB | DSN) 

• DB—The deployment process creates an ODBC connection for 
the study to the specified database instance. When you specify this 
option, include the connection string to the database instance in 
the /Connect option. 

• DSN—The study uses an existing ODBC connection. When you 
specify this option, include the name of the study DSN in the 
/TRIDSN option. 

/Connect 
DatabaseConnectString 

Connection string for the Oracle instance. 

/TRIDSN DSNString ODBC System DSN for the InForm study. 

/ServerAutoStartup The InForm server starts automatically when the InForm Service starts. 
If you do not include the /ServerAutoStartup option, the InForm 
server must be started manually.  

/TrialAutoStartup The InForm study starts automatically when the InForm Service starts. 
If you do not include the /TrialAutoStartup option, the InForm study 
must be started manually. 

/DeploymentStartDelay Time to wait (in milliseconds) for the InForm caches to initialize before 
deploying. 

/IPRServer ServerName Name of the deployment instance that points to the InForm study to 
which to apply the in-place revisions. You specify the deployment 
instance name when you create the deployment instance. 

 

For more information, see Creating a deployment instance (on page 292). 
 



Chapter 7  Validating and deploying a study  
 

304 Oracle® Health Sciences Central Designer 2.1.2 

Deployment ConfigFile options 

As an alternative to entering deployment options at the command line or in a script, you can include 
the options for executing a deployment package in a configuration file referenced by the /ConfigFile 
command-line option. The configuration file is in XML format. 

 

Option Description 
<DeploymentData> 

 

xmlns:xsd="http://www.w3.org/2001/XMLSchema" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns="http://www.phaseforward.com/DeploymentData/200
6-04-25" 

<HostName /> 

<HostUserName /> 

<HostUserPassword /> 

<HostSharedDirectory /> 

<HostSharedDirectoryLocalPath 
/> 

Reserved for future use. 

<TargetType/> INFORM 

<ServerName/> Name of the InForm application server. 

<TrialName/> Name of the InForm study. 

<UserName/> Oracle user name for the study database.  

<UserPassword/> Oracle password for the study database. 

<StrictMode/> • TRUE—Only complete MedML definitions of study 
components can be loaded into the study; an incomplete 
definition causes the installation to fail. 

• FALSE—Incomplete study component definitions are 
permitted. 

<TrialMode/> • DB—The deployment process creates an ODBC 
connection for the study to the specified database instance. 
When you specify this option, include the connection string 
to the database instance in the <DatabaseConnectString/> 
option. 

• DSN—The study uses an existing ODBC connection. 
When you specify this option, include the name of the trial 
DSN in the <TRIDSN /> option. 

<TRIDSN /> ODBC System DSN for the InForm study. 

<DatabaseConnectString/> Connection string for the Oracle instance. 

<TrialStartupMode/> • Automatic—The InForm study starts automatically when 
the InForm Service starts. 

• Manual—The InForm study must be started manually. 
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Option Description 

<ServerStartupMode/> • Automatic—The InForm server starts automatically when 
the InForm Service starts. 

• Manual—The InForm server must be started manually. 

<ForceBASEInstall/> • TRUE—Clear the study database, if the study exists, and 
install the Base study. 

• FALSE—(Default) Do not force the Base study to be 
installed. 

<CheckInFormVersion/> • TRUE—(Default) Check the InForm version to make sure 
that it is compatible with the current version of the Central 
Designer application. If the software versions are not 
compatible, deployment does not continue. 

• FALSE—Do not check the InForm version to make sure 
that it is compatible with the current version of the Central 
Designer application. You might select this option if you 
are running deployment with the /testconversion option, 
which does not install the study MedML. 

<ProtocolName /> 

<ProtocolUserName /> 

<ProtocolUserPassword /> 

<DBAdminUser /> 

<DBAdminUserPassword /> 

<DataSpace /> 

<TableSpace /> 

<UNCHelpDirectory /> 

<VirtualHelpDirectory /> 

<WebPath /> 

<SSL/> 

Reserved for future use. 

 

 
 



Chapter 7  Validating and deploying a study  
 

306 Oracle® Health Sciences Central Designer 2.1.2 

Sample deployment configuration file 
<DeploymentData xmlns:xsd="http://www.w3.org/2001/XMLSchema" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns="http://www.phaseforward.com/DeploymentData/2006-04-25"> 

<HostName /> 
<HostUserName /> 
<HostUserPassword /> 
<HostSharedDirectory /> 
<HostSharedDirectoryLocalPath /> 
<TargetType>INFORM</TargetType> 
<ServerName>INF916</ServerName> 
<TrialName>ASM916</TrialName> 
<UserName>ASM916uid</UserName> 
<UserPassword>ASM916pid</UserPassword> 
<StrictMode>false</StrictMode> 
<TrialMode>DB</TrialMode> 
<TRIDSN /> 
<DatabaseConnectString>APPSRV_dev1</DatabaseConnectString> 
<TrialStartupMode>Manual</TrialStartupMode> 
<ServerStartupMode>Manual</ServerStartupMode> 
<ForceBASEInstall>false</ForceBASEInstall> 
<CheckInFormVersion>true</CheckInFormVersion> 
<ProtocolName /> 
<ProtocolUserName /> 
<ProtocolUserPassword /> 
<DBAdminUser /> 
<DBAdminUserPassword /> 
<DataSpace /> 
<TableSpace /> 
<UNCHelpDirectory /> 
<VirtualHelpDirectory /> 
<WebPath /> 
<SSL>false</SSL> 

</DeploymentData> 
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Protecting and unprotecting study objects 

About protecting study objects 
When a study or library is protected, changes cannot be made to study objects or to the structure of 
the study or library. 

 

In a protected study, you cannot do the 
following 

In a protected study, you can do the 
following 

• Update a protected study object. 

• Explicitly or implicitly lock a protected study 
object. 

• Drag and drop a study object onto a 
protected study object. 

• Paste a study object onto a protected study 
object. 

• Delete a study object that is the direct child 
of a protected study object. 

• Validate, create, and delete baselines. 

• Create and delete deployment packages. 

• Add or copy and paste a study object into a 
container in the flat view. 

• Copy and paste a protected study object 
onto an unprotected study object. The 
protected study object remains protected. 

• Delete a study object that is not the direct 
child of a protected study object. 

 

Note: If a protected rule references a study object for which the RefName is modified, the rule is 
updated with the new RefName. 

When a study object is protected, its icon changes to reflect its protected state. 

For each study object, you can: 

• Protect—Protect the selected study object and all its children regardless of their origin, including 
study objects that you copied into the study or library from another project. 

Note: You cannot delete study objects that are the direct children of a protected study 
object. 

Note: You can protect templates and types. However, if you create a new study object from 
a template or type, the newly created study object is not protected. 

• Unprotect—Unprotect only the selected study object. You can unprotect a study object that 
came from a library only if you have the Unprotect study objects from libraries right. 

• Unprotect with children—Unprotect the selected study object and all of its children. 

The way that children are unprotected depends upon the location in which you are working. 

•  In a study:  

• If the study object that you are unprotecting with children was copied from a library, the 
study object and all of its children are unprotected as long as you have the Unprotect 
study objects from libraries right. 

• If the study object that you are unprotecting with children was created in the study and 
you copied one or more of its children from a library, the study object is unprotected, 
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but any children copied from the library are not unprotected. You can unprotect them 
individually if you have the Unprotect study objects from libraries right. 

• In a library: 

• The study object and all of its children are unprotected, regardless of whether or not any 
of the children were copied from a library or study as long as you have the Unprotect 
study objects in libraries right. If you do not have this right, the parent and children 
remain protected. 

Note: You are not prompted or required to save after you protect or unprotect a study 
object. Protecting and unprotecting does not change the study object. 

You cannot protect the following areas: 

• The Study and Library Editors. 

• The Jobs Browser. 

• The Baselines Browser. 

Note: After you protect a study object, you cannot select undo, but you can select unprotect. 

 
 

Protecting and unprotecting a study or study object 
You are not prompted or required to save after you protect or unprotect a study object. Protecting 
and unprotecting does not change the study object. 

To protect a study or study object: 

1 In the Project Explorer, right-click a study or study object and select Protect. 

If the study object or any of its children are shared within the current study, the Protect dialog 
box appears. The Protect dialog box displays the shared objects, parent study objects, and the 
type of study object. 

Note: The Protect dialog box does not appear if you protect an entire study. 

2 Click Yes to proceed. 

The selected study or study object and all of its children are protected. 

The icons to the left of the study or study object and all of its children change to reflect a 
protected state. 

Study objects that came from a library are also protected. 

Note: After you protect a study object, you cannot undo, but you can unprotect the study 
object. 
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To unprotect a study or study object: 

1 In the Project Explorer, right-click a study or study object and select Unprotect. 

If the study object is shared within the current study, the Unprotect dialog box appears. The 
Unprotect dialog box displays the shared object, parent study objects, and the type of study 
object. 

2 Click Yes to proceed. 

The selected study or study object is unprotected, and all of its children remain protected. 

The icon to the left of the study or study object changes to reflect an unprotected state. 

To unprotect a study or study object with children: 

1 In the Project Explorer, right-click a study or study object and select Unprotect with Children. 

Note: Unprotect with Children is available only if the selected study object has children. 

If the study object or any of its children are shared within the current study, the Unprotect dialog 
box appears. The Unprotect dialog box displays the shared objects, parent study objects, and the 
type of study object. 

Note: The Unprotect dialog box does not appear if you unprotect an entire study with 
children. 

2 Click Yes to proceed. 

The way that children are unprotected depends upon the location in which you are working. 

•  In a study:  

• If the study object that you are unprotecting with children was copied from a library, the 
study object and all of its children are unprotected as long as you have the Unprotect 
study objects from libraries right. 

• If the study object that you are unprotecting with children was created in the study and 
you copied one or more of its children from a library, the study object is unprotected, 
but any children copied from the library are not unprotected. You can unprotect them 
individually if you have the Unprotect study objects from libraries right. 

• In a library: 

• The study object and all of its children are unprotected, regardless of whether or not any 
of the children were copied from a library or study as long as you have the Unprotect 
study objects in libraries right. If you do not have this right, the parent and children 
remain protected. 

The icons to the left of the study or study object and all of its children change to reflect an 
unprotected state. 
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Protecting and unprotecting a library 
To protect a library: 

1 In the Project Explorer, select the Library Information Explorer bar. 

2 Right-click the library and select Protect. 

The selected library and all of the study objects within the library are protected. 

The icons to the left of the library and all of the study objects within the library change to reflect 
a protected status. 

Note: You cannot delete study objects that are the direct children of a protected study object. 
After you protect a study object, you cannot select Undo, but you can select Unprotect. 

To unprotect a library: 

1 In the Project Explorer, select the Library Information Explorer bar. 

2 Right-click the library and select Unprotect. 

The selected library is unprotected. 

The icon to the left of the library changes to reflect an unprotected status. 

Note: Unprotecting a library or a study object in a library does not affect study objects that you 
copied from the library into a study. 
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Archiving and decommissioning a study 

About decommissioning studies and projects 

Workflow for decommissioning studies and projects 
Decommissioning is the process of archiving and deleting a study, study project, or library project. 

 

Workflow step More information 

1 Archive the study or project (on page 316). • Information that is archived (on page 
313).  

• About archiving (on page 312). 

2 (Optional but highly recommended)  

Make a full database backup.  

 

3 Delete the study or project (on page 11, on 
page 317). 

• Information that is deleted when you 
delete a study or project (on page 314). 

• About deleting a study or project (on 
page 313). 

4 (If you need to modify a decommissioned 
study, study project, or library project)  

Download and import an archived study 
or project (on page 318). 

• Information that is imported from an 
archive (on page 315). 

• About downloading and importing an 
archive (on page 313). 

5 (Optional) 

Delete an archived study or project from 
the database (on page 319).  

 

 

Note: You also can archive without deleting and delete without archiving.  
 

About archiving 
Archiving and deleting allow you to decommission an entire study, study project, or library project, 
including all of its study objects. The archiving functionality is not intended to be your only backup 
mechanism. You should also schedule regular database backups.  

An archive contains the components that reconstruct a study, study project, or library project. All 
archives are saved on the database server, and you can copy them to another location and delete 
them from the database. 

The archive process locks the study or project, but not the study objects in it. Therefore, Oracle 
recommends that you schedule archive processes for a time when no one is using the application. 

Note: You cannot delete or archive the System Library or its project. 
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About deleting a study or project 
Deleting an archive file decreases the size of the database by removing unwanted studies, study 
projects, and library projects.  

Before you delete a study, study project, or library project, Oracle recommends that you perform a 
full database backup. You can also archive the study or project (on page 316). 

When you download an archive file, you have the option of permanently deleting it from the 
database. 

Note: You cannot delete or archive the System Library or its project. 

 
 

About downloading and importing an archive 
You have the following options for importing an archive: 

• Import an archived study into a study project. 

• Import an archived study project or library project and create a new project. 

You can import an archive into the database in which it was created or into another database. You 
cannot import an archived study, study project, or library project if it still exists in the target 
database—first you must delete the existing study, study project, or library project (on page 11, 
on page 317). 

Before you can import an archived study or project, you must download it from the database. 
Optionally, you can delete the file from the database after downloading it. 
 

Information that is archived 
 

Component Information that is saved in an archive 
Attachments  Attachments on: 

• The study or library. 

• The study project or library project. 

Baselines  • All baselines. 

• Most recent revision of any study objects that the most recent baseline does 
not contain. 

Categorizations  • System and user keywords.  

• Automatically generated and manually generated categories. 

• The mappings that connect keywords and categories to study objects. 

Collaboration 
notes and tasks 

All collaboration notes and tasks in the study, study project, or library project. 

Custom 
properties  

• Custom properties and their corresponding keywords and categories. 

• Values of the custom properties. 



Chapter 8  Performing post-design activities  
 

314 Oracle® Health Sciences Central Designer 2.1.2 

Component Information that is saved in an archive 
Functions  All functions in the study, study project, or library project. 

Study objects • All study objects, including their revisions and ancestry information that 
connects a study object to its parent and children. 

• Information about whether a study object is a copy of another study object, 
as well as the study object from which it was copied. 

• Information about whether a study object is published, including the 
revisions that were published. 

Teams  • Teams in the study or library.  

• Information about users in the team, such as user name, first name, and last 
name, but not the roles for the users. 

Units  The units file. 

Validation results 
(Studies only) 

Validation results for the most recent baseline only. 

Direct 
deployment 
records (for UAT 
and LIVE 
deployment type 
instances only) 

• Information about deployment requests and approvals. 

• Deployment packages. 

• Information about users associated with the request, including the user who 
created the deployment package, the user who created the deployment 
request, the user who approved or rejected the request, and the users in the 
email distribution list for the request 

• Deployment logs created for the deployment. 
 

 

Information that is deleted when you delete a study or project 
 

Component Information that is deleted 
Attachments  Attachments on: 

• The study or library. 

• The study project or library project. 

Note: Attachments are not deleted if they are referenced by study objects 
that are not deleted. For example, study objects are not deleted if they are 
shared with another library. 

Baselines  All baselines.  

Categorizations  The mappings that connect keywords and categories to study objects. 

Note: The actual keywords and categories are not deleted. 

Collaboration notes 
and tasks  

All collaboration notes and tasks in the study, study project, or library 
project. 
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Component Information that is deleted 

Custom Properties  The mappings that connect custom properties and their hierarchy to study 
objects.  

Note: The actual custom properties are not deleted. 

Study objects • All study objects, including their revisions. 

Note: When the repository contains children or a parent of a deleted 
study object, the children and parent are connected. 

• Information about whether a study object is a copy of another study 
object, as well as the study object from which it was copied. 

• Information about whether a study object is published, including the 
revisions that were published. 

Teams The teams in the study or library. 

Note: Users are not deleted from the Central Designer application, and their 
corresponding roles are not deleted from the Central Designer Administrator 
application. 

Validation results 
(Studies only) 

All validation results. 

 
 

Information that is imported from an archive 
 

Component Information that is imported 
Attachments  Attachments on: 

• The study or library. 

• The study project or library project. 

Files with the same name are overwritten. 

Baselines  All baselines. 

Categorizations  • System and user keywords.  

• Automatically generated and manually generated categories. 

• The mappings that connect keywords and categories to study objects. 

Note: If categories or keywords already exist in the target database, they are not 
overwritten. 

Collaboration 
notes and tasks 

All collaboration notes and tasks in the study, study project, or library project. 

Custom 
properties  

• Custom properties and their corresponding keywords and categories. 

• Values of the custom properties. 

Note: If custom properties with the same name and on the same study object 
already exist in the target database, they are not overwritten.  
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Component Information that is imported 
Functions  All functions in the study, study project, or library project. 

Note: Functions with the same file name in the target database are overwritten.  

Study objects • All study objects are imported with their original identifiers. Archived study 
objects are re-inserted so the family tree is restored. 

• Information about whether a study object is a copy of another study object, 
as well as the study object from which it was copied. 

• Information about whether a study object is published, including the 
revisions that were published. 

Note: The identifiers for study objects are maintained after an import. Linked 
study objects are overwritten in the target database only if the archive contains a 
newer revision of the study object. 

Validation results 
(Studies only) 

All validation results. 

 

Notes:  

• The units file is not imported. If you need to recover this file from an archive, contact Oracle 
Services. 

• Users and teams are not imported. When study objects in the archive refer to a user that does 
not exist in the target database, archiveimporter is inserted for the user's name. For example, if 
the user JohnSmith modified a study object in the archive but does not exist in the database, the 
History Viewer lists archiveimporter in place of JohnSmith after the archive is imported. 

 

Decommissioning 
Decommissioning is the process of archiving and deleting a study, study project, or library project. 

Archiving and deleting allow you to decommission an entire study, study project, or library project, 
including all of its study objects.  

Note: The archiving functionality is not intended to be your only backup mechanism. You should 
also schedule regular database backups. 
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Archiving a study or project 
You must save before archiving.  

Note: You cannot delete or archive the System Library or its project. 

Note: You cannot archive a study project if it contains hidden studies (studies for which you are 
not a team member). 

1 Do one of the following: 

• For a study project, in the Project Explorer, select the Study Information Explorer bar.  

• For a library project, in the Project Explorer, select the Library Information Explorer bar. 

2 Right-click the study project or library project, and select Archive > Create Archive. 

Note: If a deployment to a LIVE or UAT deployment instance is scheduled or in progress, you 
must wait to archive until the deployment process is complete.  

3 If you selected a study, specify whether you want to archive the study or the entire study project.   

Slide-up messages appear, indicating when the job begins and finishes. 
 

Viewing archived studies and projects 
1 Open a study, study project, or library project.  

2 In the Project Explorer, right-click a study, study project, or library project, and select Archive > 
View Archives. 

The View Archives dialog box appears. 
 

Deleting a study or project 
When you delete a study, study project, or library project, the contents are permanently removed 
from the database. 

Note: You cannot delete or archive the System Library or its project. 

Note: To delete a study deployed to a LIVE or UAT deployment instance, you must first archive the 
study. Do not delete the archive. 

1 (Optional but highly recommended) Perform a full database backup. 

2 (Optional) Archive the study or project (on page 316). 

3 In the Project Explorer, right-click a study, study project, library, or library project, and select 
Delete. 

A confirmation message appears.  
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The message indicates if the latest version of the selected study, or any of the studies or libraries 
in the selected project, has not been archived. 

Note: You cannot delete a study project if it contains hidden studies (studies for which you 
are not a team member). 

4 Click Yes. 

You receive a message that recommends performing a full database backup before deleting.  

5 Click Yes. 
 

Downloading and importing an archived study or project 
You can import an archive into the database in which it was created or into another database. You 
cannot import an archived study, study project, or library project if it still exists in the target 
database—first you must delete the existing study, study project, or library project (on page 11, 
on page 317). 

Before you can import an archived study or project, you must download it from the database. 
Optionally, you can delete the file from the database after downloading it.  

To download an archived study or project: 

1 (Optional) Perform a full database backup.  

2 In the Project Explorer, right-click a study, study project, or library project, and select Archive > 
View Archives. 

The View Archives dialog box appears. 

3 Select an archive, and click Download. 

You are asked if you want to delete the archive after it is downloaded. 

If you choose Yes, the archive file is permanently deleted from the database and cannot be 
recovered.  

4 Click Yes to delete the archive from the database, or click No to leave the archive in the database. 

The Save As dialog box appears. 

5 Navigate to a location for saving the archive, modify the file name as necessary, and click Save. 

If you chose to delete the file after downloading it, the file is removed from the list. 

6 Click Close. 

To import an archived study or project: 

1 Download the archive file from the database. 

2 To import a study, open a study project. To import a study project or library project, close the 
project in which you are working. 

3 Do one of the following: 

• Right-click a study or study project, and select Archive > Import Archive. 

• Right-click the library project, and select Archive > Import Archive. 
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The Import from Archive wizard appears. 

4 Click Next. 

The File Location page appears. 

5 Click Browse, and navigate to and select the file to import. 

The Archive Contents page appears. 

6 Click Next. 

7 Click Finish. 

If you imported a study, the project is reloaded. If you imported a project, you can open it by 
selecting File > Open. 

 

Deleting an archived study or project from the database 
Archives are stored on the database server until you delete them. Optionally, you can delete an 
archive when you download it. For more information, see Downloading and importing an 
archived study or project (on page 318). 

Note: You cannot undo the deletion of an archived study or project from the database. 

1 In the Project Explorer, right-click a study, study project, or library project, and select Archive > 
View Archives. 

The View Archives dialog box appears. 

2 Select one or more archives 

3 Click Delete. 

A confirmation dialog box appears. 

4 Click Yes. 
 

Viewing errors associated with an archive 
If errors occur during the creation of an archive, you can view the errors in the project's Jobs 
Browser.  

If a project or study fails to import, you can view the errors in a study project that is created to show 
error messages.  

1 Select File > Open. 

The Open dialog box appears. 

2 Select the Import Archive Project Placeholder, and click Open. 

The project opens. 

3 Open the Jobs Browser, where you can view the errors associated with the archive. 
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Generating reports 

About reports 
You can generate reports to check the progress of work for the following study objects: 

• Studies. 

• Libraries. 

• All study objects in a library. 

Reports provide information about study objects, such as: 

• Study objects that have been copied from a library to a study and then modified and saved in 
either the study or library. 

• Number of times a study object was copied to a study or library. 

• Data-entry rule action/locale combinations in a study. 

• RefName paths for all deployed items (InForm controls) in a study. 

Note: You can open the Reports dialog box for all study objects. If no reports are available for the 
study object, There are no reports for the selected object appears in the drop-down list. 

 

Study object Report InForm-specific 
Studies Data Entry Rule Actions Report. Yes 

InForm RefName Report. Yes 

Library Objects Modified in the Study. No 

Library Objects Modified in the Library. No 

Libraries 

 

Number of Studies Containing Library 
Objects. 

No 

Library Objects Modified in Studies. No 

Study objects in a library Studies Containing Selected Library Object. No 
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Generating, saving, and printing a report 
The View System that you select determines the reports that you can run. 

For more information, see About reports (on page 320). 

1 In the Project Explorer, select a study object (study design, study element, study event, form, 
section, item, codelist, codelist item, mapping, data set, or data series). 

2 Select Actions > Reports. 

or  

Right-click the study object, and select Reports. 

If the study contains unsaved objects, a dialog box appears, asking if you want to save the 
changes to you made to your study. 

3 Click Yes. 

The Reports dialog box appears. 

4 From the Reports drop-down list, select a report, and click Run Report. 

Note: You can open the Reports dialog box for all study objects. If no reports are available 
for the study object, There are no reports for the selected object appears in the drop-down 
list. 

5 To save the report: 

a Click Save As. 

The Save As dialog box appears. 

b Navigate to the location in which to save the report. 

c In the File name field, type the name of the report, and click Save. 

The report is saved as a CSV file. 

Note: The saved CSV file is UTF-8 encoded to accommodate international characters. You 
can open the saved file by double-clicking the file or selecting File > Open in the Microsoft 
Excel spreadsheet software.  

6 To print the report, click Print.  

Note: When you generate a report for a study that contains an invalid workflow, an error occurs, 
and the report cannot be run. 

For more information, see Invalid workflows (on page 73). 
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Data Entry Rule Actions report 
The Data Entry Rule Actions report runs at the study level. The report lists each data-entry rule 
action/locale combination in a study. Each row in the report corresponds to a supported locale for a 
unique rule action. For example, if a data-entry rule has two actions and two supported locales, the 
report would display four rows for that rule. This report does not include data for workflow rules or 
global conditions. The selected study must have at least one defined locale in order for this report to 
run. 

The report displays each rule only once, regardless of the number of times that the study object on 
which it exists is used in a study. For example, a rule that is defined on an item that appears on more 
than one form appears once in the report. 

Note: This report contains InForm-specific study objects and is not available for studies that do 
not have InForm selected as one of the Deployment Systems or contain only non-InForm study 
objects. When you generate a report for a study that contains an invalid workflow, an error 
occurs, and the report cannot be run. 

Running this report should not be considered a substitute for validation. Errors (or lack thereof) 
encountered while generating this report are not necessarily a reflection of study validity. 

Note: This report runs against data in the database. Oracle recommends that you save the study 
before running the report. 

 

Field Description 
Action Expression For SetValue expressions: The expression that you create in the SetValue 

Action box. 

For Update Workflow actions: UpdateWorkflow(). 

Action Type Type of action, such as Query or SetValue, that occurs upon evaluation 
of the rule expression. 

Email Sender 

Email Recipient 

Email Subject 

Email Body 

(Applicable for Email actions only.) 

The following information about the email that is sent upon evaluation of 
the rule expression: 

• Sender's email address 

• Recipient's email address 

• Subject 

• Body text 

Error Message(s) Description of the error(s) encountered while gathering data for the data-
entry rule action/locale combination represented in this row. 
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Field Description 

Error status icon Indicates whether an error was encountered while gathering data for the 
data-entry rule action/locale combination represented in this row. 

• A red circle with an X indicates that an error occurred. 

• A green circle with a checkmark indicates that no error occurred. 

Locale Locale in which translated text appears for the action. 

Translated text appears in the following fields: 

• Email Subject (if applicable) 

• Email Body (if applicable) 

• Query Text (if applicable) 

• Target Form Mnemonic 

• Target Item Question 

Query Status 

Query Text 

(Applicable for Query actions only.) 

Status and text of the query that is created upon evaluation of the rule 
expression.  

Rule Description Description for the data-entry rule. 

Rule Last Update User Name of the user who most recently updated the data-entry rule. 

Rule Match Selection in the Rule Wizard > Actions > If the value is section. For 
example, Always. 

Rule Name Name of the data-entry rule. 

Rule Revision Revision number of the data-entry rule. 

Rule Status Status of the data-entry rule; either Enabled or Disabled.  

Rule Switch Expression for the data-entry rule. 

Rule Timestamp Date and time when the data-entry rule was most recently updated. 

Rule Trigger Event that causes the rule to run; either FormSubmission or OnDemand. 

Rule Type Type of rule; either Intrinsic (for a rule created based on a rule template) 
or Expression (for a calculation or constraint rule). 

Study Object RefName 

Study Object Title 

Study Object Type 

The following information about the study object on which the data-
entry rule exists: 

• RefName. 

• Title. 

• Type. 

Target Form Mnemonic 

Target Form RefName 

Short title and RefName of the form on which the item that is the target 
of the rule action exists. 

Note: If the item is used on multiple forms in the study, the mnemonics 
and RefNames for the forms are listed and separated by semicolons. 
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Field Description 
Target Item Number 

Target Item Question 

Target Item RefName 

Target Item Title 

Number, question, RefName, and title of the item that is the target of the 
rule action. For example: 

• For Query actions, the item on which the query appears. 

• For Email actions, the item to which the email action is attached. 
You select this item in the Email Action dialog box, in the Item field. 

• For SetValue actions, the item for which a value is set. 

This information does not apply to UpdateWorkflow actions. 

Note: If the item is used on multiple forms in the study, the item 
numbers for the forms are listed and separated by semicolons. 

Note: When an item appears on only one form and is in a repeating 
section, therefore ending in zero, such as 2.10, the number in the Target 
Item Number column is enclosed in single brackets, such as '2.10'. 

 
 

InForm RefName report 
The InForm RefName report runs at the study level. The report lists the full InForm RefName paths 
of all items (InForm controls) for a study. The selected study must have at least one defined locale in 
order for this report to run. 

The InForm RefName Report includes: 

• One item per row. 

• Items in the study design. 

• Items that hold data. For example, the RefName for a compound item without child controls 
does not appear in the report. 

• Up to five levels of nested items. 

Note: This report contains InForm-specific study objects and is not available for studies that do 
not have InForm selected as one of the Deployment Systems or contain only non-InForm study 
objects. When you generate a report for a study that contains an invalid workflow, an error 
occurs, and the report cannot be run. 

The report does not process items on non-clinical forms, such as Regulatory Document and Visit 
Report forms. 

Note: This report runs against data in the database. Oracle recommends that you save the study 
before running the report. 
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Field Description 
Control 1 RefName RefName of the item. 

Control 2-5 RefName RefNames of the items that are conditional on the item or that are 
children of the compound item. 

For a codelist item that contains multiple conditional items, a control is 
created to contain the conditional items. The control name includes the 
RefName of the codelist item, which is: 

• Prefixed with GC_. 

• Appended with the numerical position of the codelist item in the 
codelist. 

For example, if the Medication item has three codelist items with two 
items that are conditional on the third codelist item, the following 
control is created to contain the items that are conditional on the third 
codelist item: 

GC_Medication3 

Error Message(s) The error that occurred while the report processed the data for the item. 

Error status icon Indicates whether an error occurred while the report processed the data 
for the item. 

• A red circle with an X indicates that an error occurred. 

• A green circle with a checkmark indicates that no error occurred. 

Form RefName RefName of the form on which the item exists. 

Item RefName RefName of the item. 

Itemset RefName RefName of the repeating section on which the item exists. 

If the item is not on a repeating section, this field is blank.  

Section RefName RefName of the section in which the item exists. 

If a section is not defined, the Form RefName for the item appears in 
this field. 

Visit RefName RefName of the study event in which the item exists. 

If the form on which the item study object is located is a common form, 
CommonCRF appears in this field. 
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Library Objects Modified in the Study report 
Level at which the report runs 

The report runs at the study level. 

Description 

The report lists study objects (when they exist) that were copied from a library to the study and then 
modified and saved in the study. For a copied study object to appear in the report, it must be saved 
before it was modified. Similarly, if you copy the study object, modify it without saving it, and then 
save it, the study object does not appear in the report. 

Purpose 

If all study objects in the library have been fully tested, use the report to identify study objects that 
might require further testing as part of the test plan. 

Additionally, you can use the report to monitor whether designers are adhering to library standards 
for a particular study. 

Fields 
 

Field Description 
Study Object Title Title of the study object in the study. 

Study Object RefName RefName of the study object in the study. 

Library Object Title Title of the study object in the library. 

Library Object RefName RefName of the study object in the library. 
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Library Objects Modified in the Library report 
Level at which the report runs 

The report runs at the study level. 

Description 

The report lists study objects (when they exist) that were copied from a library to the study and then 
modified and saved in the library. 

Purpose 

Use the report to identify the study objects that were modified in the library after being copied to a 
study, so you can determine if an update to the study object in the study is required, as well. 

Fields 
 

Field Description 
Study Object Title Title of the study object in the study. 

Study Object RefName RefName of the study object in the study. 

Library Object Title Title of the study object in the library. 

Library Object RefName RefName of the study object in the library. 
 

Note: It is possible for a study object to appear in the report if it has not been modified and saved 
in the study. For example, if a study object is linked in multiple libraries, copied to a study, and 
subsequently modified and saved in one of the libraries, the study object appears in the report. 
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Number of Studies Containing Library Objects report 
Level at which the report runs 

The report runs at the library level. 

Description  

The report lists: 

• Study objects (when they exist) that were created in the library and copied into a study. 

• The number of studies to which each study object was copied. 

Note: Study objects that are marked as templates or types do not appear in the report. 

Purpose 

Use the report to determine the number of studies to which a study object has been copied from the 
library. 

Fields 
 

Field Description 
Library Object Title Title of the study object in the library. 

Library Object RefName RefName of the study object in the library. 

Number of Studies Number of studies in which the study object is used. 

Note: A study object copied into a single library two or more 
times is counted only once. 
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Library Objects Modified in Studies report 
Level at which the report runs 

The report runs at the library level. 

Description 

The report lists: 

• Study objects (when they exist) that were created in the library and copied into a study. 

• The study to which each study object was copied. 

Note: Study objects that are marked as templates or types do not appear in the report. 

Purpose 

Use the report to identify how frequently a study object was modified after it was copied from a 
library to a study. Many updates to a study object might indicate that the study object needs to be 
updated in the library. 

Fields 
 

Field Description 
Library Object Title Title of the study object in the library. 

Library Object RefName RefName of the study object in the library. 

Study Copied To Name of the study to which the study object was copied. A study 
object has a row for each study to which it is copied. 
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Study Baselines Difference report 
The report runs at the study level, and decreases the amount of time it takes to determine the 
differences between two valid public study baselines. 

The report contains the following information:  

• Names of the project, study, and both baselines selected.  

• Versions of the study for which each baseline was created.  

• Date the report was generated and the name of the person who generated the report. 

You can export the report to a comma-separated value (CSV) file type. 

Note: At this time, the Study Baselines Difference Report does not report differences for data 
mappings or study administration data. 

Use this report to compare the study objects in the baselines. For each study object that changed, the 
report displays either detailed or grouped information. 

• Detailed information—Lists the study objects that changed between the two baselines, and 
displays the following information for each changed study object: 

• RefName of the study object. 

• Name of the study object property. 

• Previous and current value of the property. 

• Whether the study object was added, deleted, or modified in the more recent baseline. 

• Grouped information—Lists the study objects that changed between the two baselines and 
groups similar changes into a single difference for the study object. Displays whether the study 
object was added, deleted, or modified, but does not display details about the modification. 
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Objects with detailed information Objects with grouped information 

• Codelists 

• Codelist items 

• Constants 

• Elements 

• Events 

• Forms 

• Items (compound, date, time, float, integer, 
and text) 

• Rules (global condition, data entry, and 
workflow) 

• Rule templates 

• Sections 

• Study design 

• Study-level styles  

• Form layouts 

• Functions 

• Help 

• Rules (complex changes to a rule and actions 
changed for a rule) 

• Workflows 

• Workflow layouts 

 

 
 

Studies Containing Selected Library Object report 
Level at which the report runs 

The report runs in a library only for study elements, study events, forms, sections, items, codelists, 
codelist items, mappings, data sets, and data series. 

Description 

The report lists the studies to which the study object has been copied from a library. 

Note: Study objects that are marked as templates or types do not appear in the report. 

Purpose 

Use the report to identify the number of studies to which a study object has been copied. The usage 
of a study object might influence a decision to maintain a study object or remove it from the library. 

Additionally, when you are considering changing a study object and propagating the change to the 
studies in which the study object is used, the report can help you determine the impact of the change. 

Fields 
 

Field Description 
Study Title Title of the study to which the selected study object was copied. 
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Generating an Annotated Study Book 

About Annotated Study Books 
An Annotated Study Book is a form-by-form summary of the design of a study. Optionally, it 
includes a time and events schedule, a preview of each form, and selected annotations that list design 
details. Optionally, it includes a schedule of events, a preview of each form, and selected annotations 
that list design details. You can print an Annotated Study Book or save it to a PDF file and use it as a 
tool for reviewing the study design. 

For details about how design information is displayed in an Annotated Study Book, see: 

• Annotated Study Book Options dialog box (on page 356). 

• Schedule of Events table in the Annotated Study Book (on page 336). 

• RDE Analytics tables in the Annotated Study Book (on page 332). 
 

Annotated study books, locales, and layouts 
When you generate an annotated study book for a study that supports multiple locales, you specify 
the layout and locale to use. When you generate a deployment package, you specify the default layout 
locale for the deployment package. These settings are independent of each other. 

• Annotated Study Book—When you specify a layout and generate an annotated study book, the 
annotated study book reflects the layout customizations that you have made for the layout. 

• Deployment package—In InForm release 4.7 and later, a single study version contains the 
layout information for all locales in the study, and you specify a default layout locale, from which 
all layouts, regardless of locale, inherit customizations in the InForm application.  

The site locale language in the InForm application determines the language in which forms 
appear. 

For example, a study contains layouts for the French (France) and the English (United 
Kingdom) locales. Radio buttons are horizontal in the French (France) layout but are vertical in 
the England (United Kingdom) layout. If French (France) is the default layout locale, then all 
layout customizations for the France (French) layout, including the alignment of radio buttons, 
are deployed to the InForm application and appear for all users, regardless of their site locale. 
Therefore, if your site locale in the InForm application is English (United Kingdom), the forms 
appear in English but with the customizations that were made in the French (France) layout in 
the Central Designer application. 
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RDE Analytics tables in the Annotated Study Book 
RDE Analytics tables are listings of the column names that are generated when study data is 
extracted to the InForm reporting database.  

 

Field Description 
Data Variable Title of the item for which the column names are generated, or 

RefName if Show Object RefNames is selected in the Annotated 
Study Book Options dialog box. 

RD Column Name Name of the column in the reporting database where the data will 
be inserted.  

• Column names consist of the item RefName or the RefName 
concatenated with a suffix. 

• The special characters _-()/",+%@#$&*!~|{}[]<>:;?\ are 
removed from each study object RefName before it is 
appended with the appropriate suffix.  

• All types of top-level items have a column with the suffix _ND 
to hold the reason that an item is not done or incomplete. The 
format of the other column names generated for an item 
depends on the type of item. 

• For child items of compound items, the RefName of the 
parent and child items are concatenated before the suffix. 

• If the RefName part of the generated column name exceeds 25 
characters, an asterisk appears in front of the column name to 
indicate that it will not match the actual RDE output. A 
footnote explains the asterisk. 

• If an item is used multiple times on a form, an asterisk appears 
in front of the column name to indicate that it might not 
match the actual RDE output. A footnote explains the asterisk.  

For more information, see RD Column Name in RDE Analytics 
tables (on page 333). 

Column Data Type Data type of the column. 

Note: For each form, items that are outside of a section on a form 
and items that are in a nonrepeating section are included in a table. 
If a form contains a repeating section, each repeating section has its 
own table and the items in the repeating section are listed in the 
corresponding table for the repeating section.  
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RD Column Name in RDE Analytics tables 
 

RD Column Name Source of data Column data type 

Text, integer, or float item 
without units: 

  

• Item_RefName Entered value VARCHAR2, 
NUMBER, or FLOAT, 
depending on the data 
type of the item. 

• Item_RefName_ND Reason why an item is incomplete 
(Not Done, Not Applicable, or 
Unknown). 

VARCHAR2 

• Item_RefName_IB Value to indicate whether an item 
is marked as blank: 

• 1—Item is blank 

• 0—Item is not blank 

VARCHAR2 

Integer or float item with units:   

• Item_RefName Entered value NUMBER or FLOAT 

• Item_RefName_N Normalized value NUMBER or FLOAT 

• Item_RefName_U Entered unit symbol VARCHAR2 

• Item_RefName_NU Normalized unit symbol VARCHAR2 

• Item_RefName_ND Reason why an item is incomplete 
(Not Done, Not Applicable, or 
Unknown). 

VARCHAR2 

• Item_RefName_IB Value to indicate whether an item 
is marked as blank: 

• 1—Item is blank 

• 0—Item is not blank 

VARCHAR2 

Radio buttons or drop-down lists:   

• Item_RefName Label VARCHAR2 

• Item_RefName_C Coded value VARCHAR2, 
NUMBER, or FLOAT, 
depending on the data 
type of the item. 

• Item_RefName_ND Reason why an item is incomplete 
(Not Done, Not Applicable, or 
Unknown). 

VARCHAR2 
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RD Column Name Source of data Column data type 

• Item_RefName_IB Value to indicate whether an item 
is marked as blank: 

• 1—Item is blank 

• 0—Item is not blank 

VARCHAR2 

Checkboxes   
Two columns for each checkbox:   

• RefName_of_parent_item - 
RefName_of_child_item_or_co
ntrol 

Label of codelist item control in 
child item. 

VARCHAR2 

• RefName_of_parent_item - 
RefName_of_child_control_C 

Coded value of codelist item 
control in child item. 

VARCHAR2, 
NUMBER, or FLOAT, 
depending on the data 
type of the item. 

Dates and times:   

• Item_RefName Valid, complete date time or 
complete date plus hours and 
minutes (A complete date time 
can include UNK or ND entries). 

DATE 

• Item_RefName_DTS Date string VARCHAR2 

• Item_RefName_DTR Appears when: 

• The Item_RefName_DTS 
column name appears for an 
item. 

and 

• The value of any date part 
that appears is not required, 
or an unknown value is 
allowed for the date part.  

VARCHAR2 

• Item_RefName_TMS Time string VARCHAR2 

• Item_RefName_TMR Appears when: 

• The Item_RefName_TMS 
column appears for an item.  

and 

• The value of any date part 
that appears is not required, 
or an unknown value is 
allowed for the date part.  

VARCHAR2 
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RD Column Name Source of data Column data type 

• Item_RefName_ND Reason why an item is incomplete 
(Not Done, Not Applicable, or 
Unknown). 

VARCHAR2 

• Item_RefName_IB Value to indicate whether an item 
is marked as blank: 

• 1—Item is blank 

• 0—Item is not blank 

VARCHAR2 

Compound items (parent item):   

• RefName_of_parent_item_ND Reason why an item is incomplete 
(Not Done, Not Applicable, or 
Unknown). 

VARCHAR2 

• Item_RefName_IB Value to indicate whether an item 
is marked as blank: 

• 1—Item is blank 

• 0—Item is not blank 

VARCHAR2 

Compound items (child item):   

• RefName_of_parent_item - 
RefName_of_child_item_Suffix 

One or more columns for each 
child item, based on the item 
type. The value of Suffix is 
based on the type of the child 
item or control, as described in 
this table. 

Based on the type of the child 
item or control. 

Based on the type of the 
child item or control. 
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Schedule of Events table in the Annotated Study Book 
 

Field Description 
Element If the study design uses study elements, they appear in the first row, and the study 

events in each study element are grouped under the study element columns. 

Note: The study element name for the special Screening and Enrollment visits is 
System. 

Assessment Study events are listed in study workflow order, as they appear in the workflow editor 
for the study design or study element. 

The heading of each visit column shows the study event title, short title (in 
parentheses), and visit type (in square brackets).  

Visit types: 

• S—Scheduled 

• D—Dynamic 

• U—Unscheduled 

• R—Repeating 

CRF Short title of each form, or blank if the ShortTitle property is not defined.  

Visit Start 
Hours 

The visit start hour appears for study events. The visit start hour is a calculated value 
based on the scheduling specified for the study workflow. 

The start hour for the special Screening and Enrollment visits is zero. If the first visit 
after the Screening and Enrollment visits is not scheduled in the study workflow, its 
start hour is also zero. 

Forms • Identified with their translated names in the language in which the annotated 
study book is generated. If the translated name is not specified, the form title 
appears. This form identifier also appears on each annotated form in the 
annotated study book. 

• Forms are listed in study workflow order, except that: 

 Forms that occur in more than one visit are not duplicated. 

 If a study design includes a Regulatory Documents or Visit Report form, 
those forms appear in the form listing but do not appear in the Time and 
Events table. 

A number in each visit column where the form appears indicates the order in which 
the form occurs in the visit. 

Special form types are indicated by a code that follows the form order number: 

• C—Common 

• DF—Dynamic 

• RF—Repeating 

Key Codes used for special types of forms and visits. 
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Generating an Annotated Study Book 

Note: In the Annotated Study Book and Form Preview window, if a row contains many 
components, the browser that displays the page might wrap text to fit all components onto the 
page. Consequently, for Asian languages, a wrapped text label might appear to have vertical 
orientation, with a single character on each line, because the browser wraps text on a word 
boundary, and a single character can represent a word. To compensate, you can make the 
question portion of the row smaller so the labels in the control section are wide enough not to 
wrap. 

1 In the Project Explorer, select Study Information. 

2 Select the study. 

3 Select File > Annotated Study Book Options. 

The Annotated Study Book Options dialog box appears. 

4 Select display and cover page options. 

5 Click OK. 

6 Select File > View Annotated Study Book. 

If the deployment properties of the study include more than one locale or layout format, or the 
Annotated Study Book includes an In-place Revisions Summary Table and the study contains in-
place revision objects with IPR configurations for one or more deployment instances, the View 
Annotated Study Book dialog box appears. 

7 In the Layout and Language fields, select the name of the layout and a locale. 

Note: The language setting that you specify when generating an Annotated Study Book and 
the locale setting that you specify when generating a deployment package for the InForm 
application are independent and can produce different results. 

8 In the Deployment instance field, select the deployment instance for which to display the IPR 
Summary table. 

9 Click OK. 

When you generate an Annotated Study Book with a Schedule of Events table, and the study 
contains an invalid workflow, an error message appears in a dialog box and in the Schedule of 
Events table, and forms are listed in the Annotated Study Book in alphabetical order regardless 
of the selected order. When this occurs, the option to save the Schedule of Events table as a 
CSV file is disabled. 

For more information, see: 

• Invalid workflows (on page 73). 

• Annotated Study Book Options dialog box (on page 356). 
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Printing an annotated study book 
1 Generate an annotated study book (on page 338). 

2 In the Annotated Study Book window, click Print. 

The Print dialog box appears. 

3 Specify printer options.  

4 Click Print. 
 

Creating a PDF file for an annotated study book 

Note: To generate a PDF file for an annotated study book, you need a PDF print driver such as 
Adobe Acrobat PDF Distiller or PDFcamp from verypdf.com, Inc. 

1 Generate an annotated study book (on page 338).  

2 In the Annotated Study Book window, click Print. 

The Print dialog box appears. 

3 Select a print queue that is backed by a PDF print driver. 

4 Optionally, to set preferences for PDF generation, select Preferences. 

The dialog box for the PDF print driver appears. 

5 Specify preferences for PDF generation, and click OK. 

The Print to File dialog box appears. 

6 Specify a file location, and click OK. 
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Tips for printing an annotated study book or creating a PDF file 
 

Tip Steps 

In Microsoft Internet Explorer, 
activate printing of background 
images and colors. This ensures that 
background images used for some 
controls appear in the output. 

1 Open Microsoft Internet Explorer. 

2 Select Tools > Internet Options. 

3 Select the Advanced tab, and scroll to the Printing options. 

4 Select Print background colors and images. 

5 Click OK. 

Do not print to file. 1 In an annotated study book, click Print. 

2 In the Print dialog box, do not select Print to file. 

Do not download fonts. 1 In an annotated study book, click Print. 

2 In the Print dialog box, select a printer and click 
Preferences. 

3 Select Do not send fonts to Adobe PDF. 

Print in Landscape mode. 1 In an annotated study book, click Print. 

2 In the Print dialog box, select a printer and click 
Preferences. 

3 In the Orientation section of the Layout tab, select 
Landscape. 

 
 

Formatting dates on the Annotated Study Book for the Japanese locale 
For studies developed in the Japanese locale, the long date format is used to format the dates 
(Generated Date and Sponsor Date) that appear on the cover page of the Annotated Study Book.  

Optionally, you can customize the long date format in the following way: 

1 Open the Control Panel > Regional and Language Options.  

2 Click Region and Language. 

3 In the Format drop-down list, select Japanese (Japan). 

4 Click Additional Settings.  

The Customize Format dialog box appears. 

5 On the Formulas tab, in the Long date format drop-down list, select a formatting option. 

6 Select the Time tab, and select a Time format. 

7 Close the Control Panel. 

8 Generate the Annotated Study Book for the Japanese locale. 

The dates on the cover page match the configuration that you specified in the Control Panel. 
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Exporting the Schedule of Events table to a CSV file 
1 Generate an Annotated Study Book (on page 338). 

When you generate an Annotated Study Book with a Schedule of Events table, and the study 
contains an invalid workflow, an error message appears in a dialog box and in the Schedule of 
Events table, and forms are listed in the Annotated Study Book in alphabetical order regardless 
of the selected order. When this occurs, the option to save the Schedule of Events table as a 
CSV file is disabled. 

2 In the lower-left corner of the dialog box, click Save Time & Events as. 

Note: This option appears only when Schedule of Events Table is selected in the Annotated 
Study Book Options dialog box. 

The Save As dialog box appears. 

3 Type a file name, and click Save. 

The CSV file is different from the Schedule of Events table in the Annotated Study Book in the 
following ways: 

• The titles of forms might contain HTML tags, such as <b > and </b>. 

• The row for the study event appears in three rows instead of one. 
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About in-place revisions 
An in-place revision (IPR) allows you to make a study design change and apply it to existing study 
versions that were previously deployed to the InForm application. When you update a study by 
deploying a new study version, you can only modify forms that have not been started in the InForm 
application. However, the in-place revision feature allows you to modify an item on a form and 
deploy the changes to all instances of the form in a specified study version, including forms that were 
started or completed in that study version. 

You create an in-place revision on a top-level item or a section by navigating to the layout view of a 
form that you select in the Visit Schedule Explorer bar. The annotated study book for a study 
optionally includes a listing of the in-place revisions created for a study.  

Before you can make an in-place revision to a study, you must: 

• Be assigned to a role with the Apply in-place revisions right. For more information, see the 
Administrator Guide. 

• Be assigned to the study team for the study on which you are performing an in-place revision. 
For more information, see Setting up study teams (on page 13). 

• Set up a deployment instance for the study. For more information, see Setting up deployment 
instances (on page 291). 
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Overview of the in-place revision process 
Note: You can only perform an in-place revision for a study that you deploy to InForm release 6.1 
or later. 

1 Edit the design of a top-level item or a section. 

2 Mark the change as an in-place revision, and create an IPR configuration for the change. For 
more information, see Marking a change as in-place revision (on page 346). 

3 Validate the study. A validation baseline is created. For more information, see Validating a 
study and creating a baseline (on page 260). 

4 Create a deployment package from the validation baseline. For more information, see Creating 
a deployment package (on page 288). 

5 Install the deployment package in the InForm study. For more information, see Delivering a 
deployment package (on page 279). 
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Marking a change as an in-place revision 
1 In the Project Explorer, select the Forms and Transactions Explorer bar. 

2 Select a form. 

3 Select the Layout tab. 

4 Select an item question or section header on which to apply the in-place revision. 

• To make an in-place revision change to an existing item in a non-repeating section, select the 
item question. 

• To make an in-place revision change to an existing item in a repeating section, select the 
section header. 

• To make an in-place revision change to add an item to a repeating or non-repeating section, 
select the section header. 

5 Click the IPR Configuration button. 

The IPR Configuration dialog box appears. 

6 In the IPR Configuration dialog box, provide details about the in-place revision: 

a Optionally, in the Description of the change field, type a description of the change. 

b Click Add. 

The Add Deployment Instance dialog box appears. 

c Select the deployment instance to associate with the in-place revision. 

For more information, see Setting up deployment instances (on page 291). 

d Select the study version or versions to which to apply the change. 

• To retrieve the latest study version information from the InForm server, click Refresh 
Versions. 

Note: Refreshing version information overwrites the current study version 
association. 

• Optionally, to compare the form containing the revised study object with the same form 
from an existing InForm study version, click View Differences. For more information, see 
Viewing the differences between two versions of a form (on page 349). 

e Click OK. 

An in-place revision study object is created. In the layout tab, the in-place revision icon ( ) 
appears for the study object associated with the in-place revision. 

For more information, see IPR Configuration dialog box—Option descriptions (on page 402). 
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Marking a shared study object as an in-place revision 
The following examples illustrate two ways to apply an in-place revision to a shared study object, 
with the same results when deployed to the InForm application. 

Method 1 

Consider two forms, Vital Signs 1 and Vital Signs 2, which contain the shared item BP. You deploy 
the study and later edit both forms by adding mmHg as caption text on the BP item. Next, you create 
a single in-place revision on the Vital Signs 1 form, specifying that the change applies to the 
previously deployed Vital Signs 1 and Vital Signs 2 forms upon deployment.  

The in-place revision icon appears only on the Vital Signs 1 form in the Central Designer application. 

After deployment, the mmHg caption appears on both forms in the InForm application.  

• Original forms in the Central Designer and InForm applications: 

 
• Forms in the Central Designer application after the caption is updated and the in-place revision 

is created: 

 
• Forms in the InForm application after deployment of the in-place revision: 
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Method 2 

For the same set of forms with the same caption changes to the deployed study, you create: 

• A single in-place revision on the Vital Signs 1 form, specifying that the change applies to the 
previously deployed Vital Signs 1 form upon deployment. 

• A single in-place revision on the Vital Signs 2 form, specifying that the change applies to the 
previously deployed Vital Signs 2 form upon deployment. 

The in-place revision icon appears on both the Vital Signs 1 and Vital Signs 2 forms in the Central 
Designer application. 

After deployment, the mmHG caption appears on both forms in the InForm application. 

• Original forms in the Central Designer and InForm applications: 

 
• Forms in the Central Designer application after the caption is updated and the in-place revision 

is created: 

 
• Forms in the InForm application after deployment of the in-place revision: 
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Viewing the differences between two versions of a form 
When you create an in-place revision for a study object, the View Differences dialog box allows you 
to compare the latest version of the form containing the revised study object with the same form 
from an existing InForm study version. 

If you do not use automated deployment to deploy your study, you are unable to use the View 
Differences dialog box without a successfully deployed baseline. In addition, if a successfully 
deployed baseline exists, if you perform an in-place revision change and apply the change manually, 
the differences that appear in the View Differences dialog box are not correct.  

Note: If in-place revision changes are made to a study that was created in a Central Designer 
release prior to 2.1, you must continue to review the Annotated Study Book PDFs to see 
differences. 

1 In the IPR Configuration dialog box, select a study version, and click View Differences. 

The View Differences dialog box appears, and displays data for the first form and study version 
that appear in the Form and Preexisting version drop-down lists. 

2 To view the differences between other form versions, enter the following: 

• In the Form drop-down list, select a form. 

• In the Preexisting version drop-down list, select a study version with which to compare the 
form. 

• If your study uses more than one locale, in the Locale drop-down list, select a locale. 

3 Click Show Differences. 

The two versions of the form appear in layout view at the top of the dialog box. 

• New study objects are highlighted in green on the latest version of the form. 

• Deleted study objects are highlighted in red on the existing version of the form. 

• Modified study objects are highlighted in yellow on both versions of the form. 

4 To view details about the differences, at the bottom of the dialog box, select a study object. 

5 To preview or print each version of the form individually, click the Preview Form button, and 
select an action from the drop-down list. 
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Deploying an in-place revision 
You apply an in-place revision by deploying a package that contains the revision into the InForm 
application. In the Create deployment package wizard, you can review the changes and you must 
confirm you understand the implications of making in-place revisions before you can create a 
deployment package that contains in-place revisions. 

For more information, see: 

• Creating a deployment package (on page 288). 

• Delivering a deployment package (on page 279). 

Note: After you deploy a study that contains an in-place revision change to a LIVE deployment 
instance, Oracle recommends that you remove all IPR configurations for the study. You can 
delete the IPR configurations manually using the IPR Summary Editor, or you can configure the 
Central Designer application to do so automatically. For more information, see the Administrator 
Guide.  
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Managing in-place revisions 
Use the IPR Summary Editor to manage in-place revisions for a study. 

To view in-place revision changes for a study: 

Note: The annotated study book for a study optionally includes a listing of the in-place revisions 
created for a study. 

1 In the Project Explorer, select the Visit Schedule Explorer bar. 

2 Select the study design. 

The Study Design Editor appears. 

3 Select the IPR Summary tab. 

The In-place revision Summary editor appears. For more information, see In Place Revision 
Summary Editor—Option descriptions (on page 403). 

To delete the IPR configuration for an in-place revision: 

1 In the Project Explorer, select the Visit Schedule Explorer bar. 

2 Select the study design. 

The Study Design Editor appears. 

3 Select the IPR Summary tab. 

4 Select an in-place revision, and click Delete ( ). 

To edit the IPR configuration for an in-place revision: 

1 In the Project Explorer, select the Visit Schedule Explorer bar. 

2 Select the study design. 

The Study Design Editor appears. 

3 Select the IPR Summary tab. 

4 Select an in-place revision, and click Edit ( ). 

The IPR Configuration dialog box appears. 

5 Make the necessary changes, and click OK. 

For more information, see IPR Configuration dialog box—Option descriptions (on page 
402). 

To remove the association between a deployment instance and an in-place revision: 

1 In the Project Explorer, select the Visit Schedule Explorer bar. 

2 Select the study design. 

The Study Design Editor appears. 

3 Select the IPR Summary tab. 

4 Select one or more in-place revision study objects for which to remove a deployment instance 
association. 

5 Click IPR Configurations, and select Remove. 
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The Remove IPR Configurations dialog box appears. 

6 Select one or more deployment instances, and click OK. 

Note: If you delete a deployment instance that is associated with an IPR configuration, and 
that IPR configuration is not associated with any other deployment instances, the Central 
Designer application deletes the IPR configuration from the study.  

To copy an IPR configuration from one deployment instance to another: 

You can copy an IPR Configuration from one deployment instance to another if the source and 
target deployment instances use the same study version number and contain the same path 
information for the study object on which you made an in-place revision change.  

Note: You must manually ensure that this criteria is met, as the Central Designer application does 
not validate this information before you copy the IPR Configuration.  

1 In the Project Explorer, select the Visit Schedule Explorer bar. 

2 Select the study design. 

The Study Design Editor appears. 

3 Select the IPR Summary tab. 

4 Select one or more in-place revision study objects for which to copy an IPR configuration. 

5 Click IPR Configurations, and select Copy. 

The Copy IPR Configurations dialog box appears. 

6 At the top of the dialog box, select the deployment instance from which to copy IPR 
configurations. 

7 At the bottom of the dialog box, select one or more instances to which to copy the 
configurations. 

8 Click OK. 

Note: The Central Designer application overwrites IPR configurations that already exist for 
the deployment instance. 

To view a history of in-place revisions for a LIVE deployment instance: 

1 In the Project Explorer, select the Visit Schedule Explorer bar. 

2 Select the study design. 

The Study Design Editor appears. 

3 Select the IPR Summary tab. 

4 Click History. 

The IPR History dialog box appears. 

5 At the top of the dialog box, select a baseline with successful deployments to a LIVE 
deployment instance, and click Show IPRs. 
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The in-place revision summary for the selected baseline appears at the bottom of the dialog box. 

Note: IPR history appears only for in-place revisions applied through automated 
deployments. 

6 To view the IPR configuration for an in-place revision, select the in-place revision and click View 
Configuration. 

For more information, see the following: 

• IPR Summary Editor—Option descriptions (on page 403). 

• View Differences dialog box—Option descriptions (on page 403). 

• IPR History dialog box—Option descriptions (on page 404). 
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Copying and deleting study objects associated with in-
place revisions 

When you copy a study object, any in-place revision study objects associated with it are not copied. 
This rule also applies to child objects: when you copy a study object with children, the in-place 
revision study objects associated with the children are not copied. 

However, when you delete a study object from a study, any in-place revision study objects associated 
with it are deleted. This rule also applies to child objects: when you delete a study object and choose 
to remove its children, if the operation removes the children from the study, the in-place revision 
study objects associated with the children are removed. A confirmation dialog box appears when you 
delete a study object associated with an in-place revision. 

Note: When you delete an item, you can no longer apply an in-place revision change to it. 
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Annotated Study Book 

Annotated Study Book Options dialog box 

Note: Items with restricted values are marked with a star () in the Annotated Study Book. 

 

Option What appears in the annotated study book when you select the 
option 

Select Display 
Options section 

• No Annotated Information—Form previews without annotations. 

 Display Hidden Items—Form previews without annotations, but 
with all items visible, including those that are hidden using the 
Display Override property. Hidden items include the annotation 
for the hidden display override setting. 

Note: When you select No Annotated Information and Display 
Hidden Items, hidden items do not appear when you generate an 
annotated preview of a form from the form layout editor. 

• Selected Annotated Information—Only the selected annotation 
information. If you choose Selected Annotated Information, select 
the specific information to include in the checkboxes that appear under 
that radio button. 

• All Annotated Information—All annotated information. 

Time and Events 
Schedule 

A listing of the Schedule of Events table. 

Forms Selected information about each form in the study.  

Inline CRF 
annotations 

• If selected—The annotations described below.  

• If not selected—Titles or RefNames that appear in square brackets. 

The annotated forms display RefNames if Show Object RefNames is 
selected and titles if Show Object RefNames is not selected. 

Item formats • Text—A plus maximum character length (for example, A128). 

• Integer—N plus maximum field length (for example, N3). 

• Float—Significant digits and decimal places. The decimal point is 
included as a character in the length of an item. For example, if the 
length of a float item is 5 and the precision is 0, the annotation appears 
as xxxx. (the decimal point appears).  

Captions on 
compound items 

A caption for the parent item of a compound item appears with the 
alignment specified on the Layout tab. 

Hidden, 
ReadOnly, or 
Editable display 
overrides 

The word hidden, read-only, or editable appears in square brackets below 
the item question. 
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Option What appears in the annotated study book when you select the 
option 

Minimums and 
maximums for 
integer and float 
items 

Specifications set in the MinProperty, MinValue, MaxProperty, and 
MaxValue item properties are represented as values and operators and listed 
along with the item format. For example, the notation is 2.0 <= xx.xx < 
100.0 if: 

• MinProperty—GREATERTHANEQUAL 

• MinValue—2.0 

• Float length—5 

• Float precision—2 

• MaxProperty—LESSTHAN 

• MaxValue—100.0 

Date time items Required and unknown specifications appear in the date and time controls, 
and year ranges appear in parentheses following the controls. 

Date format The date format that you select in the Select date variable format field 
appears in parentheses before the controls. 

Required items An asterisk appears after the item number. In the grid view of fixed repeating 
sections, an asterisk appears in the column header for each required item. 

Items that 
require source 
verification 

For an item in a form or non-repeating section, a check mark appears under 
the item number. 

Repeating 
sections that 
require source 
verification 

A check mark appears in the following locations: 

• For a repeating section—Under the number in the repeating section 
header row. 

• For a fixed repeating section—Under the # symbol in the fixed-item 
section header. 

Forms and items 
that are critical 
for source 
verification 

For an item in a form or non-repeating section, a check mark inside a circle 
appears under the item number. 

For a form, a check mark inside a circle appears to the right of the form 
name. 

Forms and items that are source-verification critical are also source-
verification required, so these forms and items show only the check mark 
inside the circle and not an additional check mark denoting their source-
verification required status. 

A footnote indicates that settings for critical source verification that are made 
in the InForm application override settings made in the Central Designer 
application. 

Collapsible 
items 

A collapsible item icon ( ) appears after the item RefName. 

Note: In the InForm application, a collapsible item is called a dynamic 
control. 
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Option What appears in the annotated study book when you select the 
option 

Key items A key icon appears under the item number. 

Base units A superscript b in square brackets appears to the right of the control for the 
base unit. 

Repeating forms 
and sections 

A summary item layout containing top-level items appears (for example, the 
children of compound items and conditional items do not appear), followed 
by a form layout. 

Fixed repeating 
sections 

A fixed item icon ( ) appears after the item number. 

The following views appear: 

• Grid view containing a column for each top-level item and, for each 
fixed item, a row for each combination of item and codelist items. 
Depending on the definitions that exist in the study, column headers 
show the short question in the specified locale, the long question in the 
specified locale, or an empty cell. 

 For a hidden item, the text in the column header is grayed out.  

 The cell for a blank instance of a fixed or non-fixed item is grayed 
out and includes a blank icon ( ). 

• Data entry preview containing controls for each fixed item.  

Associated 
forms 

The name of the associated form, if it exists, appears at the bottom of the 
annotated form. 

Codelist Values and 
Tables 

Annotations on forms for codelists that are formatted as radio or checkbox 
groups. The data type and value appears in square brackets and italic font to 
the left of each option (for example, [N:1] indicates an integer data type and 
a codelist item value of 1). Data types are: 

• A—Text 

• F—Float 

• N—Integer 

Additionally, the annotated study book includes tables that list the 
specifications of each codelist and codelist item along with the title or 
RefName of the item with which they are associated. 

The tables display RefNames if Show Object RefNames is selected and 
titles if Show Object RefNames is not selected. 

Include All Codelist 
Control Types 

Available if Codelist Values and Tables is selected: 

• If selected—The codelist tables include all formats of codelists. 

• If not selected—The codelist tables include only codelists that are 
formatted as a drop-down list. 
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Option What appears in the annotated study book when you select the 
option 

Study Object 
Description Tables 

Tables that list the type (Form, Section, or Item), title or RefName, and 
description for each form, section, and item.  

The tables display RefNames if Show Object RefNames is selected and 
titles if Show Object RefNames is not selected. 

Only Show Properties 
With Values 

Available if Study Object Description Tables is selected. If selected, the 
study object description tables list only study objects that have descriptions. 

Note: If you select All Annotated Information, Only Show Properties 
With Values is not available. 

Key Items Tables Tables that list the following information for items in a repeating form or 
section that are defined as key items for navigation assistance (repeating 
forms only) or to enforce data uniqueness: 

• Item name. 

• Uniqueness (None, Individual, or Group). 

• Order in which the items appear in the drop-down summary list of a 
repeating form. 

The tables display RefNames if Show Object RefNames is selected and 
titles if Show Object RefNames is not selected. 

Coding Summary 
Tables 

Tables that list verbatim, dictionary, coding item, and context item data for 
each item on a form that is coded.  

The tables display RefNames if Show Object RefNames is selected and 
titles if Show Object RefNames is not selected. 

RDE Analytics 
Tables (on page 332) 

Tables that display the titles or RefNames, database table column names, 
and database types that are generated in the InForm Reporting Database 
Extract (RDE) Analytics offering for each data entry object in a form. The 
format of each table column name consists of the RefName of the item or 
the RefName plus a suffix that depends on the type of item and the format 
of the data entry control. The special characters _-
()/",+%@#$&*!~|{}[]<>:;?\ are removed from each study object 
RefName before it is appended with the appropriate suffix.  

The Data Variable column of the RDE Analytics tables displays RefNames 
if Show Object RefNames is selected and displays titles if Show Object 
RefNames is not selected. 
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Option What appears in the annotated study book when you select the 
option 

Data Series Summary 
Tables 

Tables that list the following information for each data series that has 
mappings for items contained in the form: 

• Item number, based on the order of the item in the form. 

• Item title or RefName, depending on whether Show Object 
RefNames is selected. 

• Mapping RefName. 

• Data set alias if available, otherwise RefName. 

• Data series alias if available, otherwise RefName. 

• Data series type. 

Display Forms in 
Workflow Order 

• If selected—Forms appear in study workflow order, except that: 

 Forms that occur in more than one study event are not duplicated. 

 Nonclinical forms (Regulatory Documents and Visit Reports) 
appear at the end of the listing. 

• If not selected—Forms appear in alphabetical order. 

Note: In the Time and Events Table, forms always appear in workflow 
order, regardless of the setting of the Display Forms in Workflow Order 
option. 

Display Hidden Items • If selected—Hidden items are included.  

• If not selected—Hidden items are not included. If a form contains 
one or more hidden items, the footer of the table indicates that hidden 
items on the table are not displayed.  

InForm Special 
Properties Table 

A table that lists the values of the InForm Special Visit, Special Form, and 
Special Item properties, along with the property type and the study objects 
to which the properties are assigned. 

If a special property has not been assigned to a study object, the table shows 
the value as Unassigned. 

Personal/Protected 
Health Information 
Table 

A table that lists each item in the study for which the PHI custom property 
is set to True, along with the section (if the item exists in a section) and 
form on which the item exists. 

Unit Conversions 
Table 

A table that lists the unit type and unit conversion formulas for items that 
have units and appear in one or more forms. 

Review States Table A table that lists information about the review states defined for the study, 
along with information about the review stages defined for each review 
state. If a review state is not activated, only the review state header appears. 

If translations are missing for one of the product locales but present for the 
other, the locale for which translations have been defined appears in the 
table in the place of the other locale. An asterisk and footnote appear for 
translations that have been replaced in this manner. 
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Option What appears in the annotated study book when you select the 
option 

In-place Revisions 
Summary Table 

A table that lists the following information about the in-place revisions 
associated with a deployment instance: 

• Deployment instance to which the in-place revision applies. 

• RefName of the in-place revision study object. 

• Type of the revised study object. 

• Description of the change. 

• Study version to which the revision applies. 

• Path in the study hierarchy where the revised study object appears. 

Show Object 
RefNames 

• The annotated study book uses study object RefNames, rather than 
titles, to identify study objects. The following areas are affected: 

• The RefName for a form or section is appended to the form or section 
title that is displayed in the annotated form header. RefNames are 
enclosed in square brackets.  

• In annotated forms, items are identified with RefNames. 

• With the following exceptions, data tables that follow the annotated 
form use a column header of RefName instead of Title, and the column 
contains RefNames.  

 The Time and Events table is not affected by this option. 

 The Data Series Summary Table always uses RefName to identify 
mappings and data sets, regardless of whether this option is 
selected. 

Select Cover Page 
Options section 

Include Cover Page—Cover page with the study design properties 
selected from the Display the following in addition to the study title 
list, along with the study design title. 

If you select a user-defined custom property, the property must have a value 
and be visible, or it does not appear on the cover page. 

Do Not Include Cover Page—No cover page. 

Note: The values of cover page options are set in the Properties Browser 
for the study design. 

Select Date Variable 
Format 

Format of date time items in the annotated forms.  
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Forms, items, codelists, and codelist items 

Codelists Editor—Option descriptions 
Columns common to all study object editors 

All study object editors have the following columns. 

Note: Not all fields appear in the default view. Optionally, you can add the other fields and 
rearrange the browser view. For more information, see the User Guide. 

 

Property Description 
Icon (first column) Status of the study object: 

• —New. 

• —Locked. 

• —Protected. When a study object is protected, you cannot : 

 Update or lock it. 

 Add child study objects to it by pasting or dragging and dropping. 

 Delete its child study objects. 

Description Description of the study object. The description can have 0-255 
characters. 

Identifier Unique internal identifier of the study object. 

Published (only in 
libraries) 

Indicates that the study object has been published. 

RefName RefName of the study object. The RefName can have 1-63 characters. 

Note: Oracle recommends that you do not use Conflict for a study event 
RefName, as there is a default Conflict visit created for the InForm 
application. 

Revision Revision number of the study object. The revision number is incremented 
each time the study object is changed and saved. 

Title Title of the study object. The title can have 1-63 characters. 

Version Version number of the study object. The version number is incremented 
only when a user explicitly updates it. 

 

Note: Not all fields appear in the default view. Optionally, you can add the other fields and 
rearrange the browser view. For more information, see the User Guide. 
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Option Description 

CodeListType Data type of the codelist. The data type of a codelist must be compatible 
with the data type of any items in which it is included.. 

 

Note: To type extended ASCII characters in text fields, press ALT while entering the decimal code 
for the character. You can also add HTML formatting characters (on page 240) to a text field to 
control its appearance when deployed. 

 

Codelist Items Editor—Option descriptions 
Columns common to all study object editors 

All study object editors have the following columns. 

Note: Not all fields appear in the default view. Optionally, you can add the other fields and 
rearrange the browser view. For more information, see the User Guide. 

 

Property Description 
Icon (first column) Status of the study object: 

• —New. 

• —Locked. 

• —Protected. When a study object is protected, you cannot : 

 Update or lock it. 

 Add child study objects to it by pasting or dragging and dropping. 

 Delete its child study objects. 

Description Description of the study object. The description can have 0-255 
characters. 

Identifier Unique internal identifier of the study object. 

Published (only in 
libraries) 

Indicates that the study object has been published. 

RefName RefName of the study object. The RefName can have 1-63 characters. 

Note: Oracle recommends that you do not use Conflict for a study event 
RefName, as there is a default Conflict visit created for the InForm 
application. 

Revision Revision number of the study object. The revision number is incremented 
each time the study object is changed and saved. 

Title Title of the study object. The title can have 1-63 characters. 

Version Version number of the study object. The version number is incremented 
only when a user explicitly updates it. 
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Note: Not all fields appear in the default view. Optionally, you can add the other fields and 
rearrange the browser view. For more information, see the User Guide. 

 

Option Description 
Code Code of the codelist item. 

CodeListType Data type of the codelists in which the codelist item is included. 

Label Label of the codelist item. The label can have 1-255 characters. 

Study Completion 
Status Item 

Function of the codelist item in the codelist that is used in the special 
Completion status item of the Study Completion form: 

• None—The codelist item is not part of the codelist in the 
Completion status item. 

• Complete Study (Study Completion). 

• Incomplete Study (Study Completion). 
 

Note: To type extended ASCII characters in text fields, press ALT while entering the decimal code 
for the character. You can also add HTML formatting characters (on page 240) to a text field to 
control its appearance when deployed. 

 

Design tab of the Codelist Editor—Option descriptions 
 

Option Description 
Title (codelist) Title of the codelist. The title can have 1-63 characters. 

Description Description of the codelist. 

Data type Data type of the codelist; must be compatible with the values specified for 
codelist item codes: 

• Float 

• Integer 

• String 

Fields  

Title (codelist item) Title of the codelist item. The title can have 1-63 characters. 

Code Value stored in the repository for the codelist item. The value can have 1-
2000 characters. 

Label Default label that appears on the form for the codelist item. The label can 
have 1-255 characters.  

Description Description of the codelist item. The description can have 0-255 characters. 
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Note: To type extended ASCII characters in text fields, press ALT while entering the decimal code 
for the character. You can also add HTML formatting characters (on page 240) to a text field to 
control its appearance when deployed. 

 

Design tab of the Form Editor or Section Editor—Option descriptions 
 

Option Description 
Repeating Indicates that the form or section is repeating. Multiple instances of the same 

set of data appear in the form or section. 

Common (forms 
only) 

Indicates that the form is common. The same data is visible in all study events 
that contain the form. 

Fixed (sections 
only) 

Indicates that the section is a fixed repeating section containing static text that 
repeats for each instance of the item. 

Keys (toolbar 
button and icon 
for repeating 
forms and sections 
only) 

• For a repeating form with no sections, opens the Keys dialog box, in 
which you can define key items. 

• For a form with one or more repeating sections, displays a drop-down list 
of repeating sections. Selecting a section opens the Keys dialog box, in 
which you can define key items.  

Fields  

Codelist Applies to text, float, and integer items only. 

Drop-down list with available codelists for the item. Available codelists are all 
of the codelists in the study or library with the same type as the item.  

Conditional On Title of the item on which the current item is conditional. The drop-down list 
in this column contains items that contain a codelist. If the current item is 
conditional on one of the items in this column, the current item provides 
additional data about one of the options in the codelist. For more information, 
see Conditional relationships between items (on page 108). 

Conditional Value Code and label of the codelist item on which the current item is conditional.  

Data Label  

Description Description of the item. The description can have 0-255 characters. 

Display Override  

Item Properties Contains an Edit link, which you can click to open the Item Properties dialog 
box. If you navigate to the field using the Tab button, you can open the dialog 
box by pressing the spacebar.  

Item Required Indicates that the item is required. 



 InForm Design Guide  

Oracle® Health Sciences Central Designer 2.1.2 367 

Option Description 

Key For key items, displays icons and numbers that indicate: 

• Type of key item uniqueness (None, Individual, or Group). 

• Order of the items in the drop-down navigation list that appears in the 
summary view of a repeating form in the InForm application. 

In the InForm application, key items are used to make it easier to navigate 
among the instances of a repeating form and to enforce data uniqueness in 
specific items. 

Length Applies to text, float, and integer items only. 

Length of the item.  

Allowed values: 

• Text items—1 to 2000. 

• Float items—1 to 18. 

• Integer items—1 to 10. 

Locked Indicates that the item is locked. 

MaxProperty If a MaxValue is specified for the item, indicates whether the value can be less 
than or less than or equal to the MaxValue. 

MaxValue Maximum value that the InForm application will allow to be typed for the 
item.  

MinProperty If a MinValue is specified for the item, indicates whether the value can be 
greater than or greater than or equal to the MinValue. 

MinValue Minimum value that the InForm application will allow to be typed for the item. 

Modified Indicates that the item has been modified and has not yet been saved. 

New Indicates that the item is new and has not yet been saved. 

Protected Indicates that the item is protected. 

Question Default question for the item. This question appears on the form if no 
customized label or translation is defined for the item. The question can have 
0-1000 characters. Certain words may be reserved for this field. For more 
information, see Reserved words for an item question or short question 
(on page 116). 

RefName RefName of the item. 

Revision Revision number of the study object. 

SDV Critical Indicates that the study object is considered critical for source verification. If 
you select SDV Critical, SDV Required becomes selected as well. 

SDV Required Indicates that the study object must be source verified in the InForm 
application. 
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Option Description 
ShortQuestion Text of a short version of the item question. In the InForm application, the 

short question appears as a column heading in a repeating form, an itemset, 
and in reports generated by the Reporting and Analysis application. The short 
question can have 0-255 characters. Certain words may be reserved for this 
field. For more information, see Reserved words for an item question or 
short question (on page 116). 

Special Fields Type of special InForm field, or None, indicating that the item is not a special 
InForm field. Available special fields, along with the forms in which they 
appear, are: 

• Initials (Screening). 

• DOB (Screening). 

• Screening date (Screening). 

• Patient No. (Enrollment). 

• Initials (Patient Identification. 

• Completion status (Study Completion). 

• Drop-out reason (Study Completion). 

• DOV (Date of Visit). 

• Randomization field (Randomization). 

For more information, see About special InForm forms (on page 84). 

Title Title of the item. The title can have 1-63 characters. 

Type Item type; one of the following, or a custom item type defined in a library to 
which the study has access: 

• Blood pressure 

• Compound 

• Date time 

• Float 

• Integer 

• Text 

• Yes No 

Version Version number of the study object. The version number is incremented only 
when a user explicitly updates it. 

 

Note: To type extended ASCII characters in text fields, press ALT while entering the decimal code 
for the character. You can also add HTML formatting characters (on page 240) to a text field to 
control its appearance when deployed. 
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Design tab of the Item Editor—Option descriptions 
Compound or blood pressure item options 

 

Option Description 
Compound Properties 
section 

 

Default question Default question for the item. This question appears on the form if no 
customized label or translation is defined for the item. The question can 
have 0-1000 characters. Certain words may be reserved for this field. For 
more information, see Reserved words for an item question or short 
question (on page 116).  

Title Title of the item. The title can have 1-63 characters.  

Child Items section  

Child Items section List the items that make up the compound item. For a blood pressure 
item, the predefined child items Systolic Variable and Diastolic Variable 
appear in this list. 

Type Item type. For a blood pressure item, the item type of the two child 
items is Integer. 

Title Title of the child item. The title can have 1-63 characters. 

RefName RefName of the child item. 

Question Caption that appears with the child item on the form.   

Languages section  

Languages section Translate item questions. This section is active if: 

• More than one language and locale have been selected for the study 
in the Study Editor. 

• You have been associated with one of the languages for the study in 
your user skills profile. An administrator user sets up this profile in 
the Central Designer Administrator application. 

Language Language in which the question appears. 

Question Text of the question in the specified language. The question can have 0-
1000 characters.  

Short Question Text of a short version of the item question. In the InForm application, 
the short question appears as a column heading in a repeating form, an 
itemset, and in reports generated by the Reporting and Analysis 
application. The short question can have 0-255 characters. Certain words 
may be reserved for this field. For more information, see Reserved 
words for an item question or short question (on page 116). 
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Note: To type extended ASCII characters in text fields, press ALT while entering the decimal code 
for the character. You can also add HTML formatting characters (on page 240) to a text field to 
control its appearance when deployed. 

Date time item options 
 

Option Description 
Date Time Properties 
section 

 

Default question Default question for the item. This question appears on the form if no 
customized label or translation is defined for the item. The question can 
have 0-1000 characters. Certain words may be reserved for this field. 
For more information, see Reserved words for an item question or 
short question (on page 116). 

Title Title of the item. The title can have 1-63 characters. The title can have 
1-63 characters. 

Year 

Month 

Day  

Hour 

Minute 

Second 

When selected, this part of the date time item (Year, Month, Day, Hour, 
Minute, or Second) can be made visible on the form if it is marked as 
visible in the Layout tab.  

• Required—(Selected by default for Year, Month, and Day) When 
selected, this part of the date time item (Year, Month, Day, Hour, 
Minute, or Second) is required. 

• Allow unknown—A data-entry user can mark this part of the date 
time item (Year, Month, Day, Hour, Minute, or Second) unknown. 
An entry marked unknown is considered completed. 

Languages section  

Languages section Translate item questions. This section is active if: 

• More than one language and locale have been selected for the study 
in the Study Editor. 

• You have been associated with one of the languages for the study in 
your user skills profile. An administrator user sets up this profile in 
the Central Designer Administrator application. 

Language Language in which the question appears. 

Question Text of the question in the specified language. The question can have 0-
1000 characters. Certain words may be reserved for this field. For more 
information, see Reserved words for an item question or short 
question (on page 116). 
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Option Description 

Short Question Text of a short version of the item question. In the InForm application, 
the short question appears as a column heading in a repeating form, an 
itemset, and in reports generated by the Reporting and Analysis 
application. The short question can have 0-255 characters. Certain 
words may be reserved for this field. For more information, see 
Reserved words for an item question or short question (on page 
116). 

 

Notes:  

• To type extended ASCII characters in text fields, press ALT while entering the decimal code for 
the character. You can also add HTML formatting characters (on page 240) to a text field to 
control its appearance when deployed. 

• The Required and Allow unknown fields are not available until you select the corresponding 
Allow fields. 

Float item options 
 

Option Description 
Float Properties section  

Default question Default question for the item. This question appears on the form if 
no customized label or translation is defined for the item. The 
question can have 0-1000 characters. Certain words may be reserved 
for this field. For more information, see Reserved words for an 
item question or short question (on page 116). 

Title Title of the item. The title can have 1-63 characters. 

Base Unit The unit for which a measurement is stored in the repository. 

Conversion Units One or more optional units in which a user can enter a measurement. 
A conversion unit value is converted to the base unit when stored in 
the study database. 

Length Maximum length of the data that a user can enter into the item, 
including the values before and after the decimal point.  

Note: When a float item is deployed to an InForm study, the 
decimal point counts in the length, and you must account for the 
decimal point when designing the float item. For example, in the 
InForm application, the largest number that can be entered in a field 
that has a length of 4 and a precision of 1 is 99.9.  

Precision Number of required characters following the decimal point. 

Codelist Settings • Select Single Value—A user must select only one codelist item. 

• Select Multiple Values—A user can select multiple codelist 
items. 

Codelist section  
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Option Description 
Codelist section Select or define a codelist for the item. A codelist consists of a group 

of codelist items, each containing a code and a label. 

Codelist List of existing codelists or the name of a new codelist that you type. 

New Create a codelist in the repository, using the name entered in the 
Codelist field. 

Code Value stored in the repository for the codelist item. The value can 
have 1-2000 characters. 

Label Default label that appears on the form for the codelist item. The 
label can have 1-255 characters. 

Languages section  

Languages section Translate item questions. This section is active if: 

• More than one language and locale have been selected for the 
study in the Study Editor. 

• You have been associated with one of the languages for the 
study in your user skills profile. An administrator user sets up 
this profile in the Central Designer Administrator application. 

Language Language in which the question appears. 

Question Text of the question in the specified language. The question can have 
0-1000 characters. Certain words may be reserved for this field. For 
more information, see Reserved words for an item question or 
short question (on page 116). 

Short Question Text of a short version of the item question. In the InForm 
application, the short question appears as a column heading in a 
repeating form, an itemset, and in reports generated by the Reporting 
and Analysis application. The short question can have 0-255 
characters. Certain words may be reserved for this field. For more 
information, see Reserved words for an item question or short 
question (on page 116). 

 

Note: To type extended ASCII characters in text fields, press ALT while entering the decimal code 
for the character. You can also add HTML formatting characters (on page 240) to a text field to 
control its appearance when deployed. 

Integer or yes no item options 
 

Option Description 
Integer Properties 
section 
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Option Description 

Default question Default question for the item. This question appears on the form if no 
customized label or translation is defined for the item. The question can 
have 0-1000 characters. Certain words may be reserved for this field. For 
more information, see Reserved words for an item question or short 
question (on page 116). 

Title Title of the item. The title can have 1-63 characters. 

Base Unit The unit for which a measurement is stored in the repository. 

Conversion Units One or more optional units in which a user can enter a measurement. A 
conversion unit value is converted to the base unit when stored in the 
study database. 

Length Maximum length of the data that a user can enter into the item, including 
the values before and after the decimal point. 

Signed Value Reserved for future use.  

Codelist settings • Select Single Value—A user must select only one codelist item. 

• Select Multiple Values—A user can select multiple codelist items. 

Codelist section  

Codelist section Select or define a codelist for the item. A codelist consists of a group of 
codelist items, each containing a code and a label. 

Note: A yes no item includes a predefined codelist named YesNo 
Codelist. This codelist has the values 0 (No) and 1 (Yes). 

Codelist List of existing codelists or the name of a new codelist that you type. 

New Create a codelist in the repository, using the name entered in the Codelist 
field. 

Code Value stored in the repository for the codelist item. The value can have 1-
2000 characters. 

Label Default label that appears on the form for the codelist item. The label can 
have 1-255 characters. 

Languages section  

Languages section Translate item questions. This section is active if: 

• More than one language and locale have been selected for the study in 
the Study Editor. 

• You have been associated with one of the languages for the study in 
your user skills profile. An administrator user sets up this profile in the 
Central Designer Administrator application. 

Language Language in which the question appears. 

Question Text of the question in the specified language. The question can have 0-
1000 characters. Certain words may be reserved for this field. For more 
information, see Reserved words for an item question or short 
question (on page 116). 



Appendix A  Option and property descriptions  
 

374 Oracle® Health Sciences Central Designer 2.1.2 

Option Description 
Short Question Text of a short version of the item question. In the InForm application, 

the short question appears as a column heading in a repeating form, an 
itemset, and in reports generated by the Reporting and Analysis 
application. The short question can have 0-255 characters. Certain words 
may be reserved for this field. For more information, see Reserved words 
for an item question or short question (on page 116). 

 

Note: To type extended ASCII characters in text fields, press ALT while entering the decimal code 
for the character. You can also add HTML formatting characters (on page 240) to a text field to 
control its appearance when deployed. 

Text item options 
 

Option Description 
Text Properties Specify text item properties. 

Default question Default question for the item. This question appears on the form if no 
customized label or translation is defined for the item. The question can have 
0-1000 characters. Certain words may be reserved for this field. For more 
information, see Reserved words for an item question or short question 
(on page 116). 

Title Title of the item. The title can have 1-63 characters. 

Length Maximum length of the data that a user can enter into the item, including the 
values before and after the decimal point. 

Codelist Settings • Select Single Value—A user must select only one codelist item. 

• Select Multiple Values—A user can select multiple codelist items. 

Codelist section Select or define a codelist for the item. A codelist consists of a group of 
codelist items, each containing a code and a label. 

Codelist List of existing codelists or the name of a new codelist that you type. 

New Create a codelist in the repository, using the name entered in the Codelist 
field. 

Code Value stored in the repository for the codelist item. The value can have 1-
2000 characters. 

Label Default label that appears on the form for the codelist item. The label can 
have 1-255 characters. 

Languages section Translate item questions. This section is active if: 

• More than one language and locale have been selected for the study in 
the Study Editor. 

• You have been associated with one of the languages for the study in your 
user skills profile. An administrator user sets up this profile in the Central 
Designer Administrator application. 
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Option Description 

Language Language in which the question appears. 

Question Text of the question in the specified language. The question can have 0-1000 
characters. Certain words may be reserved for this field. For more 
information, see Reserved words for an item question or short question 
(on page 116). 

Short Question Text of a short version of the item question. In the InForm application, the 
short question appears as a column heading in a repeating form, an itemset, 
and in reports generated by the Reporting and Analysis application. The short 
question can have 0-255 characters. Certain words may be reserved for this 
field. For more information, see Reserved words for an item question or 
short question (on page 116). 

 

Note: To type extended ASCII characters in text fields, press ALT while entering the decimal code 
for the character. You can also add HTML formatting characters (on page 240) to a text field to 
control its appearance when deployed. 

Default maximum input field lengths 

When you create an item, you specify the length of the input field. The Central Designer application 
supports the following maximum field lengths as a default. 

 

Type of input field Maximum length 
Text item 2000 

Integer item 10 

Float item 18 

Float precision 10 
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Forms and sections editor—Option descriptions 
Columns common to all study object editors 

All study object editors have the following columns. 

Note: Not all fields appear in the default view. Optionally, you can add the other fields and 
rearrange the browser view. For more information, see the User Guide. 

 

Property Description 
Icon (first column) Status of the study object: 

• —New. 

• —Locked. 

• —Protected. When a study object is protected, you cannot : 

 Update or lock it. 

 Add child study objects to it by pasting or dragging and dropping. 

 Delete its child study objects. 

Description Description of the study object. The description can have 0-255 
characters. 

Identifier Unique internal identifier of the study object. 

Published (only in 
libraries) 

Indicates that the study object has been published. 

RefName RefName of the study object. The RefName can have 1-63 characters. 

Note: Oracle recommends that you do not use Conflict for a study event 
RefName, as there is a default Conflict visit created for the InForm 
application. 

Revision Revision number of the study object. The revision number is incremented 
each time the study object is changed and saved. 

Title Title of the study object. The title can have 1-63 characters. 

Version Version number of the study object. The version number is incremented 
only when a user explicitly updates it. 

 

 

Field Description 
AssociatedForm Title of the associated form, or None, if the form is not associated with 

another form. For more information, see About forms (on page 78). 

Common Indicates that the form is common. The same data is visible in all study events 
that contain the form. 

Fixed (sections 
only) 

Indicates that the section is a repeating section containing items for which the 
text is fixed and repeated in each instance of the item. 
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Field Description 

Item Required Indicates that a value must be entered for the item for the form to be 
considered complete. 

Page Key Value Value of the Clintrial page key, used for transferring data to the Clintrial 
application through CIS mappings. If you specify the Page Key Value, it 
overrides the form RefName as the page key. 

Repeating Indicates that the form or section is repeating. Multiple instances of the same 
set of data appear in the form or section. 

SDV Critical Indicates that the study object is considered critical for source verification. If 
you select SDV Critical, SDV Required becomes selected as well. 

SDV Required Indicates that the study object must be source verified in the InForm 
application. 

Short Title Short title of the form. The short title is deployed to the InForm application 
as the form mnemonic. The short title can have 1-63 characters. 

Special Forms Type of special InForm form, or None, indicating that the form is not a 
special InForm form. Available special forms are: 

• Screening 

• Enrollment 

• Patient Identification 

• Study Completion 

For more information, see About special InForm forms (on page 84). 
 

Note: To type extended ASCII characters in text fields, press ALT while entering the decimal code 
for the character. You can also add HTML formatting characters (on page 240) to a text field to 
control its appearance when deployed. 

 

General tab of the Form Editor or Section Editor—Option descriptions 
 

Option Description 
Settings section  

Title Title of the form or section. The title can have 1-63 characters. 

Short Title (Form Editor 
only) 

Short title of the form. The short title is deployed to the InForm 
application as the form mnemonic. The short title can have 1-63 
characters. 

RefName RefName of the form or section. The RefName can have 1-63 
characters. 

Description Description of the form or section. The description can have 0-255 
characters. 

Behavior section  
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Option Description 
Repeating Indicates that the form or section is repeating. Multiple instances of the 

same set of data appear in the form or section. 

Common (Form Editor 
only) 

Indicates that the form is common. The same data is visible in all study 
events that contain the form. 

Short Title Languages 
section (Form Editor 
only) 

 

Language Language and locale to which the short title is translated. 

Short Title Translated text of the short title. The short title can have 1-63 
characters. 

 

Note: To type extended ASCII characters in text fields, press ALT while entering the decimal code 
for the character. You can also add HTML formatting characters (on page 240) to a text field to 
control its appearance when deployed. 

 

InForm Items Editor—Option descriptions 
Columns common to all study object editors 

All study object editors have the following columns. 

Note: Not all fields appear in the default view. Optionally, you can add the other fields and 
rearrange the browser view. For more information, see the User Guide. 

 

Property Description 
Icon (first column) Status of the study object: 

• —New. 

• —Locked. 

• —Protected. When a study object is protected, you cannot : 

 Update or lock it. 

 Add child study objects to it by pasting or dragging and dropping. 

 Delete its child study objects. 

Description Description of the study object. The description can have 0-255 
characters. 

Identifier Unique internal identifier of the study object. 

Published (only in 
libraries) 

Indicates that the study object has been published. 
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Property Description 

RefName RefName of the study object. The RefName can have 1-63 characters. 

Note: Oracle recommends that you do not use Conflict for a study event 
RefName, as there is a default Conflict visit created for the InForm 
application. 

Revision Revision number of the study object. The revision number is incremented 
each time the study object is changed and saved. 

Title Title of the study object. The title can have 1-63 characters. 

Version Version number of the study object. The version number is incremented 
only when a user explicitly updates it. 

 

Note: Not all fields appear in the default view. Optionally, you can add the other fields and 
rearrange the browser view. For more information, see the User Guide. 

 

Option Description 
Data Label Text label for the item, enabling access to the item in a target table with the 

Patient To Control key type or any of the pivot key types. 

Display Override Determines the default behavior of an item when a layout is generated. 

• ReadOnly—The item is visible but not editable. 

• Editable—The item is visible and editable by any user, regardless of the 
rights assigned to the user. 

• Hidden—The item is not visible. 

• None—The item is visible to all users, and visible and editable by any 
user who has the rights to view and/or edit the item. 

This is a custom property for items deployed in a study in the InForm 
application. 

Item Required True (default) or False, indicating whether the item is required for data 
entry on the form to be complete.  

This is a custom property for items deployed in a study in the InForm 
application. 

MaxProperty If a MaxValue is specified for the item, indicates whether the value can be 
less than or less than or equal to the MaxValue. 

MaxValue Maximum value that the InForm application will allow to be typed for the 
item.  

MinProperty If a MinValue is specified for the item, indicates whether the value can be 
greater than or greater than or equal to the MinValue. 

MinValue Minimum value that the InForm application will allow to be typed for the 
item. 

PHI True or False (default), indicating whether an InForm user might enter 
Personal/Protected Health Information (PHI) for the item. 
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Option Description 
Question Default question for the item. This question appears on the form if no 

customized label or translation is defined for the item. The question can have 
0-1000 characters. Certain words may be reserved for this field. For more 
information, see Reserved words for an item question or short question 
(on page 116). 

SDV Critical True or False (default), indicating whether the item is considered critical for 
source verification. If you select True, SDV Required changes to True. 

SDV Required True (default) or False, indicating whether the item requires source 
document verification. 

This is a custom property for items deployed in a study in the InForm 
application. 

ShortQuestion Text of a short version of the item question. In the InForm application, the 
short question appears as a column heading in a repeating form, an itemset, 
and in reports generated by the Reporting and Analysis application. The 
short question can have 0-255 characters. Certain words may be reserved for 
this field. For more information, see Reserved words for an item question 
or short question (on page 116). 

Special Fields Type of special InForm field, or None, indicating that the item is not a 
special InForm field. Available special fields, along with the forms in which 
they appear, are: 

• Initials (Screening). 

• DOB (Screening). 

• Screening date (Screening). 

• Patient No. (Enrollment). 

• Initials (Patient Identification. 

• Completion status (Study Completion). 

• Drop-out reason (Study Completion). 

• DOV (Date of Visit). 

• Randomization field (Randomization). 

For more information, see About special InForm forms (on page 84). 
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Option Description 

Type Item type; one of the following, or a custom item type defined in a library to 
which the study has access: 

• Blood pressure 

• Compound 

• Date time 

• Float 

• Integer 

• Text 

• Yes No 
 

Note: To type extended ASCII characters in text fields, press ALT while entering the decimal code 
for the character. You can also add HTML formatting characters (on page 240) to a text field to 
control its appearance when deployed. 

 

Item Properties dialog box—Option descriptions 
Options for the compound or blood pressure item type 

 

Option Description 
Title Title of the item. The title can have 1-63 characters. 

RefName RefName of the study object. The RefName can have 1-63 
characters. 

Default Question Default question for the item. This question appears on the form 
if no customized label or translation is defined for the item. The 
question can have 0-1000 characters. Certain words may be 
reserved for this field. For more information, see Reserved words 
for an item question or short question (on page 116). 

 

Options for the float item type 
 

Option Description 
Title Title of the item. The title can have 1-63 characters. 

RefName RefName of the study object. The RefName can have 1-63 
characters. 

Default Question Default question for the item. This question appears on the form 
if no customized label or translation is defined for the item. The 
question can have 0-1000 characters. Certain words may be 
reserved for this field. For more information, see Reserved words 
for an item question or short question (on page 116). 
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Option Description 
Base Unit The unit for which a measurement is stored in the repository. 

Conversion Units One or more optional units in which a user can enter a 
measurement. A conversion unit value is converted to the base 
unit when stored in the study database. 

Length Maximum length of the data that a user can enter into the item, 
including the values before and after the decimal point. 

Note: When a float item is deployed to an InForm study, the 
decimal point counts in the length, and you must account for the 
decimal point when designing the float item. For example, in the 
InForm application, the largest number that can be entered in a 
field that has a length of 4 and a precision of 1 is 99.9.  

Precision Number of required characters following the decimal point. 

Codelist Settings  

Codelist List of existing codelists or the name of a new codelist that you 
type. 

New Create a new codelist on the item. 

Edit Edit the codelist on the item. If the item does not have a codelist, 
this option is not available. 

Codelist Settings • Select Single Value—A user must select only one codelist 
item. 

• Select Multiple Values—A user can select multiple codelist 
items. 

 

Options for the date time item type 
 

Option Description 
Title Title of the item. The title can have 1-63 characters. 

RefName RefName of the study object. The RefName can have 1-63 
characters. 

Question Text of the question in the specified language. The question can 
have 0-1000 characters. Certain words may be reserved for this 
field. For more information, see Reserved words for an item 
question or short question (on page 116). 

Date Time Component 
Setting 
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Option Description 

Year 

Month 

Day 

Hour 

Minute 

Second 

When selected, this part of the date time item (Year, Month, Day, 
Hour, Minute, or Second) can be made visible on the form if it is 
marked as visible in the Layout tab.  

• Required—(Selected by default for Year, Month, and Day) 
When selected, this part of the date time item (Year, Month, 
Day, Hour, Minute, or Second) is required. 

• Allow unknown—A data-entry user can mark this part of the 
date time item (Year, Month, Day, Hour, Minute, or Second) 
unknown. An entry marked unknown is considered 
completed. 

Year Range  

Start Year 

End Year 

First and last year in the drop-down list for the year range for the 
item. The year range is available only when the Year component is 
selected. 

 

Options for the integer or yes no item type 
 

Option Description 
Title Title of the item. The title can have 1-63 characters. 

RefName RefName of the study object. The RefName can have 1-63 
characters. 

Default Question Default question for the item. This question appears on the form 
if no customized label or translation is defined for the item. The 
question can have 0-1000 characters. Certain words may be 
reserved for this field. For more information, see Reserved words 
for an item question or short question (on page 116). 

Base Unit The unit for which a measurement is stored in the repository. 

Conversion Units One or more optional units in which a user can enter a 
measurement. A conversion unit value is converted to the base 
unit when stored in the study database. 

Length Maximum length of the data that a user can enter into the item, 
including the values before and after the decimal point. 

Signed Value Reserved for future use.   

Codelist Settings  

Codelist List of existing codelists or the name of a new codelist that you 
type. 

New Create a new codelist on the item. 

Edit Edit the codelist on the item. If the item does not have a codelist, 
this option is not available. 
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Option Description 
Codelist Settings • Select Single Value—A user must select only one codelist 

item. 

• Select Multiple Values—A user can select multiple codelist 
items. 

 

Options for the text item type 
 

Option Description 

Title Title of the item. The title can have 1-63 characters. 

RefName RefName of the study object. The RefName can have 1-63 
characters. 

Default Question Default question for the item. This question appears on the form 
if no customized label or translation is defined for the item. The 
question can have 0-1000 characters. Certain words may be 
reserved for this field. For more information, see Reserved words 
for an item question or short question (on page 116). 

Length Maximum length of the data that a user can enter into the item, 
including the values before and after the decimal point. 

Codelist Settings  

Codelist List of existing codelists or the name of a new codelist that you 
type. 

New Create a new codelist on the item. 

Edit Edit the codelist on the item. If the item does not have a codelist, 
this option is not available. 

Codelist Settings • Select Single Value—A user must select only one codelist 
item. 

• Select Multiple Values—A user can select multiple codelist 
items. 

 
 

Keys dialog box 
 

Field Description 
Data uniqueness for 
selected keys 

 

None Key items appear in a drop-down list in the summary view of a repeating 
form as navigation aids. The key items are not used to enforce uniqueness 
of key values across instances of the repeating form. 

Individual Each key item must be unique across all instances of the repeating form 
or itemset in the InForm application. 
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Field Description 

Group The combination of all key items evaluated together must be unique 
across all instances of the repeating form or itemset in the InForm 
application. 

Key selection  

Items available as keys The list of items in the repeating form or section that have not been 
selected as keys. 

Section Name of the section in which an available item occurs; blank for repeating 
forms. 

Item Title of the available item. 

Selected keys The list of items in the repeating form or section that have been selected 
as keys. 

Section Name of the section in which the key item occurs; blank for repeating 
forms. 

Item Title of the key item. 

Unique Selected if the item is an individually or group unique key. 

Button  

>, < Moves one or more selected items between the Items available as keys list 
and the Selected keys list. 

>>, << Moves all items between the Items available as keys list and the Selected 
keys list. 

Move Up, Move Down Moves the selected key item up or down in the Selected keys list. The 
resulting order determines the order in which key items appear in a drop-
down list on a repeating form in the InForm application. 

 
 

Languages tab of the Codelist Item Editor—Option descriptions 
 

Option Description 
Language Language and locale into which the codelist item label is translated. 

The default language appears in the first row. 

Label Label of the codelist item. The label can have 1-255 characters. 
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Data mappings 

Custom Dimension Labels - Select Codelist dialog box—Option descriptions 
In the Custom Dimension Labels - Select Codelist dialog box, you select or create a codelist for the 
labels for custom data dimensions created with a data set.  

Note: The dialog box appears when you define a custom data dimension and then click the button 
in the Codelist Lookup column. 

 

Option Description 
[Codelist drop-down list] List of available codelists. 

New Create a codelist.  

Code List of codes for the selected codelist. 

Label List of labels for the selected codelist. 

Use only listed labels 
checkbox 

Indicates whether users are required to choose from the custom 
dimension labels that you provide, or if they can provide their own 
values. 

• Selected—When defining the value of the custom data dimension, 
users are required to choose from the codelist items you type in the 
Custom Dimension Labels section. 

• Not selected—When defining the value of the custom data 
dimension, user can choose from the values you type or provide a 
value. 

Note: If you select Use only listed labels, the codelist must have at least 
one codelist item. 

 
 

Data Series Editor—Field descriptions 
 

Field Description 
Item Name of the item that has been added to the selected data series.  

Form Indicates the forms that are included in the mapping of the item to the data series. 

• {All}—The item is always mapped to the data series, on every form, in every 
study, and in the library. 

• [Form names]—The item is mapped to the data series only when the item 
appears on the listed forms. 

• [blank]—The item is not added to the data series. 
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Field Description 

Study Event Indicates which study events are included in the mapping of the item to the data 
series.  

• {All}—The item is always mapped to the data series, on every form, in every 
study, and in the library. 

• [Study event names]—The item is mapped to the data series only when the 
item appears on the listed study events. 

• [blank]—The item is not added to the data series. 

State Indicates if the association between the item and data series is currently mapped. 

• Mapped—The item is mapped to the data series. 

• Unmapped—The item is part of the data series but is not mapped to the data 
series for the study. You might add an item to a data series but not want the 
mapping to exist in a particular study.  

Labels All specified values for custom data dimensions. 
 

 

Data Series Properties dialog box—Option descriptions 
 

Option Description 
Title Name of the data series in the data set. 

RefName RefName of the data series in the data set. 

Description Description of the data series in the data set. 

Alias Alias for the data series. If an alias is present, it is used as the column name in 
the customer-defined database (CDD) or as the Clintrial item name in CIS 
mappings. If an alias is not present, the RefName is used as the column 
header. Because RefNames must be unique throughout a study, you must 
create an alias if the RefName is used by a study object. Data series aliases 
must be unique within a data set. 

Checking for RefName and alias uniqueness is case insensitive; for example, 
the names BP and bp are considered identical. 

Type Data type of the data series. 
 

The data types of an item and data series must be compatible for you to add the item to the data 
series. The following table indicates the item types that you can add to each data series type.  

 

Item type Text Integer Float Date time 
Text item Yes No No No 

Integer item Yes Yes Yes No 

Float item Yes No Yes No 
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Item type Text Integer Float Date time 
Date time item Yes. You are asked if 

you want to choose 
part of the date or 
the whole date. 

Yes. You are asked 
to choose the part 
of the date. 

No Yes 

 
 

Data Series Summary tab—Option descriptions 
The Data Series Summary tab appears in the editors for study events and forms. 

 

Option Description 
Filtering bar  

Mapping View data series in the selected mapping. 

Data Set View data series in the selected data set. 

Filter 

 

• Show All—View all items 

• Associated—View items that are part of a data series. 

• Not Associated—View items that are NOT part of a data series. 

Compatible types only When selected, items that cannot be added to any data series are hidden. 

CardView View each item grouped individually. 

Fields  

Forms and Items 
columns 

Forms and items appear as the left-most column headers. The Forms 
column appears only when a study event is selected. 

The columns list all forms and items in the study.  
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Option Description 

[Data series names] 
columns 

Data series appear as column headers in the grid beneath column 
headers of their data sets. 

The cells where an item meets with the data series have one of the 
following background colors: 

• Gray—You cannot map the item to the data series. 

• White—You can map the item to the data series. The following 
mapping types are available: 

 [No value]—The item is not in the data series. Selecting [No 
value] for an item that previously was mapped to the data series 
removes the item from the data series. 

 Always—The item is always mapped to the data series, on 
every form, in every study, and in the library. 

 Form—The item is mapped to the data series only when the 
item appears on a specific section (or form, if the form has no 
sections). You can select this option for multiple sections or 
forms. 

 Study event—(Available only when a study event is selected.) 
The item is mapped to the data series only when it appears on 
any form in a specific study event. You can select this option 
for multiple study events.  

 Study event & Form—(Available only when a study event is 
selected.) The item is mapped to the data series only when it 
appears on a specific form in a specific study event. 

 
 

Data Set Editor—Field descriptions 
 

Field Description 
Title Title of the data series in the data set. 

Description Description of the data series in the data set. 

Type Data type of the data series. 

Alias Alias for the data series. If an alias is present, it is used as the column name 
in the customer-defined database (CDD) or as the Clintrial item name in 
CIS mappings. If an alias is not present, the RefName is used as the column 
header. Because RefNames must be unique throughout a study, you must 
create an alias if the RefName is used by a study object. Data series aliases 
must be unique within a data set. 

Checking for RefName and alias uniqueness is case insensitive; for 
example, the names BP and bp are considered identical. 
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Data Set Properties dialog box—Field descriptions 
In the Data Set Properties dialog box, you can define the name and description of a data set and 
choose the standard dimensions that you want to create for the data set. You have the option of 
defining custom dimensions for the data set, as well. 

 

Field Description 
Title Title of the data set. 

RefName RefName of the data set. 

Description Description of the data set. 

Alias Alias for the data set. If an alias is present, it is used as the column name in 
the customer-defined database (CDD) or as the Clintrial item name in CIS 
mappings. If an alias is not present, the RefName is used as the column 
header. Because RefNames must be unique throughout a study, you must 
create an alias if the RefName is used by a study object. Data series aliases 
must be unique within a data set. 

Checking for RefName and alias uniqueness is case insensitive; for 
example, the names BP and bp are considered identical. 

Standard 
Dimensions 
section 

In this section, you view the standard data dimensions that were selected 
when the data set was created. 

Study RefName of the study. 

Subject Subject ID. 

Section RefName of the section. 

Section Index Instance of a repeating section. 

Event RefName of the study event. 

Event Index Instance of a repeating study event. 

Form RefName of the form. 

Form Index Instance of a repeating form. 

Item RefName of the item. 

Custom 
Dimensions 
section 

In this section, you view the custom data dimensions, if any, for the data set. 

Name Name of the custom dimension for the selected data set.  

Description Description of the custom dimension created with the selected data set.  
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Field Description 

Data Type Data type of the custom dimension created with the selected data set.  

The following types are available:  

• Text—Contains alphanumeric characters. 

• Integer—Contains only numbers. 

Codelist Lookup Click the button to choose or create a codelist to use for the custom data 
dimension labels. 

 
 

Date-Time Data Point dialog box—Option descriptions 
Use the Date-Time Data Point dialog box to specify custom mappings for date time items. The 
dialog box appears when you map a date to a data series that has a type of Integer or Text or when 
you modify the date part of a mapped date time item. 

Note: When you map a date time item to an integer data series in a CDD mapping, the item is 
mapped as a split date, with a separate column for each date time part. 

 

Option Description 
All in one column Map the date to a single database column. This option is available only if the 

date item is mapped to a data series with a type of Text. 

Split columns Split the date parts into multiple database columns. If the mapping is for: 

• CDD—The Central Designer application splits the date parts into 
multiple database columns. 

• CIS—You must create a different mapping for each date part that you 
want to map to a different panel item. 

CIS Date Part Date part to map. This option is available for rule and CIS mappings but not 
for CDD mappings. 

 
 

Item has units dialog box—Option descriptions 
 

Option Description 
Normalized Value Map the normalized value of the item with the data series. Normalization is 

the process of converting data to a required format. The normalized units 
appear in parentheses. 

Entered Value Map the entered value of the item with the data series. The entered value can 
be the same as or different from the normalized value. 

Entered Unit Map the unit in which a value is entered. 
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Mapping Editor—Field descriptions 
 

Field Description 
Grid section  

Title Name of the data set. 

Description Description of the data set. 

Alias Alias for the data set. If an alias is present, it is used as the CDD table name 
in CDD mappings and as the Clintrial panel name in CIS mappings. If an 
alias is not present, the RefName is used as the column header. Because 
RefNames must be unique throughout a study, you must create an alias if 
the RefName is used by another study object. Data set aliases must be 
unique within a mapping.  

Note: Checking for RefName and alias uniqueness is case insensitive; for 
example, the names BP and bp are considered identical. 

Standard 
Dimensions 
section 

In this section, you view the standard data dimensions that were selected 
when the data set was created. 

Study RefName of the study. 

Subject Subject ID. 

Section RefName of the section. 

Section Index Instance of a repeating section. 

Event RefName of the study event. 

Event Index Instance of a repeating study event. 

Form RefName of the form. 

Form Index Instance of a repeating form. 

Item RefName of the item. 

Custom 
Dimensions 
section 

In this section, you view the custom data dimensions, if any, for the data set. 

Name Name of the custom dimension for the selected data set.  

Description Description of the custom dimension created with the selected data set.  

Data Type Data type of the custom dimension created with the selected data set.  

The following types are available:  

• Text—Contains alphanumeric characters. 

• Integer—Contains only numbers. 

Codelist Lookup Click the button to choose or create a codelist to use for the custom data 
dimension labels. 
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Note: The Standard Dimensions and Custom Dimensions sections are read-only. 

 

Select Custom Dimension dialog box—Option descriptions 
The Select Custom Dimension dialog box appears when you add an item to a data series, and the 
item is in a data series that is in a data set with one or more custom data dimensions defined. 

 

Option Description 
X When checkbox is selected, custom data dimension is selected. 

Dimension Name, 
Dimension Description 

Name and description of the custom data dimension. 

Data Type Data type of the custom data dimension  

Labels Drop-down list containing the codelist item labels for the custom data 
dimension.  

Note: If you type a label or modify an existing label, a new codelist 
item is created for the codelist. 
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Layouts 

Control Styles dialog box—Option descriptions 
General tab 

 

Option Description 

Item name Display name (either the title or RefName) of the item that is associated 
with the control. 

READ-ONLY 

Caption Caption for the control. 

Limit: 4000 characters. 

Inherit all styles When selected, all control styles are inherited from the study-level styles or 
the form-level styles, if they are defined.  

This setting does not affect the caption. The caption that you specify 
appears, regardless of whether you selected Inherit all styles.  

 

Note: Click Apply to save your changes and close the dialog box. Click Apply/Next to apply your 
changes (if you made any) and advance to the next control. 

Basic Styles tab 

The options that are available depend on the type of control that is selected in the Layout tab.  
 

Option Description 
Caption alignment (Available for all controls.) 

Align the caption to the left, top, right, or bottom of the control.  

Textbox size (Available for controls on text, float, and integer items.) 

• Width—Width of the text box, in characters. 

• Height (Available for text items only)—Height of the text box, in 
lines. 

Control orientation (Available for compound items.)  

Align the controls of the compound item either horizontally or vertically. 
 

Note: The Inherit checkbox is available for each option. When Inherit is selected, the value for the 
option is inherited from the study-level styles or, if it is used, the form-level styles. To override the 
study-level or form-level styles, deselect Inherit, and provide a different value. 

Note: Click Apply to save your changes and close the dialog box. Click Apply/Next to apply your 
changes (if you made any) and advance to the next control. 
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Date Time Settings tab 

The following options are available when you select a Date Time item in the Layout tab.  
 

Option Description 
Visible fields Select the fields to set as visible for the date time item. 

Year range Select the year range for the date time item. 
 

Note: The Inherit checkbox is available for each option. When Inherit is selected, the value for the 
option is inherited from the study-level styles or, if it is used, the form-level styles. To override the 
study-level or form-level styles, deselect Inherit, and provide a different value. 

Note: Click Apply to save your changes and close the dialog box. Click Apply/Next to apply your 
changes (if you made any) and advance to the next control. 

Control Type tab 

The Control Type tab appears when a control is: 

• A float, integer, or text item with a codelist.  

• A float or integer item with units. 

For other controls, this tab is hidden. 
 

Option Description 
Unit control type • For a float or integer item with units—Format the units as either 

radio buttons or pulldowns. 

• For a float, integer, or text item with a codelist—Format the 
controls for the codelist items as either radio buttons or pulldowns. 

 

Note: The Inherit checkbox is available for each option. When Inherit is selected, the value for the 
option is inherited from the study-level styles or, if it is used, the form-level styles. To override the 
study-level or form-level styles, deselect Inherit, and provide a different value. 

Note: Click Apply to save your changes and close the dialog box. Click Apply/Next to apply your 
changes (if you made any) and advance to the next control. 
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Advanced tab 
 

Option Description 

Display Override You can override the item's Display Override value for the control only.  

• Inherit—Use the item's Display Override value. 

• Read only—Make the control read only. (In the InForm software, 
corresponds to the Hidden value of the Display Override property of 
an item.) 

• Hidden—Make the control hidden. (In the InForm software, 
corresponds to the Read-Only value of the Display Override property 
of an item.) 

Character set 
restriction 

(Available for text items without codelists.) 

• Unrestricted (Default)—Do not restrict the entry of values in text 
fields without codelists.  

• ASCII Only—In release 5.0 and later of the InForm application, 
restrict the entry of values in text fields without codelists to the 
complete ASCII character set (byte range 0 to 127). Items with 
restricted values are marked with a star () in the Annotated Study 
Book. 

 

Note: Click Apply to save your changes and close the dialog box. Click Apply/Next to apply your 
changes (if you made any) and advance to the next control. 

 

Layout tab options and deployment to the InForm application 
The following table lists the options that are available in the right-click menus, toolbar, and form and 
control styles for the Layout tab. The table describes the effect of each option when the study objects 
are deployed in the InForm application. 

 

Option Sub-option Deployment in the InForm application 
Align Caption Left, Right, Top, or 

Bottom 
Specifies the position of the caption relative to the 
control. Corresponds to the Caption Alignment 
property. 

Align Question • Left, Center, or 
Right 

• Top, Middle, or 
Bottom 

N/A 
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Option Sub-option Deployment in the InForm application 

Control Type • Radio Button 

• Pulldown 

For codelist items: 

• Radio control 

• Pulldown control 

For units: 

• Specifies how unit selections are displayed. 
Corresponds to the Unit Display Type property. If 
an item definition has only one unit with no 
conversion units, the Unit Display Type property 
has a value of Element. 

Edit Caption  Specifies the text of the caption that appears with the 
control. Corresponds to the Caption property. 

Edit Textbox Size  For text controls: 

• Width—Specifies the number of characters that 
can be entered into a text box with the data type 
of Text. Corresponds to the Length property of a 
text box control. 

• Height—Specifies the number of lines displayed 
in a text box. Corresponds to the Height property 
of a text box control. 

For integer controls: 

• Number of characters that can be entered into a 
text box with a data type of Integer. Corresponds 
to the Length property of an integer text control. 

For float controls: 

• Number of characters that can be entered into a 
text box with a data type of Float. Corresponds to 
the Length plus the Precision properties of a float 
text control, plus the decimal point. 

Edit Question  Question text. Corresponds to the Question property 
of an item. 

Edit Question 
Column Width 

 Width of the question column. Corresponds to the 
Question Width property. 

Orientation • Horizontal 

• Vertical 

Specifies how the controls included as children of the 
grouped control are oriented. Corresponds to the 
Layout property. 

Section Header  Form or section title. Corresponds to the Title 
property of a form or section. 

Section Note  Specifies the text of a note that appears immediately 
below a form or section heading. Corresponds to the 
Note property of a form or section. 



Appendix A  Option and property descriptions  
 

398 Oracle® Health Sciences Central Designer 2.1.2 

Option Sub-option Deployment in the InForm application 
Preview Annotated 
Form 

 N/A 

Preview Form   N/A 

Reset  N/A 

Remove Caption  N/A 

IPR Configuration  Opens the IPR Configuration dialog box so that you 
can specify a change as an in-place revision. 

Note: This button only appears when you access the 
Layout tab for a form through the Visit Schedule 
Explorer bar. 

 
 

Study Level Styles and Form Level Styles dialog boxes—Option descriptions 
Form Styles page 

 

Option Description 
Question column width The percentage of the width of the layout table to use for the question 

column.  

Default—50 percent. 
 

Note: The Inherit checkbox is not available for the options on the Study Level Styles dialog box. 
When Inherit is selected, all values for the set of options are inherited from the study styles. To 
override the study styles, deselect Inherit, and provide different values. 

Codelist Control Styles page 
 

Option Description 
Control orientation Display codelist items either horizontally or vertically.  

Default—Horizontal. 

Single selection settings Note: The settings in this section apply only to items that require a 
single selection (set on the Design tab for an item, when Select Single 
Value is selected). Multiple-selection codelists are always formatted as 
checkboxes.  
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Option Description 

• Radio buttons (Default) 

Format single-selection codelists as radio buttons. 

• Use pulldown when item count exceeds—Format single-
selection codelists as radio buttons, except when the number of 
codelist items exceeds the specified number, and then format as 
pulldowns. 

Default—5. 

• Display vertically when item count exceeds—When the 
number of codelist items exceeds the specified number, display the 
codelist items as vertical radio buttons.  

Default—5. 

• Pulldown Format single-selection codelists as pulldowns. 
 

Note: The Inherit checkbox is not available for the options on the Study Level Styles dialog box. 
When Inherit is selected, all values for the set of options are inherited from the study styles. To 
override the study styles, deselect Inherit, and provide different values. 

Compound Items Control Styles page 
 

Option Description 
Caption alignment Align the caption to the left, top, right, or bottom of an item's 

controls. 

Default—Left. 

Control orientation Display nested controls either horizontally or vertically.  

Default—Vertically. 
 

Note: The Inherit checkbox is not available for the options on the Study Level Styles dialog box. 
When Inherit is selected, all values for the set of options are inherited from the study styles. To 
override the study styles, deselect Inherit, and provide different values. 

Date Time Item Control Styles page 
 

Description Description 

Year range The default year range for all date time items.  

Default—Current year for both fields. 

Caption alignment Align the caption to the left, top, right, or bottom of an item's 
controls. 

Default—Left.  
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Note: The Inherit checkbox is not available for the options on the Study Level Styles dialog box. 
When Inherit is selected, all values for the set of options are inherited from the study styles. To 
override the study styles, deselect Inherit, and provide different values. 

Float Item and Integer Item Control Styles pages 
 

Option Description 
Caption alignment Align the caption to the left, top, right, or bottom of an item's controls. 

Default—Left. 

Textbox width Specify the width of the text boxes. 

• Use the item variable's length as the width (Default)—Use each 
item's length as the width of the text box.  

• Use this width—Use a specified width for the text box. 

Unit control type Display the controls for the units for a float or integer item as either 
radio buttons or pulldowns. 

Default—Radio buttons. 
 

Note: The Inherit checkbox is not available for the options on the Study Level Styles dialog box. 
When Inherit is selected, all values for the set of options are inherited from the study styles. To 
override the study styles, deselect Inherit, and provide different values. 

Text Item Control Styles page 
 

Option Description 

Caption alignment Align the caption to the left, top, right, or bottom of an item's 
controls. 

Textbox size Specify the width and height of the text boxes. 

• Use the item variable's length as the width (Default)—Use 
each item's length as the width of the text box.  

 Increase the height by one line for every __ chars—
Increment the height of the text box by one line for every 50 
characters. For example, the height for 1-50 characters is 1; 
the height for 51-100 characters is 2; and so on. 

Default—50.  

• Use the following width and height—Use a specified width and 
height for the textbox. Specify the width using the number of 
characters and the height using the number of lines. 
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Option Description 

Character set restriction • Unrestricted (Default)—Do not restrict the entry of values in text 
fields without codelists. 

• ASCII Only—In release 5.0 and later of the InForm application, 
restrict the entry of values in text fields without codelists to the 
complete ASCII character set (byte range 0 to 127). Items with 
restricted values are marked with a star () in the Annotated 
Study Book. 

 

Note: The Inherit checkbox is not available for the options on the Study Level Styles dialog box. 
When Inherit is selected, all values for the set of options are inherited from the study styles. To 
override the study styles, deselect Inherit, and provide different values. 
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In-place revisions 

IPR Configuration dialog box 
Use the IPR Configuration dialog box to configure the settings of an in-place revision. 

The dialog box is read-only if you do not have the right to make in-place revisions, or if the object or 
in-place revision is locked or protected. 

 

Option Description 
Description of the change Description of the change. Optional. 

Add Open the Add Deployment Instance dialog box to add a deployment 
instance. 

Remove Remove the selected deployment instance. 

Refresh Versions Retrieve the latest study version information for the selected 
deployment instance. 

Apply to All Apply a change to all study versions. 

Copy Association Open the Copy IPR Configurations dialog box to copy the in-place 
revision association from the selected deployment instance to 
another deployment instance. 

View Differences Open the View Differences dialog box to compare the latest version 
of the object with the object from a selected study version. 

Columns (Study version 
association section, at the 
top of the dialog box) 

 

Deployment Instance RefName of the deployment instance. 

Type Server type for the deployment instance: 

• UAT—User acceptance testing 

• QA—Quality assurance 

• DEV—Development 

• LIVE—Production 

• TRN—Training 

Description Description of the deployment instance. 

URL URL address of the deployment instance. 

Columns (Select study 
version section, at the 
bottom of the dialog box) 

 

Checkbox When selected, associates the change to the study version on that 
row. 
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Option Description 

Study Version InForm study version. 

Form Form that contains the revision. 

Section Section that contains the revision. 

Item Item that contains the revision. 
 

 

In-Place Revision Summary Editor—Option descriptions 
 

Option Description 
Buttons  

Edit Edit the IPR configuration for the selected in-place revision. 

Delete Delete the selected in-place revision. 

IPR 
Configurations 

Copy IPR configurations from one deployment instance to another, or remove 
IPR configurations from selected deployment instances. 

Select All Select all in-place revisions. 

Lock and Protect Lock or protect the selected in-place revision objects. 

History Open the IPR History dialog box to view a history of in-place revisions for all 
baselines with in-place revisions that were successfully deployed to LIVE 
deployment instances. 

Note: The IPR History dialog box only contains information about IPRs 
applied through automated deployments. 

Columns  

RefName RefName of the in-place revision study object. 

Type Type of revised study object. 

Deployment 
Instance 

Deployment instance to which to deploy the in-place revision. 

Description Description of the change. 
 

 

View Differences dialog box—Option descriptions 
 

Option Description 
Buttons  

Show Differences View the differences between the selected versions of the form. 

Root Select the study object at the top-level in the Modified Objects tree. 

Back Select the previously-selected study object in the Modified Objects tree. 
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Option Description 
Preview Form View the current and previous layouts for the selected form. 

Fields  

Form Form for which to view differences. 

Preexisting version Deployed study version in which the form exists. Select the study version to 
view the design of the form that you selected in the Form drop-down list that 
existed in that study version. 

Locale Locale for which to view form data. 

Modified Objects Explorer tree that displays a list of study objects that were modified in the 
most current version of the study. 

Difference Modification that was made to the study object selected in the Modified 
Objects tree in the most current version of the study. 

Source Study object that was modified. 

Target New study object that was created by the in-place revision change. 
 

 

IPR History dialog box—Option descriptions 
 

Option Description 
Buttons  

Show IPRs View a list of in-place revision changes for the selected baseline. 

Note: You can only view the in-place revision changes for a baseline for a 
study that was deployed to the InForm application using automated 
deployment. 

View 
Configuration 

View the in-place revision configuration for the study object that you select in 
the bottom of the dialog box. 

Fields at the top 
of the dialog box 

 

Baseline Baseline for a study that was deployed to a LIVE deployment instance with in-
place revision changes. 

Package Name Deployment package name. 

Deployment Date Date when the study was deployed. 

Fields at the 
bottom of the 
dialog box 

 

RefName RefName of the study object that was modified using an in-place revision 
change. 

Type Study object type. 
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Option Description 

Deployment 
Instance 

Type of deployment instance to which the study was deployed. 

Description Description of the in-place revision change that was made to the study object. 
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Rules 

Assign Conditions dialog box—Option descriptions 
Use the Assign Conditions dialog box to add a global condition to or remove a global condition from 
a study object in a workflow. In this dialog box, you specify the terms under which the next object in 
a workflow appears in a study, when the next object in a workflow depends on the outcome of a 
global condition.  

 

Option Description 

Global Conditions Available global conditions. 

Assigned 
Conditions 

Global condition that has been added to the selected study object. 

Add (>>)  

Remove (<<) 

Assign the global condition to the study object, and remove the assigned 
global condition. 

Expression box Text of the global condition expression. 
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Option Description 

If the value is Specify how the result of the selected global condition determines the study 
workflow. 

Indicates when the next object in the workflow appears in a study: 

• False—Only if the global condition evaluates to false. 

• True—Only if the global condition evaluates to true. 

• Always—Regardless of the result of the global condition. This option is 
disabled for a workflow rule. 

• Only if no other action executes—Only if no other workflow object is 
in effect. This option is disabled for a workflow rule. 

• Relational statement—Only if the value returned by the global 
condition satisfies the condition specified in the drop-down list and the 
text fields for this option. The following additional information is 
required for this selection: 

 Drop-down list—Specifies how the value returned by the workflow 
rule is compared with the values in the two text fields. 

 First text field—Specifies the value to compare with the value 
returned by the global condition. If Between is selected in the drop-
down list, the first text field specifies the first of two values that 
delineate a range. The global condition result is checked to determine 
if it is between the two values. 

 Second text field—Available if Between is selected in the drop-
down list. The second text field specifies the second of two values 
that delineate a range. The global condition result is checked to 
determine whether it is between the two values. 

 Inclusive—Available if Between is selected in the drop-down list. If 
selected, indicates that the range of values delineated in the two text 
fields includes the values entered in those fields. 

Note: Do not use the relational statement fields for string values, or a 
validation error occurs. 

 
 

Define Test Values for Repeating Instances dialog box—Option descriptions 
When an item is on a repeating section, form, or study event, you must provide test values for all of 
the instances of the item.  

 

Option Description 
Buttons  

Add Repeating Instance Add an instance of the selected repeating study object to create test cases 
for each instance. 

Copy Repeating Instance Adds an instance with the value of the selected instance. 



Appendix A  Option and property descriptions  
 

408 Oracle® Health Sciences Central Designer 2.1.2 

Option Description 
Remove Repeating 
Instance 

Delete the selected instance. 

  Note: When you add, copy, or delete instances, the indexing of the 
repeating instances is reordered. For example, if you delete the second of 
four instances, the third instance becomes the second and the fourth 
becomes the third. Adding an instance increases all subsequent instance 
numbers. 

Sections  

Selected Item tree Tree that contains the study objects in the rule. Use the buttons to create 
or remove instances. 

Note: You can create instances only for repeating study objects, which 
appear in the Repeating Items list.  

Grid Path and value of items that are on repeating study objects. Provide a 
testing value in the Item Value field.  

Repeating Items list List of all items in the rule that are children of repeating study objects. 
Select an item to provide its test values in the grid. 

Rule Details tab Text representation and description of the rule. 

Item Properties tab Properties for the test name, item, or expected result that you point to in 
the grid.  

For more information, see Properties in the Rule Test Cases dialog 
box (on page 487). 

Form Preview tab Preview of the form on which the repeating item exists. 
 

 

Design tab of the Rule Test Cases dialog box—Option descriptions 
In the Design tab, you write, modify, and delete test cases for rules.  

 

Field Description 
Grid  

Test Name Name of the test case. By default, test cases are named Test<incrementing 
number>, where <incrementing number> is a number that starts with 1 and 
counts upward. 

<item name> Each item that is used in the rule expression appears as a field. You can 
provide test values for each item.  

For more information, see Writing a test case for a rule or g lobal 
condition (on page 178). 
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Field Description 

Expected Result The expected result of the test case. Multiple fields appear for data-entry 
rules with multiple actions.  

• For data-entry rules: 

• Rule issues a query—Select QUERY or NOQUERY. 

• Rule sends an email message—Select Sent or Not Sent. 

• Rule sets a value—Calculate and type the expected value. For 
example, for a BMI rule, use the Height and Weight values in the 
test case to calculate the value. 

• For workflow rules, you select the study object that you expect to appear 
next in the workflow, based upon the test case. 

• For global conditions, you select True or False, depending on whether 
the specified condition is true or false.  

Rule Details tab Text representation and description of the rule. 

Site Info tab Information appears in this tab when a locale is defined for a study.  

Site name (or 
mnemonic) 

Name of the site. This information is returned when you use the 
GetSiteMnemonic() function. 

Site locale Drop-down list of supported locales for a study. The selected locale is 
returned when you use the GetSiteLocale() function. 

Site locale date and 
time 

Drop-down list for selecting a date and time. The selected date and time is 
returned when you use the GetSiteTime() function. 

Form Associations 
tab 

Information appears in this tab if an item path contains an associated form.  

Associated Data 
View item paths 

If you used data from associated forms in the rule, select the item paths that 
you used so that the Rule Test Cases dialog box can use the information 
when running the test cases. 

Test Properties tab Properties for the test name, item, or expected result that you point to in the 
grid.  

For more information, see Properties in the Rule Test Cases dialog box 
(on page 487). 

Test Description 
tab 

Optionally, type a description of the test case. 

 
 



Appendix A  Option and property descriptions  
 

410 Oracle® Health Sciences Central Designer 2.1.2 

Edit Global Conditions dialog box—Option descriptions 
Use the Edit Global Conditions dialog box to: 

• Create, edit, and delete a global condition. 

• View the locations in which a global condition is used. 
 

Option Description 
Global Conditions list  

Name Name of the global condition. 

Description Description of the global condition. This field is not deployed.  

Maximum characters: 2000. 

Target Target application specified for the global condition. The target 
application determines the study objects that are visible in the 
References section. 

Add, Edit, Delete Create a new global condition, or edit or delete the selected global 
condition.  

Expression tab Used for developing the expression for the global condition by 
typing or by dragging in components displayed in the tabs of the 
References section. When you drag in a component, the reference to 
the component is converted to the standard Central Designer 
expression syntax. 

Typically an expression might contain a combination of typed values 
(such as operators) and dragged-in components (such as functions 
or references to study objects). 

Assignments tab View the locations in the study in which the selected global 
condition is used. 

Workflow Name Name of the study object with the workflow that contains the global 
condition.  

Workflow Type Type (such as study design) of study object with the workflow that 
contains the global condition.  

Object Name Name of the study object to which the global condition is assigned.  

Object Type Type (such as study event) of the study object to which the global 
condition is assigned.  

Rule Action Action for the global condition assignment, such as when value is 
true. 

Reference tabs—Available 
components 

List of the components that are available for use in the global 
condition being defined.  

By default, these tabs appear on the right side of the dialog box. 
When you select a tab, the Reference section appears, with tabs 
along the bottom edge. 
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Option Description 

Data tab The available study objects appear in a tree structure similar to the 
Project Explorer. 

Functions tab The available functions appear in a tree structure organized by class. 

Note: Functions are defined in the Study Editor or Library Editor. 

Constants tab The available constants appear in a tree structure organized by class. 

Note: Constants are defined in the Study Editor or Library Editor. 

Data Mappings tab The components of the available mappings appear in a tree structure 
similar to the Project Explorer. 

Show All checkbox When selected, all available study objects as well as their properties 
appear. When not selected, only the available study objects appear. 
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Edit Rule Action dialog box—Option descriptions 
Use the Edit Rule Action dialog box to specify the conditions under which the next object in a 
workflow appears in a study, when the next study object in a workflow depends on the outcome of a 
workflow rule. This dialog box appears when you: 

• Connect a rule to a form in the Workflow Diagram tab. 

• Double-click an outgoing connector from a rule in the Workflow Diagram tab. 

• Specify a workflow rule outcome as a precondition in the Workflow Diagram tab 

The dialog box allows you to define a workflow action only. 
 

Option Description 
If the value is Indicates when the next object in the workflow appears in a study: 

• False—Only if the rule evaluates to false. 

• True—Only if the rule evaluates to true. 

• Always—Regardless of the result of the rule. This option is disabled 
for a workflow rule. 

• Only if no other action executes—Only if no other workflow 
object is in effect. This option is disabled for a workflow rule. 

• Relational statement—Only if the value returned by the rule 
satisfies the condition specified in the drop-down list and the text 
fields for this option. The following additional information is 
required for this selection: 

 Drop-down list—Specifies how the value returned by the 
workflow rule is compared with the values in the two text fields. 

 First text field—Specifies the value to compare with the value 
returned by the rule. If Between is selected in the drop-down list, 
the first text field specifies the first of two values that delineate a 
range. The rule result is checked to determine if it is between the 
two values. 

 Second text field—Available if Between is selected in the drop-
down list. The second text field specifies the second of two 
values that delineate a range. The rule result is checked to 
determine whether it is between the two values. 

 Inclusive—Available if Between is selected in the drop-down 
list. If selected, indicates that the range of values delineated in the 
two text fields includes the values entered in those fields. 

Note: Do not use the relational statement fields for string values, or a 
validation error occurs. 

 
 



 InForm Design Guide  

Oracle® Health Sciences Central Designer 2.1.2 413 

Edit Schedule dialog box—Option descriptions 
Use the Edit Schedule dialog box to specify the interval before the next study event in a study 
workflow. This dialog box appears when you: 

• Connect a study element or study event to a study element or study event in the Workflow 
Diagram tab. 

• Double-click an outgoing connector from a study element or study event to a study element or 
study event in the Workflow Diagram tab. 

 

Option Description 
Target event interval Amount of time to elapse between the connected study object and study 

event. This amount is specified as the number of weeks, days, and hours. 

After event Indicates the study event that the current study event follows. 

Clear Schedule Resets the target event interval to zero. 

 
 

Edit Schedule and Rule Action dialog box—Option descriptions 
Use the Edit Schedule and Rule Action dialog box to specify the conditions under which the next 
object in a workflow appears in a study, when the next study object in a workflow depends on the 
outcome of a workflow rule. This dialog box appears when you: 

• Connect a rule to a study event in the Workflow Diagram tab. 

• Double-click an outgoing connector from a rule in the Workflow Diagram tab. 

• Specify a workflow rule outcome as a precondition in the Workflow Diagram tab. 

The Edit Schedule and Rule Action dialog box appears when you connect a workflow rule and a 
study object. The dialog box allows you to define a schedule at the same time that you define a 
workflow action. 

 

Option Description 
Event Schedule tab  

Target event interval Amount of time to elapse between the connected study object and study 
event. This amount is specified as the number of weeks, days, and hours. 

After event Indicates the study event that the current study event follows. 

Clear Schedule Resets the target event interval to zero. 

Rule Action tab  
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Option Description 
If the value is Indicates when the next object in the workflow appears in a study: 

• False—Only if the rule or global condition evaluates to false. 

• True—Only if the rule or global condition evaluates to true. 

• Always—Regardless of the result of the rule or global condition. 
This option is disabled for a workflow rule. 

• Only if no other action executes—Only if no other workflow 
object is in effect. This option is disabled for a workflow rule. 

• Relational statement—Only if the value returned by the rule or 
global condition satisfies the condition specified in the drop-down 
list and the text fields for this option. The following additional 
information is required for this selection: 

 Drop-down list—Specifies how the value returned by the 
workflow rule is compared with the values in the two text fields. 

 First text field—Specifies the value to compare with the value 
returned by the rule or global condition. If Between is selected in 
the drop-down list, the first text field specifies the first of two 
values that delineate a range. The rule or global condition result 
is checked to determine if it is between the two values. 

 Second text field—Available if Between is selected in the drop-
down list. The second text field specifies the second of two 
values that delineate a range. The rule or global condition result 
is checked to determine whether it is between the two values. 

 Inclusive—Available if Between is selected in the drop-down 
list. If selected, indicates that the range of values delineated in the 
two text fields includes the values entered in those fields. 

Note: Do not use the relational statement fields for string values, or a 
validation error occurs. 

 
 

Email Action dialog box—Option descriptions 
 

Option Description 
Item Item that triggers the email action. Optionally, drag an item from 

the Data tab.  

To (Required) 

Email address of the person to receive the email. Separate multiple 
email addresses with a semicolon. The email address must be in a 
valid format, such as name@address.value. 
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Option Description 

From Email address of the person to send the email. The email address 
must be in a valid format, such as name@address.value. 

If you do not provide an email address, an address is taken from 
the registry. If the registry does not contain an email address, 
<studyname>@<default_webserver> is used. 

Locale Locale for the email subject and message. 

Note: To translate information, you must have the necessary 
language skills defined in the Central Designer Administrator 
application. 

Subject Subject of the email message.  

You can type a value or drag information from the Data, Functions, 
Constants, and Globals tabs. 

Note: Do not add an item for which the PHI item property is set 
to True. 

Message Email message.  

You can type a value or drag information from the Data, Functions, 
Constants, and Globals tabs. 

Notes: 

Do not add an item for which the PHI item property is set to True. 

A parameterized string in an email message or query that is 
generated in the InForm application follows the formatting that is 
specified for the site in the InForm application. Not allowed and 
unknown components of a date time value appear as asterisks (*). 
Leading and following underscores in the value are removed 
automatically. 

Message and Subject 
Parameters 

Optional parameters that you can create and use in the Subject 
field, Message field, and Parameter Value field.  

Type a value or drag information from the Data, Functions, 
Constants, and Globals tabs. 

Reference tabs—Available 
components 

List of the components that are available for use in the rule being 
defined.  

By default, these tabs appear on the right side of the dialog box. 
When you select a tab, the Reference section appears, with tabs 
along the bottom edge. 

Data tab The available study objects appear in a tree structure similar to the 
Project Explorer. 

Functions tab The available functions appear in a tree structure organized by class. 

Note: Functions are defined in the Study Editor or Library Editor. 

Constants tab The available constants appear in a tree structure organized by class. 

Note: Constants are defined in the Study Editor or Library Editor. 
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Option Description 
Data Mappings tab The components of the available mappings appear in a tree structure 

similar to the Project Explorer. 

Show All checkbox When selected, all available study objects as well as their properties 
appear. When not selected, only the available study objects appear. 

 
 

Invoke Function dialog box—Option descriptions 
Use the Invoke Function dialog box to assign values to the parameters named in a function that you 
are invoking in a rule or global condition definition. 

 

Option Description 
Function Name and description of the function being invoked. 

Return Type Data type of the value returned by the function. 

Reference tabs—Available 
components 

List of the components that are available for use in the rule being 
defined.  

By default, these tabs appear on the right side of the dialog box. 
When you select a tab, the Reference section appears, with tabs 
along the bottom edge. 

Data tab The available study objects appear in a tree structure similar to the 
Project Explorer. 

Functions tab The available functions appear in a tree structure organized by class. 

Note: Functions are defined in the Study Editor or Library Editor. 

Constants tab The available constants appear in a tree structure organized by class. 

Note: Constants are defined in the Study Editor or Library Editor. 

Data Mappings tab The components of the available mappings appear in a tree structure 
similar to the Project Explorer. 

Show All checkbox When selected, all available study objects as well as their properties 
appear. When not selected, only the available study objects appear. 

Parameter description 
section 

Lists the parameters that have been defined for the function, along 
with spaces in which to specify their values in the rule or global 
condition expression. 

Parameter Name of the parameter. 

Data Type Data type of the parameter. 
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Option Description 

Value Value the parameter takes in the rule or global condition expression: 

• An explicit number or string. 

• A study object, constant, or data series dragged from the Data, 
Constants, or Data Mappings tab of the References section. 

• A function that returns a value of the required data type (for 
example, the GetValue() function). 

 
 

Query Action dialog box—Option descriptions 
 

Option Description 
Initial Query State Initial state of the query. 

• Open—The query is visible on the form and available for 
response. 

• Candidate—The query is not visible on the form until 
someone reviews and explicitly opens it. 

Item Item on which the query will be issued. You can: 

• Type the name of the item. 

• Drag an item from the Data tab to the field.  

• Type an expression that satisfies the requirements of the rule 
expression language. For more information, see About the 
rule expression language (on page 145). 

Locale Locale of the query message. 

Note: To translate information, you must have the necessary 
language skills defined in the Central Designer Administrator 
application. 
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Option Description 
Message Query message that appears. The query message must be 255 

characters or fewer. The following errors occur for query messages 
that have 256 characters or more: 

• If the query message has parameters and the message is 255 
characters or fewer without the parameters, you receive a 
warning during validation, and the query is truncated to 255 
characters in the InForm application. 

• If the query message does not have parameters, you receive an 
error during validation.  

Note: A parameterized string in an email message or query that is 
generated in the InForm application follows the formatting that is 
specified for the site in the InForm application. Not allowed and 
unknown components of a date time value appear as asterisks (*). 
Leading and following underscores in the value are removed 
automatically. 

Message Parameters Optional parameters that you can create and use in the query 
message. 

Type a value or drag information from the Data, Functions, 
Constants, and Globals tabs. 

Reference tabs—Available 
components 

List of the components that are available for use in the rule being 
defined.  

By default, these tabs appear on the right side of the dialog box. 
When you select a tab, the Reference section appears, with tabs 
along the bottom edge. 

Data tab The available study objects appear in a tree structure similar to the 
Project Explorer. 

Functions tab The available functions appear in a tree structure organized by class. 

Note: Functions are defined in the Study Editor or Library Editor. 

Constants tab The available constants appear in a tree structure organized by class. 

Note: Constants are defined in the Study Editor or Library Editor. 

Data Mappings tab The components of the available mappings appear in a tree structure 
similar to the Project Explorer. 

Show All checkbox When selected, all available study objects as well as their properties 
appear. When not selected, only the available study objects appear. 
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New Rule Template dialog box—Option descriptions 
 

Option Description 
Properties tab  

Name Name of the rule template. 

Classification User-defined term used to organize rule templates. 

Description Description of the rule template. 

Display Text Text that appears in the Rule Summary section of the Rule wizard after the When 
Value Is information. 

If this field is blank, the contents of the Expression workspace are used. If the 
expression contains parameters, the name of the parameter and the value of the 
parameter appear. For example, if the expression is value must be between {a} 
and {b}, and the value of a is 10 and the value of b is 100, the parameters appear 
as a:10 and b:100. 

Definition tab  

Return Type 
drop-down list 

Return type of the rule template; one of the following: Integer, Float, String, 
Boolean, Date/Time, or Array (A list of values, all of the same type). 

Expression Expression of the rule. For more information, see About the rule expression 
language (on page 145). 

Parameters 
(Optional) 

 

Parameter Name of the parameter. 

Data Type Return type of the parameter; one of the following: Integer, Float, String, 
Boolean, Date/Time, or Array (A list of values, all of the same type). 

Default Value Specified value of the parameter. 

References  

Data tab Lists study objects in the scope of the rule. Optionally, to view the rule model 
properties of all of the study objects, select Show all. 

Functions tab Lists functions registered in a study and the libraries that appear in the Libraries 
List in the Study Editor. Any rule in the study can reference a function. 

Constants tab Lists constants created in the study and the libraries that appear in the Libraries 
List in the Study Editor. Any rule in the study can reference a constant. 
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Option Description 
Data Mappings 
tab 

Lists: 

• RefNames of the data mappings (on page 186), data sets (on page 194), 
and data series (on page 198) in the study or library. 

• Rule model properties for data series. 

A data series has the properties of the item that is mapped to it. If a data 
series contains an item that collects more than one value, the rule model 
properties for repeating study objects appear so you can access an array of all 
of the values of the item. 

• Methods for data sets. 

A method appears if you select the corresponding standard data dimension 
of the data set. You can use data set methods to return a subset of the data 
in the data set. 

• Study events, forms, sections, and items that are mapped to each data set.  

• Study objects appear if you select the corresponding standard data dimension 
of the data set. The properties of the study objects are used as parameters of 
data set methods.  

 
 

Rule Templates tab—Option descriptions 
The grid displays rule templates created on the study object selected in the Project Explorer.  

 

Option Description 
Rule templates grid  

Data Type Return type of the rule template. 

Description Description of the rule template. 

Display Text Text that appears in the Rule Summary section of the Rule wizard after 
the When Value Is information. 

Id Identification information for the rule. 

Expression Rule expression of the rule template.  

Parameters Specified parameters of the rule template, separated by semicolons.  

Template Name Name of the rule template. 

Type Indicates that the rule was created using the Central Designer rule 
expression language. 
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Rule Wizard—Option descriptions 
The Rule Wizard provides a simple interface for creating data-entry rules, including specifying the 
type of rule, preconditions, expression, and actions. 

Navigate through the wizard using: 

• The tabs at the top of the wizard. 

• The Next button. 

• The links in the Rule Summary section. 

The Rule Wizard has the following tabs. 

Quick Start tab 

In the Quick Start tab, you choose the type of rule to create.  

Note: The tab appears when you create a rule but not when you view an existing rule. 

 

Option Description 
Intrinsic Rule An intrinsic rule is a constraint rule or calculation rule based on a predefined 

rule template. Rule templates can be created for constraint rules and calculation 
rules. If no rule templates have been defined for the selected study object, then 
you cannot create an intrinsic rule for the study object. 

Constraint Rule A constraint rule checks whether data is valid. 

Calculation Rule A calculation rule sets the value of an item based on a calculation. 
 

Properties tab 

In the Properties tab, you provide a name and a brief description for the rule.  
 

Option Description 
Name The name of the rule: 

• Cannot contain spaces. 

• Must begin with a letter and can contain letters, numbers, and underscores 
(_) but no other special characters. 

• Must be no longer than 63 characters. 

• Must be unique for the study object. For example, you can create a rule 
called rulCalcBMI on a form and an item, but you cannot create two 
rulCalcBMI rules on two different forms.  

Description Description of the rule. The Description field can contain a description of the 
rule or the formal specification that is used by the actual rule developer. The 
limit is 2000 characters. 



Appendix A  Option and property descriptions  
 

422 Oracle® Health Sciences Central Designer 2.1.2 

 

Preconditions tab 

In the Preconditions tab, you select from the options in the Evaluate on Event drop-down list to 
specify when the rule will be evaluated.  

 

Option Description 

Evaluate on Event Event that causes the rule to execute: 

• On demand (batch mode)—Rule is validated and deployed 
to the InForm application with a deactivated status, so the rule 
does not run in the InForm application. 

• Form submission—Rule runs on form submission. The 
InForm application uses the study objects on which the rule 
depends to determine rule dependencies and the form that 
causes the rule to run. 

Select the rules which should 
execute before this rule 

Reserved for future use. 

Execute this rule only if the 
following expression is true 

Reserved for future use. 

 

Expression tab 

The Expression tab has two views, one for creating an intrinsic rule and another for creating a 
calculation or constraint rule. 

For detailed information about creating rule expressions, see Components of a rule expression.  
 

Option Description 
Expression 
workspace 

(Read-only for intrinsic rules) Provide the expression of the rule. 

Parameters 
section 

(Visible only for intrinsic rules) Provide the parameters for the function. 
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Option Description 

Data Mappings 
tab 

Lists: 

• RefNames of the data mappings (on page 186), data sets (on page 194), 
and data series (on page 198) in the study or library. 

• Rule model properties for data series. 

A data series has the properties of the item that is mapped to it. If a data 
series contains an item that collects more than one value, the rule model 
properties for repeating study objects appear so you can access an array of all 
of the values of the item. 

• Methods for data sets. 

A method appears if you select the corresponding standard data dimension 
of the data set. You can use data set methods to return a subset of the data in 
the data set. 

• Study events, forms, sections, and items that are mapped to each data set.  

• Study objects appear if you select the corresponding standard data dimension 
of the data set. The properties of the study objects are used as parameters of 
data set methods. 

Constants tab Lists constants created in the study and the libraries that appear in the Libraries 
List in the Study Editor. Any rule in the study can reference a constant. 

Functions tab Lists functions registered in a study and the libraries that appear in the Libraries 
List in the Study Editor. Any rule in the study can reference a function. 

Note: This tab does not appear for intrinsic rules. 

Data tab Lists study objects in the scope of the rule. Optionally, to view the rule model 
properties of all of the study objects, select Show all.  

 

Actions tab 

In the Actions tab, you specify the action, or actions, that occur as a result of executing the rule.  
 

Option Description 
Add Action button Add an action to the rule.  

Note: Click the Add Action button after defining an action only if you 
need to add another action. 

Delete Action button Delete the action selected in the Actions grid.  

Grid  

Fire Event Event that causes the action to occur. You select the event in the If 
The Value Is section. 

Actions Action that occurs.  

If the value is section  

False If the rule calculates a False value, the action occurs. 



Appendix A  Option and property descriptions  
 

424 Oracle® Health Sciences Central Designer 2.1.2 

Option Description 
Always (Default for calculation rules) The action always occurs. 

True If the rule calculates a True value, the action occurs. 

Only if no other 
action executes 

The action occurs only if no other action occurs. Select this option only 
if you define at least two actions. 

Values to specify • Equals—If the rule calculates a value that is equal to the provided 
value, the action occurs. 

• Not Equals—If the rule calculates a value that is not equal to the 
provided value, the action occurs. 

• Less Than—If the rule calculates a value that is less than the 
provided value, the action occurs. 

• Greater Than—If the rule calculates a value that is greater than 
the provided value, the action occurs. 

• Between—If the rule calculates a value that is between the 
provided values, the action occurs. 

Note: You can include string values in the Equals and Not Equals 
fields. Enclose the string in double quotes. For example, "text". 

(Inclusive) checkbox Select this option to make the number comparisons inclusive. For 
example, Less Than becomes Less Than or Equal To. 

Execute these actions 
grid 

 

Action Available actions. 

Note: Actions appear after you select the event that causes the rule to 
execute. 

 

Rule Summary section 

As you create a rule, the Rule Summary reflects the structure of the rule, including precondition, 
action, and expression information. Click a link in the Rule Summary to navigate through the Rule 
Wizard. 
 

Rules tab—Option descriptions 
 

Option Description 
Toolbar buttons  

New Rule 
Edit 
Delete 

Create, edit, or delete a data-entry rule.  

Check Syntax Check the syntax of a rule.  
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Option Description 

Cut 
Copy 
Paste 

Cut, copy, or paste a data-entry rule. 

Enable 
Disable 

Enable all disabled rules or disable all enabled rules for a study object. 

To enable or disable only parent rules for a study object, deselect the 
Show Child Rules checkbox before clicking the button. 

Show Errors/Hide Errors View the errors associated with the rule. You must check syntax before 
you can view errors. 

Rule Tests Open the Rule Test Cases dialog box and create rule test cases. 

Top section  

Show Child Rules 
checkbox 

When selected, all data-entry rules on the selected study object and its 
children appear in the grid. 

Summary grid  

Description Description of the rule.  

Expression Expression of the rule.  

Id Identification information for the rule. 

Lock icon Appears if the rule is locked. 

Parameters Parameters for the rule template. 

Parent Title of the study object to which the rule is attached.  

Parent RefName RefName of the study object to which the rule is attached. 

Parent Type Type of study object (such as a form) to which the rule is attached. 

RefName RefName of the rule. 

Syntax icon Indicates the validity of the rule syntax. 

• —Rule syntax is valid. 

• —Rule syntax has one or more warnings associated with it, or 
the rule could not be compiled. 

• —Rule syntax contains one or more errors and is not valid. 

Target Target application to which the rule is deployed. 

When Event that triggers the rule (you select this option from the Evaluate on 
Event drop-down list in the Rule Wizard).  

Rule Summary section A structured specification of the rule appears, with links that open the 
Rule Wizard. 
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Run tab of the Rule Test Cases dialog box—Option descriptions 
In the Run tab, you run validate rules, run test cases, and view the results. 

 

Field Description 
Top section  

Check Syntax Check syntax for the selected rules. 

Execute Tests Run the selected test cases and check syntax for the selected rules.  

Stop Stop the action.  

Go to Rule You are brought to the following location: 

• Data-entry rules—The study object on which the rule is 
created. 

• Workflow rules—The Workflow Diagram tab that contains the 
workflow rule. The workflow rule is selected in the diagram. 

• Global conditions—The study object on which the global 
condition was created (in a study, the study design). The Edit 
Global Conditions dialog box opens with the global condition 
selected. 

Progress indicator If the action is successful, the indicator is green. If one or more rules or 
test cases is invalid, the indicator is red. 

Passed 
Failed 
Skipped 

Metrics for the test cases that you ran. 

Note: If the IgnoreTest property for a test case (set in the Test Properties 
tab) is set to True, the test case is skipped. 

Grid  

Status • Red circle—Test case or rule is not valid.  

• Green circle—Test case or rule is valid.  

• Yellow circle—(Can appear only after you run test cases) Test case 
was skipped. 

Object Name Study object on which the rule was created.  

Rule Name Name of the rule. 

Validation Indicates whether the rule is valid, invalid, or incomplete (for rules or 
global conditions that have valid syntax but are not complete; for 
example, if the rule has no action defined).  

Test Name • Run test cases—Name of the test case. 

• Check syntax—n/a appears 

Results • Run test cases—Passed or Failed. 

• Check syntax—n/a appears. 



 InForm Design Guide  

Oracle® Health Sciences Central Designer 2.1.2 427 

Field Description 

Expected • Run test cases—Expected result of the test case. 

• Check syntax—n/a appears. 

Actual • Run test cases—Actual result of the test case. If the test case fails, 
error appears. 

• Check syntax—n/a appears. 

Time • Run test cases—Time (in milliseconds)  

• Check syntax—n/a appears. 

Execution Results 
section 

Select a result in the grid to view additional information. 

 
 

Set Review State Action dialog box 
Use the Set Value Action dialog box to set the review stage of a form based on the outcome of a 
rule. 

 

Option Description 
Form Form for which the review state is set. You can type a name or drag 

a form from the Data tab. 

ReviewState Review state to set. 

Review Stage Review stage to set in the review state. 

Review Stage expression Expression for the review stage to set in the review state. 

Comment (optional) Optional text describing the action. 

Reference tabs—Available 
components 

List of the components that are available for use in the rule being 
defined.  

By default, these tabs appear on the right side of the dialog box. 
When you select a tab, the Reference section appears, with tabs 
along the bottom edge. 

Data tab The available study objects appear in a tree structure similar to the 
Project Explorer. 

Functions tab The available functions appear in a tree structure organized by class. 

Note: Functions are defined in the Study Editor or Library Editor. 

Constants tab The available constants appear in a tree structure organized by class. 

Note: Constants are defined in the Study Editor or Library Editor. 

Data Mappings tab The components of the available mappings appear in a tree structure 
similar to the Project Explorer. 

Show All checkbox When selected, all available study objects as well as their properties 
appear. When not selected, only the available study objects appear. 
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Set Value Action dialog box—Option descriptions 
Use the Set Value Action dialog box to set the value of an item based on the outcome of a rule. 

 

Option Description 

Item Item for which the value is set. You can type a name or drag an 
item from the Data tab. 

Value to set the Item Value for the item. You can type a value or drag information from 
any of the tabs. 

Reference tabs—Available 
components 

List of the components that are available for use in the rule being 
defined.  

By default, these tabs appear on the right side of the dialog box. 
When you select a tab, the Reference section appears, with tabs 
along the bottom edge. 

Data tab The available study objects appear in a tree structure similar to the 
Project Explorer. 

Functions tab The available functions appear in a tree structure organized by class. 

Note: Functions are defined in the Study Editor or Library Editor. 

Constants tab The available constants appear in a tree structure organized by class. 

Note: Constants are defined in the Study Editor or Library Editor. 

Data Mappings tab The components of the available mappings appear in a tree structure 
similar to the Project Explorer. 

Show All checkbox When selected, all available study objects as well as their properties 
appear. When not selected, only the available study objects appear. 

 
 

Workflow Expression Editor dialog box—Option descriptions 
Use the Workflow Expression Editor dialog box to create the expression for a workflow rule in a 
Workflow Diagram tab. 

 

Option Description 
Rule Name Name of the workflow rule. 

Rule Description Description of the workflow rule. This field is not deployed.  

Maximum characters: 2000. 
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Option Description 

Expression section Used for developing the expression for the rule by typing or by 
dragging in components displayed in the tabs of the References 
section. When you drag in a component, the reference to the 
component is converted to the standard Central Designer expression 
syntax. 

Typically an expression might contain a combination of typed values 
(such as operators) and dragged-in components (such as functions 
or references to study objects). 

Reference tabs—Available 
components 

List of the components that are available for use in the rule being 
defined.  

By default, these tabs appear on the right side of the dialog box. 
When you select a tab, the Reference section appears, with tabs 
along the bottom edge. 

Data tab The available study objects appear in a tree structure similar to the 
Project Explorer. 

Functions tab The available functions appear in a tree structure organized by class. 

Note: Functions are defined in the Study Editor or Library Editor. 

Constants tab The available constants appear in a tree structure organized by class. 

Note: Constants are defined in the Study Editor or Library Editor. 

Data Mappings tab The components of the available mappings appear in a tree structure 
similar to the Project Explorer. 

Show All checkbox When selected, all available study objects as well as their properties 
appear. When not selected, only the available study objects appear. 
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Setting up and administering a study 

Coding tab—Option descriptions 

Note: This tab appears only after you have defined context information for a coding map and 
when the coding map is selected in the top panel. Not all dictionaries allow you to define context 
information. 

 

Field Description 

Top panel  

Assign queries to 
Item 

Title of the item to which to assign queries for the verbatim in the InForm 
application. 

Assign queries to 
Question 

(Optional.) Question associated with the item to which to assign queries for 
the verbatim in the InForm application. 

Assign queries to 
RefName 

(Optional). RefName of the item to which to assign queries for the verbatim 
in the InForm application. 

Coding Map 
RefName 

RefName of the coding map. 

Dictionary Type Name of the dictionary type for which the coding map is created.  

Form Name Form on which the verbatim item exists.  

Verbatim Item Title of the verbatim item for which a coding map is created.  

Verbatim Type Verbatim type that was specified for the coding map. 

Verbatim Question Default question of the verbatim item.  

Verbatim RefName RefName of the item.  

Bottom panel—
Coding Results tab 

 

Dictionary Level  Dictionary level for which the coding map is defined. 

Level Type Information that indicates whether the target item is for: 

• Code 

• Term  

• Additional information, which appears as Additional Info for [Level 
Name], where [Level Name] is the name of the dictionary level 
(available only for the WHO-DD dictionary type and in custom 
dictionary types in which additional information is defined).  

Target Item Title of the item that is specified for the dictionary level in the coding map.  

Target Question Default question of the item that is specified for the dictionary level in the 
coding map.  

Target RefName RefName of the target item.  
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Field Description 

Bottom panel—
Context 
Information tab 

 

Context Meaning  Descriptive text for the context information. This information is displayed 
exactly as it is defined in the dictionary. 

Context Item Title of the context item.  

Context Question Default question of the context item.  

Context RefName RefName of the context item.  
 

 

Coding Map dialog boxes—Option descriptions 
 

Option Description 
Dictionary type List of all dictionary types (including custom dictionary types, if any) that have 

been installed, enabled, and selected for the given study or library. 

For more information, see: 

• Importing and overwriting a dictionary type (in the Administrator 
Guide). 

• Enabling and disabling a dictionary type (in the Administrator Guide). 

• Selecting and removing dictionary types for a study or library (on 
page 36). 

After you select a dictionary type, additional fields in the dialog box (including 
Verbatim Type and the information in the grids) are populated with data from 
the dictionary.  

Item to code List of titles for all text items that can be coded.  

Note: 

• If you are creating a coding map, you can change the selected item but 
you cannot clear it.  

• If you are modifying a coding map, this field is read-only. 

Verbatim type List of verbatim types that are enabled for the selected dictionary type.  

The field is enabled after you select a dictionary type.  
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Option Description 
Assign queries to List of items that are eligible for query assignment, including the verbatim 

item. Each item in the list is: 

• A top-level item. 

• Visible and available for editing in the InForm application. Items 
designated as query targets must not have the Display Override property 
set to ReadOnly or Hidden in the Central Designer application. 

Note: You can select <use verbatim> in the Assign queries to drop-down 
list to select the verbatim item as the query target if the verbatim satisfies the 
requirements for a query target item. 

Coding Results 
tab 

 

Dictionary Level  Dictionary level for which the coding map is defined. 

Level Type Information that indicates whether the target item is for: 

• Code 

• Term  

• Additional information, which appears as Additional Info for [Level 
Name], where [Level Name] is the name of the dictionary level (available 
only for the WHO-DD dictionary type and in custom dictionary types in 
which additional information is defined).  

Target Item List of titles for all text items that can be selected as target items for a 
dictionary level in the coding map. If you select an item, the Target Question 
field is populated with its question.  

The list does not contain items that are already a verbatim, text item, or 
context item for the specified dictionary type, unless you are modifying a 
coding map. In that situation, the list includes the item that is currently 
assigned to the row, so you can review the list of options and reselect the item 
if you decide not to change the assignment. 

Target Question List of default questions for all text items that can be selected as target items 
for a dictionary level in the coding map. If you select a question, the Target 
Item field is populated with the item name.  

Context 
Information tab 

 

Context Meaning Descriptive text for the context information. This information is displayed 
exactly as it is defined in the dictionary. 
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Option Description 

Context Item List of titles for all text items that can be selected as context items for a 
dictionary level in the coding map. If you select an item, the Context Question 
field is populated with its question. 

The list does not contain items that are already a verbatim, text item, or 
context item for the specified dictionary type, unless you are modifying a 
coding map. In that situation, the list includes the item that is currently 
assigned to the row, so you can review the list of options and reselect the item 
if you decide not to change the assignment. 

Context Question List of default questions for all text items that can be selected as context items 
for a dictionary level in the coding map. If you select a question, the Target 
Item field is populated with the item name.  

 

Note: For more information about requirements for verbatims, target items, and context items, 
see Verbatims, context items, target items, and query target items (on page 41). 

 

Libraries tab—Section descriptions 
 

Section Description For more information, see... 
Library List (In 
Search Order) 

Libraries with study objects that can be 
copied to the study. The order of the libraries 
indicates the order in which search results are 
displayed in the Libraries Browser (results 
from the first library appear first, followed by 
results from the second library, and so on). 

• Choosing the libraries to 
use for a study (on page 12). 

• Setting the order of 
libraries in the Libraries 
List (on page 12). 

 
 

Libraries tab—Button descriptions 
 

Button Description For more information, 
see... 

Add Add an existing library to the Libraries list. When 
users in the study search for study objects in libraries, 
only the libraries in the Libraries list are searched. 

Choosing the libraries to 
use for a study (on page 12). 

Remove Remove a library from the Libraries list.  

Up  Move a library up in the Libraries list.  

Note: Libraries are searched in the order in which 
they are listed. 

Setting the order of 
libraries in the Library list 
for a study (on page 12). 

Down Move a library down in the Libraries list.  
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References tab—Option descriptions 
 

Option Description 
Top section  

Title Name of the file or URL attachment.  

Preview Text that appears in the Description section. 

(Paper clip 
button) 

Indicates whether the reference has an attachment (a file, shortcut to a file, or 
URL address).  

Details section  

Description Description of the attachment.  

Attachments All file and URL attachments.  

Note: The default maximum file size is 10 MB. This value can be configured. 
For more information, see Maximum attachment size (in the User Guide). 

 
 

Review State editor—Option descriptions 
 

Field Description 
RefName, Title, 
Description 

RefName, title, and description of the review state. 

In a study, review state RefNames must be unique. In a library, duplicate 
RefNames are allowed. 

Activated If selected, indicates that the review state is visible in the InForm 
application. 

State Number of the review state, indicating the order in which the review state 
is displayed in the InForm user interface. You can define a maximum of 
five review states for a study. In a library, the number of review states is 
unlimited. 

English (United States), 
Japanese (Japan) 

InForm product locales. Each tab contains the locale-specific names for 
the review state and each of its three stages.  

The Label and Mnemonic fields for the review state and each review stage 
are required for each InForm product locale (English and Japanese). If a 
required value is missing in a product locale tab, the value from the other 
locale (if it is defined) appears in the field in red, and an icon appears in 
the tab to indicate that translation is required. Study validation also checks 
for missing translated values. Because both English and Japanese locales 
are always required for review states, the study definition does not need to 
have the Japanese locale selected, and you do not need the Japanese 
language skill to translate the review state fields. 

Label Name for the review state, which appears in hover Help and drop-down 
lists in the InForm application.  
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Field Description 

Mnemonic Abbreviated name for the review state, which appears in column headings 
in the Data Viewer of the InForm application. 

Stage 1, Stage 2, 
Stage 3 

Indicates the stage for which to specify the name, label, and mnemonic. 
You must create three review stages for each review state. 

Name RefName of the review stage. Each RefName must be unique within its 
review state. 

Label Name for the review stage, which appears in hover Help and drop-down 
lists in the InForm application. 

Mnemonic Abbreviated name for the review stage, which appears in column headings 
in the Data Viewer of the InForm application. 

 
 

Review States editor—Option descriptions 
 

Field Description 

Activated If selected, indicates that the review state is visible in the InForm 
application. 

Description Description of the review state. 

Identifier Internal identifier of the review state. 

Published (libraries 
only) 

If True, indicates that the review state is published. 

RefName RefName of the review state. 

State Number of the review state, indicating the order in which the review state 
is displayed in the InForm user interface. You can define a maximum of 
five review states for a study. In a library, the number of review states is 
unlimited. 

READ-ONLY. 

Title Title of the review state. 
 

 

Study General tab—Option descriptions 
 

Field Description 
Study Name Name of the study. 

Targets Target applications to which you will deploy the study. 

Phase Phase of the study. 

Sponsor Sponsor associated with the study. 

Protocol Name of the protocol associated with the study. 
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Teams tab—Field descriptions 
When you select a user in the left section or double-click a user in the right section of the Teams tab, 
the right section has the following fields. 

 

Field Description 

Team Name The study team to which the selected user is assigned for the selected study only.  

Must Approve Reserved for future use. 
 

 

Deployment Setup tab—Option descriptions 
 

Option Description 
Buttons  

Test URL Test the URL of the selected deployment instance.  

If the test fails, automated deployment fails. The test is successful 
when: 

• The URL and port are valid for the InForm web service that is 
associated with the deployment instance. 

• The Central Designer deployment certificate is installed on the 
InForm server. 

• The Central Designer application can connect with the InForm 
web service. 

• The type of the deployment instance matches the type selected 
for the InForm web service. 

• The Approval Required setting for the deployment instance 
matches the setting for the InForm web service. 

• The rule engine that is installed on the Central Designer server is 
also installed on the InForm server. 

For more information, see the InForm Installation Guide.  

Audit History Display all the revisions of the selected deployment instance study 
object. 

Columns Select the columns to display. 

Lock and Protect Lock or protect the selected study object. 

Columns  
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Option Description 

Icon (first column) Status of the study object: 

• —New. 

• —Locked. 

• —Protected. When a study object is protected, you cannot : 

 Update or lock it. 

 Add child study objects to it by pasting or dragging and 
dropping. 

• Delete its child study objects. 

Description Description of the deployment instance. 

Type Type of deployment instance: 

• UAT—User acceptance testing 

• QA—Quality assurance 

• DEV—Development 

• LIVE—Production 

• TRN—Training 

URL URL address of the deployment instance. 

Port Port number of the web service used to query deployment status. 

Approval Required Indicates whether deployments to the server must be approved by a 
user with the appropriate right, as configured in the Central 
Designer Administrator application. 

 
 

 

Study administration data 

Sponsor tab of the Administration editor—Option descriptions 
 

Option Description 
Sponsor Name Name of the organization that is sponsoring the study. 

Program Name of the program. 

Therapeutic area Medical area that is being investigated by the study. 

Note Additional information you may want to include. 

Address 1 Sponsor street address. 

Address 2 Additional address information. 

City City. 
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Option Description 
State State (United States). 

Zip code Zip code (United States). 

Province Province (outside the United States). 

Postcode Postcode (outside the United States). 

Country Country. 

Phone Telephone number. 

Alt phone Alternate telephone number. 

Fax Fax number. 

Email address Email address. 
 

 

System settings tab of the Administration editor—Option descriptions 
 

Field Description 
EnrollWithIncompleteForms Whether an InForm user can override a failed screening and 

enrollment. 

AutoAnswerManualQueries Whether the InForm application automatically answers a manual 
query when a data item change satisfies the rules on the data item. 

EmailForNewSiteAndUser 
Notification 

Email address of an administrator who receives notification when a 
new site or new user is added. 

RequireCommentsForNA Whether a comment is required when NA is used. 

PatientSequence Format for assigning subject numbers (read-only). 

TrialDateFormat Format of the date that appears in the study 

ViewCRFSignList Whether a list of required signatures is included on each form. 

QueryMaxLength Maximum number of characters of query text. 

Maximum characters: 350. 

InlineDuration Number of seconds that the "Form submitted successfully" 
message remains visible in the header of the form before it fades. 

Must be a value from 1 to 9. 

QuerySelection State in which queries are created. 

EnforceVisitDate Whether to require the use of Date of Visit on the first form of 
every visit. 

ScreeningSequence Sequence number format for assigning screening numbers (read-
only). 
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Field Description 

UniqueIntDOBSwitch Requirements for a subject initial/date of birth combination 
settings. 

• Initials and DOB combination must be unique within a site. 

• Initials and DOB combination must be unique within a study. 

UniquePatIDSwitch Requirements for a subject ID. 

• Subject ID must be unique with a site. 

• Subject ID must be unique within a study. 

SponsorEditFrozen Whether a sponsor can edit a form after it is marked frozen. 

FormSaveMode Location and format of the message that appears when a form is 
submitted successfully. 

VisitCalculatorEnabled Whether to enable the visit calculator. 

UserNameOrder Order in which subjects appear in the Signature Details view. 

NavigationMode Whether to allow users to change the order in which subjects 
appear in the InForm UI. 

 
 

Item Groups tab of the Administration editor—Option descriptions 
 

Option Description 

Group Name Name of the item group. 

Description Description of the item group. 

Item Name Name of an item that is associated with the item group. 

Question Question associated with the item group. 

Owner Form (s) Form or forms in which the item group is defined. 
 

 

Query Groups tab of the Administration Editor—Option descriptions 
 

Option Description 
Group Name Name of the query group. 

Description Description of the query group. 
 

 

Rights Groups tab of the Administration Editor—Option descriptions 
 

Option Description 
Group Name Name of the item group. 

Description Description of the item group. 
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Option Description 
Item Group Name Name of an item group that is associated with the rights group. 

Description Description of an item group that is associated with the rights 
group. 

Display Override Whether the group of items that make up an item group is 
hidden, editable, or read-only. 

 
 

Signature Groups tab of the Administration editor—Option descriptions 
 

Option Description 

Group Name Name of the signature group. 

Description Description of the signature group. 

Type Type of document a signature group can sign. 

Reset Form State Whether associating a new signature group with a form that is signed 
resets the state of the form to unsigned. 

Invalidation Level Invalidates a signature if items change after signoff. 

Title Name of the form a signature group can sign. 

Description Description of the form a signature group can sign. 

Language Language to use for meaning and signature text. 

Signature Meaning Whether the signature indicates that the form is Reviewed, 
Approved, or in a user-specified state. 

Signature Text The affidavit text. 
 

 



 InForm Design Guide  

Oracle® Health Sciences Central Designer 2.1.2 441 

Study elements and study events 

Study Elements editor—Option descriptions 
Columns common to all study object editors 

All study object editors have the following columns. 

Note: Not all fields appear in the default view. Optionally, you can add the other fields and 
rearrange the browser view. For more information, see the User Guide. 

 

Property Description 
Icon (first column) Status of the study object: 

• —New. 

• —Locked. 

• —Protected. When a study object is protected, you cannot : 

 Update or lock it. 

 Add child study objects to it by pasting or dragging and dropping. 

 Delete its child study objects. 

Description Description of the study object. The description can have 0-255 
characters. 

Identifier Unique internal identifier of the study object. 

Published (only in 
libraries) 

Indicates that the study object has been published. 

RefName RefName of the study object. The RefName can have 1-63 characters. 

Note: Oracle recommends that you do not use Conflict for a study event 
RefName, as there is a default Conflict visit created for the InForm 
application. 

Revision Revision number of the study object. The revision number is incremented 
each time the study object is changed and saved. 

Title Title of the study object. The title can have 1-63 characters. 

Version Version number of the study object. The version number is incremented 
only when a user explicitly updates it. 

 

Note: Not all fields appear in the default view. Optionally, you can add the other fields and 
rearrange the browser view. For more information, see the User Guide. 
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Option Description 

Drop point Data type of the codelist. The data type of a codelist must be compatible 
with the data type of any items in which it is included.. 

 
 

Study Events Editor 
Columns common to all study object editors 

All study object editors have the following columns. 

Note: Not all fields appear in the default view. Optionally, you can add the other fields and 
rearrange the browser view. For more information, see the User Guide. 

 

Property Description 
Icon (first column) Status of the study object: 

• —New. 

• —Locked. 

• —Protected. When a study object is protected, you cannot : 

 Update or lock it. 

 Add child study objects to it by pasting or dragging and dropping. 

 Delete its child study objects. 

Description Description of the study object. The description can have 0-255 
characters. 

Identifier Unique internal identifier of the study object. 

Published (only in 
libraries) 

Indicates that the study object has been published. 

RefName RefName of the study object. The RefName can have 1-63 characters. 

Revision Revision number of the study object. The revision number is incremented 
each time the study object is changed and saved. 

Title Title of the study object. The title can have 1-63 characters. 

Version Version number of the study object. The version number is incremented 
only when a user explicitly updates it. 

 

Note: Not all fields appear in the default view. Optionally, you can add the other fields and 
rearrange the browser view. For more information, see the User Guide. 
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Option Description 
Block key value Value of the Clintrial block key, used for data transfer to the Clintrial 

application through CIS mappings. If you specify this value, it overrides 
the visit RefName as the block key.  

Drop Point  

Optional Indicates whether the study event is optional or required. 

Repeating Indicates whether the study event is repeating. 

Short Title Short title for the study event. 

Special Visits Indicates whether the study event is an InForm special visit. 
 

 



Appendix A  Option and property descriptions  
 

444 Oracle® Health Sciences Central Designer 2.1.2 

Study workflow 

Common Visit tab of the Study Design Editor—Option descriptions 
You must have the appropriate language skills to edit the fields, including the skill for the primary 
locale of the study. Changes are not sorted automatically. 

 

Option Description 
Common Visit 
settings 

 

Title Title of the common visit in the language of the primary locale. 

If you do not provide a value and the study contains common forms, 
Common CRF is used. 

Limit: 63 characters. 

Short Title Short title of the common visit in the language of the primary locale. 

If you do not provide a value and the study contains common forms, 
Common is used. 

Limit: 63 characters.  

Languages grid  

Language Language and locale to which information is translated. 

Title Translated text of the title of the common visit.  

Short Title Translated text of the short title of the common visit.  
 

Notes:  

• If you do not specify localized values, the title and short title are used during deployment. 

• If you specify localized values, you must specify values for all of the study's supported locales, or 
validation fails.  

 

General tab of the Study Event Editor—Option descriptions 
 

Option Description 
Settings  

Title Title of the study event. The title can have 1-63 characters. 

Short Title Short title of the study event. The short title is deployed to the InForm 
application as the visit mnemonic. 

RefName RefName of the study event. The RefName can have 1-63 characters. 

Description Description of the study event. The description can have 0-255 characters. 

Behavior  
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Option Description 

Repeating Indicates that the study event is repeating. 

Title Languages  

Language Language and locale to which information is translated. 

Short Title Translated text of the short title. The short title can have 1-63 characters. 

Title Translated text of the title.  

The Title field (in the Settings section) is not localizable and does not 
change, regardless of what you enter in the Title column in the Title 
Languages grid. To enter a localized value for a study object's title, use the 
Title column. Providing a value in the Title column is optional: 

• If you do not specify a localized value, the title of the study object is 
used during deployment. 

• If you specify a localized title, you must specify a localized value for all 
of the study's supported locales, or validation fails.  

 
 

Schedule of Events tab—Option descriptions 
 

Field Description 
Activity/Observation Title of each form in the study. Each form creates one row of the table, in 

the order in which it was added to the study. 

A selected checkbox at the intersection of a Form row and an Event 
column indicates that the form is included in that study event. 

Short Title Short title (mnemonic) of the form. 

Event columns Title of each study event in the study. Each study event creates one 
column in the table, in the order in which it was added to the study. 

A selected checkbox at the intersection of a Form row and an Event 
column indicates that the form is included in that study event. 

 
 

Workflow Diagram tab—Option descriptions 
 

Option Description 
New Element (Study 
Editor and Study 
Design Editor only) 

Create a new study element. 

New Event (Study 
Design Editor and 
Study Element Editor) 

Create a new study event. 

New (Study Event 
Editor only) 

Create a new form. 
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Option Description 
Global Conditions Create a global condition. 

Rule Tests Create test cases for a workflow rule. 

Select All Select all study objects in the workspace. 

Layout Arrange the layout of the workflow diagram by using the following 
options: 

• Grid Layout—Align all study objects along a grid. 

• Horizontal Layout—Align all connected study objects horizontally. 

• Spring Layout—Place all connected study objects so that the 
connecting lines do not need to bend. 

• Tree Layout—Align all connected study objects in a tree format. 

• Vertical Layout—Align all connected study objects vertically. 

Zoom Adjust the size of the workflow diagram by using the following options: 

• Zoom In—Increase the diagram size. 

• Zoom Out—Reduce the diagram size. 

• Fit to Page—Adjust the diagram size to fill the workspace. 

Enable/Disable 
Workflow 

Enable or disable the workflow. The text on the button changes depending 
on the workflow state. 

 
 

Workflow Grid tab—Option descriptions 
 

Option Description 
Status Icon indicating the status of a study object, including Locked, Protected, and so 

on. 

Type Study object type. On a study design, where you can create either study elements 
or study events, the available types appear in a drop-down list. 

Title Title of the study object. 
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Validation and deployment 

Baselines Browser—Option descriptions 
 

Option Description 
Buttons  

Edit Edit the name and description of the selected baseline. 

Delete Delete the selected baseline. You can only delete a baseline that does not 
have a deployment package associated with it. 

Ignore Warnings View warning messages and either update the study to correct them or 
indicate that you will ignore the warnings. 

Make Public Mark a baseline as public so that other users can view and work with it. 

Show Validation/Hide 
Validation 

• Show Validation—Change from a grid to a tree structure that you can 
expand to view the validation messages generated during baseline 
creation. 

• Hide Validation—Change from a tree structure back to a grid that 
lists only baselines without validation messages. 

Refresh Refresh the display of baselines from the Central Designer database. Job 
results for baselines that are expanded are also refreshed from the database.  

Save As Save the contents of the Baselines Browser to a comma-separated value 
(CSV) file that can be opened in a Microsoft Excel spreadsheet. 

Columns Note: Not all fields appear in the default view. Optionally, you can add 
the other fields and rearrange the browser view. For more 
information, see the User Guide. 

Baseline ID Unique identifier of the baseline.  

Date Created Date and time that the baseline was created. 

Deployed Yes or No, indicating whether the baseline has been processed for 
deployment. 

Description Description of the baseline, updated if you edit the baseline. 

Job ID Unique identifier of the job in which the baseline was created. 

Name Name of the baseline. By default, the name consists of the string 
Validation baseline, along with the date and time it was created. 

Public Yes or No, indicating whether the validation baseline has been made 
public.  
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Option Description 
Revision Revision number of the baseline. The revision consists of three numbers: 

"Major.Minor.Revision," such as 1.0.2. 

• Major and minor number—The version number of the study design 
study object. If the study design does not have a version number, the 
first two numbers are 0.0, such as 0.0.4. 

• Revision number—The number of revisions made to the study since 
the most recent version label (either major or minor) was created. 

Status Status of the baseline: 

• Valid—No warnings and no errors. A baseline with this status can be 
processed for deployment. 

• Valid with Warnings—One or more warnings exist, but a user has 
updated them with the Ignore Warnings menu command. A baseline 
with this status can be processed for deployment. 

• Pending—Validation is in process. 

• Invalid with Warnings—One or more warnings exist and have not 
been updated with the Ignore Warnings menu command. A baseline 
with this status cannot be processed for deployment. 

• Invalid—One or more errors exist. A baseline with this status cannot 
be processed for deployment. 

Status Icon Icon that corresponds to the status of the baseline. 

Study ID Unique identifier of the study for which the baseline is generated. 

Targets The target application(s) for which you validated the study and to which 
you deploy the study. 

Sub-columns The following columns are in the grid that appears when you click Show 
Job Results and expand the results for a job.  

Code Unique identifier for the validation error or warning. You can provide the 
code when submitting issues to Oracle Support. 

Description Description of the baseline message. 

Date Created Date and time the validation message was created.  

Issue Name Type of issue for which the job result is reporting. This field contains a 
value only if the job result is a validation error on a rule. Options include 
Rule Name and sometimes Function Name.  

Job Id Unique identifier of the job in which the baseline was created. 

Job Result Id Unique identifier of the baseline message.  

Object RefName RefName of the study object that is reported in the validation message. 
This field contains a value only if the job result is a validation error on a 
rule.  

Object Title Title of the study object that is reported in the validation message. This 
field contains a value only if the job result is a validation error on a rule.  
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Option Description 

Path Path of the study object that is reported in the validation message. This 
field contains a value only if the job result is a validation error on a rule.  

Target Target application for which you validate the study and to which you 
deploy the study. 

Type Icon Icon that corresponds to the status of the validation type. 

Validation Type Type of message: 

• Information—Description of the processing step being performed 
during validation. 

• Warning—Irregularity that should be investigated. Further processing 
(for example, creation of a deployment package) can be performed if 
you explicitly choose to ignore warnings. 

• Error—Fatal problem. No further processing (for example, creation of 
a deployment package) can be performed until all errors are corrected. 

Warning Ignored Indicates if you have chosen to ignore a warning. 
 

 

Create Deployment Package Wizard—Full deployment package 
 

Page  Option Description 
Welcome  Introduction page. 

Select a Deployment 
Package Type 

 Specify the type of deployment package to create. 

Note: To deactivate a rule in the InForm application, 
do one of the following in the Central Designer 
application before creating a new deployment package: 

• Remove the rule from the study.  

• Disable the rule.  

• Change the triggering event to On Demand (Batch 
Mode). 

Rule-related changes that you make in the InForm 
application are overridden when you install a new 
deployment package. 

Note: If you create or modify a coding map, use a full 
deployment package to deploy the changes. Changes to 
coding maps are not supported in incremental 
deployment packages. 

 Full package Deployment package that contains everything needed 
to deploy a complete study, including study 
administration data. 
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Page  Option Description 

 Incremental 
package 

Deployment package that contains everything needed 
to deploy a complete study, including study 
administration data, plus additions and changes to the 
study, reflected in Alternate forms in the InForm 
application. Alternate forms are not created when you 
install an incremental deployment package that 
contains additions to repeating forms or fixed 
repeating sections (Repeating Data itemsets in the 
InForm application). 

 Administration 
data 

Deployment package that contains only study 
administration data. 

Select a Baseline  Specify the baseline to use for creating the deployment 
package. Validation baselines with a status of Valid or 
Valid with Warnings are eligible.  

Note: If you select an unpublished validation baseline, 
the baseline is made public during deployment package 
creation. 

 Please select a 
baseline 

Drop-down list of validated baselines available for 
creating a deployment package. 

In-Place Revisions  If the specified baseline contains in-place revisions, 
review the changes and confirm you understand the 
risks of deploying before proceeding. 

 View IPR 
Summary 

Open the IPR Summary dialog box to review the 
revisions included in the baseline. 

 Confirmation text Select the checkbox to confirm that you understand the 
risks involved in deploying to the InForm application. 

Select the checkbox to confirm that you understand the 
risks involved in deploying to the InForm application. 

Select Locales  Specify the locale or locales for which to create the 
deployment package. You must select at least one 
locale. 

Note: Each option is applicable for different releases 
of the InForm application, and only one option is used 
for each release. However, you must select values for 
both options.  

 Please select one or 
more locales 

List of locales available to be supported by the 
deployment package. 

Note: This option is used when you deploy to InForm 
release 4.6. 
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Page  Option Description 

 Apply layout from Specify the default layout locale for the deployment 
package.  

In InForm release 4.7 and later, a single study version 
contains the layout information for all locales in the 
study, and you specify a default layout locale, from 
which all layouts, regardless of locale, inherit 
customizations in the InForm application.  

The site locale language in the InForm application 
determines the language in which forms appear. 

For example, a study contains layouts for the French 
(France) and the English (United Kingdom) locales. 
Radio buttons are horizontal in the French (France) 
layout but are vertical in the England (United 
Kingdom) layout. If French (France) is the default 
layout locale, then all layout customizations for the 
France (French) layout, including the alignment of 
radio buttons, are deployed to the InForm application 
and appear for all users, regardless of their site locale. 
Therefore, if your site locale in the InForm application 
is English (United Kingdom), the forms appear in 
English but with the customizations that were made in 
the French (France) layout in the Central Designer 
application. 

Note: This option is used when you deploy to InForm 
release 4.7 and later. 

Select Layouts  Choose the layout to deploy. If the layout does not 
exist for a form, the primary layout for the form is 
deployed instead. 

The list contains only the registered layout names in 
the study, which appear in the Tools > Layout Names 
Manager dialog box. 

Select Customer 
Defined Database 
(CDD) Mappings 
(optional) 

 Specify the mappings used to generate mappings for a 
CDD.  This page appears only if at least one CDD 
mapping is defined for the study. Only CDD mappings 
appear in the list. 

 Optionally, select 
one or more 
mappings for CDD 
mapping 

List of CDD mappings. 

 Select All Select all mappings in the list. 

 Unselect All Deselect all mappings in the list. 
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Page  Option Description 
Select Clintrial 
Integration Solution 
(CIS) Mappings 
(optional) 

 Specify the mappings used to generate mappings for 
the CIS application. This page appears only if at least 
one CIS mapping is defined for the study. Only CIS 
mappings appear in the list. 

 Optionally, select 
one or more 
mappings for CIS 
mapping 

List of CIS mappings. 

 Select All Select all mappings in the list. 

 Unselect All Deselect all mappings in the list. 

Specify a Name and 
Description 

 Specify a name and description for the deployment 
package. 

 Please specify a 
name for your 
deployment 
package 

Name of the deployment package. 

 Package 
description 

Description of the deployment package. 

 Apply new study 
version to all sites 

Select to apply the study to all sites.  

 Email dropbox 
location 

Specify the location to which to send an email triggered 
by a rule. 

MedML Files 
(optional) 

 Attach MedML files to the deployment package. The 
order in which the files are deployed is determined by 
their order in the grid. 

Note. The MedML files are validated by the InForm 
application prior to execution. 

 Add Add a MedML file to the grid. 

 Remove Remove selected MedML file from the grid. 

 Move Up Move selected file higher in the grid. 

 Move Down Move selected file lower in the grid. 

 Select All Select all files in the grid. 

Ready to Create 
Deployment Package 

 View a summary of the deployment options selected in 
the wizard. 

 Options summary Summary of options selected for the deployment 
package. 

 
 

 



 InForm Design Guide  

Oracle® Health Sciences Central Designer 2.1.2 453 

Create Deployment Package Wizard—Incremental deployment package 
 

Page Option Description 
Welcome  Introduction page. 

Select a Deployment 
Package Type 

 Specify the type of deployment package to create. 

Note: To deactivate a rule in the InForm application, 
do one of the following in the Central Designer 
application before creating a new deployment 
package: 

• Remove the rule from the study.  

• Disable the rule.  

• Change the triggering event to On Demand 
(Batch Mode). 

Rule-related changes that you make in the InForm 
application are overridden when you install a new 
deployment package. 

Note: If you create or modify a coding map, use a full 
deployment package to deploy the changes. Changes 
to coding maps are not supported in incremental 
deployment packages. 

 Full package Deployment package that contains everything needed 
to deploy a complete study, including study 
administration data 

 Incremental 
package 

Deployment package that contains everything needed 
to deploy a complete study, including study 
administration data, plus additions and changes to the 
study, reflected in Alternate forms in the InForm 
application. Alternate forms are not created when you 
install an incremental deployment package that 
contains additions to repeating forms or fixed 
repeating sections (Repeating Data itemsets in the 
InForm application). 

 Administration 
data 

Deployment package that contains only study 
administration data. 

Select a Previously 
Created Deployment 
Package 

 Specify the previously created deployment package 
for which this is an incremental package. 

 Please select a 
deployment 
package 

Drop-down list of previously created deployment 
packages. 
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Page Option Description 
Select a Baseline  Specify the validation baseline to use for creating the 

incremental deployment package. This baseline must 
have a date and time that is later than the validation 
baseline used to create the deployment package 
selected on the previous page. 

 

 

Deployment 
Package 

Name of the deployment package selected on the 
previous page. 

Package Baseline Validation baseline used to create the selected 
deployment package. 

Please select a 
baseline for the 
incremental 
package 

Drop-down list of validated baselines available for 
creating the incremental deployment package. 

In-Place Revisions  If the specified baseline contains in-place revisions, 
review the changes and confirm you understand the 
risks of deploying before proceeding. 

 View IPR 
Summary 

Open the IPR Summary dialog box to review the 
revisions included in the baseline. 

 Confirmation text Select the checkbox to confirm that you understand 
the risks involved in deploying to the InForm 
application. 

Add Locales (Optional)  Specify the additional locale or locales for which to 
create the incremental deployment package. This page 
appears only if you have added new locales to the 
validation baseline. 

 

 

Optionally, select 
one or more 
locales  

List of locales available to be supported by the 
deployment package. 

Select All Select all locales in the list. 

Unselect All Deselect all locales in the list. 

Add Customer Defined 
Database (CDD) 
Mappings (Optional) 

 Specify the additional mapping or mappings, if any, to 
use in the incremental package for generation of 
CDD mappings. This page appears only if you have 
added new CDD mappings to the validation baseline.  

If you have made changes to existing CDD mappings, 
those mappings are used in the deployment package 
to update the CDD mappings. 

 

 

Optionally, select 
one or more 
CDD mappings 

List of CDD mappings. 

Select All Select all mappings in the list. 

Unselect All Deselect all mappings in the list. 
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Page Option Description 

Add Clintrial 
Integration Solution 
(CIS) Mappings 
(Optional) 

 Specify the additional mapping or mappings, if any, to 
use in the incremental package for generation of CIS 
mappings. This page appears only if you have added 
new CIS mappings to the validation baseline.  

If you have made changes to existing CIS mappings, 
those mappings are used in the deployment package 
to update the CIS mappings. 

 Optionally, select 
one or more CIS 
mappings 

List of CIS mappings. 

 Select All Select all mappings in the list. 

 Unselect All Deselect all mappings in the list. 

Specify a Name and 
Description 

 Specify a name and description for the incremental 
deployment package 

 Please specify a 
name for your 
deployment 
package 

Name of the incremental deployment package. 

 Package 
description 

Description of the incremental deployment package. 

 Apply new study 
version to all sites 

Select to apply the study to all sites.  

 Email dropbox 
location 

Specify the location to which to send an email 
triggered by a rule. 

MedML Files (optional)  Attach MedML files to the deployment package. The 
order in which the files are deployed is determined by 
their order in the grid. 

Note. The MedML files are validated by the InForm 
application prior to execution. 

 Add Add a MedML file to the grid. 

 Remove Remove selected MedML file from the grid. 

 Move Up Move selected file higher in the grid. 

 Move Down Move selected file lower in the grid. 

 Select All Select all files in the grid. 

Ready to Create 
Deployment Package 

 View a summary of the deployment options selected 
in the wizard. 

 Options summary Summary of options selected for the incremental 
deployment package. 
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Create Deployment Package Wizard—Administration data deployment 
package 

 

Page  Option Description 
Welcome  Introduction page. 

Select a Deployment 
Package Type 

 Specify the type of deployment package to create. 

Note: To deactivate a rule in the InForm application, 
do one of the following in the Central Designer 
application before creating a new deployment package: 

• Remove the rule from the study.  

• Disable the rule.  

• Change the triggering event to On Demand (Batch 
Mode). 

Rule-related changes that you make in the InForm 
application are overridden when you install a new 
deployment package. 

Note: If you create or modify a coding map, use a full 
deployment package to deploy the changes. Changes to 
coding maps are not supported in incremental 
deployment packages. 

 Full package Deployment package that contains everything needed 
to deploy a complete study, including study 
administration data. 

 Incremental 
package 

Deployment package that contains everything needed 
to deploy a complete study, including study 
administration data, plus additions and changes to the 
study, reflected in Alternate forms in the InForm 
application. Alternate forms are not created when you 
install an incremental deployment package that 
contains additions to repeating forms or fixed 
repeating sections (Repeating Data itemsets in the 
InForm application). 

 Administration 
data 

Deployment package that contains only study 
administration data. 

Select a Baseline  Specify the baseline to use for creating the deployment 
package. Validation baselines with a status of Valid or 
Valid with Warnings are eligible.  

Note: If you select an unpublished validation baseline, 
the baseline is made public during deployment package 
creation. 
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Page  Option Description 

 Please select a 
baseline 

Drop-down list of validated baselines available for 
creating a deployment package. 

Specify a Name and 
Description 

 Specify a name and description for the deployment 
package. 

 Please specify a 
name for your 
deployment 
package 

Name of the deployment package. 

 Package 
description 

Description of the deployment package. 

Ready to Create 
Deployment Package 

 View a summary of the deployment options selected in 
the wizard. 

 Options summary Summary of options selected for the deployment 
package. 

 
 

Deployment Editor—Option descriptions 

Note: Not all fields appear in the default view. Optionally, you can add the other fields and 
rearrange the browser view. For more information, see the User Guide. 

 

Option Description 
Buttons  

New Package Create a deployment package from a validation baseline by using the Create 
Deployment Package Wizard. 

Save as Deliver a deployment package to a location from which it can be deployed. 
Available for deployment packages created in Central Designer release 2.1 and 
later. 

Delete Delete a deployment package. 

Deployment • Request—Create a deployment request for the selected deployment 
package. 

• History—Open the Deployment History dialog box to view a history of 
deployment requests for the selected package. 

Columns Select the columns to display in the Deployment Editor. 

Refresh Refresh the display of deployment packages. 

Columns  

Apply to All Sites Apply the study version to all sites that use the study. 

Base Layout Layout that was created in the Central Designer 1.3 release or earlier and is 
used with a multilingual study that was deployed to the InForm 4.7 release or 
later. 
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Option Description 
Baseline Name of the validation baseline on which the deployment package is based. 

Contains IPR Indicate that the study contains in-place revision changes. 

Deployment 
Counts 

Number of deployments performed for the deployment package. 

Description Description of the deployment package. 

Main Layout Primary layout that appears if a layout is not specified. 

Name Name of the deployment package. 

Package Created 
By 

User name of the user who created the deployment package. 

Package Creation 
Date 

Date and time when the deployment package was created. 

Targets The target application(s) for which you validated the study and to which you 
deploy the study. 

Type Type of deployment package: 

• Full 

• Incremental 

• Administration data 

Version Version of the study that you are deploying. 
 

 
 

Pending Approvals Tab on the Home Page—Option descriptions 
 

Option Description 
Buttons  

Approve/Reject  
Request 

Open the Approve Deployment Request dialog box to view detailed 
information about the selected deployment request, and approve or reject 
the request. 

Deployment History Open the Deployment History dialog box to view a detailed list of 
deployment data that includes: 

• Deployment requests waiting for your approval and deployment 
requests for studies on which you are a team member. 

• Deployment requests from all studies, if you are assigned to a role with 
the View deployments across studies right. 

Locking Display the lock options for pending deployment requests. 

Columns Select the columns to display in the Approvals tab. 

Columns  
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Option Description 

Additional Reason 
Info 

Additional information about the reason for the approval request. 

Approval ID Unique identifier of the deployment.  

Deployment Type One of the following: 

• Modify an existing trial—Deploy modified content to an existing 
study. 

• Deploy to new trial—Deploy content to a new study. 

Has IPR Indicates that the deployment contains in-place revision changes. 

Package Name Name of the deployment package. 

Package Type Type of deployment package: 

• Full 

• Incremental 

• Administration data 

Port Number Port used to query for deployment status. 

Project Name of the project containing the study. 

Reason Reason for deployment provided when the deployment request was 
created. 

Requested By User name of the user who created the deployment request. 

Requested Date Date when the deployment request was created. 

Schedule Date and time when to perform package deployment. Configured when the 
deployment request was created. 

Status URL URL used to query for the deployment status of the study. 

Study Name of the study for which the deployment package was created. 

Trial Server Name Name of the machine on which to deploy the study. 

Trial Type Type of study server to which the deployment package was deployed. One 
of the following: 

• UAT—User acceptance testing 

• QA—Quality assurance 

• DEV—Development 

• LIVE—Production 

• TRN—Training 

Trial URL URL used to log on to the machine on which to deploy the study. 
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Deployment History dialog box—Option descriptions 
 

Option Description 
Buttons  

Package History Open the Deployment History dialog box for the selected deployment 
package. 

View Log Open the Deployment Log dialog box. 

Export Save approval history information to a comma-separated value (CSV) file that 
can be opened in a Microsoft Excel spreadsheet. 

Columns Select the columns to display. Not all columns appear in the default view. 

Columns  

Additional 
Information 

Additional information provided in the deployment request. 

Approval Required Whether the deployment of the package requires approval. 

Approval Status Approval status for the deployment request. One of the following: 

• Not Required—Request does not re quire an approval. 

• Requested—Request has been created, and it has not been approved or 
rejected yet. 

• Approved—Request has been approved. 

• Rejected—Request has been rejected. 

Archived Whether the deployment package is archived. 

Date Completed Date and time when the deployment process completed. 

Date Performed One of the following: 

• If the approval status is Not Required or Requested, date and time when 
the deployment request was created. 

• If the approval status is Approved or Rejected, date and time when the 
request was approved or rejected. 

Date Started Date and time when the deployment process started. 

Deployment ID Unique identifier of the deployment. 

Deployment 
Instance 

RefName of the deployment instance to which the deployment package was 
deployed. 

Deployment 
Option Type 

One of the following: 

• Modify an existing trial—Deploy modified content to an existing study. 

• Deploy to new trial—Deploy content to a new study. 
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Option Description 

Deployment Status Deployment status for the deployment request. One of the following:  

• Not Applicable—Deployment has not been initiated. 

• Unknown—Deployment has been initiated, but the InForm application 
has either not detected the deployment package, or has not located it. 

• Submitted—Deployment has been initiated, the package has been 
transferred to the InForm server, but the InForm application has not 
detected it yet. 

• Scheduled—Deployment has been initiated, the package has been 
transferred to the InForm server, and the InForm application has 
scheduled it for installation. 

• In Progress—Deployment is currently being executed. 

• Succeeded—Deployment has completed successfully. 

• Failed—Deployment has failed. 

• Canceled—Deployment has been canceled. 

Deployment Type Type of study server to which the deployment package was deployed. One of 
the following: 

• UAT—User acceptance testing 

• QA—Quality assurance 

• DEV—Development 

• LIVE—Production 

• TRN—Training 

Deployment URL URL address of the deployment instance. 

Has IPR Indicates that the deployment contains in-place revision changes. 

Is Immediate Whether the deployment schedule option selected in the deployment request 
was Immediate. 

Package Name Name of the deployment package. 

Package Type Type of deployment package: 

• Full 

• Incremental 

• Administration data 

Performed By One of the following: 

• If the approval status is Not Required or Requested, user name of the user 
who created the deployment request. 

• If the approval status is Approved or Rejected, user name of the user who 
approved or rejected the deployment request. 

Project Name of the project containing the study. 



Appendix A  Option and property descriptions  
 

462 Oracle® Health Sciences Central Designer 2.1.2 

Option Description 
Reason for 
Deployment 

Reason for deployment provided when the deployment request was created. 

Schedule Date and time when to perform package deployment. Configured when the 
deployment request was created. 

Status URL URL used to query for the deployment status of the study. 

Study Name of the study for which the deployment package was created. 
 

 

Deployment Package History dialog box—Option descriptions 
 

Option Description 
Buttons  

Cancel Request Cancel the selected deployment request. Available only if the deployment 
request has not been approved or rejected yet. You cannot cancel a request if 
the deployment does not require an approval. 

Note: Cancelled deployment requests are not archived. 

Cancel 
Deployment 

Cancel the selected deployment. Available only if the deployment status is 
Scheduled or Submitted. 

View Log Open the deployment log for the selected deployment. Available if the 
deployment status is either Succeeded, Failed, or Canceled. 

Save as Open the Save as dialog box to save the deployment package as a zip file. 
Available only for deployment packages created in Central Designer release 2.1 
and later. 

Export Save the deployment package history to a comma-separated value (CSV) file 
that can be opened in a Microsoft Excel spreadsheet. 

Columns Select the columns to display. Not all columns appear in the default view. 

Filter by 
Deployment Id 
field 

Enter a Deployment Id to display information only for that deployment. 

Fields  

Package Name of the deployment package. 

Baseline Name of the validation baseline on which the deployment package is based. 

Package Type Type of deployment package: 

• Full 

• Incremental 

• Administration data 

Columns  
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Option Description 

Additional 
Information 

Additional information provided in the deployment request. 

Approval Required Whether the deployment of the package requires approval. 

Approval Status Approval status for the deployment request. One of the following: 

• Not Required—Request does not re quire an approval. 

• Requested—Request has been created, and it has not been approved or 
rejected yet. 

• Approved—Request has been approved. 

• Rejected—Request has been rejected. 

Archived Whether the deployment package is archived. 

Date Completed Date and time when the deployment process completed. 

Date Performed One of the following: 

• If the approval status is Not Required or Requested, date and time when 
the deployment request was created. 

• If the approval status is Approved or Rejected, date and time when the 
request was approved or rejected. 

Date Started Date and time when the deployment process started. 

Deployment Id Unique identifier of the deployment. 

Deployment 
Instance 

RefName of the deployment instance to which the deployment package was 
deployed. 

Deployment 
Option Type 

One of the following: 

• Modify an existing trial—Deploy modified content to an existing study. 

• Deploy to new trial—Deploy content to a new study. 
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Option Description 
Deployment Status Deployment status for the deployment request. One of the following: 

• Not Applicable—Deployment has not been initiated. 

• Unknown—Deployment has been initiated, but the InForm application 
has either not detected the deployment package, or has not located it. 

• Submitted—Deployment has been initiated, the package has been 
transferred to the InForm server, but the InForm application has not 
detected it yet. 

• Scheduled—Deployment has been initiated, the package has been 
transferred to the InForm server, and the InForm application has 
scheduled it for installation. 

• In Progress—Deployment is currently being executed. 

• Succeeded—Deployment has completed successfully. 

• Failed—Deployment has failed. 

• Canceled—Deployment has been canceled. 

Deployment Type Type of study server to which the deployment package was deployed. One of 
the following: 

• UAT—User acceptance testing 

• QA—Quality assurance 

• DEV—Development 

• LIVE—Production 

• TRN—Training 

Deployment URL URL address of the deployment instance. 

Has IPR Indicates that the deployment contains in-place revision changes. 

Is Immediate Whether the deployment schedule option selected in the deployment request 
was Immediate. 

Performed By One of the following: 

• If the approval status is Not Required or Requested, user name of the user 
who created the deployment request. 

• If the approval status is Approved or Rejected, user name of the user who 
approved or rejected the deployment request. 

Project Name of the project containing the study. 

Reason for 
Deployment 

Reason for deployment provided when the deployment request was created. 

Schedule Date and time when to perform package deployment. Configured when the 
deployment request was created. 

Status URL URL used to query for the deployment status of the study. 
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Option Description 

Study Name of the study for which the deployment package was created. 
 

 
 

Deployment Request dialog box—Option descriptions 
Use the Deployment Request dialog box to initiate the automated deployment of a package. 

Settings tab 
 

Option Description 
Deployment instance Select a deployment instance from the Name drop-down list. The 

following information will be displayed for the selected instance: 
type, URL, and whether approvals are required. 

Deployment schedule Select when to perform the deployment: 

• Time—Select the time when to deploy the package (local time 
of the client). 

• Immediate (after approval)—Deploy the package immediately 
after the deployment request is approved. 

Deployment option One of the following: 

• Modify an existing trial—Deploy modified content to an 
existing study. 

• Deploy to new trial—Deploy content to a new study. 

Reason for deployment Select a reason for the deployment. The reason is included in the 
email notification sent to the deployment approvers. 

Additional information Optionally, provide more information about the deployment 
request. The information is not included in the email notification 
sent to the deployment approvers. 

Email distribution list Users who receive email notifications when the deployment request 
is created, approved or rejected, and when the deployment is 
completed. 

Note: The user who requests the deployment and all the users who 
have the right to approve the request are automatically added to the 
list. 

 

Advanced tab 

You can configure advanced options if overriding the settings is allowed for the server type in the 
Central Designer Administrator application. For more information, see the Administrator Guide. 

 

Option Description 

Deployment start delay Time to wait (in milliseconds) for the InForm caches to initialize. 
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Deployment Wizard for InForm deployment 
 

Page Option Description 
Welcome  Introduction page. 

Connecting to 
InForm 

Connect to the InForm application and requests server and study 
information. 

 Message section Informational and error messages. 

 Reconnect Reconnect to the InForm application after correcting 
any error conditions. 

InForm Trial 
Parameters 

 Specify information about the InForm application 
server and study to which to deploy the package. If 
either the server or the study does not already exist, 
subsequent pages collect additional information 
needed to create them. 

 Server Name Name of the InForm application server. 

 Trial Name Name of the InForm study. 

 Strict Mode If selected (default)—Only complete MedML 
definitions of study components can be loaded into 
the study; an incomplete definition causes the 
installation to fail. 

If not selected—Incomplete study component 
definitions are permitted. 

Create a New 
InForm Server 

 Specify whether the InForm server should start 
automatically when the InForm Service starts. This 
page appears if the specified InForm server does not 
yet exist. 

 Startup Server 
Automatically on 
InForm Startup 

If selected—The InForm server starts automatically 
when the InForm Service starts. 

If not selected—The InForm server must be started 
manually. 

Create a New 
InForm Trial 

 Specify information needed to create the study. This 
page appears if the specified InForm study does not 
yet exist. 

 User Name Oracle user name for the study database.  

 User Password Oracle password for the study database. 

 Please specify a 
database for creating 
a new InForm study 

One of the following: 

• Connect String—Connection string for the 
Oracle instance. 

• TriDSN—ODBC System DSN for the InForm 
study. 



 InForm Design Guide  

Oracle® Health Sciences Central Designer 2.1.2 467 

Page Option Description 

 Startup Trial 
Automatically on 
InForm Startup 

If selected—The InForm study starts automatically 
when the InForm Service starts. 

If not selected—The InForm study must be started 
manually. 

Ready for 
Deployment 

 View a summary of the parameters that will be used 
for deployment. 

Deployment Results  View messages generated during deployment 
processing, along with the elapsed time. These 
messages are also collected in the StudyInstaller.log 
file in the directory where you execute the 
deployment package. 

 
 

Jobs Browser—Option descriptions 

Note: Not all fields appear in the default view. Optionally, you can add the other fields and 
rearrange the browser view. For more information, see the User Guide. 

 

Option Description 
Buttons  

Hide Job Results/ 

Show Job Results 

• Show Job Results—Change from a grid to a tree structure that you can 
expand to view the job results for each job.  

• Hide Job Results—Change from a tree structure back to a grid that lists 
only jobs without job results.  

Refresh Refresh the display of jobs from the Central Designer database. When you 
refresh, the job results for expanded jobs are also refreshed. 

Save As Save the contents of the Jobs Browser to a comma-separated value (CSV) file 
that can be opened in a Microsoft Excel spreadsheet. 

Jobs Since Drop-down list specifying how far back the display of job results goes. 

Columns  

Finish Time Date and time at which the job ended.  

Job State Run status of the job, either Started or Finished.  

Job Id Unique identifier of the job that generated the listing. 

Job Result Indicates whether the job scheduler ran successfully for the specified job. This 
field is not an indication of the status of the job.  

• Succeeded 

• Failed 
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Option Description 
Name Name of the job: 

• For deployment package jobs—Name of the deployment package. 

• For library import jobs—[Import to], plus the name of the target library. 

• For validation jobs—[Validation baseline], plus the date and time of job 
submission. 

Start Time Date and time when the job started.  

Status Overall status of the job results for the selected job. 

• Information—Job results contain only informational messages. This status 
also appears if the job has started but no job results have been reported yet.  

• Warning—Job results contain at least one warning (but no errors). 

• Error—Job results contain at least one error. 

Status Icon Icon that corresponds to the status of the job. 

Study Id Unique identifier of the study for which the job was run. 

Type Type of job, either Import, Validation, or BuildDeploymentPackage.   

Sub-columns The following columns are in the grid that appears when you click Show Job 
Results and expand the results for a job.  

Code Unique identifier for the validation error or warning. You can provide the code 
when submitting issues to Oracle Support. 

Date Created Date and time the message was generated. 

Description Text of the message. 

Issue Name Type of issue for which the job result is reporting. This field contains a value 
only if the job result is a validation error on a rule. Options include Rule Name 
and sometimes Function Name.  

Job Id Unique identifier of the job that generated the listing. 

Job Result Id Unique identifier of the job result.  

Object RefName RefName of the study object that is reported in the job result. This field 
contains a value only if the job result is a validation error on a rule. 

Object Title Title of the study object that is reported in the job result. This field contains a 
value only if the job result is a validation error on a rule. 

Path Path of the study object that is reported in the job result. This field contains a 
value only if the job result is a validation error on a rule.  

Target Target application for which you validate the study and to which you deploy the 
study. 
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Option Description 

Type Type of message: 

• Information—Description of the processing step being performed in the 
job. 

• Warning—Irregularity that should be investigated. Further processing (for 
example, creation of a deployment package) can be performed if you 
explicitly choose to ignore warnings. 

• Error—Fatal problem. No further processing (for example, creation of a 
deployment package) can be performed until all errors are corrected. 

Type Icon Icon that corresponds to the type of message. 

Warning Ignored True or False, indicating whether you have chosen to ignore the warning 
message for the purpose of performing additional processing. 
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Properties 

CDD data mapping properties 
 

Study 
object 

Option Description 

Item Data Label 

 

User-defined string to use for searching on data in the column. 
Maximum length is 30 characters. This label is included in the 
CDD data mapping control path definition in the InForm database. 
For CDD data mappings, it also appears in target CDD data 
mapping tables that have any of the following key types: Patient to 
Control, Pivot Patient, Pivot Visit, Pivot Form, and Pivot Section. 

Data set Associated 
Forms 

Names of pairs of forms for which associations have been created. 
Selecting a pair of associated forms results in the generation of 
CDD data mappings for that association. 
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Study 
object 

Option Description 

 Target Key 
Type 

For the following key types, the target key type specifies the 
composition of the primary key columns of the target table. Each 
time a component of the primary key changes from the previous 
primary key submitted, the InForm application inserts a new row in 
the target table. Primary keys consist of the following DBUIDs and 
indexes: 

• Patient Only—PatientID, FormIndex, ItemsetIndex. 

• Patient Visit (default)—PatientID, VisitID, FormIndex, 
ItemsetIndex, and VisitIndex. 

• Patient to Form—PatientID, VisitID, FormIndex, 
ItemsetIndex, VisitIndex, and FormID. 

• Patient to Section—PatientID, VisitID, FormIndex, 
ItemsetIndex, VisitIndex, FormID, and SectionID. 

• Patient to Itemset—PatientID, VisitID, FormIndex, 
ItemsetIndex, VisitIndex, FormID, SectionID, and ItemsetID. 

• Patient to Item—PatientID, VisitID, FormIndex, 
ItemsetIndex, VisitIndex, FormID, SectionID, ItemsetID, and 
ItemID. 

• Patient to Control—PatientID, VisitID, FormIndex, 
ItemsetIndex, VisitIndex, FormID, SectionID, ItemsetID, 
ItemID and five ControlIDs. A target table with this key type 
also contains a data label that can be used for data selection. 

For the following key types, the primary key columns are 
PatientID, VisitID, ItemsetIndex, VisitIndex, FormID, SectionID, 
ItemsetID, ItemID and five ControlIDs. The key type selection 
determines the composition of a pivot set. Within a pivot set, data 
points mapped to non-pivot columns are repeated in each row. 
Target tables with these key types also contain a data label that can 
be used for data selection. Pivot set keys consist of the following 
DBUIDs and indexes: 

• Pivot Patient—PatientID and VisitIndex 

• Pivot Visit—PatientID, VisitID, and VisitIndex 

• Pivot Form—PatientID, VisitID, FormID, and VisitIndex 

• Pivot Section—PatientID, VisitID, FormID, SectionID, and 
VisitIndex 

Data series Pivot Column Identifies the column to use as the pivot column, if the key type is 
Pivot Form, Pivot Patient, Pivot Section, or Pivot Visit. 

Note: Only one column can be the pivot column, and it must be 
the first column in the table. 

 Target Column 
Max Length 

Maximum length of a column, in the range 1-255. This property is 
applicable for columns with a type of STRING. 



Appendix A  Option and property descriptions  
 

472 Oracle® Health Sciences Central Designer 2.1.2 

 
 

CIS data mapping properties 
Use the following custom properties for CIS data mappings to specify how the data that is passed 
from the InForm application should be used in the Clintrial application. The custom properties have 
default values or are required only when you want to support specific Clintrial features, such as 
master-detail panel relationships. 

 

Study object Option Description 
Study event Block Key Value Value of the Clintrial block key. If you specify this value, it 

overrides the study event RefName as the block key. 

Form Page Key Value 

 

Value of the Clintrial page key. If you specify this value, it 
overrides the form RefName as the page key. 

Data set Detail Key Item Name of the item identified as the detail key item, if the panel 
definition is part of a detail page section. 

 Detail Panel True or False (default), indicating whether the panel definition 
participates in a detail page section in a master-detail 
relationship. A master-detail relationship is a relationship 
between two page sections on a study page, in which each 
record in one page section (the master page section) can have 
one or more associated records in the other section (the detail 
page section). During data entry the displayed records in the 
detail page section are associated with the selected record in the 
master page section. 

 Master Item Name of the item on the master panel that corresponds to the 
detail key item specified in the Detail Key Item property. 

This property applies only if the value of the Detail Panel 
property is True. 

 Master Panel Name of the master panel with which this panel definition 
participates in a master-detail relationship. 

This property applies only if the value of the Detail Panel 
property is True. 
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Study object Option Description 

 Panel Type A specification of how the database tables associated with the 
panel are structured: 

• Panel Type 1—One record per subject, collected once 
during the study. 

• Panel Type 2—Multiple records for each subject, collected 
once during the study. 

• Panel Type 3—One record per subject, collected at 
multiple visits. 

• Panel Type 4 (default)—Multiple records for each subject, 
collected at multiple visits. 

• Context Panel—One record containing custom context 
items that are associated with each record in a clinical data 
table. Use this type to specify a custom context panel. 

• Enrollment Panel—One record of enrollment data for 
each enrolled subject. 

• Non-Patient Data—Data not related to a study subject, 
for example, lab normals or standard coding thesauruses. 

 Protected True or False (default), indicating whether access rights to the 
panel are limited in the Clintrial application. 

 SAS Name Name of the panel when data is sent to SAS through the 
Clintrial SAS interface. 

OPTIONAL; if entered, the name must be 8 characters or fewer 
and conform to SAS naming requirements. 

Note: Panel SAS names must be unique within a protocol. 

 Verifiable True or False (default), indicating whether double-entry of data 
in panel items is required for verification. 

Data series Checklist Name of a Clintrial checklist associated with the item. A 
checklist is a type of codelist used to view suggested entries for a 
field. 

The checklist name must be 20 characters or fewer. 

Checklist and CIS Codelist are mutually exclusive properties. 
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Study object Option Description 

 CIS Codelist Name of a Clintrial codelist associated with the item. A codelist 
encodes entered values.  

The codelist name must be 20 characters or fewer. 

Checklist and CIS Codelist are mutually exclusive properties. 

Note: When CIS synchronization processes data mappings and 
autogenerates codelists, it does not autogenerate codelists for 
items that have a value in the Code List property. The CIS 
Codelist property refers to an existing codelist. Therefore, if you 
want CIS to autogenerate a codelist for an item, leave the Code 
List property blank. 

 Context Type Specifies the usage of a user-defined context item: 

• Not a context item (default). 

• Subject-related context item. 

• Visit-related context item. 

• Page-related context item. 

• Other context item. 

Note: Data series with a Context Type of Other context 
item are designed to be used in hybrid studies in which 
users can enter data using either the Clintrial or the InForm 
application. When you deploy a study that contains a data 
series with a Context type property of Other context item, 
the item definition for that data series is created in the 
Clintrial context panel, but the CIS application does not 
synchronize data from the InForm application to that 
context item. To enter data into a context panel item that is 
defined using the Other context item Context type 
property, users must use the Clintrial Enter module. 

 Copy With Panel True (default) or False, indicating whether the item should be 
included with the panel if the panel is copied.  

 DB Format 
Float Precision 

Number of characters that can be added after the decimal place 
in an item with a type of FLOAT. This value can be a number 
between 1 and 15. The default is 10. 

 DB Format 
Length 

Number of characters that can be entered in this item. The 
default is 2000 for text items, 18 for numeric items. 

 Derived True or False (default), indicating whether the value of the item 
is determined from a derivation associated with the panel. 

 Is Key True or False (default), indicating whether the item mapped to 
the data series is a subject key, block key, block repeat key, page 
key, or page repeat key item in the context panel. 

 Item Required True or False (default), indicating whether the item is required. 
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Study object Option Description 

 Key Order The order in which the item appears in the concatenation of key 
items, if the item is part of the panel's key. 0 (not a key item) is 
the default. 

 Max Maximum value that can be entered for the value of the item. 

 Min Minimum value that can be entered for the value of the item. 

 Repeated True or False (default), indicating whether an item is one for 
which multiple values can be entered within a page section.  

 SAS Name (Optional) Name of the item when data is sent to SAS through 
the Clintrial SAS interface. 

If entered, the name must be eight characters or fewer and 
conform to SAS naming requirements. 

Note: Item SAS names must be unique within a panel. 
 

 

Codelist properties 
Properties common to all study objects 

All study objects have the following properties. 
 

Property Description 
Description Description of the study object. The description can have 0-255 

characters. 

Identifier Unique internal identifier of the study object. 

Locked When True, the study object is locked. 

Modified When True, the study object has not been saved since the last 
modification. 

New When True, the study object has not been saved yet. When False, the 
study object has been saved at least one time.  

Protected When true, the study object is protected. When a study object is 
protected, you cannot : 

• Update or lock it. 

• Add child study objects to it by pasting or dragging and dropping. 

• Delete its child study objects. 

RefName RefName of the study object. The RefName can have 1-63 characters. 

Revision Revision number of the study object. 

Title Title of the study object. The title can have 1-63 characters. 

Version Version number of the study object. The version number is incremented 
only when a user explicitly updates it. 
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Property Description 
CodeListType Type of codelist; integer, float, or text. 

 
 

Codelist item properties 
Properties common to all study objects 

All study objects have the following properties. 
 

Property Description 
Description Description of the study object. The description can have 0-255 

characters. 

Identifier Unique internal identifier of the study object. 

Locked When True, the study object is locked. 

Modified When True, the study object has not been saved since the last 
modification. 

New When True, the study object has not been saved yet. When False, the 
study object has been saved at least one time.  

Protected When true, the study object is protected. When a study object is 
protected, you cannot : 

• Update or lock it. 

• Add child study objects to it by pasting or dragging and dropping. 

• Delete its child study objects. 

RefName RefName of the study object. The RefName can have 1-63 characters. 

Revision Revision number of the study object. 

Title Title of the study object. The title can have 1-63 characters. 

Version Version number of the study object. The version number is incremented 
only when a user explicitly updates it. 
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Property Description 
InForm properties  

Study Completion 
Status Items 

Codelist items in the codelist for the Completion Status item on the Study 
Completion form, which is used in reporting in the InForm application to 
determine whether a subject dropped out of a study. Options include:  

• None—(default) The codelist item is not part of the codelist for the 
Completion Status item.  

• Complete Study (Study Completion)—Indicates that the subject has 
completed the study.  

• Incomplete Study (Study Completion)—Indicates that the subject 
has not completed the study. 

Standard properties  

Code Code of the codelist item. 

CodeListType Type of codelist; integer, float, or text. The value of this property is 
populated with the value for the CodeListType property of the codelist 
parent of the codelist item. 

READ-ONLY 

Label Label of the codelist item. 
 

 

Data mapping properties 
 

Property Description 
Standard 
properties 

 

Description Description of the study object. The description can have 0-255 characters. 

Identifier Unique internal identifier of the study object. 

Locked When True, the study object is locked. 

Modified When True, the study object has not been saved since the last modification. 

New When True, the study object has not been saved yet. When False, the study 
object has been saved at least one time.  

RefName RefName of the study object. The RefName can have 1-63 characters. 

Revision Version or revision number of the study object. 

Title Title of the study object. The title can have 1-63 characters. 
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Data series standard properties 
 

Property Description 
Standard 
properties 

 

Alias Alias for the data series. 

Classification Type of the data series:  

• Integer 

• Float 

• Boolean 

• Text 

• DateTime 

Description Description of the study object. The description can have 0-255 characters. 

Identifier Unique internal identifier of the study object. 

Locked When True, the study object is locked. 

Modified When True, the study object has not been saved since the last modification. 

New When True, the study object has not been saved yet. When False, the study 
object has been saved at least one time.  

RefName RefName of the study object. The RefName can have 1-63 characters. 

Revision Version or revision number of the study object. 

Title Title of the study object. The title can have 1-63 characters. 
 

 

Data set properties 
 

Property Description 
Standard 
properties 

 

Description Description of the study object. The description can have 0-255 characters. 

Identifier Unique internal identifier of the study object. 

Locked When True, the study object is locked. 

Modified When True, the study object has not been saved since the last modification. 

New When True, the study object has not been saved yet. When False, the study 
object has been saved at least one time.  

RefName RefName of the study object. The RefName can have 1-63 characters. 

Revision Version or revision number of the study object. 
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Property Description 

Title Title of the study object. The title can have 1-63 characters. 
 

 

Form and section properties 
Properties common to all study objects 

All study objects have the following properties. 
 

Property Description 

Description Description of the study object. The description can have 0-255 
characters. 

Identifier Unique internal identifier of the study object. 

Locked When True, the study object is locked. 

Modified When True, the study object has not been saved since the last 
modification. 

New When True, the study object has not been saved yet. When False, the 
study object has been saved at least one time.  

Protected When true, the study object is protected. When a study object is 
protected, you cannot : 

• Update or lock it. 

• Add child study objects to it by pasting or dragging and dropping. 

• Delete its child study objects. 

RefName RefName of the study object. The RefName can have 1-63 characters. 

Revision Revision number of the study object. 

Title Title of the study object. The title can have 1-63 characters. 

Version Version number of the study object. The version number is incremented 
only when a user explicitly updates it. 

 

 

Property Description 

CIS properties  

Page Key Value Value of the Clintrial page key, used for transferring data to the Clintrial 
application through CIS mappings. If you specify the Page Key Value, it 
overrides the form RefName as the page key. 

InForm properties  

Item Required True (default) or False, indicating whether the item is required. 

SDV Required True (default) or False, indicating whether the item requires source 
document verification. 
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Property Description 

SDV Critical True or False (default), indicating whether the item is considered critical 
for source verification. If you select True, SDV Required changes to True. 

Special Forms Type of special InForm field, or None, indicating that the item is not a 
special InForm field. Available special fields, along with the forms in which 
they appear, are: 

• Initials (Screening). 

• DOB (Screening). 

• Screening date (Screening). 

• Patient No. (Enrollment). 

• Initials (Patient Identification. 

• Completion status (Study Completion). 

• Drop-out reason (Study Completion). 

• DOV (Date of Visit). 

• Randomization field (Randomization). 

For more information, see About special InForm forms (on page 84). 

Standard properties  

AssociatedForm Indicates whether the form is an associated form. 

• None—Form is not an associated form. 

• [Form name]—Name of the form with which the form is associated.  

Common When True, the form is a common form. 

Fixed For sections only. When True (used for repeating sections), the section 
contains items that are deployed as a Repeating Data itemset. 

Repeating When True, the study object is repeating. 

Short Title Short title of the form, used as a mnemonic when deployed. 
 

 

Item properties 
Properties common to all study objects 

All study objects have the following properties. 
 

Property Description 
Description Description of the study object. The description can have 0-255 

characters. 

Identifier Unique internal identifier of the study object. 

Locked When True, the study object is locked. 
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Property Description 

Modified When True, the study object has not been saved since the last 
modification. 

New When True, the study object has not been saved yet. When False, the 
study object has been saved at least one time.  

Protected When true, the study object is protected. When a study object is 
protected, you cannot : 

• Update or lock it. 

• Add child study objects to it by pasting or dragging and dropping. 

• Delete its child study objects. 

RefName RefName of the study object. The RefName can have 1-63 characters. 

Revision Revision number of the study object. 

Title Title of the study object. The title can have 1-63 characters. 

Version Version number of the study object. The version number is incremented 
only when a user explicitly updates it. 

 

 

Property Description 
CDD properties  

Data Label Text label for the item, enabling access to the item in a target table with 
the Patient To Control key type or any of the pivot key types. 

Component Settings (The following settings are used only for date time items.) 

DayAllow, 
HourAllow, 
MinuteAllow, 
MonthAllow, 
SecondAllow, 
YearAllow 

When True, indicates that the date time item includes a control for the 
component of the date time. 

DayAllowUnknown, 
HourAllowUnknown, 
MinuteAllowUnknown, 
MonthAllowUnknown, 
SecondAllowUnknown, 
YearAllowUnknown 

When True, indicates that the date time item includes a control for the 
component of the date time and allows a user to mark the value 
unknown. 

DayRequired, 
HourRequired, 
MinuteRequired, 
MonthRequired, 
SecondRequired, 
YearRequired 

When true, indicates that the component of the date time item is 
required. 

InForm properties  
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Property Description 
Collapsible True or False (default), indicating whether the item is always visible on 

the form in the InForm application, or is collapsed and not visible until a 
condition is met. 

Display Override  Determines the default behavior of an item when a layout is generated. 

• ReadOnly—The item is visible but not editable. 

• Editable—The item is visible and editable by any user, regardless of 
the rights assigned to the user. 

• Hidden—The item is not visible. 

• None—The item is visible to all users, and visible and editable by 
any user who has the rights to view and/or edit the item. 

Item Required True (default) or False, indicating whether the item is required for data 
entry on the form to be complete.  

MaxProperty If a MaxValue is specified for the item, indicates whether the value can be 
less than or less than or equal to the MaxValue. 

MaxValue Maximum value that the InForm application will allow to be typed for the 
item.  

MinProperty If a MinValue is specified for the item, indicates whether the value can be 
greater than or greater than or equal to the MinValue. 

MinValue Minimum value that the InForm application will allow to be typed for the 
item. 

PHI True or False (default), indicating whether an InForm user might enter 
Personal/Protected Health Information (PHI) for the item. If you select 
True: 

• A warning appears when you close the Rule Wizard if you create a 
rule with an email action and you add the item to the subject or body 
of the email. 

• A validation error occurs if a rule with an email action contains the 
item in the subject line or body of the email.  

SDV Critical True or False (default), indicating whether the item is considered critical 
for source verification. If you select True, SDV Required changes to 
True. 

Note: The SDV Critical setting for an item can be overridden in the 
InForm application. 

SDV Required True (default) or False, indicating whether the item requires source 
document verification. 
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Property Description 

Special Fields Fields used on the special forms for the InForm application. 

• None—Field is not a special InForm field. 

• Screening form: 

 Initials 

 DOB 

 Screening date 

• Enrollment form: Patient No.  

• Patient Identification form: Initials 

• Study Completion form: 

 Completion status 

 Drop out reason 

• Date of Visit form: DOV 

• Randomization form: Randomization field 

Standard properties  

Question Question for the item. The question can have 0-1000 characters. 

ShortQuestion Short question for the item. The short question can have 0-255 
characters. 

 
 

Study and library standard properties 
 

Property Description 
Enabled For libraries only. Indicates whether the library is enabled or disabled. 

Description Description of the study object. The description can have 0-255 characters. 

Identifier Unique internal identifier of the study object. 

Locked When True, the study object is locked. 

Modified When True, the study object has not been saved since the last modification. 

New When True, the study object has not been saved yet. When False, the study 
object has been saved at least one time.  

Protected True or False, indicating whether the study or library is protected. 

Title Title of the study object. The title can have 1-63 characters. 

Version Study or library version. 
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Study design properties 
Properties common to all study objects 

All study objects have the following properties. 
 

Property Description 
Description Description of the study object. The description can have 0-255 

characters. 

Identifier Unique internal identifier of the study object. 

Locked When True, the study object is locked. 

Modified When True, the study object has not been saved since the last 
modification. 

New When True, the study object has not been saved yet. When False, the 
study object has been saved at least one time.  

Protected When true, the study object is protected. When a study object is 
protected, you cannot : 

• Update or lock it. 

• Add child study objects to it by pasting or dragging and dropping. 

• Delete its child study objects. 

RefName RefName of the study object. The RefName can have 1-63 characters. 

Revision Revision number of the study object. 

Title Title of the study object. The title can have 1-63 characters. 

Version Version number of the study object. The version number is incremented 
only when a user explicitly updates it. 

 

 

Property Description 
InForm 
properties 

 

Shared Form 
Block Key 

Block key to use for a shared form; used for data transfers to the Clintrial 
application through CIS mappings. You must use this property if the block key 
in the Clintrial application is defined as a numeric field. The block key that you 
specify overrides the internal text block key (CommonCRF) that the Central 
Designer application creates during deployment from the system RefName of 
the special visit for shared forms. 

Standard 
properties 

 

Generic Drug 
Name 

Generic name for a drug. 

Protocol Name of the study protocol. 
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Property Description 

Sponsor Name of the sponsor of the study. 

Sponsor Date Date specified by the sponsor of the study. 

Sponsor Drug 
Name 

Code name given to a drug by a sponsor. 

Study Name Name of the study. 

Trade Drug Name Commercial name of a drug. 
 

 

Study element properties 
All study objects have the following properties. 

 

Property Description 
Description Description of the study object. The description can have 0-255 

characters. 

Identifier Unique internal identifier of the study object. 

Locked When True, the study object is locked. 

Modified When True, the study object has not been saved since the last 
modification. 

New When True, the study object has not been saved yet. When False, the 
study object has been saved at least one time.  

Protected When true, the study object is protected. When a study object is 
protected, you cannot : 

• Update or lock it. 

• Add child study objects to it by pasting or dragging and dropping. 

• Delete its child study objects. 

RefName RefName of the study object. The RefName can have 1-63 characters. 

Revision Revision number of the study object. 

Title Title of the study object. The title can have 1-63 characters. 

Version Version number of the study object. The version number is incremented 
only when a user explicitly updates it. 
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Study event properties 
Properties common to all study objects 

All study objects have the following properties. 
 

Property Description 
Description Description of the study object. The description can have 0-255 

characters. 

Identifier Unique internal identifier of the study object. 

Locked When True, the study object is locked. 

Modified When True, the study object has not been saved since the last 
modification. 

New When True, the study object has not been saved yet. When False, the 
study object has been saved at least one time.  

Protected When true, the study object is protected. When a study object is 
protected, you cannot : 

• Update or lock it. 

• Add child study objects to it by pasting or dragging and dropping. 

• Delete its child study objects. 

RefName RefName of the study object. The RefName can have 1-63 characters. 

Revision Revision number of the study object. 

Title Title of the study object. The title can have 1-63 characters. 

Version Version number of the study object. The version number is incremented 
only when a user explicitly updates it. 

 

 

Property Description 
CIS  

Block Key Value Value of the Clintrial block key, used for data transfer to the Clintrial 
application through CIS mappings. If you specify this value, it overrides the 
visit RefName as the block key.  

InForm  

Optional True or False (default), indicating whether the formset (visit) is optional or 
required. 

Special Visits When a special visit type is selected, the study event is deployed as a special 
InForm visit.  

Standard properties  

Repeating When True, the study object is repeating. 
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Property Description 

Short Title Short title of the study event. The short title deploys to the InForm 
application as the visit mnemonic. The short title can have 1-63 characters. 

 
 

Study project and library project properties 
 

Property Description 

Standard 
properties 

 

Description Description of the study object. The description can have 0-255 characters. 

Locked When True, the study object is locked. 

Modified When True, the study object has not been saved since the most recent 
modification. 

Name Name of the study object. 

New When True, the study object has not been saved yet. When False, the study 
object has been saved at least one time.  

Title Title of the study object. The title can have 1-63 characters. 
 

 

Properties in the Rule Test Cases dialog box 
The following properties appear in the Test Properties tab, which you can select in the Design tab of 
the Rule Test Cases dialog box. 

When you point to a component of a test case, its properties appear.  
 

Property Description 
Properties for test names  

Ignore test When False, the test case is run. When True, the test case is 
not run. 

Rule name Name of the rule or global condition. 

Rule type Type of rule (data-entry rule, global condition, or workflow 
rule). 

Properties for item names—
Item Settings grouping 

 Notes:  

If the item is repeating, the grouping is called Repeating Item 
Settings.  

Not all properties are available for all types of items. 
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Property Description 
Codelist choices Indicates the type of the codelist. Expand the property to view 

the code and label for each codelist item in the right column.  

Note: The numbers in the left column are for ordering 
purposes only and do not necessarily correspond to the codes 
for the codelist items. 

Codelist type The type of codelist on the item, such as float or integer.  

Float length Length of the float item. 

Float precision Precision of the float item. 

Item object path Path of the item in the context of the rule scope. 

Object RefName RefName of the item.  

Object Title Title of the item.  

Repeating objects List of repeating study objects that are in the item's path, 
including the type of study object (such as form or section). 

Properties for item names—Test 
Settings grouping 

 

Ignore test When False, the test case is run. When True, the test case is 
not run. 

Properties for expected results—
Repeating Objects grouping 

 

Repeating Form Index 

Repeating Section Index 

Repeating Event Index 

Properties appear in this section when an item path contains a 
repeating study object. For example, if the only repeating 
study object in the item path is a section, only Repeating 
Section Index appears. 

The number of the repeating instance that you are testing. 

Properties for expected results—
Test Settings grouping 

 

Ignore test When False, the test case is run. When True, the test case is 
not run. 

Default: False. 

Item object path Path of the item in the context of the rule scope. 

Rule action type • Data-entry rules—Value, Query, or Email. 

• Global conditions—Condition. 

• Workflow rules—NextStep. 

Rule name Name of the rule or global condition. 

Rule type Type of rule (data-entry rule, global condition, or workflow 
rule). 
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A 
annotated study book 

A form-by-form summary of the design of a study. 
Optionally, it includes a time and events schedule, a 
preview of each form, and selected annotations that 
list design details. 

See also study book (on page 496). 
 

application role 

A role associated with administrative activities. 
 

arm 

See study arm (on page 496). 
 

authentication 

The method of ensuring that you are using the 
correct user name and password to log on. 
 

authorization 

The method of giving users access to information or 
functionality. Access is controlled using rights, roles, 
and teams. 
 

automated deployment 

The process through which a deployment package is 
sent directly from the Central Designer application 
to the InForm application and installed without 
additional action required. 
 

B 
baseline 

A snapshot of all components in a study. Validation 
creates a baseline. 
 

Baselines Browser 

A browser in which you view the results of 
validation and make temporary baselines public so 

that other users can work with them. 
 

branch 

See study branch (on page 496). 
 

C 
calculation rule 

A rule that sets the value of an item based on a 
calculation. 
 

catalog 

A collection of categories and keywords that can be 
attached to users and study objects to facilitate 
searching in the Libraries Browser and Users 
Browser. 
 

catalog administration 

The process of creating keywords and categories and 
assigning them to users and study objects for faster 
and more sophisticated searching. 
 

category 

A hierarchical grouping of keywords. You can create 
categories only from existing keywords. 
 

CDISC 

Clinical Data Interchange Standards Consortium. 
CDISC is an open, multidisciplinary, non-profit 
organization committed to the development of 
industry standards to support the electronic 
acquisition, exchange, submission and archiving of 
clinical trials data and metadata for medical and 
biopharmaceutical product development.   
 

checkbox 

A type of data entry control in which you can select 
one or more options by selecting the box that 
represents each option. 
 

Glossary 
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clinical project 

See study project (on page 496). 
 

clinical protocol 

See protocol (on page 494). 
 

clinical study 

See study (on page 495). 
 

codelist 

A collection of code-label pairs that gather together 
the entry choices for an item. A code-label pair 
consists of a single code (the value that is used for 
analysis) and a label (the value that is visible to 
users). 

See also codelist item (on page 490). 
 

codelist item 

A code-label pair consisting of a single code (the 
value that is used for analysis) and a label (the value 
that is visible to users). Multiple codelist items make 
up a codelist. 

See also codelist (on page 490). 
 

coding 

The process of selecting terms and codes from a 
dictionary for a verbatim. 
 

coding dictionary 

A standardized collection of terms and the codes 
that correspond to those terms. 
 

coding map 

A study object that contains the necessary 
information to code an item. 
 

coding target 

See target item (on page 497). 
 

collaboration 

The process by which users with different roles and 
specialties can work together to create, validate, and 
deploy a study. 
 

collaboration note 

A note that you attach to any study object. 
 

collaboration note type 

A classification used to identify the type and purpose 
of a collaboration note. 
 

Collaboration Notes Browser 

A browser in which you work with collaboration 
notes. 
 

common form 

A form that is designed for use with multiple study 
events. The same data appears in the form in all 
study events in which the form is used. 
 

component 

Any design building block that is configured in a 
study or library. Design components include study 
objects (such as a project, study, study element, 
study event, form, or item) as well as rules, 
individual items selected from drop-down lists, and 
controls (such as checkboxes and radio buttons). 
 

compound item 

An item that has one or more child items that can 
have different data types. 
 

constant 

A value that is defined in a library or study and that 
can be referenced by any rule. 
 

constraint rule 

A rule that checks whether data is valid. Constraint 
rules are used to confirm that clinical data meets the 
requirements of the clinical protocol. 
 

container 

A node in the Project Explorer that contains zero or 
more study objects or components. 
 

context item 

An item that provides additional coding information, 
such as the indication and route of administration 
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for drugs, that can be displayed with an item coded 
using the WHO-DD dictionary. 
 

CSML 

Clinical Study Markup Language. CSML is an XML-
based markup language developed by Oracle for 
representing and exchanging clinical data definitions 
created in the Central Designer application. 

See also MedML (on page 494). 
 

custom data dimension 

See data dimension (on page 491). 
 

custom property 

A user-defined or default characteristic of a study 
object. 
 

D 
data dimension 

A key item for a data set. A data dimension specifies 
the additional information that will be saved when 
study data is collected. You can specify standard data 
dimensions (Study, Subject, Event and Event Index, 
Form and Form Index, and Item) and custom data 
dimensions. 
 

data series 

A grouping of one or more items with the same 
clinical meaning, such as one or more items that 
measure weight. 

See also data set (on page 491), mapping (on page 
493). 
 

data set 

A grouping of one or more related data series. 

See also data series (on page 491), mapping (on 
page 493). 
 

data type 

An attribute for items and data series. For an item, 
the data type determines the type of entry an item 
will accept. For a data series, the data type 
determines which items can be added to it. Data 
types include date time, integer, float, and text. 
 

data-entry rule 

A rule that checks whether data is valid or that sets 
the value of an item based on a calculation. 

See also workflow rule (on page 498). 
 

date time item 

An item used to collect date and time information 
on a form. 
 

deployment 

The process of sending a study to a target 
application. To collect data, a study must be 
deployed into a target application as a complete 
deployment package. 
 

deployment approval 

The optional process by which a study deployment 
is approved by a user with the appropriate rights. 
 

deployment instance 

The server to which you deploy a study. 
 

deployment request 

A request from a user with the appropriate rights to 
initiate an automated deployment to the InForm 
application. 
 

dictionary metadata item 

An identifier that describes administrative data about 
a dictionary and that you can use to create a coding 
map. 
 

dictionary type 

A name or identifier for the metadata for a 
dictionary. 
 

drop-down list 

A data entry format in which you select an option 
from a list. 
 

dynamic form 

A form that is automatically generated in the 
InForm application when subject data satisfies 
certain criteria tested in another form. 
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dynamic visit 

A visit that is automatically generated in the InForm 
application when patient data satisfies certain criteria 
tested in another visit. 
 

E 
edit check 

A data-entry rule that checks whether entered data is 
valid. 

See data-entry rule (on page 491). 
 

element 

See study element (on page 496). 
 

event 

See study event (on page 496). 
 

explicit lock 

A lock that you request and that does not expire. 

See also implicit lock (on page 492). 
 

expression 

The part of a rule that specifies what to evaluate. 
 

F 
field 

The area in a data-entry window where the value for 
an item is entered or displayed. 
 

float item 

An item used to collect numerical values with 
decimal points. 
 

form 

A container for one or more items. A form can 
contain one or more sections and supports multiple 
locales and layouts. A form is deployed to a target 
application as a data-entry form used to collect 
subject information and other clinical data. 
 

full installation deployment package 

A deployment package that contains everything 

needed to deploy a complete study. 
 

function 

A reusable piece of code that extends the behavior 
of a rule. A function can be predefined or user-
defined. 
 

G 
global condition 

A logical construct that, when applied to a study 
object, determines whether the study object will 
appear for a particular subject. A global condition 
does not affect other study objects in the workflow. 

See also workflow rule (on page 498). 
 

globals 

Study objects and properties that are related to 
mappings. 
 

grouping 

A default or user-provided value used to organize 
custom properties of a study object. 
 

I 
implicit lock 

A type of lock used when you edit a study object. An 
implicit lock is automatically applied when you select 
or open a study object and is automatically released 
when you close or save a study object. 

See also explicit lock (on page 492). 
 

incremental deployment package 

A deployment package that contains a complete 
study based on a previously created deployment 
package, plus any additions or changes. 
 

in-place revision (IPR) 

A study design change that is applied to existing 
study versions previously deployed to the InForm 
application. 
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integer item 

An item used to collect a numerical value without a 
decimal point. 
 

internationalization 

The process of configuring a study for translation 
into different languages or for different regional 
requirements. 
 

intrinsic rule 

A constraint rule or calculation rule based on a 
predefined rule template. 
 

item 

A study object used as a container for the collection 
of clinical data. 
 

item group 

A study object used to combine items so that you 
can set their display override options in the InForm 
application. 
 

J 
Job Log Browser 

A browser in which you view the results of 
asynchronous jobs, such as validation or import. 
 

K 
keyword 

An identifier that is associated with users and study 
objects to facilitate more powerful and efficient 
searches. 
 

L 
Libraries Browser 

A browser in which you search the repository for 
study objects and then add them to studies or 
libraries. 
 

library 

A container used to store related study objects and 
templates to be published for reuse in studies or 
other libraries. A library provides a view of the study 
objects in the repository. 

See also repository (on page 495). 
 

Library List 

A hierarchical list of libraries from which resources 
can be used. The hierarchy determines the order in 
which libraries are searched. The Library List is 
defined for each study in the Study Editor.  
 

library project 

A project containing a library. 
 

library role 

A role associated with library activities. 
 

library team 

A group of users who have rights granted by a 
certain role to perform tasks in a particular library. 
 

locale 

A supported language or language variation. 
 

localization 

The process of designing a study for a specific 
locale. 
 

locked 

A state in which only the user who created the lock 
can modify a study object. Locks can be implicit or 
explicit. 

See also implicit lock (on page 492), explicit lock 
(on page 492). 
 

M 
mapping 

A data grouping that provides an alternate data view 
of a study. Mappings were previously called logical 
schemas. 

See also data series (on page 491), data set (on 
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page 491). 
 

MedML 

An XML-based markup language developed by 
Oracle for representing and exchanging clinical data 
definitions created in the InForm application.. 

See also CSML (on page 491). 
 

method 

A block of code that is called by a rule and that is 
used to manipulate data. 
 

N 
normalization 

The process of converting data to a required format. 
 

O 
object 

See study object (on page 496). 
 

ODM 

Operational Data Model. ODM is an XML-based 
standard developed by the Clinical Data Interchange 
Standards Consortium (CDISC) for representing 
and exchanging clinical data. 
 

P 
precondition 

The part of a rule that specifies when to evaluate the 
rule expression. 
 

project 

See library project (on page 493) and study project 
(on page 496). 
 

Project Explorer 

A browser that displays a view of the open project 
and the study objects it contains. 
 

Properties Browser 

A browser in which you can view and modify the 
properties of the study object selected in the Project 
Explorer. 
 

property 

A defining characteristic of a study object. 
 

protocol 

A detailed plan that describes how investigators 
conduct a study. The clinical protocol sets the 
guidelines for the study, describes the conditions of 
the study, and contains a set of forms on which 
clinical data is collected. 
 

publish 

The action that makes a study object created in a 
library available to other users. 

See also unpublish (on page 497). 
 

Q 
query 

A text string that appears on a CRF item in the 
InForm application when a rule on that item fails. 
When designing a rule in the Central Designer 
application, you can specify the query text and the 
circumstances under which a rule results in a query. 
 

query group 

A study object used to specify the users who can act 
on queries created by other members of the group in 
the InForm application. 
 

R 
radio button 

A type of data entry format in which you must select 
a single item from a list of choices. 
 

reference 

A text note, a link to a Web page or file (URL), a 
document, or a combination of all three, that is 
attached to a study project for users to consult 
during the development of a study. 
 

RefName 

A unique identifier for a study object. 
 

repeating form 

A type of form for which the Repeating property is 
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set to true. You use a repeating form to collect 
multiple instances of the same data at different dates 
and times. 
 

repository 

A single database instance that contains all Central 
Designer study objects, components, and users.  
 

revision 

An audit history record that is created automatically 
when a user edits a study object and saves the 
changes. 
 

right 

A predefined permission that controls access to a 
specific feature or activity in the Central Designer 
client or Central Designer Administrator client and 
that can be assigned to one or more roles. 

See also role (on page 495). 
 

rights group 

A study object used to create a set of predefined 
InForm rights in the InForm application. 
 

role 

A collection of rights. When a user is assigned to a 
role, the rights associated with the role are granted 
to the user. 

See also library role (on page 493), study role (on 
page 496), and user role (on page 497). 
 

role administration 

The process of managing tasks that users perform in 
the Central Designer and Central Designer 
Administrator applications, assigning rights to roles, 
and assigning roles to users. 
 

rule 

See data-entry rule (on page 491), workflow rule 
(on page 498). 
 

rule action 

The action, or actions, that takes place as a result of 
the evaluation of a rule expression. 
 

rule scope 

The set of study objects that a rule can reference. 
The scope of a rule is determined by the study 
object on which the rule is defined. 
 

rule template 

A function that is defined on a study object, study 
object template, or study object type and can be 
used as the expression clause of a rule. 
 

rule type 

See calculation rule (on page 489), constraint rule 
(on page 490), and intrinsic rule (on page 493). 
 

S 
SDTM 

Study Data Tabulation Model. SDTM is a CDISC 
model used to standardize data structures in data 
extracts. 
 

shared form 

See common form (on page 490). 
 

signature group 

A study object used to specify the forms that require 
signature and the signature type in the InForm 
application. 
 

site 

A location that participates in a study. 
 

sponsor 

A study object used to define the sponsor properties 
of a study, such as name or address, in the InForm 
application. 
 

standard data dimension 

See data dimension (on page 491). 
 

standard task type 

A task type that is typically used for all non-
translation tasks assigned to an individual or team. 
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study 

The definition of the workflow, data-entry, and data-
management system for a clinical study. 
 

study administration object 

A collection of study objects that are used to capture 
study administration data for deployment to the 
InForm application. 

See also item group (on page 493), query group 
(on page 494), rights group (on page 495), 
signature group (on page 495), sponsor (on page 
495), study configuration (on page 496). 
 

study arm 

The CDISC term for a study branch consisting of a 
planned sequence of study elements. A study arm is 
typically equivalent to a treatment group. 
 

study book 

The set of forms used to collect clinical data. 

See also annotated study book (on page 489). 
 

study branch 

A path for which data is collected for certain 
subjects. A study can contain multiple branches as 
different conditions are assessed, and a branch is 
followed depending on the subject and other 
circumstances. 
 

study configuration 

A study object used to specify the value of an 
InForm configuration variable in the InForm 
application. 
 

study design 

A container for the structure of a study. 
 

study element 

The CDISC term for a basic building block of a 
study. A study element represents a segment of a 
study and can consist of one or more study events. 
Study elements are optional. 
 

study event 

A subject evaluation checkpoint when data is 
collected. Study events usually correspond to visits, 
but one visit can span multiple study events. 
 

study object 

A study building block that appears in the Project 
Explorer. Study objects include study projects, 
library projects, studies, libraries, study elements, 
study events, forms, sections, items, codelists, 
codelist items, deployment instances, in-place 
revisions, and study administration objects. 

See also component (on page 490) and study 
administration object (on page 496). 
 

study object editor 

An editor for each study object, such as a project, 
study, study element, study event, form, or item. A 
study object editor appears in the workspace when 
you select a study object. 
 

study project 

A project containing one or more studies that are 
related to each other. 
 

study role 

A role associated with study activities. 
 

study team 

A group of users who perform tasks granted by a 
certain role for a particular study. 
 

study workflow 

See workflow (on page 498). 
 

subject 

An individual who participates in a clinical study. 
 

system 

An application to which you deploy a study from the 
Central Designer application. 
 

system configuration administration 

The process of creating, configuring, and managing 
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internationalization, collaboration, and 
customization information using the Central 
Designer Administrator application. 
 

T 
target item 

An item that holds a term, code, or additional 
information after a verbatim is coded. 
 

task 

A request that you attach to a study object and 
assign to an individual or a study team. 
 

task classification 

The classification of a task. You can choose either 
standard (used for all non-translation tasks assigned 
to an individual or team) or translation (used for 
tasks that request translation of a study object into 
one or more languages). You define the classification 
for task types in the Central Designer Administrator 
application. 
 

task type 

A classification used to identify the type of the task 
and the way the task is used. 
 

Tasks Browser 

A browser in which you work with tasks. 
 

team 

See study team (on page 496), library team (on 
page 493). 
 

template 

A study object that is either partially or fully defined 
and that can be used to create other study objects. 
You can create templates for study projects, studies, 
study elements, study events, forms, items, codelists, 
and mappings. 
 

text box 

A data-entry format in which you type data. 
 

text item 

An item used to collect alphanumeric information. 
 

translation task type 

A task type that is used for tasks that request 
translation of a study object into one or more 
languages. 
 

type 

A study object that is either partially or fully defined 
and can be used to create other study objects. Types 
are like templates except that types appear as options 
in the Actions menu and in the Project Explorer 
menu when you create a new study object. 
 

U 
unpublish 

The action that makes a study object in a library no 
longer available to other users. 

See also publish (on page 494). 
 

user 

A person who works in the Central Designer or 
Central Designer Administrator application. 
 

user administration 

The process of managing users. 
 

user role 

A role associated with user activities. 
 

Users Browser 

A browser in which you search the repository for 
users and then add them to study teams or library 
teams. 
 

V 
validation 

The process of checking the status of a study to 
indicate if the study is ready for deployment. The 
study validation process determines whether all 
essential components exist and are consistent. 
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verbatim 

The original reported text that describes the adverse 
event, disease, drug, or other item to be coded in the 
Central Coding application. 
 

verbatim type 

A classification of a verbatim as defined in a coding 
dictionary. 
 

version 

An explicitly requested audit history record for a 
study object. 
 

visit 

See study event (on page 496). 
 

W 
workflow 

The progression of work for a study, as determined 
by the study designers. 
 

workflow rule 

A logical construct that tests data values to 
determine the study element, study event, or form to 
which a subject progresses next. A workflow rule 
prevents study objects in the workflow from 
appearing until the rule is evaluated. 

See also data-entry rule (on page 491), g lobal 
condition (on page 492). 
 

workspace 

The work area of the Central Designer and Central 
Designer Administrator applications. The contents 
of the workspace depend on the type of activity you 
are performing and the rights that you have been 
granted. The workspace displays the editor for the 
study object that is selected in the Project Explorer. 
 

Y 
yes no item 

An item used to collect yes or no answers to 
questions. A yes no item contains a predefined 
codelist with Yes and No options. 
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A 
annotated study book in Central Designer 

about • 332 
Annotated Study Book Options dialog box • 356 
generating • 338, 339, 340 
locales, layouts, and • 332, 340 
printing • 339, 340 
RDE Analytics table • 333, 334 
Schedule of Events table • 337, 341 

Annotated Study Book Options dialog box • 356 
archive 

about • 312 
archiving a study or project • 317 
deleting an archived study or project • 319 
downloading and importing an archived study or 

project • 313, 318 
importing an archived study or project • 313, 315, 318 
information that is archived • 313 
viewing archived studies and projects • 317 
viewing associated errors • 319 

Assign Conditions dialog box • 406 
associated forms, mapping to a CDD • 210 

B 
baseline 

creating • 260 
deleting • 263 
editing • 263 
making public • 264 

Baselines Browser • 447 
block key, Clintrial • 215, 216, 217 
browser 

Baselines Browser • 447 
Job Log Browser • 467 

C 
calculation rule 

about • 132 
creating with a function • 159 
creating without a function • 154 
when to use intrinsic rules, expression rules, and 

functions • 134 
caption 

aligning • 243 
editing • 243 
removing • 243 

CDD mappings 
associated form mappings • 210 
date time mappings • 212, 213 
deployment • 209 

example • 209 
pivot tables • 212 
properties • 470 
target keys • 210, 211, 212 

CIS mappings 
block keys and page keys • 215, 216, 217 
Clintrial subsets • 214, 215 
Context panel • 218, 219, 220 
date time mappings • 221, 222, 223 
deployment • 214 
Enrollment panel • 219 
mapping properties • 472 
Type 0 panel • 219 
unmapped items • 223 

Clintrial application 
block keys and page keys • 215, 216, 217 
CIS mapping properties • 472 
Clintrial subsets • 214, 215 
data mappings • 214, 215, 217, 221, 223, 472 

Clintrial panels 
Context panel • 218, 219, 220 
Enrollment panel • 219 
Type 0 panel • 219 

codelist in Central Designer 
about • 109 
creating and editing • 122 
properties • 475 

codelist item 
about • 109 
creating and editing • 123 
editing a codelist item override • 245 
formatting • 246 
properties • 476 
translating a codelist item label override • 245 
translating a label • 253 

coding concepts 
coding maps • 39 
dictionary types • 40 
terms and definitions • 38 
verbatim types • 41 
verbatims, context items, and target items • 42 

coding map 
creating, modifying, and deleting • 35 

coding setup and administration 
about • 38 
administering • 35 
dictionary type • 37 
verbatim type • 37 

common visit, entering and translating the title and short 
title • 251 

constraint rule 
about • 130 

Index 
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creating with a function • 159 
creating without a function • 154 
when to use intrinsic rules, expression rules, and 

functions • 134 
context item (CIS mappings) • 218, 219, 220 
control style • 227, 394 
conversion of a layout 

converting layouts • 231 
copying 

about copying and moving data-entry rules • 137 
about copying study objects grouped by mappings • 

191 
custom data dimension 

about • 197 
deleting • 206 
modifying the label of a mapped custom data 

dimension • 206 
Custom Dimension Labels - Select Codelist dialog box • 

386 

D 
data dimension 

about • 195, 196, 197, 208 
deleting • 206 
modifying the label of a mapped custom data 

dimension • 206 
Data Entry Rule Actions report • 322 
data mappings 

CDD • 192, 193, 210, 212, 470 
CIS • 214, 215, 217, 221, 223, 472 
for rules • 204, 205 

Data Mappings tab 
data series mapping options • 207 
data set methods • 208 
mappings and • 206, 207, 208 
study objects • 208 

Data Series Editor 
field descriptions • 386 
opening an item from • 203 

data series in Central Designer 
about • 186, 188, 198, 199 
Globals tab • 207 
mappings • 206, 207 
properties • 478 
working with • 198, 199, 201, 202, 203 

Data Series Properties dialog box • 387 
Data Series Summary tab • 388 
Data Set Editor • 389 
data set in Central Designer 

about • 186, 195 
creating • 195 
standard data dimensions and data set methods • 197, 

208 
data set method 

standard data dimensions and data set methods • 208 
Data Set Properties dialog box • 390 
data-entry rule 

about • 126 
calculated fields • 136 
calculation rule • 132 

checking syntax • 177 
collaboration • 134 
constraint rules • 130 
creating • 149, 154, 159 
deactivating • 166 
disabling • 139, 167 
enabling • 167 
intrinsic • 128 
modifying • 165 
multiple actions • 137 
opening from the Rule Test Cases dialog box • 176 
repeating study objects • 137 
Rules tab • 135 
scope • 135 
translating query and email information • 165 
updating the state of a workflow rule • 169 
viewing all for a study object and its children • 166 
viewing errors • 177 
writing a test case • 179 

Date of Visit item • 93 
date time item 

CDD mappings for • 212, 213 
CIS mappings for • 221, 222, 223 
specifying the year range • 248 

Date-Time Data Point dialog box • 391 
decommissioning a study or project 

about • 316 
workflow • 312 

Define Test Values for Repeating Instances dialog box • 
407 

deletion 
deleting an archived study or project • 319 

Deployment Editor 
about • 290 
option descriptions • 457 

Deployment History dialog box • 460 
deployment in Central Designer 

about • 256, 257, 279, 280, 282, 298 
automated deployment • 291, 293, 294, 295, 296, 297 
command-line options • 301 
configuration file • 304, 306 
Create Deployment Package Wizard • 449, 453, 456 
data mappings and • 209, 214 
Deployment Wizard • 466 
installing a deployment package • 299, 300 
manual deployment • 297, 298, 299, 300, 301, 304, 

306 
study components in Central Designer and InForm • 

282 
deployment package 

about • 279 
creating • 289 
deleting • 290 
delivering • 298 
Deployment Package History dialog box • 462 
installing • 299, 300 
processing of • 280 
saving the job log for • 288 

Deployment Request dialog box • 465 
Deployment Setup tab • 436 
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Deployment Wizard • 466 
Design tab of the Codelist Editor • 365 
Design tab of the Form Editor • 366 
Design tab of the Item Editor • 369 
Design tab of the Section Editor • 366 

E 
Edit Global Conditions dialog box • 410 
Email Action dialog box • 414 
Enrollment form 

about • 86 
overriding failures in the InForm application • 136 

errors and warnings, validation • 261, 262 
export in Central Designer 

study administration data • 32 

F 
fixed repeating section 

about • 103, 105 
creating and editing • 106 
default view • 239 
rules for • 105 

float value • 10 
Form Editor 

Data Series Summary tab • 388 
Rule Templates tab • 420 
Rules tab • 135 

form in Central Designer 
about • 78 
associating two • 81 
creating a layout • 233 
creating and editing • 79, 80, 81 
creating and translating instructions and Help • 82 
editing the appearance using styles • 227 
editing the title • 243 
key items • 119, 121 
previewing • 235 
previewing an annotated form • 235 
resetting the state • 31 
special InForm forms • 81, 84, 86, 87, 89 
translating short title • 252 
translating title • 243 
viewing parents of • 83 

function 
creating a rule with • 159 
creating a rule without • 154 
when to use intrinsic rules, expression rules, and 

functions • 134 

G 
General tab of the Form Editor • 377 
General tab of the Section Editor • 377 
General tab of the Study Event Editor • 444 
global condition 

about • 141 
assigning and removing • 172 
checking syntax • 177 
creating • 171 
deciding between a global condition and a workflow 

rule • 144 
viewing and editing • 173 
writing a test case • 178 

group control • 247 
groups 

item groups • 22 
query groups • 24 
rights groups • 25 
signature groups • 28 

H 
hidden • 248 
Home Page 

Pending Approvals tab • 458 
HourUnknown 

InForm Refname report • 324 
HTML formatting tags • 240 

I 
import in Central Designer 

study administration data • 33 
InForm application 

special forms and items • 84 
study components in Central Designer and InForm • 

282 
inheritance • 227 
in-place revisions (IPRs) 

about • 344 
copying study objects • 354 
deleting study objects • 354 
deploying • 350 
making a change • 346 
managing • 351 
overview • 345 
validation • 277 
viewing the differences between form versions • 349 

instrinsic rule 
about • 128 
creating • 149 
when to use intrinsic rules, expression rules, and 

functions • 134 
invalidation • 31, 32 
Invoke Function dialog box • 416 
IPR Configuration dialog box • 402 
IPR History dialog box • 404 
IPR Summary Editor • 403 
item groups • 22, 23, 24, 27, 439 
Item has units dialog box • 391 
item in Central Designer 

about • 108 
adding child item to compound • 114 
conditional relationships • 108 
creating a layout for • 233 
creating and editing • 108, 110, 114, 116 
formatting items with units • 246 
groups • 22 
key item • 119, 120, 121 
marking as hidden • 248 
marking as read-only • 248 
reordering in a form or section • 115 
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special InForm items • 84, 93, 94 
specifying column heading text in a repeating form or 

section • 116 
translating question text • 253 

Item Properties dialog box • 381 

J 
Job Log Browser • 467 

K 
key item 

about • 119, 120, 121 
as unique key • 120 
creating • 121 
for navigation • 119 
requirements • 121 

key, target • 210, 211, 212 
Keys dialog box • 384 

L 
Languages tab of the Codelist Item Editor • 385 
layout in Central Designer 

about • 226 
about layout design • 233 
adding a layout name • 228 
annotated study books • 332 
converting • 231 
creating for a form or item • 233 
creating site-specific layouts • 234 
editing the appearance with styles • 227 
form previews • 235, 239, 240 
HTML formatting tags • 240 
redoing an action • 231 
removing • 229 
removing a layout name • 228 
renaming • 230 
resetting • 230 
setting the primary layout • 5 
translating • 254 
undoing an action • 231 
viewing locale-specific translations • 254 

Layout tab 
navigating • 234 

Libraries tab 
button descriptions • 433 
section descriptions • 433 

library in Central Designer 
choosing libraries for a study • 12 
properties • 483 
protecting • 308, 311 
setting the order in the Library List • 12 

Library List 
choosing libraries for • 12 
setting the order • 12 

library project 
archive • 312, 317 
decomissioning • 312 
delete • 11, 313, 314, 317 
delete an archive • 319 

download and import an archive • 318 
properties • 487 
saving • 11 

library team 
removing a user from • 16 

link to a study object 
viewing the parents of • 83, 102 

locale 
choosing the default locale for a study • 7, 8 
choosing the supported locales for a study or library • 

6 
developing a study across multiple locales • 8 
viewing locale-specific translations • 254 

locks 
about locking data-entry rules, workflow rules, and 

global conditions • 138 

M 
Mapping Editor • 392 
mapping options, data series • 207 
mappings in Central Designer 

CDD mappings • 470 
CIS mappings • 472 
concepts • 186, 188, 191, 192, 196, 204 
creating • 187 
data mappings and • 187, 188, 190, 192, 193 
examples • 192, 197 
for data extraction • 187, 188, 190, 192, 193 
Globals tab and • 206, 207, 208 
in rules • 194, 204, 205, 207 
validation and deployment of • 209, 214, 273 

monitoring form 
about • 97 
creating • 97, 98 
validation • 273 

N 
New Rule Template dialog box • 419 

P 
Patient Identification form • 87 
phase of a study, choosing • 3 
primary layout • 5 
properties in Central Designer 

codelist • 475 
codelist item • 476 
data series • 478 
data set • 478 
editing study properties • 4 
item • 480 
library • 483 
library project • 487 
mapping • 477 
Rule Test Cases dialog box • 487 
special InForm forms and items • 96 
study • 483 
study element • 485 
study project • 487 
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Q 
Query Action dialog box • 417 
query groups • 24, 25, 439 
question 

editing • 242 
editing the width of the question column • 245 
translating • 242 

R 
Randomization item • 94 
RDE Analytics table in the Annotated Study Book • 333, 

334 
read-only • 248 
reference • 17 

about • 17 
attaching to a study or library • 17 
removing from a study or library • 18 

References tab • 434 
regulatory document form 

about • 97 
creating • 97 
validation • 273 

repeating 
creating key items in a repeating form or section • 

119, 121 
repeating section, fixed 

about • 103, 105 
creating and editing • 106 
default view • 239 
rules for • 103, 105 

report 
about • 320, 321 
generating, saving, and printing • 321 
Library Objects Modified in Studies report • 329 
Library Objects Modified in the Library report • 327 
Library Objects Modified in the Study report • 326 
Number of Studies Containing Library Object report 

• 328 
Studies Containing Selected Library Object report • 

331 
review state 

about • 44 
creating, modifying, deleting • 44 

rights groups • 25, 26, 27, 439 
rights in Central Designer 

groups • 25 
rule expression language 

about • 145, 147 
dynamic prompts • 147, 148 

rule in Central Designer 
about • 126, 128, 130, 132, 134 
calculation • 132 
compilation • 181 
constraint • 130 
creating • 149, 154, 159, 165 
data-entry rules • 126 
deciding between a workflow rule and a global 

condition • 144 
global conditions • 141 

intrinsic • 128, 149 
mappings and • 194, 205 
selecting • 166 
translation and • 165 
workflow rules • 140 

rule model properties 
dynamic prompts and • 148 

Rule Templates tab • 420 
Rule Test Cases dialog box 

filtering the rules that appear • 181, 183 
finding a rule • 182 
opening • 175 
option descriptions • 408, 426 
properties • 487 
viewing rules • 176 

Rule Wizard • 421 
Rules tab 

about • 135 
option descriptions • 424 

S 
Schedule of Events tab 

working in • 74, 75 
Screening form 

about • 84 
overriding failures in the InForm application • 136 

search 
clearing parameters • 16 
closing • 16 
deleting • 16 
finding a user • 14 
opening • 15 
saving • 14, 15 
Users Browser • 13 

Section Editor 
Data Series Summary tab • 388 
Rule Templates tab • 420 
Rules tab • 135 

section header 
hiding • 243 
showing • 243 

section in Central Designer 
about • 99 
creating and editing • 99 
creating and translating instructions and Help • 101 
fixed repeating • 103, 239 
key items in • 119, 121 
reordering on a form • 101 
viewing parents of • 102 

section note 
creating • 242 
editing • 242 
removing • 242 
translating • 242 

section title 
editing • 243 
translating (a section title) • 243 

Select Custom Dimension dialog box • 393 
sequence numbers in a workflow • 58, 63, 72 
Set Value Action dialog box • 428 
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signature groups • 28, 29, 30, 31, 32, 440 
special InForm forms and items 

about • 84 
custom properties • 96 
Date of Visit item • 93 
Deciding whether to create custom • 96 
Enrollment form • 86 
Patient Identification form • 87 
Randomization item • 94 
Screening form • 84 
Study Completion form (special InForm forms and 

items) • 89 
validation • 271 

sponsor • 19, 20, 437 
sponsor settings • 20, 437 
standard data dimension • 195, 197 
study administration data 

about • 19 
exporting • 32 
importing • 33 
rights • 19 

Study Design Editor 
Rules tab • 135 
Workflow Structure tab • 446 

study design in Central Designer 
about • 48 
creating • 49 
working in • 250 

Study Editor 
References tab • 434 

Study Element Editor 
Rules tab • 135 
Workflow Structure tab • 446 
Workflow Structure tab • 446 

study element in Central Designer 
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